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THE NATIONAL ANTHEM
Jana-gana-mana adhinayaka, jaya he

Bharatha-bhagya-vidhata.

Punjab-Sindh-Gujarat-Maratha

Dravida-Utkala-Banga

Vindhya-Himachala-Yamuna-Ganga

Uchchala-Jaladhi-taranga

Tava subha name jage,

Tava subha asisa mage,

Gahe tava jaya gatha.

Jana-gana-mangala-dayaka jaya he

Bharatha-bhagya-vidhata.

Jaya he, jaya he, jaya he,

Jaya jaya jaya, jaya he!

PLEDGE

India is my country. All Indians are my brothers and sisters.

I love my country, and I am proud of  its rich and varied heritage.

I shall always strive to be worthy of it.

I shall give my parents, teachers and all elders respect, and treat

everyone with courtesy.

To my country and my people, I pledge my devotion. In their

well-being and prosperity alone lies my happiness.
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Foreword

Dear learners,

The syllabus of Computer Application for the Humanities stream

has been revised in view of the growing importance of computer

aided technology for various applications, especially in the field

of publishing, information sharing, data analysis, etc. While

designing the syllabus and the textbook, the other subjects of

the Humanities group were also taken into consideration. Such

a study will render the learning of those subjects more

interesting and effective. It will also enlighten the learner about

emerging trends in the field of computer applications and

Information Technology.

The syllabus of Class XII Computer Application (Humanities) focus

on the two major publishing media - print media and the web.

The textbook, designed in accordance with the syllabus, begins

with the basic idea about publishing and proceeds detailing word

processing activities. Since we are in the age of Internet and

most of us are users of web applications, HTML is introduced to

develop and host websites. The concept of database and facilities

of information retrieval are included. An exclusive section on

the new trends and issues in the field of Information

Communication Technology is also incorporated. Considering the

increase in the use of Internet, an awareness about Cyber laws

is presented to safeguard against Cyber crimes.

I hope this book will meet all the requirements for stepping to

levels of higher education and pave the way to the peak of

success.

Dr. S. Raveendran Nair

Director

SCERT, Kerala

Foreword
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1 Introduction to Publishing

After the completion of this chapter, the

learner

• explains the process of  publishing.

• identifies the different types of

publishing.

• identifies the stages in publishing.

• uses the elements of design while

designing a page.

• applies principles of design while

designing a page.

• identifies the need for creating a

proof.

• explains the need of plates for

printing.

• explains the different types of

printing processes.

• explains electronic publishing.

• identifies the different types of

electronic publishing.

Significant Learning Outcomes A
ny new idea, story, poem, news, etc. has

to be distributed for it to be useful for

the society. Information like those

discussed above can be distributed in the society

only by publishing it. Previously, publishing was

done only by printing and distributing it.  Today,

the popularity of Internet and devices like e-

book readers which are built for reading

electronic books increased the need of

publishing a work electronically. Books,

newspapers, magazines, etc. whether it is in print

or through electronic media should be

presented in an attractive manner so that it

invites the attention of  the reader. The page

design principles, page setting, placement of

images, etc. improves the readability of  a

document. This chapter discusses the ways in

which content can be presented attractively. The

different press related processes and post press

activities in printing are also discussed. The

recent developments in electronic publishing

like blogs, websites, etc. have changed the world

of  publishing.

1.1 Publishing

Publishing comprises of the creation,

compilation and mass reproduction of graphic

and text images thereby making information
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available to the public. Books, newspapers, notices, etc. are published to provide

information to the society.

The process of publishing dates back to 30000 BC when ancient humans drew

pictures on the walls of  the caves. Humans continued publishing as a way of

expressing themselves on various media like stones, barks of  trees, leaves, etc. Later

Egyptians and Chinese contributed to the invention of  paper and this led to a

major change in publishing history. In 1455, Johannes Gutenberg, developed a

printing machine. This printing machine was in use till the 20th century. With the

advent of  computers and advanced printing technologies, publishing of  books,

magazines, newspapers, etc. was made easy. Today publishing has transformed from

print media to Internet and digital formats.

Publishing can be classified as publishing through print media and publishing

through electronic media (electronic publishing). Publishing though print media

involves designing the document, printing and preparing it for distribution. The

quality of  document design, paper quality, paper size, type of  press used for printing,

type of  binding, etc. determines the quality of  publishing through print media. The

publication of  books, periodicals, etc. in digital format, usually on CD, DVD or as

downloadable from Internet, for subscribers or public is called publishing through

electronic media or electronic publishing. Today, electronic publishing has gained

popularity and has reached a stage where some magazines are having electronic

editions only. The acceptance of  devices like electronic book readers and facilities

in mobile phones to read books, prompted publishers to publish electronic versions

of  their print editions.

1.2 Publishing through print media

Publishing a work in print can be in the form of  advertisement, poster, brochure,

books, packaging, newspaper, magazine, etc. Publishing process starts when the

editor edits content for publishing. Once the content is ready, it is considered to be

Johannes Gutenberg was a German inventor who

developed a method of printing from a movable type.

In those times, the types (characters or letters) for

printing were carved from wood. Gutenberg

developed a metal type instead of wooden types for his press.

Gutenberg's innovation of developing metal types using special

alloys made production easier. He printed the first book, 'The

Bible', which had only forty two lines, using his printing press.
Johannes Gutenberg

1398 - 1468
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in production stage. The activities in production stage are classified as prepress

jobs, printing and post press jobs. Prepress is the process of  making the document

ready for printing. Printing is the stage where the actual printing happens inside a

press. Post press jobs include binding, cutting, etc. after which the document is in

the finished stage. Fig. 1.1 shows the stages in publishing through print media. We

will now discuss the different stages in publishing through print media.

Fig. 1.1 : Stages in publishing through print media

Prepress Printing Post press

1.2.1 Prepress

Prepress is the stage of work that happens between the designing of the page layout

up to sending the book for printing in the press. Prepress is an important stage

where the visual impact of the presentation is decided. While deciding the layout

of a page, the size of book or magazine is an important factor to be considered.

After finalising the layout of a page, the text and image content in the publication is

added to the page layout.

Today, there are several Desktop Publishing (DTP) softwares available that make

this process easy. Desktop Publishing is the creation of  page layouts for documents

using DTP software. Some of  the popular DTP software are Scribus, Adobe

InDesign, QuarkXPress, etc.

A. Designing

You might have noticed while browsing through books in a library or a book shop,

some books catch our eye. They prompt us to read through some pages of the

book. This is mostly due to the design of the book. The design of a book has an

impact on the readability and success of the published material. Therefore, more

attention is given by DTP operators while designing a page. Page layout design

deals with the arrangement of visual elements in a page. It involves the specific

communication objectives of the book. Some of the elements and principles of

design that creates an impact on the reader of the publication are given below:
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Elements of design

i. Line : Lines are useful for

dividing space and drawing the eye

to a specific location. Artists use

lines to create edges, outlines of

objects, etc. A line is created by

the movement of the artist's pen.

The direction of a line can convey mood. Horizontal lines are calm and quiet, vertical

lines suggest movement, while diagonal lines strongly suggest movement and give

more of  a feeling of  energy to a picture. The lines in Figure 1.2 show the moods

reflected by the lines.

ii. Shape : Shapes, geometric or organic, add

interest. Shapes are defined by boundaries,

such as lines or colour. They are often used to

emphasize a portion of the page. Shapes have

two dimensions, length and width. They can

also be geometric or free-form. A good

designer must think in terms of  how the

various elements of a design are creating

shapes, and how those shapes are interacting.

Figure 1.3 shows the different shapes and their effect.

iii. Colours : Colour is one of the most noticeable

elements of a design. It can stand alone, as a background,

or can be applied to other elements, like lines, shapes,

textures or typography. Colour creates a mood. Every

colour says something different, and combinations can alter

that impression further. Figure 1.4 shows the different

colours.

iv. Space : White space is the area in a document

where there is no text or graphics. When used

effectively, white space can be used to guide the

reader's eyes exactly where you want them to go. Space

is also a three dimensional volume that can be empty

or filled with objects. It has width, height and depth.

Space that appears in a two dimensional painting

creates an illusion of three dimension and a feeling

of  actual depth. Various techniques can be used to show such visual depth or space.

Figure 1.5 shows a feeling of three dimension and depth.

Fig. 1.2 : Design using line

Fig. 1.3 : Different shapes

Fig. 1.4 : Colours

Fig. 1.5 : Space creates depth
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v. Typography : One of  the most important

parts of  design is typography. Typography is

the art and technique of arranging type (letters)

to make written language readable and beautiful.

The arrangement of type involves selecting

typefaces, point size, line length, line-spacing,

letter-spacing and adjusting the space within

letters pairs. The fonts used tell the readers about

the seriousness of  the publication. Words are

important, but the style of the words is equally essential. Generally fonts are classified

into two styles: Sans Serif and Serif. Sans Serif is a style of fonts 'without feet'.

Common Sans Serif  typefaces include Arial, Tahoma and Verdana. Serif  style of

fonts have a 'little feet.' Common Serif fonts include Times Roman, Garamond and

Palatino. The visual difference between the two styles is shown in Figure 1.6.

Principles of design

Principles are concepts used to organise or arrange the elements of design. The

way in which these principles are applied affects the expressive content, or the message

of the work. The principles of design are balance, proportion, rhythm, emphasis

and unity.

i. Balance : Balance is the distribution of  the visual weight of  objects, colours,

texture and space. In visual images, balance is formal when both sides are

symmetrically arranged. Balance is informal when sides are not exactly symmetrical,

but the resulting image is still balanced. Informal balance is more dynamic than

formal balance and normally keeps the learner's attention focused on the visual

message. Figure 1.7a shows formal balance and Figure 1.7b shows informal balance.

Fig. 1.6 : The different font styles

Fig. 1.7a : Formal balance Fig. 1.7b : Informal balance

ii. Repetition : Repetitive works with a pattern makes the artwork look active. The

repetition of elements of design creates unity within the artwork. Repetition with

variation is interesting, without variation repetition can become monotonous. If
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you wish to create interest towards the document, the repeating element should

include a degree of variation. Repetition can also give a work a sense of motion.

Figure 1.8a shows a repetitive work without variation and Figure 1.8b displays a

repetitive work with variation.

iii. Contrast : Contrast is the association of  opposing elements like opposite colours,

tone, direction, etc.  It can be contrast in the colour wheel where opposites like red

and green, blue and orange, etc. are used (Shown in Figure 1.9a). Contrast in tone

can be light and dark (Shown in Figure 1.9b). Contrast in direction can be horizontal

and vertical. The major contrast in a painting should be located at the center of

interest. Too much contrast scattered throughout a painting can destroy unity and

make a work difficult to look at. Contrast allows us to highlight key elements in our

design. Contrast focuses on making items stand out by emphasizing differences in

size, colour, direction and other characteristics.

Fig. 1.8a : Repetition without
variation

Fig. 1.8b : Repetition with variation

Fig. 1.9a : Colour contrast Fig. 1.9b : Tone contrast
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iv. Harmony : Harmony is the visually satisfying effect of  combining similar, related

elements. The combination of  adjacent colours on the colour wheel, similar shapes,

related textures, etc. Harmony in visual design means all parts of  the visual image

relate to and complement each other. Harmony of  colours and shapes are displayed

in Figure 1.10a and 1.10b respectively.

Fig. 1.10a : Harmony of colours Fig. 1.10b : Harmony of shapes

v. Unity : Relating the design elements to

the idea being expressed strengthens unity.

A design on active aggressive subject

would work better with diagonal

direction, course, rough texture, angular

lines, etc. as shown in Figure 1.11. A design

on quiet passive subject would be better

if  horizontal lines, soft texture and less

tonal contrast are used. Unity in a painting also refers to the visual linking of various

elements of the work.

vi. Dominance : Dominance raises interest,

reducing confusion and monotony. Dominance

can be applied to one or more of the elements to

give emphasis. A dominant element in the center

(horizontally or vertically) creates symmetry, producing a formal, static design. A

dominant element close to the edge creates an out of balance tension as shown in

Figure 1.12. The position of the dominant element (colour, shape, line, etc.) should

be used to the advantage of the topic.

Everyone involved in the creation of visual content, whether knowingly or

unknowingly, uses this collection of  tools known as the elements and principles of

Fig. 1.11 : Unity

Fig. 1.12 : Dominance
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design. An understanding of this simple set of tools opens infinite choices to them.

The designers can make use of these tools to make their designs look right.

Once the page layout and design is set, the entire material is reviewed for

modifications. The correction cycle includes processes such as proof  reading and

image retouching. This is continued until no further modifications are required.

Design a poster in a chart paper for saving trees. Apply the design principles and

use the elements of design effectively to convey the message.

Know your progress

1. What is publishing?

2. The different classifications of printing are _______ and

_______.

3. What are the three activities in the production stage of publishing

through print media?

4. State whether true or false.

a. Prepress is the process of making the document ready for

printing.

b. Page designing is done during the post press stage.

5. Choose the odd one out.

a. line b. typography c. balance d. colours

6. Expansion of DTP is _______.

7. What do you mean by unity in design?

B. Pre-flighting

Once the graphics file has been created by the designer, it undergoes the next pre-

press stage called pre-flight. In this stage, the file is checked to make sure it contains

all the elements necessary for a successful printing.

The file is checked to make sure the images have the proper format and resolution,

all the fonts are included and CMYK colours are set up appropriately. We have

discussed the use of CMYK in Chapter 7 of Class XI.

You might have noticed the mark shown in Figure 1.13a in the corners of  books.

This is called crop marks. Crop marks (trim marks) are lines printed in the corners

of  the page to show the printer where to trim the paper. The layout elements such

as margins, crop marks and bleeds are also checked to make sure that it is set up

correctly. Bleed refers to printing that goes beyond the edge of  the sheet before
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trimming. It is the bleed area

that is to be trimmed off. A

margin is the area between the

main content of a page and the

page edges. The margin helps to

define where a line of text

begins and ends. Crop marks,

bleed and margin are displayed

in Figure 1.13b.

Depending on the software used to create the graphics file, sometimes the entire

file needs to be converted to a format better suited for commercial printing. The

most popular format that is supported by most printers is Adobe PDF (Portable

Document Format).

C. Creating a proof

In this stage, a proof is prepared, which will be a representation of how the finished

piece will appear when it is printed.

In the case of  business cards or postcards, a proof  is often created as a PDF. Since

a PDF is an electronic file, it can be e-mailed to the client for approval. But, if the

process involves finishing operations such as binding or folding, like that of a book

or brochure, it is recommended that a physical proof be created. A physical proof

will demonstrate how the piece will be constructed, where it will be folded, the

order of  the pages, etc.

In addition to avoiding any unforeseen errors, the purpose of  the proof  stage is to

ensure that the printed material is of the quality required.

D. Printing plates

After the proof has been approved, the

project is ready to be produced on a

printing press. If  the project is to be

produced on a digital printing press,

printing of plates is not required. This is

because the graphics file can be

electronically transferred directly to the

digital press for output.

However, if the project is to be produced

on an offset press, it will need printing
Fig. 1.14 : Plate prepared  for offset press

Fig. 1.13a : Crop
mark

Fig. 1.13b : 1-Crop marks, 2-
Bleed, 3-Margin
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plates. In this case, the final stage of  the pre-press process is the creation of  printing

plates. Printing plates are made for each job and they provide the method for

transferring the inked images to the proper place on the paper. The size of  a plate

depends on the press. Each plate can be used to print a number of  pages, depending

on the size of the page to be printed. The plates fixed on an offset press are shown

in Figure 1.14.

In the case of colour printing, separate plates are to be prepared for the four colour

components cyan, magenta, yellow and black, known as CMYK. For this, colour

separation of the project has to be done. Colour separation is the process by which

original artwork is separated into individual colour components for printing. By

combining CMYK colours, a wide spectrum of  colours can be produced on the

printed page. When the colours are combined on paper, the human eye combines

these colours to see the final image.

1.2.2 Printing

Once the prepress jobs are over, the project is ready for the next stage - printing.

Here the finished file/plate is given to the press for printing. The printing process

can be lithography, digital, gravure, flexography and screen printing. We will discuss

the different printing processes in detail below.

A. Lithographic printing

Lithography is an offset printing technique using

plates. In offset printing, ink is applied to the

printing plate to form an image to be printed. It is

then transferred or offset to a rubber blanket. The

image on the blanket is then transferred to the paper

to produce the printed product. The lithographic

process for printing is based on the repulsion of

oil and water. Lithographic printing is popular for

commercial printing of  newspapers, books, forms,

etc. An offset press is shown in Figure 1.15.

B. Digital printing

Digital printing refers to methods of printing from a digital image directly to a

variety of media. In this type of printing plates are not used. Digital printing can be

done using large format, high volume laser or inkjet printers. Digital printing has a

higher cost per page than more traditional offset printing methods. But this price is

usually offset by avoiding the cost of all the technical steps required to make printing

plates. It also supports the modification of  the image (pages to be printed) anytime,

Fig. 1.15 : Offset press
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which is not possible in offset printing once the

plates are made. It also allows on-demand

printing, where a book is printed only when an

order is received. A digital press is shown in Figure

1.16.

C. Gravure printing

Gravure or rotogravure printing is used in flexible

packaging printing process. It can be used to print

on materials including polyester, nylon, polyethylene, aluminium foils and paper.

The cylinder of the gravure printer is engraved with the image to be printed. The

cylinder is immersed in ink and its engraved cells store the ink which is transferred

to the material to be printed. Its features are good quality image reproduction and

low cost per unit on high volume production. Rotogravure printing is a suitable

choice to print on laminated packaging for different ingredients. Figure 1.17a shows

a rotogravure press and Figure 1.17b shows printing samples.

Fig. 1.16 : Digital press

Fig. 1.17a : Rotogravure press Fig. 1.17b : Gravure printing samples

Fig. 1.18 : Flexographic press

D. Flexography

Flexographic presses are capable of

producing good quality printing on many

different materials. It is considered as the

least expensive and simplest of the printing

processes used for printing on packing

material. Flexography has a relatively simple

operation, similar to the use of  a rubber seal

and ink stamp pad. The image to be printed

is prepared on flexographic plates made of

a flexible material, such as plastic, rubber,

etc.  This plate is then inked and then it is

transferred to printing material. Compared
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to offset and gravure, its ink dries faster which results in faster production, thereby

lowering costs. Due to this the use of  flexographic printing presses is on the rise.

Flexography is used for the production of  shopping bags, flexible plastics for milk

and other food packets, self-adhesive labels, disposable cups and containers,

envelopes and wallpaper.

E. Screen printing

Screen printing is a simple

process for printing. It is a

printing technique that uses a

woven mesh to support an ink

blocking stencil to receive a

desired image. A rubber blade

is moved across the screen

stencil which forces the ink

through the mesh openings on

to the print surface. Screen

printing has to be done on a flat

surface and the area being printed should not be under pressure. It can be used to

print on a wide variety of  materials, including paper, plastics, glass, metals, fabrics

and others. A screen printing process is displayed in Figure 1.19.

1.2.3 Post press

Post press is the final stage in the printing process. It involves all the cosmetic or

functional changes that are done on the final print. The four major operations in

post press are folding, assembling, binding and cutting. There are many additional

post press finishing processes such as varnishing, laminating, embossing, perforating,

drilling, etc. that improves the appearance or functionality of the printed material.

A. Folding

Usually in a printing press, several pages

are printed on both sides of a large paper

and then they are folded according to an

imposition scheme. Imposition scheme is

the arrangement of pages for printing in

such a way that when the sheet is folded,

the pages will be in the correct order. The folding process can be according to

various imposition schemes. A sample layout of  the pages after printing is given in

Figure 1.20. Page numbers are specified in the figure. This sheet has to be folded

Fig. 1.19 : Screen printing

Fig. 1.20 : Folding scheme for 16 pages
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according to a scheme so that the pages are in serial order. A folding machine can

automatically fold any type of paper according to the imposition scheme for

notebooks, textbooks, magazines, brochures, etc.

B. Assembling

The assembling/gathering is the process that brings all the printed pages of the

final product together in the required order according to the binding style. Assembly

processes can be manual, semiautomatic or fully automatic. Manual and

semiautomatic assembling requires the attention of  a worker. Fully automatic

assemblers are kept in line with the binding machines in order to improve efficiency.

C. Binding

Book binding is the process of physically assembling a book from a number of

folded or unfolded sheets of paper or other material. The type of binding is usually

selected based on the function of the document, the number of pages it contains

and the printing budget. Some of the popular binding techniques are hard cover

binding, punch and binding (spiral binding), thermally activated binding, stitched

binding, etc. Some of the types of binding are given

in Figure 1.21.

D. Cutting

Cutting is done according to the crop marks printed

on the paper. Cutting can be either done manually

or using a machine. A cutting machine cuts the

stacked printed pages. The cutting blade is powered

electrically. Though cutting is generally considered

a postpress operation, most lithographic and

gravure presses have integrated cutters as well as

Fig. 1.21 : Different types of binding

Fig. 1.22 : Cutting machine
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Calico is an all-cotton plain woven fabric printed with simple designs in

one or more colours. Calico originated in Calicut, India, by the 11th century.

Calico cloth was used for binding books. This style of binding was popular

as calico binding. This process involved stiching, gluing and then coving

the area to be binded using calico cloth. In the 17th and 18th centuries calicoes were

an important commodity traded between India and Europe.

Job Definition Format (JDF) is a printing industry standard designed to

simplify information exchange between different programs and printing

systems. It is managed by the industry association CIP4 (International

Cooperation for the Integration of Processes in Prepress, Press and

Postpress Organization). It manages the print, packaging and label work (job) flows.

JDF starts a job ticket with an 'intent' for the job. More JDF details are added later

in various steps of the production workflow. A JDF ticket contains information that

enables each node to determine what files it needs as input, where they are found and

what processes it should perform. After executing a task, it modifies the JDF job

ticket to describe what it has done and examines the JDF ticket to determine where

accompanying files and instructions should be sent next.

Know your progress

1. What is pre-flighting?

2. The expansion of pdf is ____________.

3. What is the purpose of  creating a proof?

4. State whether true or false.

a. The lines printed in the corners of the page to show the

printer where to trim the paper is called margin.

b. Bleed refers to printing that goes beyond the edge of the

sheet before trimming.

5. Name the printing technology that can be used to print on nylon.

a. Gravure b. Digital c. Offset d. Screen

6. List the different types of  binding.

7. What is lithography?

equipment to perform related operations like perforating. Perforation is a small

hole or a row of small holes punched in a sheet of paper so that paper can be easily

torn through this. Figure 1.22 displays a cutting machine.
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1.3 Electronic publishing

You might have noticed people watching movies, enjoying songs, reading books,

etc. in their mobile devices like mobile phones, tablets, laptops, etc. while travelling.

Today more and more people are forced to spend time for travel regularly due to

many reasons like work, visiting relatives, etc. They wish to utilise their time fruitfully

by reading books, listening to music, etc. This has compelled the publishing

companies to release electronic versions of  their publications. These publications

can be bought online and people can read them using their mobile devices.

Electronic publishing is the digital publication of  e-books, digital magazines and

the development of  digital libraries and catalogues. Electronic publishing takes the

format of  works published online, on a compact disk, e-mailed or provided in a

file format compatible with handheld electronic readers. It is also called e-publishing

or digital publishing.

Electronic publishing can be either web based publishing or as digital distribution

of  content. In web based publishing, information is published in websites. We can

browse and use the website to read the material. Websites like www.wikipedia.org

publish content over their websites. In the case of  digital distribution publishing,

the material can be downloaded from a website and can be read using an electronic

reading device like mobile phone or e-book reader. Many publishers now publish

their books electronically in downloadable format.

The effective use of elements of design improves the appearance of content in

elctronic publishing. Principles of  design can also be used to enhance the design of

pages.

1.3.1 Web based publishing

Web publishing or online publishing is

the process of publishing content on

the Internet. It includes creating and

uploading websites, updating

webpages, and posting blogs online.

The published content may include text,

images, videos, and other types of

media. Websites like Wikipedia, online

newspapers, blogs, etc. are examples of  web based publishing.

Web based publishing requires an Internet connection to read the material. This

material is available on any device that has an Internet connection. Web based

publishing are mostly freely available on Internet.

Fig. 1.23 : Web based publishing
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To develop a website for publishing content, we require a web development tool

like, HTML (Hypertext Markup Language), CSS (Cascading Style Sheet),  JavaScript,

PHP, etc. The site thus developed has to be uploaded to a web server, called web

hosting. We will discuss HTML, CSS and the technologies for uploading web sites

to a web server in detail in the forthcoming chapters. Publishing through blogs

does not require much knowledge about the web based technologies. This can be

done easily using the user friendly features provided by the popular blogging services

like blogger.com, wordpress.com, etc.

Since web publishing does not require physical materials such as paper and ink, the

cost of  publishing content on the web is almost nothing. Therefore, anyone with

basic knowledge of  Internet can be a web publisher. It has a vast audience since

content posted on the web can be viewed by anyone in the world with an Internet

connection. These advantages of web publishing have led to a new era of publishing

that was not possible before. Figure 1.23 displays websites and blogs in various

devices.

1.3.2 Digital distribution

The electronically published materials like e-books, e-journals, etc. can be downloaded

from various websites. This type of  publishing is called digital distribution. Book

publishing companies sell the e-book versions of their hard bound publications

through the various e-commerce websites. Users can download any number of

these e-books from these websites to their mobile devices and can read them when

required.

Barnes & Noble - Nook Apple-  iPad

Fig. 1.24 : Popular e-book readers

Amazon - Kindle

An e-book reader is a mobile electronic device that is designed for reading e-books

and digital periodicals. An e-book reader is similar in form, but more limited in

purpose than a tablet. In e-book readers, the light in the screen is from above,

whereas in the case of  mobile phones, tablets and laptops the light from the screen
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is backlit. The backlit screen causes fatigue, if  used for reading for long hours. The

front lit screens in the e-book readers provide a better reading experience. In

comparison to tablets, many e-book readers are better than tablets for reading

because they are more portable, have better readability in sunlight and have longer

battery life. The popular e-book readers are Amazon Kindle, Barnes & Noble Nook,

Apple iPad, etc. Some of  the popular e-book readers are displayed in Figure 1.24.

Electronically published materials can be developed using the same DTP software

used for print based publishing. The process of  publishing the material in the

prepress stage of  print based publishing is the same here too. The material to be

published is then converted to a format readable by the e-book readers. The popular

e-book formats are PDF, iBook, Kindle, etc.

PDF (Portable Document Format) was developed by Adobe Systems and first

released in 1993. This format was developed to provide a platform independent

means of  exchanging documents. PDF documents can be read using a wide variety

of  readers freely available like Adobe Reader, Open Office.org, Nitro PDF, etc.

PDF files are supported by almost all modern e-book readers, tablets and

smartphones. iBook is the native file format for Apple iPad and Kindle is the file

format for Amazon's Kindle book reader.

Know your progress

1. What is electronic publishing?

2. Name any two web based publishing technologies.

3. Write an example of  a popular blog for publishing.

4. What is the use of an e-book reader?

5. PDF was developed by _____________.

6. List two examples for PDF readers.

Let us conclude

Any creative work has to be published for distributing to the society. The success

of a published work depends on its appearance. Publishing can now be divided

into print based and digital publishing. Print based publishing dates back to the

years of  Johannes Gutenberg, the person who developed the first printing machine.

Today the different stages of  print based publishing like prepress, printing and

post press has been automated. Prepress work includes designing the document to

be printed. Softwares are used to design the layout of a page. This is done based on

the principles of  design and also by giving importance to the various design elements.
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The well designed material is checked for errors by creating a proof and then

transferred to plates. Once the plates or the material is ready for printing, it can be

printed using the press suitable for the material. Once printing is over, the pages

need to be cut, folded, assembled and bound to form a book. Electronic publishing

has gained importance due to the popularity of Internet. The different types of

electronic publishing are web based and downloadable format. Web based

publishing can be done through websites or through blogs. They are mostly cheap.

Downloadable e-books requires specific softwares to read. Portable e-book readers

can be used to buy and read e-book versions of popular hard bound books online.

 Let us assess

1. Explain the three different stages in publishing.

2. Arun plans to design a brochure for his restaurant. Name two softwares that

can be used to design the brochure.

3. Explain the elements of design.

4. In a paper advertisement, a designer has space to draw lines. Suggest a line

style that can give a feel of  energy to the brochure.

5. Classify the following fonts into serif  and sans serif  categories.

Arial, Times New Roman, Garamaond, Verdana, Palatino

6. Write short notes on contrast and balance in design principles.

7. Why are plates not used in a digital press?

8. What is the use of plates in an offset press?

9. What is colour separation?

10. Harilal is planning to publish a book. Suggest a printing process that can be

used for this purpose. Justify your suggestion.

11. Why is flexography used in mass production when compared to other printing

processes?

12. Explain how screen printing is done.

13. What do you mean by post press? List and explain the four major operations

that are done during this stage.

14. What is electronic publishing? What are the different types of electronic

publishing?

15. You have written a story in English and you wish to publish it electronically.

Which type of publishing would you prefer? Why?

16. Vimala has an e-book reader and a mobile phone with a large screen. Which

device will be better for reading while travelling? Why?
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Introduction to Word

Processors

Significant Learning Outcomes W
e discussed various aspects of

publishing in the last chapter. It is

identified that pre-press activities

play an important role in print-media

publishing. This chapter introduces a type of

software called word processor that helps to

perform prepress activities when the text

material is ready. Word processor is an

application software tool or package that

processes textual matter and creates organised

and flawless documents. Document is a file

that contains text or images which was earlier

prepared using pen and paper, and typewriting

machines. Bio data, reports, write-ups,

publications, etc are examples of  documents.

Word processor not only removes all the

limitations of conventional typewriting

machines but also offers various useful and

attractive features. Many software companies

offer word processor packages. A large

community of  users like scholars, teachers,

lawyers, doctors, publishers, students, etc.

enjoy the features of  word processors. Some

of the popular examples are LibreOffice

Writer, Microsoft Word, AbiWord, etc.

After the completion of this chapter, the

learner

• recognises the use of word

processing software and its

features.

• differentiates various components

of the IDE of the word processor.

• creates documents using word

processor.

• copies or moves text from one

place to another in a document.

• searches a particular text in the

document and replaces it with

another text.

• changes the appearance and style

of text by applying the features like

bold, italic, underline, font face,

font size, etc.

• configures a paragraph of text by

changing alignment, indent, line

space, etc.

• creates lists using bullets or

numbers.

• alters the page size, orientation and

page margins.

• inserts header and footer in pages.

• takes the  hard copy of a document.

2
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2.1 Features of a word processor

The word processing software is developed in such a way that it helps the creation
of  a document with ease. It provides menus and tools to perform various operations
like creating documents, editing and formatting text, inserting tables and images,
etc. Let us see some of  the important characteristics of  word processors.

Quickness: Word processors help easy creation of  a new document and
manipulation of  the content. Tools are available for speedy typing, editing and
formatting in the form of  menus, icons and short-cut keys. Document files can be
saved, retrieved and printed quickly and easily.

Word wrapping: As we type the text matter towards the end of  a line, a word may
not fit completely in the line. In that case, the word going past the right margin is
placed in the next line automatically. This feature is called word wrapping.

Editing features: Editing is the process of correction like insertion or deletion of
text, copying or moving of  text, etc. We can perform these with ease using word
processors.

Drawings and graphics: Word processor provides tools for drawing various
shapes and figures. It also allows pictures or images to be inserted in documents.

Tables: Tables are provided in documents to present text or data in rows and
columns.

Formatting features: Word processor offers various types of  formatting like
character formatting, paragraph formatting and page formatting. Formatting the
content makes a document more legible and beautiful.

Header, Footer and Page number: Header is the text appearing at the top of  all
pages and footer is the text appearing at the bottom of all pages in a document.
Page numbers are continuous numbers given to each page in the document. Word
processors provide these features to manage multi pages document effectively.

Object Linking and Embedding (OLE): OLE is a program-integration
technology used to share information between programs through objects. Objects
are saved entities like images, charts, equations, files created using other software,
etc. These objects can be linked and embedded with a document.

Spell check and Grammar check: Using this feature, a word processor scans
documents to identify any spelling or grammatical error in the document. The
comparison of  the text in document is made with a standard built-in dictionary.

Mail merging: This facility helps to print many documents with same content and
addressed to different people. This is mainly used for mailing invitation letters,
notices, etc.

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



29

2. Introduction to Word Processors

Index and Table of contents: Index is usually created at the end of  a professional

document like project report, survey report, government write-ups, etc. Index

includes important terms or words appearing in the document. Table of  Contents

appears at the beginning of a professional document or textbook, after the title

page. This contains the main headings and sub headings appearing in the document

with the respective page numbers. Both the above pages can be easily created using

the options available in word processors.

Templates: Templates are predefined document formats available with the

software. They have predesigned layouts and formats. It is easy to create a new

document from a template. We need only to enter the text at required positions.

This chapter introduces the basic formatting features of  word processing software.

The advanced features will be explained in the next chapter. Though there are several

products for word processing, we use the LibreOffice Writer for further discussions.

It is one of the components of LibreOffice integrated package, which is an open

source software. It provides all features of  a typical word processor. LibreOffice

has separate versions for both Linux OS and Windows OS.

2.2 LibreOffice Writer IDE

In the Linux Operating System, we open LibreOffice Writer using the command

sequence Applications → Office → LibreOffice Writer. The LibreOffice Writer window

will be opened as shown in Figure 2.1. This window is known as LibreOffice Writer

Integrated Development Environment (IDE) window. The main components of

the IDE window are Title bar, Menu bar, Toolbars, Ruler, Scroll bars and Text area.

Fig.2.1: LibreOffice Writer IDE window

Title Bar

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



30

Computer Applications (Humanities) - XII

These components are similar to those seen in the opening window of LibreOffice

Calc. Let us have a look at these components.

Title bar: It is the topmost part of  the IDE window. It shows the name of  the

document and the name of the software at the left, and the control buttons (Minimize,

Maximize and Close) at the right. In Figure 2.1, we can see the text item Untitled1,

the default name of the document which can be changed when we save the document

with a user-supplied name. It is followed by the name of the software

LibreOfficeWriter. We know that on clicking the Minimize button the document

window (IDE) is minimised to a small icon and kept in the task bar, Maximise

button is used for maximising the current document window to fit the whole screen

area, and the Close button closes the software itself.

Menu bar: It contains all the important menus available with the software. They

include File, Edit, View, Insert, Format, etc. When we click on a menu item, a pull-

down menu appears with more commands associated with the menu item as options.

There may be sub-menus under certain options in the pull-down menus.

Toolbar: It contains shortcut commands in the form of  various buttons. Each button

is characterised by the presence of an icon (small pictures or symbols). If we place

the mouse pointer on a button, a short text will appear as its description called

'Tool Tip'. There are many toolbars like Standard toolbar, Formatting toolbar,

Drawing toolbar, etc. Toolbars can be managed using the View menu. Additions

and removal of toolbars are possible by selecting the required toolbar from the

list. In Figure 2.1, we can see Standard toolbar and Formatting toolbar at the top

and Drawing toolbar at the bottom.

Scroll bars: Scrolling is the process of moving up and down or left and right through

the document window. There are two scrollbars namely Vertical and Horizontal

scroll bars for scrolling the document vertically or horizontally. The Vertical scroll

bar appears at the right most part of the IDE screen. The Horizontal scroll bar

appears just above the Status bar which is at the bottom part of  the IDE window.

This scroll bar will be visible only when it is required, i.e.; when the document

window resizes to small window. We can see vertical scroll bar in Figure 2.1.

Ruler: This allows changing the left and right margins of the document. There are

two rulerbars. One is at the top and the other is at the left side. Figure 2.1 shows

In Figure 2.1, the Title bar is marked. Similarly, identify the other

components that are detailed below and mark them in the figure.

You may refer the opening window of  LibreOffice Calc that you

learned in Class XI or run the software in the computer.Let us do

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



31

2. Introduction to Word Processors

these rulers. Margin is the distance between the text and an edge of  the paper. The

ruler in the IDE window displays the positions of  margins.

Margins are mainly of four types:

1. Left Margin : The distance between the text and the left edge of  the paper.

2. Right Margin : The distance between the text and the right edge of  the paper.

3. Top Margin : The distance between the text and the top edge of  the paper.

4. Bottom Margin: The distance between the text and the bottom edge of  the paper.

Status bar: It is visible at the bottom of  the IDE window. It displays information

like page numbers, column and line number where the cursor (small vertical blinking

character) is located, the selected language etc. as shown in Figure 2.1. The page

number area usually shows the page number where the cursor waits and the total

number of  pages in the document. For example, Page 1/4 indicates that the current

position of the cursor is at page number 1 and the total number of pages in the

document is 4. Another important item on the Status bar is the zoom area which is

placed at the right most end of  the Status bar. The middle point button present in

the area can be drawn to the right (+) or to the left (-). If we drag the button to the

right (zoom out), the document window enlarges and when the button is moved

left (zoom in), the document window shrinks. This is very useful for getting a closer

view or distant view of the document. The Status bar also shows the Insert/

OverWrite status which will be discussed later.

Text area:  It is the place where we type the text matter of  the document to be

created. It is also called the document area. The cursor will be present in the text

area.

2.3 Creating a new document

We have seen that when we run the LibreOffice Writer in a computer we get a

window as shown in Figure 2.1. Actually a new document is opened and we can

input or type in the desired text in this document. If an existing document is visible

in the IDE, a new document can be opened using the command sequence File →New

→Text Document or by pressing the key combination Ctrl+N (the keys Ctrl and N).

A new document can also be open by clicking New button  in the Standard

toolbar. In such a case, the new document will be opened in a new IDE window. Let

us prepare an article for the school magazine about voluntary blood donation.

Assume that we are ready with enough material for the article. Let us type in the

text matter in the new document. Assume that the first page looks like the one as shown

in Figure 2.2.
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Fig.2.2: A document in Writer IDE window

While typing, the space bar key, tab key and Enter key, etc. may have to be used. We

can see that the text matter is aligned to the left margin. The font characteristics of

the text take the default values like Liberation Serif face, 12 point size, black colour, etc.

These are visible in the Formatting toolbar (just above the horizontal ruler) in the

window. We can see that some words are underlined in red colour. This indicates

that the word is misspelt. We can correct them by adding some letters or deleting

some other letters. There may be grammatical error also. Such corrections are part

of  editing process. We may also have to change the font characteristics of  some

text and set the margins and spacing to make the article more presentable and

attractive. These are part of  the formatting processes. We will discuss these details

in the coming sections.  Before doing these processes, it is better to save the document

with a suitable file name.

2.4 Saving a document

As mentioned in the previous section, when we open a new document for storing a

text matter, it is better to be saved frequently to avoid loss of material due to

unexpected termination of  the program. The document can be saved permanently

in the computer by selecting the command sequence File → Save or by pressing the

key combination Ctrl+S or by clicking the Save button  on the Standard toolbar.
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When we save the document for the first

time using any of  these methods, the

Save window appears as shown in

Figure 2.3. We can give a suitable name

to the file in the text box against the label

Name:. As seen in Figure 2.3, the default

name Untitled1 will be highlighted

initially, which will be replaced by the

user-supplied name. The file will be

saved with extension .odt in the current

folder. We have the freedom to place

the file in the desired folder. Let us save

the file with the name donation.odt. The

window shown in Figure 2.3 will not appear on further execution of Save command.

But, if we select the command sequence File → Save As... or press Ctrl+Shift+S

frequently, this window will appear each time and the same document has to be

saved in another name in the current folder or with the same name in another folder.

When we complete a session in the preparation of the document, it is to be closed.

Fig. 2.3: Save window of Writer

2.5 Closing a document

At the end of a session we need to close the file in which we are preparing the

document. A file can be closed by using the command sequence File → Close or by

clicking the Close button  in the Menu bar. Note that if  we click the Close

button  in the Title bar, the software LibreOffice Writer will be closed along

with the file(s) in use. Before closing a document, it is always better to save the latest

changes in the file. In case if we have not saved the document with the latest version,

the Writer will prompt us with a dialog box with three options namely, Close without

saving, Cancel and Save as shown

in Figure 2.4. One of those

buttons can be selected. If we

select the Save button, the Save

dialog box will appear if it is the

first time saving, otherwise the file

will be saved with the latest

Create a document to prepare an assignment paper on "Influence of

the Visual Media on Students". Initially you collect sufficient material

and start typing into the document, and save it in a file. Don’t bother

about the format, layout, mistakes and such things for the time being.Let us do

Fig. 2.4: Save document? window
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changes in the current file name. If we click the Close without saving button, the file

will be closed without saving the changes after the last save. On clicking the Cancel

button the dialog box will disappear and the document will remain in the edit mode

itself.

The final step of  every Writer session is to come out of  the software. It can be done

with the command sequence File → Exit LibreOffice or using the keyboard shortcut

Ctrl+Q. It is also possible with a click on the the Close button in the Title bar as

mentioned earlier.

2.6 Opening a document

Suppose we want to see the content of a file or make some modifications in the

form of  adding more data, deleting some existing content or replacing some current

portion with new material. Whatever be the intention, the file is to be opened first.

This can be done with the command sequence File → Open or with the shortcut

keys Ctrl+O. It is also possible with a click on the Open button    in the Standard

toolbar. Now a dialog box appears as shown in Figure 2.5. Choose the required file

from those visible in the

window. If  the file is not found

in the opened folder, find the

folder first from the Places list

box in the window. Once the

file is selected, click the Open

button in the window. Double

click on the file will also do the

same. The file will be displayed

on the screen.

2.7 Editing a document

Editing is a process of bringing about changes in a document. It may include copying,

moving, finding, replacing, deleting, and inserting text or graphics. This process

may require navigation through the document. Let us see the common activities

during document editing.

2.7.1 Prerequisites for editing

Before editing a document we may need to perform some operations like navigation,

Insert/OverWrite mode setting, selection of  text, etc. Let us familiarise ourselves

with these operations.

Fig. 2.5: Open dialog box

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



35

2. Introduction to Word Processors

A. Navigation

Moving froma point to another in a document is normally called navigation. While

editing a document, to make changes at a particular location, the cursor is to be

placed at that place. The following keys facilitate navigation:

Arrow keys: To move the cursor to the very next character (to the left or right, or

at the previous or next line).

Home: To move the cursor to the beginning of  the current line.

End: To move the cursor to the end of  the current line.

Page Up: To place the cursor after moving one screen full of  content upwards from

the current position.

Page Down: To place the cursor after moving one screen full of  content downwards

from the current position.

Ctrl+→→→→→: To move the cursor to the beginning of  the previous word.

Ctrl+←←←←←: To move the cursor to the beginning of  the next word.

Ctrl+Home: To move the cursor to the beginning of  the document.

Ctrl+End: To move the cursor to the end of  the document.

Navigation can also be performed by scrolling the mouse. The document can be

scrolled upwards or downwards by keeping the mouse pointer anywhere in the

document and rolling the scroll wheel on the mouse. The same effect can also be

achieved by dragging the scroll button on the scroll bars in the window or clicking

on the up and down scroll arrows. In Figure 2.1, you might have identified a vertical

scroll bar. Though it is not present in this figure, there is a horizontal toolbar at the

bottom of  window.

B. Insert/OverWrite mode setting

The Status bar at the bottom of  the IDE window shows this setting. If  we can see a

blank box to the right of  Language status display, we will say that the document is

in Insert mode. This mode allows insertion of a new character in the document

without losing the existing information. If  we press the Insert key in the keyboard,

the status will change to OverWrite mode which we can see in the Status bar. In this

mode, a new character will replace the existing one. Insert key is a toggle type key.

By default the mode is Insert mode. When we insert a new text in the Insert mode,

the existing matter will be shifted to the right to accommodate the new text. Addition

of  new text in a document and replacing existing content by new information are

all part of  editing.
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C. Undo and Redo actions

Writer provides two special buttons Undo and Redo . We can use Undo

for undoing or cancelling the most recent actions. However, if  we want to retrieve

an action cancelled by Undo we can use Redo button. The Undo and Redo actions

can also be performed by the keyboard shortcuts Ctrl+Z and Ctrl+Y, respectively.

D. Text selection

While working with a document, we may have to perform some operations on a

block of text. A word, phrase, sentence, paragraph or even the entire document

can be a block of text. The block of text is to be marked or selected prior to

perform any edit operation. This is called text selection, which is mostly done in

two ways as follows:

Using mouse: Place the cursor at the starting position of the text to be selected.

Hold down the left mouse button and drag slowly till the end of the text is selected.

Using keyboard: Place the cursor at the starting position of the text to be selected.

Hold down the Shift key and press the proper navigation keys until the required

text matter is selected.

The selected text will appear

in a shaded area with a slight

colouration. If we want to

select the whole document, it

can easily be done with the

keyboard shortcut Ctrl+A, or

using the command sequence

Edit → Select All. After

selecting the text, if we click

anywhere in the document

area, the selection will be lost.

Figure 2.6 shows a selection

in the document we are

creating.

2.7.2 Cut, Copy, and Paste functions

These are the functions used frequently in editing.

Commands, keyboard shortcuts and button are available

to perform these functions. Figure 2.7 shows these

buttons seen in the Standard toolbar.

Fig. 2.6: Text selection

Fig. 2.7: Cut, Copy, Paste
buttons
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While preparing the document or at a later stage we may find that some text is at an

improper location in the document. We may think of  deleting the content from its

current place in the document and retyping it at the new location. But Writer helps

us by providing the facility of  Cut and Paste function, by which we can move a

block of  text or any other object from one position to another. It requires the

following steps:

i. Select the text or object to be moved.

ii. Use any one of following actions for cutting:

• Select the command Cut from Edit menu.

• Right click the mouse at the selected text and select Cut from the context

menu.

• Press Ctrl+X.

• Click Cut button (refer Figure 2.7) in the Standard toolbar.

iii. Place the cursor at the position where the text/object is to be moved.

iv. Use any one of the following actions for pasting:

• Select the command Paste from Edit menu.

• Right click the mouse at the selected text and select Paste from the context

menu.

• Press Ctrl+V.

• Click Paste button (refer Figure 2.7) in the Standard toolbar.

Sometimes, a text may need to appear in different places in the document. In some

cases, a portion of  the content in one document may need to be present in another

document. If  the text is too large to type again and again, Writer gives the facility of

copy and paste. The procedure is as follows:

i. Select the text or object to be copied.

ii. Use any one of following actions for cutting:

• Select the command Copy from Edit menu.

• Right click the mouse at the selected text and select Copy from the context

menu.

• Press Ctrl+C.

• Click Copy button (refer Figure 2.7) in the Standard toolbar.

iii. Place the cursor at the position where the text/object is to be copied.

iv. Use any one of the following actions for pasting:

• Select the command Paste from Edit menu.
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• Right click the mouse at the selected text and select Paste from the context

menu.

• Press Ctrl+V.

• Click Paste button (refer Figure 2.7) in the Standard toolbar.

2.7.3 Deleting text

Deleting is the act of  removing a selected word or text matter permanently from

the document. It can be performed by any method mentioned in the previous section

for cutting the text. Alternatively, we can press the Del or Delete key in the keyboard

after the selection.

As soon as we copy or cut a selected text, it will be placed in a temporary memory

area called Clipboard. At any point of time, this matter can be pasted somewhere

before exiting from the package.

2.7.5 Find and Replace facility

While editing a document, we may need to search for a particular word or text in

the document. Sometimes, the searched text is to be replaced by some other word.

Word processor provides Find and Replace facility for this purpose. Let us see

how we can do this in Writer.

A. Finding a text

There may be one or more occurrences of the searched item. If we want to search

for a text in the document select Find option from Edit menu or use the keyboard

shortcut Ctrl+F. A floating toolbar as shown in Figure 2.8 will be opened. Here we

have to type in the search text (see the word blood in the textbox) and then click on

Let us distinguish between Cut - Paste and Copy - Paste functions.

Table 2.1 contains some points. The cells left blank are intended for

you. Fill in with suitable value points.
Let us do

Cut - Paste Copy - Paste

• Does not duplicate text

• ....................................

....................................

• Moves the text from one place to

another

• ............................................

• Selected text will be present at both

the source and destination location

• ..............................................

Table. 2.1: Cut-Paste Vs Copy-Paste
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the Next or Previous button. The

very next occurrence of the search

text after or before the cursor

position will be highlighted as

shown in Figure 2.8. All the

occurrences of the search text will

be highlighted if we click Find All

button in the toolbar. Usually the

case of the text will not be

considered while searching. Case sensitivity can be enforced by clicking the check

box visible at the left of  Match Case in the Find toolbar.

B. Finding and Replacing a text

When we want to replace an existing text by a new one, we have to select Find &

Replace option from Edit menu or press Ctrl+H. The Find & Replace dialog box

will appear as shown in Figure 2.9. The dialog box provides all facilities to find the

search text in the document and

replace with the new text wherever it

is needed. In the Search for box, enter

the text to be searched. There are

mainly two checkboxes. One is the

Match case as mentioned earlier. The

other is Whole words only, which on

click will search for the text that

appear as whole words only.

In the Replace with box, enter the

replacement text. Then click the

Replace or Replace All button as per

our requirement. To cancel a search

in progress, we need to press Esc key

in the keyboard.

Fig. 2.8: Find floating tool bar

Fig. 2.9: Find & Replace dialog box

Write down the procedure to search for the word "blood" and replace

it by "Blood", whenever it appears at the beginning of a sentence.
Let us do

2.8 Formatting the document

A document can be made attractive by applying certain formatting features. The

general arrangement of  text is known as formatting. Formatting makes our

PreviousNext
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document presentable. We can make some text bigger in size, stylish in font and

beautiful in colour. Different types of  emphasis can be given by underlining,

italicising, etc. All these activities are included in the process of  formatting the

document. The whole content in the document will not be of the same importance

or at the same level. There may be headings at different levels, listing of  items,

notable content, etc. While formatting a document, we need to keep in mind all

these factors. Formatting provides documents a neater and more legible outlook.

There are various aspects of  text formatting like character formatting, paragraph

formatting and page formatting.

2.8.1 Character formatting

Character formatting plays an important role in enhancing the appearance of  a

document. It decides how individual characters in the document should appear.

Character formatting is concerned about making decisions regarding the font

characteristics such as type of  font, size and colour. The character formatting is

also associated with the setting of  text attributes like bold, italics, underline, etc.

and text positioning  like superscript,  subscript, etc. Some of the important text

attributes in character formatting and their effect are shown in Table 2.2. Word

processor offers a variety of

character formatting facilities at

the same place. Let us see the steps

for character formatting in

Writer. Before applying the

character formats, the text is to

be selected. Using the command

sequence Format → Character...,

the Character dialog box as

shown in Figure 2.10 can be

opened where the formatting

facilities are provided in different

tabs.

i. Font tab provides Family (different font faces), Style (Regular, Bold, Italic,

Bold Italic), and Size. (In Ubuntu Linux based LibreOffice Writer, fonts for English

and Malayalam languages will be visible as in Figure 2.10).

ii. Font Effects tab gives options for Font color, Effects (Capitals, Lowercase,

etc.) and Relief (Embossed and Engraved). It also provides Overlining,
Strikethrough and Underlining with different types and colours of  lines. Some

checkboxes are given for Outline, Shadow, etc.

Text attribute Effect after
applying the attribute

Bold

Italic

Strikethrough

Overlining

Underlining

Font color

Superscript

Subscript

Computer Applications

Computer Applications

Computer Applications

Computer Applications

Computer Applications

Computer Applications

A2 (2 is superscripted)

A
2
 (2 is subscripted)

Table 2.2: Text attributes
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Figure 2.11 shows a portion of the document "donation.odt" in which

we can see formatted text. Write down the procedure required for

this and check whether you get the same format with your procedure.

Note the position of the character + after Na and K in the last line

of  the window. Also identify the buttons in the Formatting toolbar

seen in the figure, to apply Font Style (Bold, Italic, Underline) to the

selected text.

Let us do

iii. Position tab facilitates superscripting, subscripting, etc. It also gives options

to rotate the selected text at an angle. Another facility available is that, the

spacing between the characters in the text can be increased (expanded) or

decreased (condensed).

iv. Hyperlink, Background and Borders are the other tabs in the dialog box.

The font style Bold, Italic and Underline can also be applied to a selected text by

the keyboard shortcuts Ctrl+B, Ctrl+I, and Ctrl+U, respectively. The key combination

Ctrl+B+I+U can make the three styles effective on the selected text.

Fig. 2.10: Character formatting dialog box

2.8.2 Copying a format

The word processor provides an easy way to copy the character formats applied to

a selected text and use the same for a particular text at another place in the document.

Suppose we have formatted a heading text with some font characteristics and font

style. The same can be easily copied and apply to another text in the same document

using the Format Paintbrush button  in the Standard toolbar. The procedure is

as follows:
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• Select the text from where the format is to be copied.

• Click the Format Paintbrush button.

• Click the text or paragraph where the format is to be applied.

Fig. 2.11: The document after some character formatting

Know your progress

1. State whether the following statements are True or False:

a. Writer automatically wraps the text extending beyond the right

margin to the next line.

b. Ctrl+S is the short cut key combination to select a text in Writer.

c. Copy/Cut/Paste buttons are present in the Standard toolbar.

d. Writer does not offer a facility to cancel the most recent actions.

e. A text entered in Writer can be rotated to 900.

2. Fill in the blanks

a. The Bold button is present in ______ toolbar.

b. Formats applied to one text can be copied using the ______ button.

c. The text or graphics copied or cut from the document will be

temporarily placed in the memory area called ______.

d. To move a text or object from one place to another in a document,

______ and ______ operation is required. (Cut, Copy, Paste)

e. The keyboard shortcut for opening an existing file in Writer is ______.
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2.8.3 Paragraph formatting

Paragraph formatting involves controlling the appearance of  the entire text in a
paragraph. The main contents of  documents like articles, assignment papers,
textbooks, reports, etc. appear in paragraphs. So it is very important to format
paragraphs properly. Some of  the formatting features are text alignment, tab stops,
paragraph indentation, line spacing, etc. The text delimited by the Enter key is
treated as a paragraph. In that sense, paragraph formatting is applicable to headings,
list of  items, etc.

The facilities provided by Writer to format paragraph is made available using the
command sequence Format → Paragraph... A dialog box as shown in Figure 2.12
will be opened. Different tabs are available in this dialog box for paragraph
formatting.

A. Paragraph alignment

Paragraph alignment refers to the
text layout within a paragraph with
respect to the document margins.
The boundaries of text get affected
by left and right margins and the
indentation for the paragraph.
There are two categories of text
alignment - horizontal alignment
and vertical alignment.

Horizontal alignment refers to the text alignment with respect to the left and right
margins. There are four types of  horizontal text alignment as specified below:

i. Align Left: This alignment aligns the selected text/paragraph aligned to the
left margin. This is the default alignment.

ii. Align Right: This alignment aligns the selected text/paragraph aligned to the
right margin.

iii. Centered: This alignment aligns the selected text/paragraph in the middle
between the left and right margins.

iv. Justified: In this alignment, the text is flushed to both the left and right margins,
thus the text/paragraph aligns evenly between left and right margins. The spacing
between the text or words will be automatically adjusted.

Modify your assignment paper with necessary editing and apply

suitable character formatting features.
Let us do

Fig. 2.12: Paragraph formatting dialog box
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Vertical alignment refers to the alignment of  the selected text or object relative to

the current line or top and bottom margins of cells in a table. There are four types

of  vertical text alignments. These alignments have no effect on normal text appearing

in a document. It is applicable when the text is placed in a table cell. We will discuss

this in the next chapter. The various types of  vertical alignments are given below:

i. Top:  The text in the cell is aligned at the top.

ii. Bottom: The text in the cell is aligned at the bottom.

iii. Middle: The text in the cell is aligned at the centre with respect to upper and

lower margins of the cell in a table.

B. Paragraph indentation and line spacing

The indent refers to the distance between text boundaries and page margin. When

we start a new paragraph, we usually start typing by leaving some space from the

left margin. This space is indentation. There are mainly four types of indents as

shown in Figure 2.13.

Figure 2.14 shows the Indents & Spacing tab of  Paragraph dialog box where we

can specify values for the indents shown in Figure 2.13.

On the basis of the values given, indentation can also be classified as follows:

i. Positive Indent: Here the text is placed a little inward from the margins.

ii. Negative Indent: This type of indent allows the text to extend outward from

the margins.

iii. First line Indent: Here the very first line of the selected paragraph is placed a

little inward with respect to the rest of the text.

Smoking is injurious to health.

Smoking kills. Avoid smoking and

being smoked. Be healthy.

Smoking is injurious to health.

Smoking kills. Avoid smoking and

being smoked. Be healthy.

Smoking is injurious to health.

Smoking kills. Avoid smoking and being

smoked. Be healthy.

Smoking is injurious to heath. Smoking

kills. Avoid smoking and being

smoked. Be healthy.

Fig. 2.13: Four types of indents

Indent before text

or Left indent

First line indent

Hanging  indent

Indent after text

or Right indent
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iv. Hanging Indent: It makes the text other than the first line to move little inward

from the left margin.

When the indent applied is applicable to the left side of the page, it is called Before

text indent and the indent for the right side of the page is called After text indent.

Sufficient spacing can be given before and after a paragraph. Similarly, line spacing

within a paragraph can also be specified in the Indent & Spacing tab of  Paragraph

dialog box. Line spacing refers to the space between two lines of text in a paragraph.

Another way of interpretation is the total height of a line of text. The standard line

spacing are Single, 1.5 lines and Double. Refer to Figure 2.14 to see more options

for line spacing. The desired spacing in all these cases are specified in centimetres.

C. Drop Caps feature

In some documents, the first letter in a paragraph, usually the first paragraph, may

take the height of  two or more line. This is called Drop Caps feature. We can see

this feature in all chapters of this textbook. Have a look at the first page of any

chapter. To incorporate drop caps in a paragraph, proceed as follows:

• Place the cursor anywhere in the paragraph in which we utilise this facility.

• Open the Paragraph dialog box and select Drop Caps tab.

• Specify the number of characters to be dropped from the first and number of

lines it should span.

• Click OK button.

Fig. 2.14: Indents & Spacing tab of Paragraph dialog box
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Several formatting facilities are available for paragraph formatting. Considering

the scope of  the syllabus we confine our discussion only on these features.

Look at Figure 2.15. Our document is now formatted according to

the settings as shown in Figure 2.14. Write down the procedure

adopted to make the document as shown in Figure 2.15.
Let us do

Fig. 2.15: Document after applying character and paragraph formatting

2.8.4 Bullets and Numbering

Documents may contain list of  items. Two types of  lists are common - bulleted lists

and numbered lists. Bulleted lists are used when the list does not rquire any order

for the presentation of  its items. Bullet is a small graphic symbol, as shown in Figure

2.16, that appears in front of  each item in the list. For example, one’s hobbies can

be presented as a bulleted list. But some items may need to be presented in an

order. In such a case we use numbered list. For example, the districts in Kerala may

be presented with numbers 1 through 14 for Thiruvanathapuram to Kasaragode.

The procedure for making a list is as follows:

• Click the Edit menu and choose  Bullets and Numbering... option.

A window as shown in Figure 2.16 will be opened. We can select the Bullets or

Numbering type tab and choose the style of  bulleting or numbering. Figure

2.16 and 2.17 shows different types of  bulleting and numbering.

• Select the desired bullet/number and click OK  button.

• Go on with typing of each item.
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Whenever Enter key is pressed after presenting an item, a new bullet for the

next item will appear automatically. The window provides more tags for

colourful bullets, alignments, nesting (a list in which some or all items may

have another sub list), etc. Figure 2.18 and 2.19 shows a bulleted list and a

numbered list respectively. These lists belong to our article, which is now under

formatting process.

Note that a tool bar appears at the

bottom of the IDE window (just

above the Status bar) which facilitates

moving of items upwards or

downwards within the list,

renumbering, navigation through

sublevels, etc.

Fig. 2.16: Bullets tab of Bullets and
Numbering window

Fig. 2.17: Numbering type tab of
Bullets and Numbering window

Fig. 2.18: Bulleted list in the document

Fig. 2.19: Numbered list in the document

2.8.5  Page formatting

Page formatting involves the

setting of page layout and

design. That is we have to

specify the page size,

orientation, margins etc. In

Writer, page formatting is

controlled through Page Style

dialog box which is obtained

by selecting the Page option

from the Format menu. Figure 2.20 shows Page Style dialog box.
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A. Page Size (Paper Size) and Orientation

Writer offers standard page sizes for the documents like A3, A4, Letter, Legal etc.

To set the page size, click the Page tab of  Page Style dialog box which shows the

page formatting facilities as in Figure 2.20. Here we specify any of  the predefined

paper sizes available in the Format: box of  Paper format section. We can also select

the desired page-orientation by clicking on one of the desired Orientation buttons

- Portrait or Landscape.

Orientation refers to whether the text is to be printed length-wise or width-wise.

When the text is printed or typed length-wise, it is called Portrait Page Orientation

and when the text is printed or typed width-wise, it is called Landscape Page

Orientation. Figures 2.21(a) and 2.21(b) show the two types of orientation.

In the Page tab, we can specify the

margins (left, right, top and bottom)

and layout settings. Margins can be set

in two ways - using Ruler bars and using

Page Style dialog box

Using Ruler bars:  Move the mouse

over the area where the white ruler

changes to gray. When the cursor

becomes a double-ended arrow, click with the mouse and drag the margin indicator

to the desired location. Release the mouse when the margin is set.

Using Page Style dialog box: In the Page tab on the Page Style dialog box, either

directly specify the desired measurement for the margins in the corresponding boxes

Fig. 2.20: Page tab of Page Style dialog box

a. Portrait b. Landscape

Fig. 2.21: Page orientations
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or increment/decrement the default measurements using increment/decrement

buttons till we get the desired result (refer to Figure 2.20).

B. Header and Footer

Look at the top of  the pages of  our text book. We can see in print the words

“Computer Applications (Humanities) - XII” on every left pages. Similarly page

numbers can be seen at the bottom with a design. These text items are called header

and footer, respectively. These are commonly used in publications, books, project

reports etc. The common text appearing on the top of every page is the header and

at the bottom is the footer. Thus header or footer may be the page number, system

date, or a company logo. A header is printed in the top margin, and footer in

bottom margin. We can insert either header or footer or both in a document. Once

it is inserted in any page, it will be available in all pages of the document.

To add a header to a page, choose Header option from Insert menu and type the

text in the Header box. Similarly, to add footer to a page, choose Footer option

from the Insert menu. Usually we put page numbers in the footer. When the cursor

is in the footer section, the command sequence Insert →Field→ Page Number can

be used to get page number in the footer. Some other information like Total pages,

Author, Date, etc. can also made avaiable in the footer.

Alternatively, we can select Header or Footer tab in the Page Style dialog box (refer

to Figure 2.20). Here we have to select the Header on or Footer on textbox. Clicking

the Apply button followed by OK button brings the cursor at the header or footer area.

2.9 Printing the document

When we complete the preparation of  a document after editing and formatting, its

hard copy (print out) may be required. Usually the documents are to be submitted

to the concerned in the form of  hard copy. Now we can see how to take a print out.

We can use the command sequence File →Print, or the keyboard shortcut Ctrl+P,

or the Print button in the Standard toolbar. The Print dialog box will be opened

as shown in Figure 2.22. We can see the print preview of  a page in the left pane of

the window. Any page of  the document can be previewed by clicking the next or

previous button seen below the preview. Page numbers, number of  copies,  layout

setting, etc. can be given in this window. On clicking the OK button, the document

will be printed, if  the printer is ready.

Print preview of more than one page can be obtained using the the command

sequence File → Print Preview, or the keyboard shortcut Ctrl+Shift+O, or the Print

Preview button in the Standard toolbar. The Print Preview window is shown in

Figure 2.23.
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Fig. 2.22: Print dialog box

Know your progress

1. Name the four types of  text/paragraph alignments.

2. Which type of  indent shows the text present in the paragraph

little inward from the first line of text?

3. Common text appearing on top of all pages is ______.

4. Print Preview option is available in ______ menu.

5. Line spacing option is available in ______ menu.

Fig. 2.23: Print Preview window
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Let us conclude

A word processor is a package that helps to create attractive documents. It provides

editing and various kinds of  formatting facilities. It also provides features like word

wrapping, copy/cut and paste features, finding and replacing, etc. Character

formatting features include font setting, bold facing, italicizing, underlining, etc.

Different types of  alignments, indentations, line spacing, etc. are covered in paragraph

formatting. Towards the end, page formatting features and print setting are discussed.

Let us practice

1. Open a new Writer document and prepare the following letter to a parent

regarding PTA general body meeting.

From

Principal,

Your school name,

School address.

To

Parent's Name,

Home address.

Dear parent,

Sub: PTA General body meeting

It is decided to conduct the PTA general body meeting of this year  in our school
auditorium next Monday. You are requested to attend the meeting without fail.

Thanking you

Yours faithfully

Principal

Place

Date

a. Save the document as pta.odt

b. Make the From and To addresses bold and italic

c. Change the font face to Arial and size 12.

d. Under the text 'Sub: PTA General body meeting' .
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e. Copy your name from the 'From' address to the bottom of the document.

f. Align the text 'Thanking You' at the centre.

g. Right align 'Yours faithfully' and 'Principal' at the bottom.

h. Double space the matter of  the letter.

i. Save the letter again.

2. Prepare your own bio data. Apply the formatting features of  the word

processor to beautify it.

3. Prepare an application to the principal requesting for TC and Conduct

certificate.

 Let us assess

1. What is meant by 'word wrapping'?

2. How is a Writer document saved?

3. What is meant by indenting?

4. Differentiate between 'Undo' and 'Redo' features.

5. Write down the effect of  using the key combinations Ctrl+N and Ctrl+Q.

6. Differentiate between 'Save' and 'Save As' options.

7. Distinguish between Copy-Paste and Cut-Paste functions.

8. Differentiate between Print and Print Preview options.

9. Differentiate between Portrait and Landscape page orientation.

10. Write a few features of  a Word processing software.

11. Explain the various types of  text alignments in Writer.

12. Suppose you want to replace a particular text in the document with another

text. Write the steps to do that.

13. Differentiate between Left indent, First line indent and Hanging indent.

14. How do you change the margins of a document?

15. Write the steps to take a print out of  the document.

16. Briefly explain the IDE of  the word processor, LebreOffice Writer.

17. Explain the various formatting features of  Writer.
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Creating Professional

Documents

After the completion of this chapter, the

learner

• inserts graphics, drawings, drop

caps, symbols and watermarks in

the documents.

• uses tables for presenting matter in

a tabular form and manipulate it.

• converts the text data directly to

into a table.

• removes spelling and grammar

mistakes in the document.

• types complex equations using

equation editor.

• applies multi column style to the

document matter.

• generates table of contents for the

documents.

• defines index entries in the text

document under preparation.

• uses mail merge features to send

letters.

Significant Learning Outcomes W
e have familiarised ourselves with the

basic features of the word processor

(LibreOffice Writer) like document

creation, editing, formatting and printing. In this

chapter we will explore the  powerful features

of  Writer to prepare professional documents

like project reports, resumes, survey reports,

business plans, company profiles, reports created

for governments, international organisations,

etc. These reports may contain tables, graphics,

symbols, equations and watermarks. These

professional documents also require spelling

and grammar correction. Today's word

processors provide solutions to all these

requirements. Apart from this, facilities for

formatting the text in multiple columns are also

provided. In the case of reports and books

where the content is divided into different topics,

a Contents page and an Index are usually

included. These features are incorporated in

almost all word processors. We also discuss mail

merge features used to send letters with

common content to multiple recipients.

3.1 Inserting tables

Tables are effective to organise and present large

amount of  information like financial or

statistical reports, product catalog showing
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descriptions, prices and photographs of  products, list of  names with address, age

and other information, etc. Tables can often be used as an alternative to spreadsheets

to organise data. Table is an arrangement of  data in the form of  rows and columns.

Rows appear in horizontal manner and columns appear in vertical manner. A well-

designed table can help readers understand the data better than writing contents in

a paragraph. Usually, tables are used to align text and numbers, but they can also be

used to align images. Tables can also be used as a page-layout tool to position the

text with proper alignments and indentations. For this, the cells in the table are

filled with the text and then the borders are removed.

3.1.1 Creating a table

Let us consider a survey statistics regarding cleanliness in 100 children within the

age group 13 to 17. For this, first we must decide all the number of  columns and

rows. Suppose we consider three aspects such as (i) Wash hands before food, (ii)

Wash hands after the use of  toilet, and (ii) Brushing teeth twice a day. Responses of

the children for each of  these aspects are collected by giving four options - Always,

Frequently, Sometimes and Never. So, it is clear that we need a table with 5 columns

and 4 rows to present the consolidation.

A table can be inserted in a document either by

clicking the Standard toolbar icon  or using

the menu option Table → Insert → Table.... It is

also possible with the keyboard shortcut

Ctrl+F12. It opens the Insert Table dialog box as

shown in Figure 3.1. We can see Table1 as the

table name in the textbox  which can be replaced

if we need. There is provision to specify the

number of columns and rows required. In the

figure, we can see the number 2 for each of these,

which are the default values. After giving the

required number(5 and 4), click the Insert button

to get the table on the page. A table consisting

of 5 columns and 4 rows will be inserted in the

document as shown in Figure 3.2.

The Heading check

box in the Insert Table

dialog box can be

used to provide a

heading to the table. If

Fig. 3.1: Insert Table dialog box

Fig. 3.2: Table with 5 columns and 4 rows
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the table spans over more than one page, the heading can be repeated on all pages.

The number of rows to be used as heading can also be provided here. The default

is one row. The checkbox for Don't split table over pages prevents the table from

spanning to more than one page. This can be useful in situations where a table is

about to start near the end of a page. If we tick mark the checkbox, the table will be

placed on the following page. If the table is too long to fit in a page, we need either

to deselect this option or manually split the table. Border checkbox is available in

the dialog box to specify border lines

required for the table.

If we click AutoFormat button  in the

Insert Table dialog box, we will get

AutoFormat dialogbox as shown in

Figure 3.3. It gives a set of predefined

table styles from which we can select the

the desired one.

3.1.2 Applying borders to tables

Borders are the boundary lines

appearing around each cell in

the table. By default the

thickness and style will be

normal. Table border can be

changed using the menu option

Table → Table Properties. The

Table Format dialog box will

be opened as shown in Figure

3.4, which gives facilities to set

the border. In  this dialog box,

we can set the line style, line

width, and colour of  the border. It also facilitates spacing between cell border and

its contents. All these formatting can also be done using the tools in  the Table

Properties toolbar shown in Figure 3.5.

Fig. 3.3: AutoFormat dialog box

Fig. 3.4: Table Format dialog box

Fig. 3.5: Table Properties toolbox

The Table Format dialog box or the Table Properties toolbar can be used to give

background colour, border style, border colour and various other formatting to

make the table attractive as shown in Figure 3.6.
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3.1.3 Managing tables

After inserting the table, the data are entered in the table cells. A cell is the intersection

of a row and a column. Sometimes we may have to change the width or height of

the rows or columns. After creating a table, we may need to insert a new row or a

column into it. Sometimes we may have to remove a row or a column from the

table. Such activities can be managed using Table menu or Table Properties toolbar.

a. Changing column width or row height

If we want to change the column width or row height, place the mouse pointer on

the column/row boundary. The mouse pointer changes to a double headed arrow.

Click and  drag to resize the column/row. The column width or row height of  the

selected rows can be set or can be made equal using the menu options Table →

Autofit.

b. Inserting new rows/columns

While working with tables, it may be necessary to insert a new row or a column into

the table.  Inserting a row or column can be done by the following steps:

i. Place the cursor in the row/column of the table.

ii. From the Table menu select the Table → Insert → Rows or

Table → Insert → Columns. A dialog box appears as in Figure 3.7.

iv. Enter the number of rows/columns to insert.

The position to insert the row/column has to

selected. It can be either before the current

row/column or after the current row/column.

v. Click OK button to insert the new row/

column.

c. Deleting rows/columns

Deleting means removing rows or columns from

the table permanently. This can be done as follows:

i. Place the cursor in the row/column or select the required rows/columns in

the table.

Fig. 3.7: Insert Rows dialog box

Fig. 3.6: Cleanliness in children between ages 13 to 17
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ii. From the Table menu select Table → Delete → Rows

or Table → Delete → Columns. The row/column will be deleted.

d. Merging rows/columns

Merging means combining the selected cells into a single cell. The procedure is as

follows:

i. Select the cells to be merged.

ii. Right-click and choose Cell → Merge in the context menu, or choose Table →

Merge Cells from the menu bar. The contents of  the cells appear in the merged

cell.

e. Splitting rows/columns

It is the process of dividing the selected cell into

multiple cells. We can proceed as follows:

i. Place the cursor inside the cell.

ii. Right-click and choose Cell → Split in the

context menu, or choose Table → Split Cell

from the menu bar.

iii. Select how to split the cell from the Split Cells

dialog box that appears as given in Figure 3.8. A cell can be split either

horizontally (create more rows) or vertically (create more columns) and we

can specify the total number of cells to create.

Fig. 3.8: Split Cells dialog box

Insert a table as in Figure 3.6. Insert one more row with row heading

'Wash hands using soap'. Add sample values in the columns. Make

sure that all the table cells are filled with sample data. Then apply a

formatting for the table using Table Format dialog box. Finally,

remove the second row from the table.Let us do

3.2 Inserting graphics

Supporting images along with text description  convey the content effectively. This

improves readability and helps to understand the content easily. There are three

basic types of graphic content that can be inserted in a document.

a. Image files such as photos, drawings or scanned images.

b. Diagrams created using tools available in the Drawing toolbar.

c. Charts created using the chart facility.
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3.2.1 Adding an image

This facility allows the user to insert an external image file into the document. Images

can be scanned pictures, photographs, etc. with file extensions .jpg, .gif, .png, .bmp,

etc. Inserting a picture can be done either by using the From File  icon in the

Picture toolbar or by using menu option, Insert → Image → From File.

Before inserting an image, we have to place the cursor in the document where we

need to insert the picture. Let us now insert an image of Mahatma Gandhi cleaning

the premises in the document. Using any of the methods mentioned above we can

obtain the Open dialog box as shown in Figure 3.9. Choose the image file from the

folder listed in the Open dialog box and click Open button. The image will be

inserted in the article in the position where the cursor is placed. The resultant

document is displayed in Figure 3.10.

3.2.2 Using drawing tools

Drawing tools can be used to create graphics, such as simple diagrams using

rectangles, circles, lines, text and other predefined shapes. This includes inserting

autoshapes, curves, lines, freeform line, callouts, fontwork gallery, etc. If  the Drawing

toolbar as shown in Figure 3.11 is not present in the current window, it can be

added by clicking View → Toolbars → Drawing. The Drawing toolbar contains

buttons for drawing shapes or art works.

On selecting any of the tools in the toolbar the mouse pointer changes to a drawing

pointer. To cancel the selected drawing function, press the Esc key or click on the

Select icon on the Drawing toolbar. Let us discuss some of  the important tools in

the Drawing tool bar.

Fig. 3.9: Insert Image dialog box Fig. 3.10: Image inserted in the document

Fig. 3.11: Drawing toolbar
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Line Tool: It is used for drawing straight lines. The length of  the line can be increased

or decreased by clicking on it and resizing.

Rectangle and Ellipse Tool: These are used for drawing rectangles and ellipses in

the document.

Freeform Tool: Freeform tool is used to draw a freehand figure or shape.

Text Tool: This tool helps to insert a text box in the document. Any text matter

can be typed inside it.

Basic Shapes, Symbol Shapes, Block Arrows, Flowcharts, Callouts, Stars: The

shapes in these categories can be inserted into a document. Almost all these shapes

allow the text to be inserted inside it. Figure 3.12 shows the different shapes available

in these categories of  tools.

Fig. 3.12: Drawing shapes

Basic Shapes Symbol Shapes Block Arrows Flowcharts Callouts Stars

Fontwork Gallery Tool: Fontwork tool can be

used to create graphical text art objects. These are

custom shapes or art works readily available as

shown in Figure 3.13. Any of these can be selected

and applied to the text. The text will appear in the

form of  selected art work.

From File: This tool is used to insert images from

a folder as we have discussed in the previous

section.

Extrusion on/off: This tool switches the 3D effects on and off  for the selected

objects.

Set or change properties for drawing objects

Before drawing, we can set the properties for a drawing object by proceeding as

follows:

i. Click the Select tool on the Drawing toolbar (refer to Figure 3.11). It opens

the Drawing Object Properties toolbar as shown in Figure 3.14.

Fig. 3.13: Fontwork Gallery
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ii. Provide suitable values to the relevant properies for the drawing object

The properties of  drawing objects may differ. When an object is selected, only the

properties associated with that object will be enabled in the toolbar.

3.2.3 Inserting charts

In Class XI, Chapter 4, Data Analysis using Spreadsheet, we discussed the creation

of  charts using spreadsheet software. Here Writer, the word processing software

also provides limited features for creating charts. Charts or graphs are created for

easy analysis and representation of data. This feature is mainly useful for interpreting

mathematical data like marks, percentage, result analysis etc.

Consider a survey statistics regarding cleanliness in 100 children within the age

group of 13 to 17 given in Figure 3.6.

A chart can be inserted into a document using the following steps.

i. Select the table for which chart is

to be created.

ii. Select the menu option  Insert →

Object → Chart.... It opens the

Chart Wizard as shown in Figure

3.15

iii. In the Chart Wizard dialog box,

select the Chart Type, Data Range,

Data Series and Chart Elements.

iv. Click Finish button to create the

chart. This chart can be placed at

the desired position in the

document.

Figure 3.16 shows the chart created

using the content in Figure 3.6.

3.3 Inserting special characters

A special character is one not found on a standard English keyboard. For example,

©, ¾, ?, ?, ø, ¢, etc. are all special characters. We can insert a special character with

the following steps:

i. Place the cursor in the document where the character is to appear.

Fig. 3.14: Drawing Object Properties toolbar

Fig. 3.15: Chart Wizard window

Fig. 3.16: Chart displaying cleanliness in
children
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ii. Click Insert → Special

Character... to open the Special

Characters dialog box as shown

in Figure 3.17.

iii. Select the required character

provided by the default font

family. We can also choose other

fonts to get a variety of special

characters.

iv. If more than one character is needed, select them in the required order and

then click OK button.

As we select each character, it will be shown on the right side of the dialog box

along with the numerical code for that character. All the selected characters will  be

shown in the lower left side.

3.4 Inserting page breaks

Page break happens when we reach the end of  a page and start working with the

new page. There will be a predefined number of  lines of  text for a page. Normally

in word processors, the new page comes automatically when the current page is

completed. This is called automatic page break.  This also depends on page size.

But there may be situations where we need to break the current page forcefully and

start a new page. This is called manual page break. Let us see the procedure.

i. Click on the document where we want the

new page to begin.

ii. Select the menu option Insert → Manual

Break.... Insert dialog box appears as in

Figure 3.18.

iii. Now select Page break option under Type

section in the dialog box.

iv. Click the OK button. A page break line

appears and a new page starts.

The same can be done using the keyboard shortcut  Ctrl+Enter. Similarly we can

insert a Line break or Column break in the document using the same dialog box.

Fig. 3.17: Special Characters dialog box

Fig. 3.18: Insert Break dialog box
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3.5 Inserting page borders

It is possible to insert a closed line around a page in a document. This is generally

called page border. The page border inserted for a page will be applicable to all

pages in the document. Any change made to borders applies to all pages that use

the same page style. This can be done as follows:

i. Choose menu option Format → Page.... It open the Page Style dialog box, as

shown in Figure 3.19.

ii. In the Borders tab of this dialog box,

select one of the border styles given

under Line arrangement area.

iii. Select a line style, width and colour for

the selected border style in the Line

area. These settings apply to all border

lines that are included in the selected

border style.

iv. Select the distance between the border lines and the content in the page in the

Spacing to contents area of the dialog box.

v. Click OK button to apply the changes.

If we apply the procedure on the article on cleanliness it will now appear as in

Figure 3.20.

Fig. 3.19: Page Style dialog box

3.6 Inserting watermarks

We might have seen some lightly coloured text or graphics appearing as background

in official documents like reports, balance sheets, certificates, etc. The text may be

like 'Confidential', 'Official', 'Draft Copy', etc. Similarly, while viewing television

programmes, you might have seen the name of  the channel in the background of

Fig. 3.20: After giving borders
Source: http://www.mkgandhi.org,

http://shubhsrathi.blogspot.in
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the screen. If  somebody copies such documents or records the TV shows, the

background will also be copied or recorded. This is called watermark. Watermark

is a facility to define text, graphics or colours in the background of the document

pages. The watermark appears merged with the page background. It is possible to

type any content on the page as usual. The watermark will not be a barrier. In Writer,

watermark can be inserted only while exporting the document to the Portable

Document Format (PDF). This is usually done after finishing the entire work of

the document because the PDF document is non-editable. The article on cleanliness

can be given a watermark and exported to PDF format through the following

steps:

i. Open the file to be exported.

ii. Choose the menu option File →

Export as PDF option. PDF

Options dialog box appears as

shown in Figure 3.21.

iii. Type the required watermark.

iv. Click the Export button to convert

the document to PDF format with

watermark text.

Fig. 3.23: PDF file with watermark

Fig. 3.21: PDF Options dialog box

v. The Export dialog box appears as

shown in Figure 3.22. Give a suitable

file name and save it.

The article on cleanliness is now in PDF

format and will appear as in Figure 3.23.

Fig. 3.22: Export dialog box
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3.7 Converting text to table

Writer provides a facility to convert text matter directly into a table. Using this

feature we can present data in tabular form with less effort. The text to be converted

must contain characters to indicate column separators. It can be tab, semicolon,

space or any other character. Paragraph marks indicate an end of  a table row.

Let assume that we have data on plastic waste, organice waste, etc. collected by

NSS volunteers in urban and rural areas. The figures are in kilograms. To  convert

this text to a table, the steps to be followed are:

i. Select the text matter.

ii. Select the menu option Table → Convert

Text to Table.

iii. Convert Text to Table dialog box as in

Figure 3.24 appears.

iv. Choose the column separator from the

options given under Separate text at area in

the dialog box.

v. Then click OK button.

This creates a table in the position of text matter

in the document. A text matter and its corresponding table is given in Figure 3.25.

Fig. 3.24: Convert Text to Table
dialog box

Fig. 3.25: Text to table conversion

In the above example the text separator is the comma( , ) character. The

corresponding option button is to be selected based on the delimiter given in the

text matter which is to be converted to table. The Border checkbox is selected for

displaying border for the table's cells.

Know your progress

1. Name the three types of  graphics that can be inserted in Writer.

2. Identify the name of the tool which is used to apply custom shapes

to text entries.

3. Which drawing tool is used for drawing shapes or figures of our

own interest?

4. What are the two ways of inserting a table in a document?

5. Watermarks can be inserted while _____ the text document.
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3.8 Splitting text into columns

You might have noticed that the text matter appearing in the news paper is in multiple

columns. This is because it enhances the readability of  the content. Writer provides

the facility to split the single column matter to multi column.

Suppose we want to separate the text matter in the article into two columns. The

following steps are to be performed for this.

i. Select the matter in the document area.

ii. Choose the menu option Format → Columns...

iii. The Columns dialog box as in

Figure 3.26 appears. Then

select the number of  columns,

width of  columns, spacing

(space between column border

and text matter), separator

lines (column boundary line),

etc. in the dialog box.

iv. Click OK button to complete

the task.

Figure 3.27 shows the two column formatted article.
Fig. 3.26: Columns dialog box

Fig. 3.27: Article formatted into two columns

3.9 Spelling and Grammar

It is very essential that a professional document must be free from errors in spelling

and grammar. Writer provides us with a feature to check spelling and grammar

mistakes and correct them. Spellings are compared with the built in dictionary in

the word processor. This feature helps us to produce error-free documents.

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



Computer Applications (Humanities) - XII

66

Writer provides two ways to check spelling and

grammar.

Activate AutoSpellcheck feature by clicking on the

AutoSpellcheck button  which is present in the

Standard toolbar, before typing the content. Writer

will automatically check the document for spelling and

grammar mistakes and shows wavy underline. To

correct an error, click the right button, a short-cut

menu appears as in Figure 3.28 and choose the

suggested replacement. The replacement can also be

from the AutoCorrect submenu available in the context

menu.

The second method is by selecting the menu item Tools → Spelling and Grammar

or by clicking the Spelling and Grammar button  present in the Standard toolbar.

Writer will check each and every word in

the document which are wrongly spelt or

missing in the built-in dictionary. A Spelling

dialog box will appear as shown in Figure

3.29 and allow the user to select the

suggestions or ignore it.

The software will indicate names of persons

or places as wrong words because these

words will not be present in the dictionary

available with the word processor. Suppose we want to add such words to the

custom dictionary, it is possible using the Add to Dictionary button in the Spelling

dialog box. After that the particular word will be available in the dictionary and

spelling mistakes can be corrected

accordingly. User is allowed to select the

required language as the text language. The

spelling corrections will be based on that

selected language. For example, here we

selected English(UK) as the text language

which is the default language.

Another helpful feature present in the

software is AutoCorrect. The user can enter

the commonly misspelt words and their

replacements in AutoCorrect dialog box.

Fig. 3.28: Autocorrect menu

Fig. 3.29: Spellings dialog box

Fig. 3.30: Autocorrect dialog box
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After that, if we type the wrong word, it will be replaced by the correct word

immediately. Figure 3.30 shows the AutoCorrect dialog box to add a wrong word

and its replacement.

3.10 Working with formulas

While preparing a document, we may need to type complex mathematical equations.

Normally it is a tedious work. Writer gives an easy way to do the task.

Suppose we need to enter the formula 
2

4

2

b b ac
x

a

− ± −

= . The following steps

describes the whole process:

i. Choose the menu option Insert → Object → Formula. Now, the document

window turns to a form as given in Figure 3.31. A new pane appears below the

normal work area and we can type

the required formula there. Several

functions, formula patterns,

mathematical symbols etc. can be

seen on the left pane of  the window.

ii. Select the appropriate type of

formula element for typing the

equation.

On clicking the document window, the word processor IDE is back to normal.

3.11 Defining Table of Contents

Before the content begins in a professional document or text book or any publication,

a Table of  Contents (TOC) page is necessary. It clearly indicates the main contents

of  the document or book. The main headings, the sub headings and the page numbers

usually appear in the Table of  Contents. The reader can easily go to the required

page. LibreOffice Writer proviodes Table of  Contents feature to build an automated

table of contents from the headings in our document. These entries are automatically

generated as hyperlinks in the table. Whenever changes are made to the text of a

heading in the body of  the document, or the page on which the heading appears,

those changes automatically appear in the table of contents when it is updated.

Creating TOC involves two steps. Initially, the TOC entries are to be made. It is

followed by the creation of  Table of  Contents.

Creating TOC entries

To create the TOC entries the following steps are to be taken:

i. Select the headings or sub-headings in the document which are indented for TOC.

Fig. 3.31: Entering equations
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ii. Choose the menu option Insert → Indexes and

Tables → Entry. Insert Index Entry dialog box

appears as shown in Figure 3.32.

iii. Set Index as Table of Contents.

iv. Select the Level as, 1 for main headings, 2, 3, 4,

etc. for sub-headings.

v. Click the Insert button.

Creating Table of Contents page

To create the TOC page the following

steps are to be taken:

i. Click on a fresh page of the

document where you want to

create the Table of  Contents.

ii. Choose the menu option Insert

→ Indexes and Tables →

Indexes and Tables. The Insert

Index Entry dialog box

appears as in Figure 3.33.

iii. Click the Index/Table tab

iv. Select Table of Contents in

the Type box.

v. Click OK button to complete

the task.

Table of  Contents page will be

inserted in the document as

shown in Figure 3.34.

3.12 Defining index entries

In text books, professional documents, standard publications, etc. there will be an

index page towards the end. An alphabetical index (referred to as an index) is a list

of keywords or phrases used throughout a document. Across each index entry the

corresponding page number will also appear, which helps the readers to find the

information quickly. It is mainly used for reference.

Let us now create an index for the article on cleanliness. The whole process involves

three steps:

Fig. 3.32: Insert Index Entry
dialog box

Fig. 3.33: Insert Index/Table dialog box

Fig. 3.34: Table of Contents
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1. Decide the words needed for the index page.

2. Create index entries.

3. Create the index page.

Creating index entries

The steps for the selection of words are:

i. Click on a word, or select the words in your document that you want to use as

an index entry.

ii. Choose the menu option Insert → Indexes and Tables → Entry. The Insert

Index Entry dialog box appears as shown in Figure 3.35. The selected word

will appear in the Entry box.

iii. To add an index mark to similar words in

the document, select Apply to all similar texts.

v. Then click the Insert button.

For example the word 'sanitation' is selected as

an index entry as shown in the Figure 3.35.

Similarly all entries are to be made.

Creating an index page

After defining the index entries, the index page is to be prepared. For that, the

following steps are required:

i. Click on the document where we want to create the alphabetical index.

ii. Choose the menu option Insert → Indexes and Tables → Indexes and Tables.

Insert Index/Tables dialog box

appears as shown in Figure 3.36

and then click the Index/Table

tab.

iii. Select Alphabetical Index in the

Type box.

iv. Select any additional options in

the tabs Columns, Style,

Background, etc. if required.

v. Click OK button to complete

the process..The index will be

created as in Figure 3.37.

Fig. 3.35: Insert Index Entry

Fig. 3.36: Insert Index/Table dialog box

Fig. 3.37: Alphabetical index created
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3.13 Concept of templates

Documents can also be created with predefined styles, formats, company logos,

header/footer etc. For doing that Writer provides us the facility of  using templates.

A template is a document model using which we can create other documents.

Templates can contain anything that regular documents contain, such as text, graphics,

a set of  styles, etc.  If  we do not specify a template when we start a new Writer

document, the document is based on the default template for text documents.

3.13.1 Using templates

The following steps can be used to create a template for a document:

i. Choose the menu option File → New → Templates.

ii. Template Manager dialog box appears as shown in Figure 3.38.

iii. Double-click the folder that contains the

template that we want to use, typically

this will be My Templates. All the

templates (predefined document

formats) contained in that folder are

then listed. More templates can also be

added from outside sources like

Internet.

iv. Double-click on the required template.

A new document based on the selected

template opens in Writer. We can then edit and save the new document just as

we do in any other document.

3.13.2 Creating a template

Writer also provides the facility to create our own templates. Suppose we have

created a document like a bio data which is professionally designed. This can be

saved as a template file so that when we open it a new copy of it opens and anybody

can customize it, then save with a new name. We need to enter only the data. The

formatting remains the same as that of  the template file. The following steps illustrate

the way of creating a template from a document:

i. Open a new or existing document that we want to make it as a template.

ii. Add or modify the content and styles or formats as we want.

iii. Choose File → Template → Save as Template option.

iv. A Template Manager dialog box appears with default folders.

v. Select the My Templates folder.

Fig. 3.38: Template Manager dialog box
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vi. Click the Save button.

vii. Enter a name for the template in

the text input box that opens, and

click OK button. Figure 3.39

displays a newly saved template

with the name article.

Any settings that are added to or

modified in a document can be saved

in a template. The file extension will

be .ott (Document Text Template) by

default. Thus the file will be saved as

'article.ott'.

Fig. 3.39: Template saved with name Article

Know your progress

1. Column option is available in the _______ menu.

2. In a Writer document, the presence of  a red wavy underline below

some words indicates _______.

3. Identify the facility provided by Writer which corrects the wrongly

spelt words immediately after typing.

4. What is a template?

5. What is TOC in a document?

6. Name the option available in Insert menu to create formulas.

3.14 Mail merge

In government/private offices there may be situations where a letter containing the

same text matter may have to be sent to different people. These documents also

have a typically common layout but only the recipient address, salutation, etc. are

different. Such letters will be prepared by typing the unique contents like address,

salutation, etc. in documents and then saving each letter separately. But this is

laborious and time consuming.

Mail merge is a tool in word processors which allows to create formal letters, mailing

labels and envelopes by linking a main document to a set of data or data source.

The main document, which contains the common text, is linked to the data source

by common fields of  data, called merge fields. We can also create our own merge

fields, specific to the data source.
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Let us assume that the NSS Programme Co-ordinator of Directorate of Higher

Secondary Education has to send a letter to all Principals of higher secondary schools

in Kerala to conduct a cleanliness campaign as part of  Independence day.

The whole process of mail merging can be done easily through Mail Merge Wizard.

A wizard is nothing but a series of steps in which dialog boxes appear and the user

needs to input sufficient data and instructions and finally the task will be completed.

At first, let us create the letter from the Programme Co-ordinator which will be

called as the main document as shown in Figure 3.40.

Fig. 3.40: Main document

In this document the address

of the principals of the

different schools in Kerala

has to be inserted below the

"To" address. Now click on

a position below the "To"

address and use the menu

option Tools → Mail Merge

Wizard to start the Mail

Merge Wizard as shown in

Figure 3.41.

Fig. 3.41: Template saved with name Article
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Step 1: Select starting document

This step allows to select the main document. Since we have taken the Mail Merge

Wizard from the main document, we can select the option Use the current document.

This step provides options, as shown in Figure 3.41, to create a new main document

or to select a document that already exists, recently saved document or a template.

After selecting the main document click Next button.

Step 2: Select document type

This step allows to select the type of document to be created as shown in Figure

3.42. The type of document can be a written letter or an e-mail message. After

selecting Letter option click Next button.

Fig. 3.42: Select type of document

Step 3: Insert address book

As shown in Figure 3.43, this

step is used to insert/create the

address list for merging.

Address list consists of

address (Name, Office Name,

Address, City, State, PIN code,

etc.) of various persons to

whom the letters are to be sent.

In the wizard, click the Select

Address List.... button to open

the Select Address List dialog

box as shown in the figure. This

dialog box allows to add an
Fig. 3.43: Insert address book
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existing address list, create a new address list or to filter or edit an existing list. In

this case let us create a new address list using the Create... button.

This opens a New Address List dialog box as shown in Figure 3.44. In this dialog

box add the required fields/elements like First Name, Company Name, Address

Line1, etc. To enter another address, click New button. After entering all the

addresses, click OK button to save the address list.

A new dialog box to save the address list appears as shown in Figure 3.45. Give a

suitable name to the list and click Save button to save the list. Let us give the name

"Address" to this file.

This will be displayed in the Select Address List dialog box as shown in Figure

3.46. Now click OK button to select the recepient address list named "Address".

This opens a section to set an address block using the address elements as shown in

Figure 3.47. This block can be

inserted into the main document.

Here we can see that the address

does not contain the school name.

Fig. 3.44: New address list dialog box Fig. 3.45: Save address list dialog box

Fig. 3.46: Select Address List dialog box
after creating address list

Fig. 3.47: Dialog box displaying options
to set the address book
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We can add it by editing this block. For this use the More... button in the dialog

box.

It opens a Select Address

Block dialog box as shown

in Figure 3.48. Click on

Edit... button to open Edit

Address Block dialog box

as shown in Figure 3.49.

Using the arrows provided

we can add or remove the

Address elements to create

the address block. We have

entered the school name  in

the field "Company Name".

Insert this field in the block. The position of the elements  can be changed using the

arrows on the right side of the dialog box. A preview of the address is also displayed

in the dialog box. The modified block is displayed in the Figure 3.49. Click OK

button to set the address block. In the Select Address Block dialog box, click OK

to select the address block created. Then click the Next button on the wizard to

proceed to the next step.

Fig. 3.48: SElect Address Block dialog box

Fig. 3.49: Edit Address Block dialog box

Step 4: Create salutation

In this step a dialog box as shown in Figure 3.50 is provided to create a personalised

salutation in the main document. i.e., "Mr." for males and "Mrs." for females. To

check whether a person is a male or female, an address field/element can be used in

the address list. According to the value in the field "Mr." or "Mrs." will be displayed.
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In the case of our letter, the

recipients are principals of

schools. Therefore we have

the salutation "Sir", which

is placed in the main

document itself. Because of

this, we remove the check

mark against This

document should contain a

salutation. Click Next

button to move to the next

step.

Step 5: Adjust layout

In this step, Writer gives a dialog box as shown in Figure 3.51 to align the address

block to the correct position in the main document. The position can be adjusted

according to its distance from the left and top of the main document. The distance

in centimeters can be modified to position the block. It can also be aligned to text

body by putting tick mark against the check box Align to text body. A preview of

the block is provided in the dialog box. Use Next button to move to the next step.

Fig. 3.51: Dialog box to adjust the position of the address block

Fig. 3.50: Step to create salutation

Step 6: Edit documents

This step  helps to preview and edit the merged documents as shown in Figure

3.52. To preview a particular merged document, use the arrows. To edit the
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document, click Edit Document... button. We can also create/modify the contents

of the main document using this option. The Mail Merge Wizard will be reduced to

a small button while editing the main document as shown in Figure 3.53. We can

click on the button to return back to the wizard. Clicking the Next button takes us

to the next step.

Fig. 3.52: Editing the main document

Fig. 3.53: Editing process in progress
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Step 7: Personalise documents

The Mail Merge Wizard

creates a single merged

document with page breaks

between each recipient.

When we reach a page

through the wizard, the

names and the addresses of

that particular recipient will

be contained in the

document. This merged

document can be

personalised by editing it.

This is as shown in Figure 3.54. The wizard provides a feature to edit individual

documents and also find a particular word in the merged document.

Step 8: Save, print or send

This step provides the output options for merged documents as shown in Figure

3.55. The main document now contains the address block inserted into it. This

document can be saved using the first option Save starting document. The merged

document containing letters to the principals can be saved as a single document or

separate documents for a group of  letters. This can be done using the Save merged

document option. Print merged document option prints all or selected letters on a

printer. Send merged documents as E-Mail option sends the output as e-mail

Fig. 3.54: Personalised merged document

Fig. 3.55: Saving merged document
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messages to all the recipients. This option provides features to specify To, CC,

BCC addresses, e-mail subject, attachments, etc. Click on Finish button to receive

the merged file. A part of our merged document/letter is given in Figure 3.56.
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Let us conclude

We have discussed the advanced features of  a word processing software like inserting

objects like picture or image,  inserting tables, watermarks, special symbols, etc.

Then we have gone through converting text into table, multi column formatting,

editing complex equations, correcting spelling and grammar, etc. Towards the end,

powerful features like index entries, table of  contents, templates, mail merging, etc.

are also detailed. The features of  Writer do not end here. Learners can explore

other advanced features at their own interest.

Let us practice

1. Using the word processor, create a leave letter addressed to your class teacher,

requesting for one day leave. Perform the following activities also in the same

document

a. Save the file as 'Leave.odt'

b. Bold face the 'From' and 'To' addresses appearing in the document.

c. Change the font size of above addresses to 12.

d. Make the body of  the letter justify within left and right margins.

e. Change the line spacing of the body of the letter to double and font size 11.

f. Right align the name and signature at the end of the document.

g. Save the document with another name 'Leave1.odt'

2. Prepare your class time table using the inserting Table feature of  word

processor. Save the document with name 'MyClass.odt'

3. Some data is given below. Convert the data directly into tabular form

ClassNo,Name,Sub1,Sub2,Sub3,Total

1. Aneesh.50.45.55.150

2. Parvathi.50.40.50.140

3. Sreedev.40.30.50.120

4. Sreedhar.40.40.30.110

5. Rahul.50.50.40.140

Hint. The text separator is full stop (.)
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4. Type the following expressions using the word processor

a. H
2
 + O

2
 = H

2
O

b. (A+B)2 = A2 + B2 + 2AB

5. Insert the following special symbols in the word processor

α  (alpha), 

β

 (beta), 

γ

 (gamma), 

σ

 (sigma), 

λ

 (lamda), 

Ω

 (ohm), 

θ

 (theta ),

π

 (pi)

6. Suppose your school day is to be conducted on next Monday. Invitation letters

are to be sent to nearby schools, addressed to respective Principals. The content

of the letter is the same, but the recepient addresses are different. Use the mail

merge facility to do the task.

A sample letter is given below:

From

The Principal,

Name of  Your School

Place

To

Mr /Ms/Mrs ……

Sub: Invitation

This is to inform you that our school anniversary is planned to be conducted

on next Friday. You are invited to attend the function.

Thanking you

Yours faithfully

Principal

Place:

Date:
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12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567 Let us assess

1. Name the button in the toolbar which when pressed shows wrongly spelt words

while we type the document with a wavy red line.

2. A picture can be added into a document using _______ menu.

3. Name the tool in drawing toolbar which helps to draw a figure or picture in

free hand style.

4. Which tool in the Drawing toolbar is used for creating graphical text art objects?

5. Suppose you have prepared a question paper. Your school name is to be lightly

printed on all pages. The presence of  the text does not block the normal text

in the pages. Identify the name of  thisfeature in Writer. How do you do that?

6. The facility for applying predefined table formats is called ________.

7. A table is made up of _________ and _________.

8. Name the button in the Table toolbar using which predefined format can be

applied to a table.

9. Write the steps to convert a text matter directly to table.

10. Suppose you want to insert some special symbols like£, ©, etc. in your

document. Write the steps to do that.

11. Write the need for templates in Writer. How do you prepare a document from

a template.

12. You are supplied with a common letter file (main document) and another

address file (contains many addresses). Write the steps to combine these two

documents using  mail merging.

13. Write the steps to prepare an index page for the document.
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Significant Learning Outcomes

Web Technology

After the completion of this chapter, the learner

• explains how secure communication is

brought about on the web.

• describes the use of a web server and

the concept of web hosting.

• differentiates static and dynamic pages.

• identifies the differences between

programming languages and scripts.

• compares the different types of scripting

languages.

• explains the need for cascading style

sheet.

• identifies the basic HTML elements to

create web pages.

• lists fundamental HTML tags and their

important attributes.

• classifies the HTML tags.

• uses formatting tags appropriately in

an HTML document to make the web page

attractive.

• identifies the similarities and

differences among the formatting tags.

• observes the use of the tags <PRE> and

<DIV>.

• chooses the tag for moving objects/

contents in a document.

• uses the <FONT> tag to format the text

content effectively.

• utilises the facility of comments in an

HTML document.

• inserts images into HTML document

using <IMG> tag.

W
e are all living in an era of  the Internet

and might have accessed it for seeking

information. You might have

searched for your Class XI results and viewed

it from a website. People rely on different

websites for various purposes like submitting

online applications, viewing web contents,

watching movies, for banking transactions,

purchase of goods through online transaction,

and so on.  We know that a website is a

collection of  web pages. A web page may

contain texts, graphics, sounds, animations, and

movies. A website consisting of  several web

pages are designed to give information about

an organisation, product, service, etc. How is

this website made available on the Internet?

These web pages are to be stored in web servers

connected to the Internet, to be made available

to others. This chapter presents an overview

of communication over the Internet and the

role of  web servers in it. The different tools

and technologies that are available for

developing websites are introduced here. The

concept of dynamic web pages and an

overview of  the scripting languages used to

make web pages dynamic are also discussed.

Web pages are developed with the help of  a

language called Hyper Text Markup Language

4 Web Technology

Significant Learning Outcomes
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(HTML). HTML is also known as the language of the Internet. HTML tells the

browser how to display the contents on a browser window. In this chapter, we will

also familiarise ourselves  with the fundamentals of creating web pages using HTML.

4.1 Communication on the web

We have learned the actions that occur when a web browser (client) tries to access a

website from the Internet in Chapter 9, Internet of  Class XI. First, the URL (Uniform

Resource Locator) is sent to a Domain Name System (DNS) server to obtain its

corresponding IP (Internet Protocol) address and then the browser connects to

this server using the IP address. The web server software installed in the server

computer processes this request and the web page to be displayed is then sent to

the client. The client browser formats and displays this web page.

In order to communicate on the web, computers/devices need to understand each

other. This is made possible by making all devices follow the same protocol, namely

the Transmission Control Protocol/Internet Protocol (TCP/IP). We have discussed

TCP/IP protocol and its working in detail in Chapter 8, Computer Networks of

Class XI. The data to be sent is broken down into small data packets along with the

address of  the recipient computer by the TCP protocol. The devices called routers,

route and transport these data packets to their destination computers using Internet

Protocol. Figure 4.1 shows the route of a data packet from a sender to a recipient.

Fig. 4.1: Routing of a data packet from a sender to a recipient

STEP 1:

TCP breaks

the data into

packets

STEP 2: The

packets travel

from router to

router over

the Internet

according to

the IP

STEP 3: TCP

reassembles the

data packets

back to original

form

In the Internet, there are several types of  communication like, accessing websites,

sending e-mails, etc. We have already learned in Chapter 9, Internet of  Class XI that

websites are accessed using HTTP (Hyper Text Transfer Protocol) and e-mail
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communication happens using SMTP (Simple Mail Transfer Protocol). Both these

protocols work on top of lower level protocol called Internet Protocol. Internet

Protocol provides the basics of communication over Internet. The use of a single

protocol - Internet Protocol - for all communication over the Internet has several

advantages. The routers need not be programmed separately to handle different

types of data. They do not need to know about the data they are transporting and

are concerned only about the address to which the packet is to be delivered. This

openness of the data part of the packet gives the freedom to design new protocols

for the Internet. It is this openness and flexibility of TCP/IP that led to the

development of  protocols for social media websites to handle messages, content

websites to handle video and audio, banking websites to handle money transfer

securely, etc. This turned out to be a deciding factor for the economic success of

the Internet.

Communication on the web can be categorised as (i) client (browser) to web server

and (ii)web server to web server communication. Authentication and security are

essential for communication over the Internet. Authentication on the web is the

process of  determining whether a computer/server is the computer that it claims

to be. Security should be provided to communication over Internet so that the

messages are not intercepted and modified by hackers.

4.1.1 Client to web server communication

Client to web server communication does not usually require authentication. But in

the case of  web based banking applications/e-mail services, user names and

passwords are required to be sent to the server. This information cannot be sent to

the server in plain text due to security reasons. The hackers may steal usernames

and passwords, if  it is communicated and shared as plain text. In such cases we use

HTTPS (Hyper Text Transfer Protocol Secure) technology to encrypt the username

and password, and then send it to the server. HTTPS works using Secure Sockets

Layer (SSL) which provides a standard security technology for establishing an

encrypted connection between computers on Internet. SSL provides security

capabilities to HTTP. The SSL protocol not only ensures privacy, but also ensures

that no other website can impersonate the user's login account nor alter the

information sent.

When the browser requests for a secure web page, the server first returns its SSL

certificate. The browser then verifies whether this certificate is valid by checking it

with the corresponding certification authority. A certification authority certifies

whether an SSL certificate given to it is a valid one. This is an assurance that the

particular website is of  the organisation it claims to be. Verisign Inc. is a certification
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authority. If  an SSL certificate is valid, the browser starts an encrypted session.

During this session, the browser and the server encrypts all the transmitted data.

This process is displayed in Figure 4.2(a). In India, Information Technology Act

makes it mandatory for websites that provide banking transactions to use HTTPS

to accept confidential information from clients. You can click on the lock symbol in

the address bar and view the certificate as shown in Figure 4.2(b).

4.1.2 Web server to web server communication

Web server to web server communication also may be required in certain web

applications. For example, the web server of  an online shopping website (seller/

merchant on Internet) needs to send confidential information to a bank web server

and vice versa. In such cases the web servers of  the merchant and the bank are to be

authenticated. Digital certificates help to verify whether the data received is from

Fig. 4.3 : End to end online trading process

Merchant's
web server

Fig. 4.2(a) : Client - server authentication process Fig. 4.2(b): https authentication of SBI
website

Browser requests to start a secure SSl session

Server returns its SSL certificate

Browser checks that:
• Certificate is valid
• Signed by someone user trusts

Server and browser encrypts all the transmitted data

If valid, browser initiates and encrypted session3

1 2

4

01010010110 01010010110

User placing
order

Bank
web serverMerchant

bank account

Payment
gateway
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the actual server itself. Once the servers are authenticated, the servers communicate

using encrypted data. Payment gateway is a server that acts as a bridge between

merchant server and bank server and transfers money in an encrypted format

whenever an online payment/money transfer is made. This process is shown in

Figure 4.3.

4.2 Web server technologies

Let us see what happens internally when we visit the website www.dhsekerala.gov.in,

the official website of the Directorate of Higher Secondary Education (DHSE).

At first, the home page (the first page displayed when a website will be accessed) of

the website will be transferred to our computer (client) from the web server of

DHSE. The client is usually a computer or a mobile device which has a browser

software that requests for web pages. The web server uses the web server software

to store the pages of the websites and delivers it on request from the client. In the

following sections, we will discuss the features of  a web server and the requirements

for setting up a web server.

4.2.1 Web server

The term web server is often used for referring to the server computer that hosts

websites. It is also used to refer to a web server software that is installed in a server

computer in order to make it a web server. In this section we will discuss the features

of  a web server computer and a web server software.

A web server enables us to deliver web

pages or services like e-mail, blog, etc.

to users on the Internet. A web server

consists of  a server computer that runs

a server operating system and a web

server software installed on it for

providing services like www, e-mail,

etc. over the Internet.

A web server is a powerful computer

which is always switched on and

connected to a high bandwidth Internet connection. This will facilitate Internet users

around the world to access the websites and services hosted by it at any point of

time. Depending on the requirements, a web server can have single or multiple

processors, fast access RAM, high performance hard disks, Ethernet cards that

supports fast communication, etc. To ensure faster Internet connectivity and

redundant power supply, a web server is usually installed in a data center.

Fig. 4.4 : A data center
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A data center is a dedicated physical location where

organisations house their servers and networking

systems. Data centers are used for storing, processing

and serving large amounts of  mission-critical data

to their clients. A data center requires extensive

backup power supply systems, cooling systems, high

speed networking connections and security systems.

A typical data center facility is shown in Figure 4.4.

In a data center several servers may be mounted into

special racks that offer good ventilation and easy

maintenance as shown in Figure 4.5.

Popular server operating systems include various

Linux distributions (Redhat, openSUSE, Debian,

Ubuntu, etc.), Microsoft Windows Server, FreeBSD,

Oracle Solaris, etc.

After setting up a server, a web server software has to be installed in it and configured

according to the given operating system. The web server software is a program

that uses the client-server model and the Hypertext Transfer Protocol (HTTP) to

ensure timely distribution of  files stored in it to the users. These files are sent as

webpages to the user on request using the web server software and can be accessed

using a web browser. Some of  the preferred web server packages are Apache Server,

Microsoft Internet Information Server (IIS), Google Web Server (GWS) and nginx

(pronounced as engine-x).

After the installation and configuration of  a web server software, software packages

like FTP (File Transfer Protocol), e-mail, DNS, database, etc. can be added as well.

The main features provided by the web server software are the provisions to create

multiple websites, configure website security, etc.

4.2.2 Software ports

We have discussed hardware ports in Chapter 2, Components of  the Computer

System of Class XI. Hardware ports are used to connect external devices to the

computer. These devices communicate with the computer using these ports, i.e.,

VGA ports are used to connect monitors, PS/2 ports for keyboard/mouse, etc.

Similarly, a software port is used to connect a client computer to a server to access

its services like HTTP, FTP, SMTP, etc. To distinguish the ports, the software ports

are given unique numbers. The purpose of  software ports is to identify different

services like e-mail, file transfer, etc. running on a single server computer. Each

service available on the server can be set and accessed using a different port number.

Fig. 4.5 : Rack mounted servers
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Port number is a 16-bit number which when added to a computer's IP address/

URL, can be used for communicating with a particular service available on that

server. A service in a website can be accessed in the format given below:

http://google.co.in:80

Here http is the protocol, google.co.in is the domain name and 80 is the port number.

Some well-known ports and the associated services are listed in Table 4.1.

Default Port No. Service

20 & 21 File Transfer Protocol (FTP)

22 Secure Shell (SSH)

25 Simple Mail Transfer Protocol (SMTP)

53 Domain Name System (DNS) service

80 Hypertext Transfer Protocol (HTTP)

110 Post Office Protocol (POP3)

443 HTTP Secure (HTTPS)

Table 4.1: Ports and their services

4.2.3 DNS servers

In Chapter 8, Computer Networks of Class XI, we learned about Domain Name

System (DNS). A DNS server runs a special purpose networking software that

contains a database of  domain names and their IP addresses. The Domain Name

System (DNS) runs on a DNS server and returns the IP address of  a domain name

requested by the client computer.

A Domain Name System contains several DNS server computers. The DNS servers

are arranged in a hierarchy. At the top level there are 13 root servers that contain

name server information for all the

generic top-level domains such as

.com and .org as well as country-

specific domain addresses such as

.in or .uk. Several copies of these

root servers are placed in different

locations around the globe as

shown in Figure 4.6. All other DNS

servers are installed in the lower

level of  hierarchy. Fig. 4.6 : Root servers around the globe
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Let us see how the DNS searches

and locates the IP address of a

domain name. Suppose we are

visiting the website of  the Police

department of the Government of

Kerala. Let us type the domain

name for the police department, namely www.keralapolice.org in our browser. The

following steps illustrate how the DNS resolves the IP address. See Figure 4.7.

1. All browsers store the IP addresses of the recently visited websites in its cache.

Therefore, the browser first searches its local memory (mini cache) to see

whether it has the IP address of this domain. If found, the browser uses it.

2. If it is not found in the browser cache, it checks the operating system's local

cache for the IP address.

3. If  it is not found there, it searches the DNS server of  the local ISP.

4. In the absence of  the domain name in the ISP's DNS server, the ISP's DNS

server initiates a recursive search starting from the root server till it receives

the IP address.

5. The ISP's DNS server returns this IP address to the browser.

6. The browser connects to the web server using the IP address of

www.keralapolice.org and the webpage is displayed in the browser window. If

the IP address is not found, it returns the message 'Server not found' in the

browser window.

The 13 root servers around the globe manage the entire database of

domain names and their corresponding IP addresses. Each of these root

servers are a network of servers installed in many countries around the

world. They are named as A, B, C, D, E, F, G, H, I, J, K, L and M. These

servers are maintained by various agencies like ICANN, NASA (National Aeronautics

and Space Administration), University of Maryland, VeriSign Inc., etc. ICANN's

(Internet Corporation for Assigned Names and Numbers) Root Server System Advisory

Council is comprised of the organisations that manage the root servers. They are

responsible for advising ICANN on matters relating to the operation, administration,

security and integrity of the Internet's Root Server System. In India, NIXI (National

Internet Exchange of India) has sponsored three root servers at Mumbai (I Root),

Delhi (K Root) and Chennai (F Root).

 
Fig. 4.7 : DNS search 

 

Fig. 4.7 : DNS search

In large organisations like educational institutions, government departments,

software firms, etc. where there are hundreds of  computers or devices connected

to the Internet, a local DNS server is hosted inside the intranet of  the organisation.
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4.3 Web designing

The first step in setting up a website is planning the web pages for the website.

Suppose we are going to develop a website for our school. After deciding the

pages and the links, we need to design these web pages. Any text editor can be used

to create a home page, a page for displaying the courses in the school, facilities

available, contact address, etc. and link them using a menu to form an attractive

website.

Instead of directing the computer to search for IP address in the ISP's

DNS server, we can direct it to search the public DNS operated by

Google. Google Public DNS is a free Domain Name System (DNS)

resolution service that can be used as an alternative to our current DNS

provider. The IP addresses for Google's public DNS are 8.8.8.8 and 8.8.4.4. We can

configure our network settings to direct to Google's public DNS using either of the IP

addresses.

Know your progress

1. Name a protocol that works on top of the Internet Protocol

(IP).

2. Expand HTTPS.

3. What are the advantages of  installing web servers in data centers?

4. State whether true or false.

a. The web server software works based on a client-server model.

b. The web server consists of  server operating system and web

server software.

5. The number of bits in a software port number is _____.

a. 8 b. 16 c. 32 d. 64

6. A Domain Name System returns the ___________ of a domain

name.

This local DNS server contains a list of  domain names and their IP addresses which

the users in the organisation regularly access. This list can be updated periodically

to include new domain names. Whenever a computer in the intranet tries to access

a website in the Internet, it first searches for the domain name in the local DNS

server and finds the IP address. This speeds up the Internet access in the organisation.

Only if  the domain name is not found in the local DNS server, it searches the DNS

of  ISP.
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There are many web designing softwares available. You can also employ the features

available in any of the web designing tools that helps you to create a web page with

the ease of  preparing a document in a word processor. These software also provide

features to design web pages and link them together to form a website. Facilities to

transfer files to the server using FTP protocol is also built into such software. Popular

web designing softwares are Bluefish, Bootstrap, Adobe Dreamweaver, Microsoft

Expression Web, etc. Figure 4.8 shows the Integrated Development Environment

(IDE) of  popular web designing softwares.

Fig. 4.8 : IDE of web designing software

Bluefish Dreamweaver

You have already learned the basics of  creating web pages in high school classes.

HTML consists of  tags and its attributes used to format web pages. In this chapter

we will also get familiar with the different HTML tags and attributes.

4.4 Static and dynamic web pages

You might have noticed that the web pages in the website of  some small business/

organisations, school website, etc. remain the same whenever you visit it. These

websites are called static websites. There are some other websites like the website

that displays your mark in SSLC or Higher Secondary Examination (HSE), that

changes when different register numbers are given to them. They are called dynamic

web pages.

Static web pages are web pages that remain the same all the time until their code is

changed manually. Initially, web pages were created with HTML only and such web

pages are static web pages. Later, the emergence of  scripting languages like JavaScript,

VBScript, etc. brought animations into the web page. The colour and style of a

portion of the web page changes when the mouse is kept over it, images are loaded
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and displayed one after another in a sequence - all these are designed using scripting

languages. The web pages that contain all these features are also classified as static

web pages.

Static web page Dynamic web page

Table 4.2: Comparison of static and dynamic web pages

The content and layout of a web page is

fixed.

Static web pages never use databases.

Static web pages directly run on the

browser and do not require any server

side application program.

Static web pages are easy to develop.

The content and layout may change

during run time.

Database is used to generate dynamic

content through queries.

Dynamic web page runs on the server

side application program and displays

the results.

Dynamic web page development

requires programming skills.

The web pages that contain server side code which creates a web page each time it

is accessed are called dynamic web pages. Program code that runs on the server is

called server side code. Dynamic web pages are executed using a server side

application program that is installed on a web server. The script in the web page is

executed on the web server and the resulting HTML page is sent to the client browser.

In most cases data is accessed from databases to create web pages. The web pages

that display SSLC, HSE results, bus, train and flight booking, banking/financial

transactions, etc. display dynamic content, and are considered as dynamic web pages.

Technologies like PHP, ASP, JSP, etc. are used to develop dynamic web pages. The

working of static and dynamic web pages is represented using Figure 4.9. A

comparison of  static and dynamic web pages is given in Table 4.2.

Fig. 4.9 : Static and dynamic web page requests

Static web page requests Dynamic web page requests

HTTP request

(URL)Client

Computer

Web

Server

Requested

web page

HTTP response

Application

Server

Database
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4.5 Scripts

Scripts are program codes written inside HTML pages. They are written using a

text editor like notepad. Scripting languages like JavaScript, VB script, PHP, Perl,

etc. are used to create dynamic web pages.

Traditional programming languages are set of  instructions carried out by the

computer hardware with the help of an operating system, whereas scripting languages

are interpreted by a web browser or by a web server software. Today most of  the

standalone programs are being replaced by web based programs. Earlier, the

software used in banks were installed in the branches of the bank itself. Almost all

banks have their banking software available on the bank's web server and the bank

employees access them using the Internet. Web based software like banking software,

higher secondary admission software, etc. use scripting languages for their

development.

In an HTML page, a script is written inside <SCRIPT> and </SCRIPT> tags.

<SCRIPT> is used to embed or refer to an executable script within an HTML

document. It has the attributes Type and Src. Type attribute is used to identify

the scripting language code embedded within the script tag.  We will see more

about HTML tags and attributes later in this chapter.

<SCRIPT Type="text/javascript"> is used to insert JavaScript code in the

HTML code.

Scripts can be written as an external file and can be linked to an HTML file. Src

attribute is used to specify the URL of an external file containing scripting code to

be linked to a web page.

<SCRIPT Type="text/javascript" Src="scriptcode.js"> is used to

insert JavaScript code inside the file scriptcode.js into an HTML file.

4.5.1 Types of scripting languages

Let us consider a login page of a website in the Internet. Usually the page will

prompt the user to enter the user name and password. User will click the 'Login'

button after entering the user name and password. What will happen if the user

clicks the 'Login' button without entering the user name? Naturally, the computer

will tell the user that he/she has not entered the user name. Remember that the web

page we are viewing is controlled by two computers - the client computer where

the web page is viewed and the server computer where the web page comes from.

Where will we check whether the user has entered a user name or not - in the client

computer or in the server computer? The server computer is thousand times busier
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than the client computer, because a large number of people may be visiting the

same web site and the server is the only one computer to handle all those requests.

Therefore, all the tasks that can be done at the client side must be done at the client

side itself. This will reduce the workload of  the server.

It should also be noted that, if  this type of  checking is done at the server, when the

user clicks the 'Login' button, the entered data has to be sent to the server from the

client through the Internet. The data has to travel a long distance through the Internet

to reach the server. When the data reaches the server, it will be placed in a queue

because a large number of  clients may be sending the same request to the server.

The sent data will wait in the queue till it gets the chance to be processed by the

server. The server will check whether any user name or password is entered by the

client or not. If not, it will send a message back to the client specifying that the user

name is not given as displayed in Figure 4.10. Again, the message has to travel a

long distance back from the

server to the client through the

Internet. In short, if the user

clicks the submit button, without

entering the user name, he/she

has to wait a few seconds till he/

she gets the message that he/she

has not given the user name.

Besides this, the data has to travel

from client to server and back

from server to client, which

unnecessarily makes network

traffic busy.

If this checking is done at the client side itself, when the user clicks the submit

button, the script code in the client side can check, whether the user has given some

entry as the user name and password. If not, a message can be displayed. During

this process, the data does not travel across the Internet to the server, nor does it

disturb the server for this simple task. When the user clicks the submit button, the

user gets the message that he has not given the user name, within a second as shown

in Figure 4.11. It also does not engage network resources unnecessarily.

Now let us consider another situation. Suppose a user enters a wrong user name

and password. The client computer may be able to check whether there is any entry

with such a user name and password. However it cannot check whether the user

name and password are correct or not. This is because only the server computer

has the details of  all user names and corresponding passwords. Therefore, whether

Fig. 4.10 : Response from the server
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the user name and password match

each other, can be checked at the

server side only. This is a situation

where you have to use the server side

scripting for the validation. When

you need to perform some kind of

validation of data that makes use of

information from the server, it must

be done at the server side itself.

Isn't it now clear that scripting

languages are classified into client

side scripts and server side scripts?

Client side scripting is used to

perform any task at the client side

and is executed in the browser. Scripts that are executed in the server are called

server side scripts. The output produced after execution of  the server side scripts

is in the form of  an HTML page which is sent to the client.

A. Client side scripting

In client side scripting, the script code for validation is downloaded along with the

HTML code to our browser. When we click the submit/save button this client side

script is executed in our browser. If  there is an error, it displays the message. It will

send the data to the web server only if  the validations are correct.

Since the script code is executed on the client browser, it provides a quicker response

to users. This type of  scripting will allow the client browser to share some of  the

burden on the web server while running a web application. The disadvantage of

client side scripting is that there are browsers that do not support scripts. In some

cases users may turn off  the execution of  scripts in the browser. In such cases client

side scripting may not work.

Popular client side scripting technologies are JavaScript and VB script. Client side

scripting is mostly used for validations and also for performing simple calculations

at the client side before sending the data to the web server.

B. Server side scripting

We discussed dynamic web pages in the previous section. Server side scripts are

used to create dynamic web pages. Let us discuss another example for server side

scripting. Consider the website that displays the results of  SSLC examination. When

we enter the SSLC register number of a student, the website displays the scores of

Fig. 4.11 : Response from client browser
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that particular student. This is the same

for each student who has appeared for

the SSLC examination. We know that it

is not practical to design a web page for

each of the several lakhs of students who

have written the SSLC examination. If

so, how is this done? The results of  these

several lakhs of students are stored in a

database in the web server. Server side

scripts are used to access the result of a particular student from the database whose

register number is entered by the user. The server side script then uses this result to

create a simple HTML web page. This web page is then sent to the client browser

and the browser displays it. This way the server side script creates a web page for

each student who has appeared for SSLC examination as shown in Figure 4.12. The

rapid growth of  web based applications has increased the use of  server side scripting.

Server side scripting is a technology in which the web page containing server side

scripts requested by the user is executed in the server and the result, which is an

HTML code, is sent to the client browser. Server side scripting creates web pages

dynamically. Since the scripts are executed at the server, the type and version of  the

browser or operating system on the client's computer does not affect its execution.

Since the scripts are executed on the server, it consumes server resources. Popular

server side scripting languages are Perl, PHP, ASP, JSP, etc.

A comparison of  the classifications of  scripting languages is given in Table 4.3.

Fig. 4.12 : Working of server side scripts

Client side scripting Server side scripting

Script is copied to the client browser

Script is executed in the client browser

Client side scripts are mainly used for

validation of data at the client.

Users can block client side scripting

The type and version of the web browser

affects the working of a client side script

Script remains in the web server

Script is executed in the web server and

the web page produced is returned to the

client browser

Server side scripts usually used to

connect to databases and return data

from the web server

Server side scripting cannot be blocked

by a user

The features of the web browser does

not affect the working of  server side

script

Table 4.3 : Comparison of client side and server side scripting
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4.5.2 Scripting languages

We have learned the different classifications of  scripting languages. Let us now

discuss the features of  some of  the popular scripting languages.

A. JavaScript

JavaScript is a client side scripting language used to make web pages interactive.

JavaScript was developed by Brendan Eich (Figure 4.13) while he was working for

Netscape Communications Corporation. On the client side, JavaScript is

implemented as an interpreted language. Any text editor such as Geany IDE,

Notepad,  etc. can be used to write JavaScript code. It is popular as a client side

scripting tool and works in almost every web browser.

JavaScript can be inserted inside HTML code or can be written

as an external file and then included inside HTML file. If a

JavaScript code is written as an external file, it is common to

use the extension .js. This identifies the file as a JavaScript file.

JavaScript is popular as a tool for validation of  forms in the

client side. It can also be used for performing simple

calculations and also for bringing animations to a web page.

The popularity of  JavaScript has led to more developments in client side scripting.

While applying online for Higher Secondary Plus One admissions, immediately

after entering your SSLC register number, you might have noticed that your name,

date of  birth and other details appear in the text boxes below. This is done without

reloading the entire web page. The data is taken from the server and filled in the

text boxes without refreshing the web page. Ajax is the technology used here. Ajax

improves the interactivity of  the browsers. Ajax is Asynchronous JavaScript and

Extensible Markup Language (XML). XML is a markup language which helps users

to create new tags. After implementing Ajax on a website, it does not require the

entire page to be reloaded for displaying dynamic content on web pages. Ajax

Fig. 4.13: Brendan
Eich (1961 - )

We have seen that the client side scripts are mainly used for validations

at the user's browser and that it reduces the load on the server and

network traffic. Therefore, the entire validation checking scripts are

moved to the client side. Now the data sent to the web server is free

from all errors and can be directly saved to the database. But if the client's browser

does not support scripts or the user has turned off the scripting in the browser for

security reasons, the data will be sent to the server without validation. This causes

invalid data to be stored in the database. In order to protect the validity of the data

saved in the database, it is better to have a validation check at the server side also.
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allows web pages to be updated by exchanging small amounts of data between the
client and the server behind the scenes. This means that it is possible to update
parts of a web page, without reloading the entire web page. However, since Ajax
relies more on JavaScript, if  the browser is not capable of  handling JavaScript or
the user has turned off  JavaScript functionality in the browser, the Ajax application
will not work.

B. VB Script

VBScript is a scripting language developed by Microsoft Corporation based on
the popular programming language Visual Basic. VBScript was developed to use
either as a client side scripting language for the Microsoft Internet Explorer or as a
server side scripting language with the Microsoft Internet Information Server (IIS).
Unfortunately, browsers other than Internet Explorer may not be able to correctly
interpret and display the VBScript code. Therefore, it is less popular as a client side
scripting tool. Since Windows operating system is popular as a server based
operating system, VBScript is popular for server side scripting. With the introduction
of .NET framework - a library of usable program code, Microsoft has taken the
decision to incorporate VBScript as a part of  ASP.NET in .NET framework.

C. PHP

PHP stands for 'PHP: Hypertext Preprocessor'. PHP is an open
source general-purpose scripting language that is suited for web
development and can be embedded into HTML code. It is a server
side scripting tool and its code is similar to Java, C and Perl. The
main objective of PHP is to develop dynamic web pages at ease.
PHP was originally created by Rasmus Lerdorf (Figure 4.14) in
1994 but it is now developed by The PHP Group. The web page
files that contain PHP code have the extension .php.

PHP code is inserted inside HTML code and when the user requests for a PHP
web page, it is interpreted and executed on the web server. To process the PHP
code on the web server, a PHP interpreter has to be installed on the web server.
After execution of  the PHP code in the web server, an HTML page is created,
which is sent to the client browser. One of  the strongest and most significant features
in PHP is its support for database programming. The most common database
used with PHP is MySQL. PHP interpreter is available for all operating systems.
Linux platforms commonly use LAMP (Linux, Apache, MySQL and PHP) server
software which is freely downloadable. LAMP uses Linux as the server operating
system, Apache as the web server, MySQL as the database and PHP for server side
scripting. Windows operating systems use WAMP server software which is also
available for free download.

Fig. 4.14: Rasmus
Lerdorf (1968 - )
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D. Active Server Pages

Microsoft Active Server Pages (ASP) is a server-side scripting environment that

can be used to create and run interactive web applications. ASP contains HTML

and a scripting language code. The scripting language can be VBScript or JavaScript.

ASP files have the extension .asp. These files are compiled using a feature built in

Microsoft's web server software, Internet Information Server (IIS). ASP files are

executed only on Windows operating systems. After execution at the server, the

resultant HTML web page is sent to the client browser. It is a very powerful scripting

language that provides support to a variety of  databases. The introduction of

ASP.NET stopped Microsoft from releasing further versions of  ASP. ASP.NET

provides features like reduced coding, availability of  a variety of  buttons, text boxes

etc. which help in creating web based applications.

E. Java Server Pages

Java Server Pages (JSP) technology provides a simple and fast way to create dynamic

web content. It is a server side scripting language that was developed by Sun

Microsystems in 1999. JSP is similar to PHP, but uses Java as programming language.

JSP files have the extension .jsp. To run JSP, Apache Tomcat web server is required.

The JSP code consisting of  HTML and Java is executed on the web server and the

resulting HTML code is sent to the browser. JSP is an integral part of  Java 2 Platform

Enterprise Edition (J2EE) which is used for developing and running large scale

web based softwares.

4.6 Cascading Style Sheet

Cascading Style Sheets (CSS) is a style sheet language used for describing the

formatting of  a document written in HTML. Using CSS, we can control the colour

of  the text, the style of  fonts, the spacing between paragraphs, how columns are

sized and laid out, borders and its colours, what background images or colours are

used, as well as a variety of other effects in a web page. A CSS file allows us to

separate HTML content from its style. CSS can be implemented in three different

ways - inline, embedded and linked.

• In inline style, the CSS style is applied to each tag separately using the style

attribute in the body part of the web page.

• Embedded CSS codes are placed within the <HEAD> part of the web page.

• Linked CSS implementation is done using an external file with the file extension

.css that contains only CSS code and is linked with the web page.

The advantage of  CSS is that we can reuse the same code for all the pages. If  the

CSS styles for a website is implemented as a linked external file, then the modification
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of a style, modifies the way the tags are presented in all the web pages of the website.

Since CSS styles are written in a common place, it separates CSS and HTML, which

makes it easy for maintenance. Moreover, the tags in web pages are well organised

with the style specifications and therefore it is easy to understand. This also reduces

the size of  the web page thereby providing faster downloads for web pages.

CSS allows adapting the presentation of a web page to devices with different screen

sizes such as desktop monitors, tablets or mobiles. It is considered that CSS along

with JavaScript will be used in the next version of  HTML called HTML5, to bring

animations and interaction to web pages. More about CSS will be discussed in

Chapter 6.

4.7 Basic concepts of HTML documents

HTML is the most widely used language to write web pages. Every web page is

actually an HTML file. Each HTML file is a plain text that defines a set of commands

for creating hypertext documents. These commands are known as HTML tags.
While using these tags, some keywords may be attached to them, which make the

instruction more specific. These words are known as attributes. Therefore, an

HTML document is made up of tags and attributes which work together to decide

how the contents of  the web page have to be displayed on the browser. Actually,

the study of  HTML means the study of  tags and their attributes. Before going into

the details of  tags and attributes, let us have a look at the basic structure of  an

HTML document.

Know your progress

1. The web pages that remain the same until their code is changed

manually are called ______.

2. Name two technologies that can be used to develop dynamic

web pages.

3. The tag used to embed scripts is ______.

4. Write any one of  the uses of  client side scripting.

5. A JavaScript file has the extension ______.

6. What is the advantage of using Ajax?

7. Classify the following scripting languages into client side and

server side.

Javascript, PHP, ASP, VBScript

8. .asp files are compiled using the web server software ______.

9. List the different ways of  implementing CSS.
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4.7.1 Basic structure of an HTML document

The basic structure of  an HTML document is shown in Example 4.1.

Example 4.1: A sample HTML document to illustrate the structure of a web page

<HTML>

<HEAD>

<TITLE> This is the title of web page </TITLE>

</HEAD>

<BODY>

Hello, Welcome to the world of web pages!

</BODY>

</HTML>

You can see some of  the words in the upper case within a pair of  angle brackets <
and >. These are HTML tags. It is not necessary that tags be written in the upper
case. HTML is not case sensitive. We can use either the upper or lower case or even
a mix of  the two. In this book, we follow the style of  using the upper case for
HTML tags and sentence case (i.e., the first letter is capital) for attributes to
distinguish them from other words or text.

As shown in Example 4.1, all HTML pages begin with the tag <HTML> and end
with tag </HTML>. There are mainly two sections in an HTML document namely
head section and body section. The <HEAD> tag is used to define the head section.
The head section contains the information about the document, including the title
of the web page. The <TITLE> tag is used to define the title of the page, which will
be displayed on the title bar of  the browser window. The <BODY> tag is used to
define the body section. The body section contains the contents to be displayed in
the web page. If we open this document in a web browser, it will appear as shown
in Figure 4.15.

Fig. 4.15 : A sample web page opend in a web browser

Versions in HTML: HTML was created by Tim Berners Lee in late 1991
but "HTML 2.0" was the first standard HTML specification which was
published in 1995. HTML 4.01 was a major version of HTML and it was
published in late 1999. The latest version, HTML 5 was released in 2012,
more features are being added for multimedia integration.
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4.7.2 Tags in HTML document

As mentioned earlier, tags are the commands used in the HTML document that tell

web browsers how to format and organise our web pages to show the contents.

Every tag consists of a tag name enclosed between the angle brackets '<' and '>'.

HTML tags are not case sensitive. Therefore the tags <HTML>, <html>, <Html>,

<HtmL>, etc. have the same meaning.

4.7.3 Container tags and empty tags

Most tags are used in pairs - an opening tag and a closing tag.  For example <HTML>

is the opening tag and </HTML> is the closing tag. Note that the closing tag has the

same text as the opening tag, but has an additional forward slash (/) character after

the first angle bracket. Tags that require opening tag as well as closing tag are known

as container tags. Container tags are applicable for a section. The opening tag is

given at the beginning of a section and closing tag is placed at the end of the section.

For example, <HTML> and </HTML> forms the opening and closing tag pairs for

an HTML document.

Some tags are given an exemption to this rule, and these tags do not require closing

tag. Such tags are known as empty tags. This kind of  tag does not span over a

section.  The tags <BR>, <HR>, <IMG>, etc. are examples of  empty tags. We will see

these tags in the forthcoming section of  this chapter.

4.7.4  Attributes of tags

Certain parameters are frequently included within the opening tag to provide

additional information such as colour, measurement, location, alignment or other

appearances to the web browser. These parameters are called attributes. Most of

the attributes require a value. In HTML, the value can be given in single quotes or

double quotes (i.e., attribute='value' or attribute="value"). Each tag

has a standard set of attributes and we can use them as per the requirement. If an

attribute is used, normally it appears after the tag name separated by a space. If

more than one attribute is used, their order of appearance is not important.

For example, to change the background colour of  the web page to yellow, we can

write the code as <BODY Bgcolor = "Yellow">. Here, Bgcolor is the attribute

and Yellow is the value of  this attribute. The other attributes of  <BODY> tag and

other tags will be discussed in the forthcoming section.

4.7.5  HTML Elements

A pair of tags and the content enclosed between these tags are known as an element.

Figure 4.16 shows that the Body element contains the opening tag <BODY> with
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attributes if  any, the closing

tag </BODY> , and the

contents in between these two

tags.

The basic structure of  an

HTML document contains

four sets of  HTML tags.

They are:

<HTML>   </HTML>

<HEAD>   </HEAD>

<TITLE>  </TITLE>

<BODY>   </BODY>

4.8 Creating an HTML document

Now, let us create a simple web page using the HTML code given in Example 4.1.

Text editors like Geany, Gedit, TextPad, Notepad, Notepad++, etc. can be used to

create HTML documents. The file is to be saved with a name with an extension

.html or .htm (for example, sample.html). Figure 4.17 shows an HTML code in

Geany editor, saved as sample.html.

       Element 

 

<BODY> Welcome to HTML </BODY> 

        

      Opening tag                                          Closing tag 

 Fig. 4.16 : An HTML element

Viewing an HTML document in a Browser

Once the HTML document is prepared, it can be viewed in a browser by opening

the document with the browser. There are many browsers like Mozilla Firefox,

Google Chrome, Internet Explorer, Netscape navigator, etc. Screen shots given in

this book, are obtained by opening the web page using Mozilla Firefox. The output

of the HTML code created using Geany can also be obtained by clicking the  Execute

button in the tool bar of  Geany.

Fig. 4.17: HTML code in Geany Editor
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4.9 Essential HTML tags

Let us have a detailed discussion on the essential tags required to create web pages.

The tags, their use, associated attributes and their values, and their appearance in

the browser window will be illustrated in this section.

4.9.1  <HTML> - Starting an HTML page

The entire HTML document is bounded by a pair of  <HTML> and </HTML> tags.

The <HTML> tag identifies the document as an HTML document. In general <HTML>

is always the first tag in an HTML page and the </HTML> is the last tag. Everything

else in the web page is in between these two tags. That is, the Head section and the

Body section lie inside the <HTML> and </HTML> tags. It is a container tag pair. The

main attributes of  the <HTML> tag are Dir and Lang.

Dir

The Dir attribute of <HTML> tag specifies the

direction of the text to be displayed on the web

page. This attribute can have values either ltr

(left-to-right) or rtl (right-to-left). By default,

the value of  this attribute is ltr. The value rtl

is used when languages like Arabic, Hebrew,

Chinese etc. are used for content presentation.

For example, <HTML Dir = "rtl"> specifies

that the document is to be read from right-to-

left.

Lang

The Lang attribute of <HTML> tag specifies the

language we have generally used within the

document. The value "en" is used for English

language and "it" is used to specify Italian

language.

For example, the code <HTML Lang = "ar"> specifies that the language used in

the HTML document is Arabic language. Some common language codes used with

Lang attribute are given in Table 4.3.

4.9.2  <HEAD> - Creating head

It contains the head of  an HTML document, which holds information about the

document such as its title, scripts used, style definitions, etc. The tag pair <HEAD>

and </HEAD> declares the head section. It is also a container tag pair.

Sl. No. Code Language 

1 En English 

2 Fr French 

3 De German 

4 It Italian 

5 El Greak 

6 Es Spanish 

7 Ar Arabic 

8 Ja Japanese 

9 Hi Hindi 

10 Ru Russian 

Table 4.3 : Some common language
codes
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4.9.3  <TITLE> - Creating a title

It is a container tag pair that contains the title of the HTML document, which will

appear in the web browser's title bar. The search engine uses the Title to identify the

page. The tag pair <TITLE> and </TITLE> is used inside the tag pair <HEAD> and

</HEAD> to mention the document title.

4.9.4  <BODY> - Creating a body

The body tag pair <BODY> and </BODY> specifies the document body section.

This section contains the content to be displayed in the browser window. Hence, all

other tags, which define the document content are given in the body section. Before

discussing these tags, let us discuss various attributes of  <BODY> tag.

Background

This attribute sets an image as background for the documents body. This attribute

of  <BODY> tag  makes the page more attractive. The general format is:

<BODY Background = "URL of the picture">

The HTML code given in Example 4.2 shows the sky as the background image of

a web page.

Example 4.2: To set an image as background for a web page

<HTML>

<HEAD>

<TITLE> Background Image </TITLE>

</HEAD >

<BODY Background = "Sky.jpg">

Hello, Welcome to the world of Web Pages!........

</BODY>

</HTML>

Here, the HTML code in Example 4.1

is modified by prioviding an attribute

Background with the value "Sky.jpg"

in the <BODY>  tag as <BODY

Background = "Sky.jpg">. Before

opening the page, we have to place the

image file in the current working

directory. The web page is displayed as

shown in Figure 4.18.
Fig. 4.18 : An image as background
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Bgcolor

This attribute specifies a colour for the background of  the document body. For

example, <BODY Bgcolor = "grey"> will display the background in grey

colour.

The value of  Bgcolor attribute can be given in two ways.

• Color_name - specifies the background colour with a colour name (like "red",

"grey" etc.)

• Hex_number - specifies the background colour with a hexadecimal code (like

"#ff6080", "#303030" etc.). Each hexadecimal code will be preceded with a

hash sign #.

The six digit number and letter

combinations represent colours by

giving their RGB (Red, Green, Blue)

value. Of  the six digits, the first two

digits represent the amount of red, the

second two digits represent the amount

of green, and the last two digits

represent the amount of blue as a

hexadecimal value in the range 00 - FF.

For example, #000000 is black,

#FF0000 is bright red, #00FF00 is

bright green, and #FFFFFF is white

(fully saturated with all the three

colours). We can try various colour

combinations according to our choice

of  hex number. Table 4.4 shows a few

colours with their Names and Hex

values.

Text

This attribute specifies the colour of the text content in the page. By default the

browser displays the text in black colour on a white/grey background. We have

already discussed how to change the   background colour  using Bgcolor attribute.

Simillarly the colour of  the text can be changed using the attribute Text. For

example, <BODY Text = "yellow"> shows the text in yellow colour. Like

Bgcolor, the value of Text attribute can be given as colour name or hexadecimal

code. For example, Text = "Blue" or Text = "#00FFDD" etc.

Black #000000

Red #FF0000

Green #00FF00

Blue #0000FF

Yellow #FFFF00

Aqua #00FFFF

Grey #C0C0C0

White #FFFFFF

Colour
Colour Colour
Name HEX

Table 4.4:  List of colours with their
Name and Hexadecimal value
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Link, Alink and Vlink

A hyperlink is an element, a text or an image that we can click on, and jump into

another document or another section of the same document. A hyperlink points to

a whole document or to a specific element within a document. We will discuss

hyperlink in detail later in this chapter.

Link: This attribute specifies the colour of the hyperlinks that are not visited by

the viewer. The default colour for Link attribute is blue.

Alink: It specifies the colour of the active hyperlink. The link remains active only

for the moment the mouse is clicked on it. Hence at the time of selection

the colour of the link will be changed to Alink value. The default Alink

colour is green.

Vlink: It specifies the colour of  the hyperlink which is already visited by the viewer.

The default colour for Vlink is purple.

Leftmargin and Topmargin

The margin refers to the blank area left from the edge of the page. Leftmargin

attribute is used to leave some blank area on the left side of the document and

Topmargin refers to the blank area at the top edge of  the document window. The

value is specified in pixels.

For example, <BODY Leftmargin = "60" Topmargin = "70">  will make

the body text indent 60 pixels away

from left edge of the page and 70

pixels away from the top edge of

the page.

The code in Example 4.3 is an

illustration to the attributes

Bgcolor, Text, Topmargin, and

Leftmargin of  <BODY> tag.

Figure 4.19 shows the

corresponding web page.

Example 4.3: To set a colour in the background of a web page

<HTML>

<HEAD>

<TITLE> This is the title of web page </TITLE>

</HEAD>

<BODY Bgcolor= "cyan" Text= " Blue"

Fig. 4.19: Use of attributes with BODY tag

 Bgcolor is cyan 
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 Topmargin= "70" Leftmargin= "60">

 Hello, Welcome to the world of Web Pages!........

</BODY>

</HTML>

Know your progress

1. HTML stands for _______.

2. What is a container tag?

3. The type of tag that requires only a starting tag but not an ending

tag is called  ______.

4. State true or false

a. Tags are case sensitive.

b. Bgcolor is an attribute of   <BODY> tag.

c. <TITLE> tag is an empty tag.

d. Dir is an attribute of  <HEAD> tag.

5. Name the  attributes of  <HTML> tag.

6. What is the use of attributes in a tag?

7. List the different attributes of  <BODY> tag.

Create an HTML document to display the name of your school with

an image of the school as background of the web page. Then modify

the page by changing the colour of the text and background.
Let us do

4.10 Some common tags

We have discussed the basic tags and their attributes needed for an HTML

document. There are several other tags, with which web page contents can be made

more attractive. Some of  these tags are used for formatting the text contents in the

body section of  the HTML document and therefore they are called formatting

tags. Now let us see some of  them, which are essential for the layout of  the body

content.

4.10.1  <H1>, <H2>, <H3>, <H4>, <H5> and <H6> - Heading tags

A heading is a word, phrase, or sentence given at the beginning of a written passage

that explains what it is about. Headings are typically displayed in larger and/or

bolder fonts than normal body texts. HTML has six levels of  headings from <H1>
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to <H6>. Here <H1> creates the biggest text and <H6> the smallest. While displaying

any heading, browser adds one line before and one line after that heading. The main

attribute of this tag is Align and the possible values are,

Left : Text is aligned to the left margin.

Right : Text is aligned to the right margin.

Center : Text is aligned to the centre of  the page.

Example 4.4 shows different heading types and alignments and Figure 4.20 shows

the corresponding web page.

Example 4.4: To illustrate different heading styles

<HTML>

<HEAD>

<TITLE> Heading Tags </TITLE>

</HEAD >

<BODY Bgcolor= "#FFEFD5">

<H1 Align= "left"> This is a Heading type 1 </H1>

<H2 Align= "center"> This is a Heading type 2 </H2>

<H3 Align= "right"> This is a Heading type 3 </H3>

<H4> This is a Heading type 4 </H4>

<H5> This is a Heading type 5 </H5>

<H6> This is a Heading type 6 </H6>

</BODY>

</HTML>

Fig. 4.20 : Setting different heading tags with different alignments

 
Note the various 

headings. <H1> is the 
biggest and <H6> is 

the smallest 
headings 

 
Note the various alignments of 

headings. No alignments are 
specified for <H4>, <H5> and 

<H6>. The default alignment is left 
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4.10.2  <P> tag - Creating paragraphs

The <P> tag enables us to organise the text within the <BODY> tag into paragraphs.

It indicates a new paragraph and instructs the browser to add a blank line before

the paragraph. Paragraphs in HTML acts much like the paragraphs in any word

processor. The paragraph element begins with the <P> tag and ends with  </P> tag.

The Align attribute sets the alignment of the text in the paragraph with the values

left, right, center or justify.

The code given in Example 4.5 shows how paragraphs are designed with different

alignments. Figure 4.21 shows the resultant web page.

Example 4.5: To design paragraphs with different alignments

<HTML>

<HEAD>

<TITLE> Paragraph Tags </TITLE>

</HEAD>

<BODY>

<P>

This paragraph         contains

a lot of lines in the source code,

but the browser ignores it.

</P>

<P Align= "right">

This paragraph      contains a lot of spaces

in the source code,but the browser ignores it.

</P>

<P Align= "justify">

The number of lines in a paragraph depends on

the size of the browser window.

If you resize the browser window, the number of lines

in this paragraph will change.

When we align a paragraph as justify, the space between

the words in a line will be adjusted

so that the lines will be both left and right aligned

at the same time.

</P>

</BODY>

</HTML>
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In Example 4.5, we can see that the source code contains three lines in  the first

paragraph and two lines in the second paragraph with extra spaces. But the web

page of  this code shown in Figure 4.21 gives a single line for the  first two paragraphs.

That is, the browser will remove extra spaces and extra lines when the page is

displayed. Note that the second paragraph is right aligned and the third paragraph

is aligned as justify. Any number of  spaces and any number of  lines count as only

one space. Therefore with HTML, we cannot change the output by adding extra

spaces or extra lines in the  HTML code. But this is possible in HTML. Now let us

discuss how an extra line can be added to the text content using  <BR> tag. Note

that the web pages obtained in large or small screens and resized windows  may not

match with the one given in Figure 4.21.

4.10.3  <BR> tag - Inserting  line break

The purpose of BR element is that it creates a line break within a block of text in a

web page. The <BR> tag is used to break the current line of text and continue from

the beginning of the next line. The <BR> tag is an empty tag, which means that it

has no ending (closing) tag.

The HTML code in Example 4.6 displays our National Pledge and Figure 4.22

shows the resultant page in which we can see the effect of <BR> tag and the difference

between <P> tag and <BR> tag.

Example 4.6: To show the National Pledge with line breaks

<HTML>

<HEAD>

<TITLE> Line Breaks </TITLE>

</HEAD >

<BODY Bgcolor = "#FFEFC5">

<H1 Align = "center"> Our National Pledge </H1>

<P>India is my country and all Indians

Fig. 4.21: Use of <P> tag with Align attribute

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



4. Web Technology

113

are my brothers and sisters.<BR>

I love my country and I am proud of its

rich and varied heritage.<BR>

I shall always strive to be worthy of it.<BR>

I shall give respect to my parents, teachers and all

elders and treat everyone with courtesy.<BR>

To my country and my people, I pledge my

devotion. <BR>In theirwell-being and prosperity alone

lies my happiness.

</P>

</BODY>

</HTML>

Referring to Example 4.6 and Figure 4.24, fill in Table 4.5 with

appropriate points to distinguish between <P> tag and <BR> tag.

Let us do

<P> tag <BR> tag

Container tag

Breaks the current line and continues to

the next line.

Table 4.5: <P> tag Vs <BR> tag

4.10.4  <HR> tag - creating horizontal line

The <HR> tag produces a horizontal line (rule) spread across the width of  the browser

window. We can change the size (thickness) and width (length) of  the line using its

attributes Size and Width. The value of Size is given in pixels; and the value of

Fig. 4.22 : Output showing the use of <BR>tag
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Width attribute is given in pixels or in percentage of total width of the document

window (72 pixels = 1 Inch). The other important attributes of <HR> tag are Noshade

and Color. The Noshade attribute has no value. The Color attribute sets the

colour of  the line (rule). Remember that <HR> is an empty tag. Obviously Align is

another attribute which uses to set the alignment to left, center or right.

The code given in Example 4.7 creates a web page as shown in Figure 4.23 to show

the effect of  <HR> tag and its attributes.

Example 4.7: To draw various types of lines

<HTML>

<HEAD>

<TITLE> Horizontal Rules </TITLE>

</HEAD >

<BODY Bgcolor= "#BDB76B">

<H1 Align= "center"> Horizontal Rules </H1>

Line 1<HR Width= "50%" Align= "center"> <BR>

Line 2<HR Width= "40%" Align= "center" Noshade> <BR>

Line 3<HR Size= "10" Width= "30%" Align= "center"> <BR>

Line 4<HR Size= "10" Width= "30%" Align= "center" Noshade><BR>

Line 5<HR Size= "10" Width= "20%" Align= "center" Noshade

     Color= "gold"> <BR>

Line 6<HR Size="10" Width="20%" Align="center" Color="Aqua">

</BODY>

</HTML>

Examining this HTML document and its

output, can you identify the similarities

and the differences in the shapes of lines?

Here, the first two lines are drawn

without the Size attribute and the first

line hasn't any Noshade atribute. Line 3

and Line 4 are of size 10 but the third

one does not have any Noshade

attribute. The last two lines have an

additional attribute Color. Note the

different shapes of these lines in each

case. You may modify this code with all

possible values for different  attributes

and see the changes in the web page,

during your lab activity.
Fig. 4.23 : Different types of horizontal rules
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4.10.5  <CENTER> tag - Centering the content

The <CENTER> tag brings the content to the centre of  a web page horizontally. The
content may be text, image, table, etc. This is a container tag and the content enclosed
between <CENTER> and </CENTER> tag pair will be centred in the browser window.
There is no attribute for this tag.

4.10.6 Text formatting tags

The text in the web page can be formatted, as we often do in word processors. The
importance of  a text is usually specified with features such as bold, italics, underline,
etc. Let us discuss the HTML tags available for this purpose.

<B> - Making text bold

This tag sets the text style to bold. The <B> element displays the content enclosed
in bold typeface.

<I> - Italicising the text

It sets the text style to italics. The content enclosed between <I> and </I> tags
become italicised.

<U> - Underlining the text

The <U> tag is used to underline  a text in HTML.  The contents enclosed between
<U> and </U> tags become underlined. The formatting tags <U>, <B> and <I> can
be combined, so that the content will become bold, italicized and underlined.

<S> and <STRIKE> - Striking through the text

The <S> and <STRIKE> tags are used for the same effect. They display the text in
strike through style. For example,   Thank you all is a strike through text.

<BIG> - Making the text bigsized

The <BIG> tag is used to make the content bigger in size than the normal text size.
It is often used to emphasise the word or lines in the document. Normally the font
size of  <BIG> tag is one size bigger than the current font size.

<SMALL> - Making the text smallsized

The <SMALL> tag is used to make the size of the text smaller than the current size.
Normally the font size of  <SMALL> tag is one size smaller than the current font
size.

<STRONG> - Making bold text

The <STRONG> tag is a phrase tag. It defines an important text. The <STRONG> text
is usually rendered in bold face. It is just the same as <B> tag. The strong element is

used to emphasize a phrase of text content.
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The code given in Example 4.8 illustrates the application of  these tags. For instance,

let us quote the words of Mahatma Gandhi. Figure 4.24 shows the resultant web

page of this code.

Example 4.8: To illustrate the text formatting tags

<HTML>

<HEAD>

<TITLE> Formatting Tags </TITLE>

</HEAD>

<BODY>

<P>

<CENTER><B>Mahatma Gandhi </B>is the <I> <U> Father of

our Nation.</U> </I> </CENTER>

Every student must learn the inspiring words (quotes)

of Gandhiji. It will inspire everyone. Let us have a

look at it.

</P><BR>

<SMALL> The weak can never forgive </SMALL>.

<BIG> Forgiveness is an attribute of the strong</BIG>

<BR> Live as if you were to die tomorrow.

<STRONG> Learn as if you were to live forever.</STRONG>

</BODY>

</HTML>

Let us see some more tags which give the text some special appearance.

<EM> - Emphasising the text

The <EM> tag is used to emphasise the text. In practice, the  element is usually

rendered in italics. The effect of  using <EM> tag is the same as that of  <I> tag.

<SUB> and <SUP> tags- Creating subscripts and superscripts

We  have studied the molecular formula of  water, sulfuric acid, etc. in high school

classes. Obviously they are H
2
O and H

2
SO

4
 respectively. How can we represent

Fig. 4.24: Illustration of text formatting tags
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such notations in HTML? We can see that the figures are written in subscript form.

The <SUB> tag is used to create subscripts in a web page. We can to display the

text H
2
O with the code H<SUB>2</SUB>O.

Similarly, the superscripts as in algebraic expressions like (a+b)2 = a2 + 2ab+ b2 can

be represented by the tag <SUP>. The above expression can be written as

(a+b)<SUP>2</SUP> = a<SUP>2</SUP> + 2ab + b<SUP>2</SUP>

<BLOCKQUOTE> and <Q> tags - Indenting a quotation

The <BLOCKQUOTE> tag is used to indent the content enclosed in these tags. The

HTML <Q> tag (Quote tag) is used to indicate the text  enclosed in double quotation

marks with an indent. This tag is intended for short quotations that do not require

paragraph breaks, whereas <BLOCKQUOTE> is used for long quotations.

The illustration of the tags mentioned above is done in Example 4.9. Let us remember

that World Environment Day is celebrated on June 5. Let us create thoughts for

this day and create a web page using these tags. The corresponding web page is

shown in Figure 4.25.

Example 4.9: To illustrate <SUP>, <BLOCKQUOTE> and <Q> tags

<HTML>

<HEAD>

<TITLE> BlockQuote and Q tags  </TITLE>

</HEAD>

<BODY Bgcolor= "#98FB98" Text= "#008000">

Every year we celebrate World Environment Day on 5<SUP>

th</SUP> June. Let us have a message to all on this

occassion.

<BLOCKQUOTE> <B>June 5<SUP>th</SUP> is World Environment

Day. </B>

Mother nature too needs care and protection. Show her

your care by caring for her trees. Love trees and love

nature. And work for a greener environment because

generations have to come... The future depends on us...

</BLOCKQUOTE>

<Q>Keep your world clean and green. Save trees, Save the

 environment!!

</Q>

</BODY>

</HTML>
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From Figure 4.25, it can be

seen that the first paragraph

is a normal paragraph,

which starts from the left

edge of the browser

window. The superscripting

is also applied in it. The

second paragraph starts with

an indent due to the use of

<BLOCKQUOTE> tag. Finally,

the third paragraph is within

double quotes. It is the

content enclosed by the <Q>

tag pair. Observe the alignment of  these paragraphs also. Note that, the

<BLOCKQUOTE> tag may include more than one paragraph.

Know your progress

1. Name some of  the text formatting tags.

2. List the different attributes of  <HR> tag.

3. How many levels of heading tags are available in HTML?

4. Write an HTML code segment to display x3+y3.

5. State True or False.

a. <BR> tag is an empty tag.

b. <EM> and <I> tags have same usage in HTML document.

c. <U> and <I> tags are not allowed to be used together.

6. What is the use of <STRONG> tag?

7. Which tag performs the same function as that of  <STRONG>

tag?

8. Pick the odd one out from the following:

a. HTML b. ALIGN c.  HEAD d.  CENTER

4.10.7  <PRE> - Displaying preformatted text

Suppose we want to display the content as we entered in the text editor. The <PRE>

tag can facilitate this purpose. Normally the browser delimitted the white spaces,

new line characters, the tab spaces, etc. Therfore, we can turn off  the automatic

formatting applied by the browser with the help of  <PRE> tag. This  tag tells the

browser that the enclosed text is preformatted and should not be reformatted again;

i.e., it tells the browser to display the text exactly in its original form.

Fig. 4.25: Output of Example 4.9
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Example 4.10 and Figure 4.26 give us an idea of  this tag. Let us create a web page

that contains some slogans on World Environment Day.

Example 4.10: To illustrate <PRE> tag

<HTML>

<HEAD>

<TITLE> Pre Formatting tags </TITLE>

</HEAD>

<BODY Bgcolor = "#eee8aa" Text = "#b22222">

<PRE>

Don't Pollute Water,

  Don't Pollute Air,

Don't Pollute Environment,

  And Don't Pollute Yourself,

Celebrate World Environment Day ...

</PRE>

</BODY>

</HTML>

The web page in Figure

4.26 shows that anything

written within <PRE> and

</PRE>  tags will be

displayed as it is in the

HTML document.

4.10.8  <ADDRESS> - Displaying the address

The <ADDRESS> tag defines the contact information for the author/owner of  a

document or an article. The content of  this tag can include name, phone numbers,

PIN numbers, e-mail addresses, etc. Most of  the browsers display the texts in italics.

The code given in Example 4.11 illustrates the <ADDRESS> tag. The appearance of

this page is shown in Figure 4.27.

Example 4.11: To illustrate <ADDRESS> tag

<HTML>

<HEAD>

<TITLE> Address tag </TITLE>

</HEAD>

<BODY Bgcolor= "#DDA0DD">

Fig. 4.26: Illustration of <PRE> tag
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The contact details of the "SCERT" is the following:

<ADDRESS>

State Council of Educational Research and Training

(SCERT),<BR>

Poojappura,<BR>

Thiruvananthapuram,<BR>

PIN: 695012, KERALA.<BR>

Tel : 0471 - 2341883

</ADDRESS>

</BODY>

</HTML>

The <ADDRESS> tag is

usually used to describe

a postal address, when

it is considered as a

part of the contact

i n f o r m a t i o n .

Although the address

element displays the

text with the same default styling as that of  <I> or <EM> elements, it is suitable for

use while dealing with contact information. Typically an <ADDRESS> element can

be placed inside the footer which contains information about the author, copyright,

etc. of  the current section, if  any.

4.10.9 <MARQUEE> - Displaying text in a scrolling Marquee

So far we discussed the tags in HTML that just display the contents in the browser.

But there is a tag called <MARQUEE>, which displays a piece of text or image scrolling

horizontally or vertically in the web page.

Given below is the list of  important attributes that are used with <MARQUEE> tag.

• Height: Sets the height of the marquee in pixels or in percentage of browser

window height.

• Width: This specifies the width of the marquee in pixels or in percentage of

browser window's width value.

• Direction: This specifies the direction in which marquee should scroll. This

can have a value like up, down, left or right.

• Behaviour: This specifies the type of scrolling of the marquee. This can have

a value like scroll, slide and alternate.

Fig. 4.27 : Web page containing <ADDRESS> Tag
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• Scrolldelay: This specifies time delay between each jump. This will have

value in seconds like 10, 15, etc.

• Scrollamount: This specifies the speed of the marquee text.

• Loop: This specifies how many times the marquee element should scroll on

the screen. The default value is Infinte, which means that the marquee scrolls

endlessly.

• Bgcolor: This specifies background colour in terms of  colour name or colour

hex value.

• Hspace: This specifies horizontal space around the marquee. This can be a

value in pixels or percentage value.

• Vspace: This specifies vertical space around the marquee. This can be a value

in pixels or percentage value.

The code given in Example 4.12 illustrates the use of <MARQUEE> tag and Figure

4.28 shows the corresponding web page.

Example 4.12: To illustrate <MARQUEE> tag

<HTML>

<HEAD>

<TITLE> HTML marquee Tag </TITLE>

</HEAD>

<BODY>

<MARQUEE Width= "50%"> This  will take only 50% width of

Browser Window</MARQUEE>

<MARQUEE Height= "100" Hspace= "100" Bgcolor= "#44BB22"

Direction= "up"> Scrolling up </MARQUEE>

<MARQUEE Height= "20" Vspace= "30" Bgcolor= "#FFBB00"

Direction= "right"> This will scroll from left to right

</MARQUEE>

</BODY>

</HTML>

The first marquee starts from

the middle and scrolls

towards the left of the

window since the width is

50%. The second marquee is

in the green coloured portion

and 100 pixels height is

provided for scrolling. The Fig. 4.28 : Marquee tag with different attributes
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scroll area is set 100 pixels horizontally away from the left margin. The third marquee

is filled with the background colour "#FFBB00" and placed 30 pixels vertically

below the previous marquee. The scroll window has a height of 40 pixels and it

scrolls from left to right. Instead of  words or phrases, we can also use images as the

marquee content.

4.10.10  <DIV> - Formatting a block of text

The <DIV> tag is used for defining a section or a block in the document. With the

<DIV> tag, we can group large sections of  HTML documents together and format

them. This section may contain paragraphs, tables, etc. Most browsers place a line

break before and after <DIV> elements. The attributes of  <DIV> tag are:

Align : sets the horizontal alignment with values left, right, center, and

justify.

Id : assigns a unique identifier for the tag.

Style : indicates how to render the content in terms of  colour, font, etc.

In Example 4.13, we use <DIV> tag to apply Align and Style. Figure 4.29 shows

the resultant web page.

Example 4.13: To illustrate <DIV> tag

<HTML>

<HEAD>

<TITLE> DIV Tag </TITLE>

</HEAD >

<BODY Bgcolor= "#ddffff">

<H2 Align= "center"> Success Story </H2>

<DIV Align= "Center" Style= "Color:#0000FF"> One day a

partially deaf four - year old child came home with a

note in his pocket from his teacher, "Your Tommy is too

stupid to learn, get him out of the school."

<P>His mother read the note and answered, "My Tommy is

 not too stupid to learn, I will teach him myself." And

 that Tommy grew up to be the great Thomas Alwa Edison.

</P> He had only three months of formal schooling.

</DIV>

All success stories are stories of great failures.

You learn from your failure and move forward.

</BODY>

</HTML>
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In the code given in Example 4.13, we apply the <DIV> tag to a section, including

paragraphs. For this section, we apply both the Align and Style attributes.

4.10.11  <FONT> - Specifying font characteristics

The <FONT> tag allows us to change the size, style and colour of the text enclosed

within <FONT> and </FONT> tags. It is generally used for changing the appearance

of a short segment of the document. The attributes of <FONT> tag are:

Color : This attribute sets the text colour using either a ColorName or a colour

in the Hexadecimal format.

Face : This attribute specifies the font face. If no face attribute is mentioned, the

document text in the default style is used in the first font face that the

browser supports.

Size : This attribute specifies the font size whose value ranges from 1 to 7, with

default value 3.

The code given in Example 4.14 illustrates the usage of <FONT> tag and Figure

4.30 shows the corresponding web page.

Example 4.14: To illustrate <FONT> tag

<HTML>

<HEAD> <TITLE> Font tags </TITLE> </HEAD>

<BODY Bgcolor= "#eee8aa">

Every success story is also a story of great failure.

The only difference is that every time they failed,

they bounced back. <BR><BR>

Fig. 4.29 : Application of <DIV> tag
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<FONT Size="6" Face="Courier New" Color="#B22222">

Successful people don&apos;t do great things,

they only do small things in a great way.

</FONT>

</BODY>

</HTML>

In the above code, we marked a

portion &apos; in green colour.

What do you mean by this? From

the output, we can understand that

this is for getting the single quote

in the word don't. There are several

other characters like this. They are

discussed in the following section.

4.11 HTML entities for reserved characters

In HTML, the symbols like <, >, &,

etc. have special meaning and cannot

be used in the HTML documents as

part of the text content. The browser

treats these symbols as the punctuation

marks of HTML words like tags and

entities. For example, the angle

brackets < and > are used to express

tags. So, when we want to display these

symbols as part of the text in the web

page, we must use HTML entities.

Table 4.6 shows a list of  a few special

characters and their equivalent entities.

In order to display the text  A < B &

A > C in a web document, we have to

specify it in the HTML document as:

A &lt; B &amp; A &gt; C.

4.12 Adding comments in HTML document

It is a good practice to add comments in HTML documents, especially in complex

documents. Comments help us to understand the code and it increases the code

readability.  HTML provides comment tag to insert comments in the source code.

Character Entity Description 

 &nbsp; Non Breaking Space 

" &quot; Double quotation mark 

' &apos; Single quotation mark 

& &amp; Ampersand 

< &lt; Less than 

> &gt; Greater than 

© &copy; Copyright Symbol 

™ &trade; Trademark Symbol 

® &reg; Registered Symbol 

Table 4.6 :  List of entities and their description

Fig. 4.30: Illustration of <FONT> tag
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Comments are not displayed in the browser window. HTML comments are placed

within <!--    --> tag. So any content placed within <!--    --> tag will be

treated as a comment and will be completely ignored by the browser. In Geany

editor the comments are displayed in red colour. The code in Example 4.15 illustrates

the use of comments and Figure 4.31 shows the resultant message.

Example 4.15: To illustrate the use of comment tag

<HTML>

<HEAD> <!-- Document Header Starts -->

<TITLE> Comment Tags </TITLE>

</HEAD>

<BODY Bgcolor= "#D8D8D8">

<!-- This is a comment -->

<p>The paragraph starts here. Comment statements are

not displayed in the browser window</p>

<!-- Comments are not displayed in the browser -->

</BODY>

</HTML>

Know your progress

1. How are special characters represented in HTML?

2. Face attribute is used with ______ tag.

3. List the attributes of  <FONT> tag.

4. What is the use of <PRE> tag?

5. For scrolling a text, we use _______ tag.

6. What are the main attributes of <MARQUEE> tag?

7. What is the use of <ADDRESS> tag?

8. What is the normal font size in <FONT> tag?

9. Name the main attributes of  <DIV> tag.

Fig. 4.31: Comments in HTML
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4.13 Inserting images

Images always make content presentation more attractive and communicative. Now

a days, most of  the websites are rich in visuals. New versions of  HTML come with

many web development features, but the code required for adding images is simple.

HTML provides a tag <IMG> to insert images in HTML pages. The following is the

simple way of using this tag:

<IMG Src = "picture1.jpg">

The <IMG> tag is an empty tag and it has many attributes. Src is the main attribute

and it specifies the file name of  the image to be inserted. We can use JPEG, PNG or

GIF image files based on our needs, but make sure that the correct filename with

the extension is specified using Src attribute. If the image file is not in the current

working directory, we have to specify the path of  the file or the URL where the file

is available.

Setting space for the image

We can set the space in the web page for the image by specifying the values for the

Width and Height attributes. The values are given in terms of  either pixels or

percentage of its actual size. If these attributes are not specified, the browser will

display the image in its actual size.

Now let us discuss how to set space between images. We know that there are two

types of space between the images when they are placed in a window - vertical

space and horizontal space. HTML offers two attributes Vspace and Hspace, for

providing vertical spacing and horizontal spacing between the images in the web

page.

The HTML code in Example 4.16 demonstrates the two types of spacing discussed

above and Figure 4.32 shows the web page obtained from the code.

Example 4.16: To provide different types of spacing for images

<HTML>

<HEAD>

<TITLE> Inserting Images </TITLE>

</HEAD>

<BODY Bgcolor="#E0FFFF">

<H2 Align="center">Inserting vertical and horizontal

 spacing between images</H2>

Here the images are placed with <B><I><U> Vspace and

Hspace </U></I></B> attributes <BR>
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<IMG Src= "book3.jpg" Height= "50" Width= "70"

   Vspace= "10" Hspace= "10">

<IMG Src= "book3.jpg" Height= "50" Width= "70"

   Vspace= "10" Hspace= "10"> <BR>

<IMG Src= "book3.jpg" Height= "50" Width= "70"

   Vspace= "10" Hspace= "10">

<IMG Src= "book3.jpg" Height= "50" Width= "70"

   Vspace= "10" Hspace= "10"> <BR>

</BODY>

</HTML>

Figure 4.32 shows that the

images are placed within the

given width and height, and the

distance between the images is

according to the specified

horizontal and vertical spacing.

Now let us discuss another

important attribute, Align for

<IMG> tag, which aligns the

image with respect to the base

line of the text. The possible

values for this attribute are the following:

Bottom : Aligns the bottom of the image with the baseline of the text and this is

the default setting.

Middle : Aligns the middle of the image (vertically) with the baseline of the text.

Top : Aligns the image with the top of the text.

Let us see the effect of these values for the attribute Align. Example 4.17 and Figure

4.33 demonstrate this.

Example 4.17: To provide different alignments for an image

<HTML>

<HEAD>

<TITLE> Alignment of Images </TITLE>

</HEAD>

<BODY Bgcolor= "#E0FFFF">

<H2 Align= "center">Alignment of Images</H2>

This Image is <I><U>aligned at the bottom </U></I>

Fig. 4.32:  Images within the specified size and with
horizontal and vertical spaces between them.
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<IMG Src= "book3.jpg" Height= "40" Width= "50"

   Align= "Bottom"> <BR> <BR>

  This Image is <I><U>aligned at the Middle </U></I>

<IMG Src= "book3.jpg" Height= "40" Width= "50"

   Align= "Middle"> <BR> <BR>

   This Image is <I><U>aligned at the Top </U></I>

<IMG Src= "book3.jpg" Height= "40" Width= "50" Align="Top">

</BODY>

</HTML>

There are some more values for the

Align attribute of  <IMG> tag. They

are left and right, which align the

image the left and right sides of the

browser window respectively.

Setting border around an image

Suppose we want to give a border to an image inserted in a web page. It is possible

with the Border attribute of  <IMG> tag. The thickness of  the border can be set by

giving appropriate value to this attribute. The HTML code in Example 4.18 and

the corresponding web page shown in Figure 4.35 give the effect of border attribute.

Example 4.18: To give a border to an image

<HTML>

<HEAD>

<TITLE> Inserting Images </TITLE>

</HEAD>

<BODY Bgcolor= "#E0FFFF">

<H2 Align= "center">Inserting Border to Images</H2>

Here is an image <B><I><U> with Border </U></I></B>

attribute

Fig. 4.33: Different alignment of images with the text

Fig. 4.34:  Images aligned left and right of
browser window

Observe Figure 4.34, in which

the left and right alignments of

images in the browser window

are shown. Write the HTML

document for this web page. Let us do
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<IMG Src= "book3.jpg" Height= "50" Width= "70" Border="5">

<BR>Here is an image<B><I><U> without Border</U></I></B>

attribute

<IMG Src= "book3.jpg" Height= "50" Width= "70">

</BODY>

</HTML>

We have learnt

various attributes of

<IMG> tag and their

effects on the image. If

the image file specified

with the Src attribute

is not found in the

given path, how will the web page look? The specified place in the web page for the

image will be left blank. Due to some other reason also, the web browser may not

be able to display the image. In such a situation, we can provide an alternative text

in the browser in the absence of image. HTML provides the attribute Alt to specify

an alternate text for an image, if the browser cannot display the image. The code in

Example 4.19 illustrates the effect of Alt attribute and Figure 4.36 shows the

resultant web page.

Example 4.19: To illustrate the effect of Alt attribute of <IMG> tag

<HTML>

<HEAD> <TITLE> Inserting Images </TITLE> </HEAD >

<BODY Bgcolor= "#E0FFFF">

<H2 Align= "center">Inserting Images</H2>

If the browser cannot display the image, then the text

entered in the <B>Alt</B> attribute will be displayed.<BR>

<IMG Src= "book5.jpg" Height= "20%" Width= "20%"

   Alt= "Image of an opened book"> <BR>

</BODY>

</HTML>

Fig. 4.35:  Images with border and without border

Fig. 4.36 : Effect of Alt attribute in <IMG> tag

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



Computer Applications (Humanities) - XII

130

Let us conclude

The security of  communication over the Internet is a determining factor in the

success of the Internet. The security of transactions over the Internet is implemented

using HTTPS and digital certificates. Internet infrastructure consists of  technologies

like web server, software ports and DNS servers used to store and communicate

data. Web servers consist of  a single/several websites. Websites consists of  web

pages. We can design web pages either by writing HTML code or using web designing

softwares. Webpages can be classified as static and dynamic. Dynamic web pages

can be developed using scripts. We can perform client side validations using client

side scripting languages like, JavaScript, VBScript, etc. Server side scripts like PHP,

ASP, etc. are used to create pages dynamically in the web server. Cascading Style

Sheet (CSS) can be used to provide a uniform style to the entire website. The basic

concepts of  HTML language and web page designing are discussed here. We are

now familiar with different tags and their important attributes. We know that some

of  the tags are container tags, but some others are empty tags. We can make a web

page with neatly formatted text using a variety of  formatting tags. Different kinds

of listing are discussed to make the text more presentable. The beauty of the web

pages can be enhanced by including marquees, images, audio and video. We have

also discussed the importance of hyper linking and have been familiarised with

various kinds of  hyperlinks. We should have a sound knowledge of  the concepts

discussed in this chapter and an excellent practical experience in creating HTML

documents, so that we can easily internalise the concepts in the following chapters.

Also, we will be able to design beautiful web sites and develop web applications

ourselves.

Know your progress

1. To insert images in an HTML document _______ tag is used.

2. _______ is the main attribute of  <IMG> tag.

3. What is the use of Alt attribute of <IMG> tag?

4. Name the attributes that are used to display an image in a particular

size.

5. Which are the attributes that provides horizontal and vertical

spaces between two images?
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           Let us practice

1. Wrtie an HTML code for a web page of  Kerala with the following details and
features:

♦ A heading followed by a paragraph of 5 sentences about Kerala using
text formatting tags and attributes.

♦ Background of  the page needs an image of  a scenary.

2. Wrtie an HTML code for a web page for your school with the following details
and features:

♦ A heading followed by a paragraph of 3 sentences about the district using
text formatting tags and attributes.

♦ Provide a colour to the background of the page.

♦ Include an image of the school.

3. Wrtie an HTML code for a web page for your school with the following details
and features:

♦ A heading followed by a paragraph of 3 sentences about the district using
text formatting tags and attributes.

♦ Give the postal address of the school.

♦ Include a marquee that "Admission for the new accademic year commences

on 10th May"

4. Wrtie an HTML code for a web page to show the lyrics of  our National Anthem
with the following details and features:

♦ A heading with a different font characteristics.

♦ An image of our national flag

 Let us assess

1. What is the role of routers in transporting data over the Internet?

2. The social media websites developed their own protocol for communicating
over the Internet. How is this possible when Internet uses TCP/IP protocol?

3. The user name and password of an e-mail account has to be sent securely over
the Internet.

a. Name the technology used to send the data to the server.

b. How does this technology support secure data communication?

4. What is the role of payment gateway in online purchases?

5. ABC Engineering College has about 1000 computers connected to the Internet,
in its campus. What is the advantage of  having a local DNS server in the college's
intranet?
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6. Write an example of  a web server operating system and a web server package.

7. What is the use of  software ports in a web server?

8. The port used for HTTP is ________.

9. Suppose you are browsing the website www.prdkerala.org. Explain how the
DNS resolves the IP address.

10. What are scripts? Explain the different scripting languages.

11. Consider the home page of your school website and the web page that displays
the results of  class XI examinations.

a. Compare the difference between the two web pages based on their creation.

b. Write the technologies that can be used for developing these web pages.

12. a. The file name extension for a JavaScript file is _________.

b. Write two popular uses of  JavaScript in a web page.

13. What is Ajax? What is its use?

14. Your friend Ravi wishes to create a website that displays the marks of  the
students in your class in each examination.

a. Suggest a technology to implement this.

b. Justify your suggestion.

15. Consider that Manoj is developing a website using PHP that uses a database in
MySQL. What are the requirements to implement this if he is using Linux web
hosting?

16. "Almost all websites today use CSS for its development." What are the
advantages of using CSS in web sites?

17. Who developed HTML?

18. In HTML, there are mainly two sections. Can you name them?

19. If  you analyse web pages you can see different colours for links, visited links,
background etc. Expalin how this can be done in HTML, with examples.

20. Compare container and empty tags in HTML with examples.

21. The default colour of the attribute Alink is __________.

22. The default color of the attribute Vlink is  __________.

23. Classify the following HTML related words:

BR, IMG, ALIGN, FONT, FACE

24. Name the tag which has Noshade attribute.

25. Write the main attribute of  <IMG> tag to insert an image file in the webpage.

26. Mention the purpose of  Alt atribute in <IMG> tag.

27. The default alignment of an image obtained by using <IMG> tag is ________.

28. List the main attributes of  <FONT> tag.
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After the completion of this chapter, the

learner

• uses different list tags to present the

content effectively in web pages.

• identifies the relevance of hyper

linking and uses <A> tag for different

types of linking.

• provides audio and video in web

pages with the help of <EMBED> tag.

• produces inline sounds and videos

in web pages.

• lists and explains the tag and

attributes for creating a table.

• uses the tags associated with

<TABLE> tag to design tables with

different characteristics.

• constructs different tables using the

tags and attributes.

• identifies the importance of frames

in the web page.

• creates frames using appropriate

tags to display different web pages

in the same browser window.

• identifies the concept of Forms in the

web page.

• explains various components in a

Form and creates them using proper

tags and attributes.

• designs web pages with tables,

frames and forms.

I
n the previous chapter, we studied the basic

tags of  HTML. We have also learnt to create

some simple web pages using those tags and

their attributes. But we are familiar with websites

that provide much more facilities and utilities.

There are websites that contain different types

of  lists. Linking between web pages is the

backbone of  World Wide Web. The different

types of  linking are discussed in this chapter.

You might have come across certain information

in tabular form. Sometimes you see more web

pages in the same browser window. We are also

familiar with websites through which we submit

the register number to obtain the mark list of

examinations, apply for admission and

scholarships, pay the bills of  electricity and

water consumption etc. How can we create

tables in web pages to present information? Can

we place more than one web page in a single

browser window? If  yes, how? How are web

pages created to accept data from the user to

provide information? HTML provides all these

facilities for web developers. In this chapter, we

discuss the HTML tags required to answer all

these questions.

5
Web Designing

using HTML

Significant Learning Outcomes
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5.1 Lists in HTML

While presenting information, the facility of  listing can make it more communicative.

Lists are of  different types. We are familiar with numbered lists and bulleted lists.

HTML offers several mechanisms for specifying lists of  information. All lists must

contain one or more list elements. There are three kinds of  lists in HTML - unordered

lists, ordered lists and definition lists.

5.1.1 Unordered lists

Unordered lists or bulleted lists display a bullet or other graphic in front of each

item in the list. We can create an unordered list with the tag pair <UL> and </UL>.

Each item in the list is presented by using the tag pair <LI> and </LI>. Unordered

lists are used when a set of  items can be placed in any order.

The code in Example 5.1 presents some hardware components of a computer in

bulleted list. The corresponding web page is shown in Figure5.1.

Example 5.1: To create an unordered list

<HTML>

<HEAD>

<TITLE> Unordered Lists </TITLE>

</HEAD>

<BODY Bgcolor= "#DEB887">

<CENTER> <H2> Unordered List </H2> </CENTER>

While buying a computer, we have to consider many items.

Here are some important items to consider.

<UL>

<LI> RAM </LI>

<LI> Hard Disk </LI>

<LI> Mother Board </LI>

<LI> Processor </LI>

</UL>

</BODY>

</HTML>

We can customise unordered lists by setting the

Type attribute to three different values: Disc

(default value), Square and Circle, which set

the type of bullet that appears before each list

item. The following code creates a list as shown

in Figure 5.2.

Fig.5.1: Web page containing
unordered list
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<UL Type= "Square">

<LI> RAM </LI>

<LI> Hard Disk </LI>

<LI> Mother Board </LI>

<LI> Processor </LI>

</UL>

5.1.2 Ordered lists

Ordered lists present the items in some

numerical or alphabetical order. HTML

provides the tag pair <OL> and </OL> to create

an ordered list. The items in the ordered list are presented by <LI> tag in <OL>

element. The ordered list is also called numbered list. Ordered lists or numbered

lists are used to display a list of  items that need to be placed in a specific order.

Example 5.2 is a code that presents an ordered list of  items. The corresponding

web page is shown in Figure 5.3.

Example 5.2: To create an ordered list

<HTML>

<HEAD>

<TITLE> Ordered Lists </TITLE>

</HEAD>

<BODY Bgcolor= "#DDA0DD">

<H2 Align= "center"> Ordered List </H2>

Consider the memory devices of a computer.

Then according to the speed of data processing,

we can arrange the memory devices as follows.

<OL>

<LI> Registers </LI>

<LI> Cache </LI>

<LI> RAM </LI>

<LI> Hard Disk </LI>

</OL>

</BODY>

</HTML>

We can see that the list in Figure 5.3 is

numbered from one through four. There are

other numbering styles for presenting the list

Fig.5.2: Unordered list with square bullet

Fig.5.3: Web page containing ordered list
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items. We can customise the numbering system used in ordered list by using the

Type attribute, which can set with the values as detailed below:

1 Default numbering scheme (1, 2, 3, ...)

A Upper case letters (A, B, C, ...)

a Lower case letters (a, b, c, ...)

I Large roman numerals (I, II, III, ...)

i Small roman numerals (i, ii, iii, ...)

An ordered list, by default, starts with the first number in the series used in the list.

That is, the starting number will be any one from 1, A, a, I and i. If  we want to start

with any other number in the series, then the Start attribute of  <OL> tag enables

us to change the beginning value. To start numbering a list at 5, for example, we

may write: <OL Start= "5">. Thus, the numbering starts from 5 and then proceeds

with 6, 7, 8, ... and so on.

The Start attribute sets the starting value of the item (it must be an integer) and

the Type attribute sets the numbering style. For example, the following ordered

list starts numbering from V and continues with VI, VII, ... and so on. The output

of this code is shown in Figure 5.4.

<BODY Bgcolor ="#DDA0DD">

<H4 Align="center">Ordered List with Type attribute</H4>

<OL Type= "I" Start= "5">

<LI> Registers </LI>

<LI> Cache </LI>

<LI> RAM </LI>

<LI> Hard Disk </LI>

</OL>

</BODY>

5.1.3 Definition lists

A definition list is a list of  terms and the

corresponding definitions. The definition

text is typically indented with respect to

the term. No bullet symbol or number is provided for the list items. The tag pair

<DL> and </DL> enclose the definition lists. Each term in the list is created using

the <DT> tag and the <DD> tag supplies the definition of  the term.

The code in Example 5.3 creates a web page to present the definitions of some

terms related to security aspects of  Internet. Figure 5.5 shows the resultant web

page.

Fig.5.4: Ordered list with different numbering
style and starting value
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Example 5.3: To create a definition list

<HTML>

<HEAD> <TITLE> Definition List </TITLE> </HEAD >

<BODY Bgcolor= "#FFE4C4" Leftmargin= "100" Rightmargin= "150">

<H2 Align= "center"> Definition List </H2>

Today cyber security has an immense role in the

field of Internet. The following are some of

the threats that affect a computer network.

<DL>

<DT>Spam :</DT>

<DD> Spam is the unsolicited e-mail sent in the

hope of increasing the sales of some product, or

just for annoying people.</DD>

<DT>Phishing :</DT>

<DD> Phishing is an attempt to acquire information

such as usernames, passwords and credit card details

by posting as the original website, mostly that

of banks and other financial institutions. </DD>

</DL>

</BODY>

</HTML>

Fig. 5.5: Web page containing a definition list

In Figure 5.5, we can see that each annotation is indented under the corresponding

term. Also note the left and right margins in the window.
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5.1.4 Nested lists

A list of items can be given under each item of another list. It is known as nesting

of  lists. This is possible in many ways. For example, we can insert an unordered list

into another unordered list, an unordered list into an ordered list, an ordered list

inside an unordered list, etc. The code given in Example 5.4 demonstrates the concept

of nested list and Figure 5.6 shows the resultant web page.

Example 5.4: To create a nested list

<HTML>

<HEAD>

<TITLE> Nested Lists </TITLE>

</HEAD>

<BODY Bgcolor= "#E0FFFF">

<H2 Align= "center"> Nested List </H2>

Consider the devices of a computer.

We can list some of them as follows.

<OL>

<LI> Input Devices </LI>

<UL>

<LI>Keyboard</LI>

<LI>Mouse</LI>

<LI>Scanner</LI>

<LI>MICR</LI>

</UL>

<LI> Output Devices </LI>

<UL Type= "Square">

<LI>Printers</LI>

<LI>Monitors</LI>

<LI>Speakers</LI>

</UL>

<LI> Memory Devices </LI>

<UL Type= "Circle">

<LI>Hard Disc</LI>

<LI>CD Rom</LI>

<LI>Flash Drive</LI>

</UL>

</OL>

</BODY>

</HTML>

In Example 5.4, three sets of unordered lists are nested into an ordered list.

Fig.5.6: Classification of devices using nested
list
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Know your progress

1. What are the different types of lists in HTML?

2. Suppose your teacher asks you to display the list of students in

your class using HTML document. Which type of list will you

prefer? Why?

3. What are the common attributes of <UL> and <OL> tags?

4. What is the difference between <UL> tag and <OL> tag?

5. Name the tags used in the definition list.

5.2 Creating links

A hyperlink is an element, a text, or an image in a web page that we can click on, and

move to another document or another section of the same document. Hyperlinks

allow visitors to navigate between websites by clicking on words, phrases and images.

HTML provides the ability to hyperlink text, image etc. to another document or

section of  a document. Hyperlink is often referred to as links. In HTML, the <A>

tag provides the facility to give hyperlinks. This tag is called anchor tag and anything

given between the tag pair <A> and </A> becomes part of the link and a user can

click that part to reach the linked document. Href is the main attribute of <A> tag

and it means hyper reference. The value of this attribute is the URL of the document

(address of the web page/site) to which hyperlink is provided.

For example, consider the following code segment:

<A Href= "http://www.dhsekerala.gov.in">Higher Secondary</A>

This creates the target of  the hyperlink to the website http:// www.dhsekerala.gov.in.

At the time the user clicks the link, the browser opens the home page of this URL.

The text inside the tag pair <A> and </A> will appear underlined and in different

colour.

The HTML code in Example 5.5 and Figure 5.7 show how hyperlinks are created

in web pages.

Example 5.5: To create a hyperlink in a web page

<HTML>

<HEAD>

<TITLE> Anchor Tag </TITLE>

</HEAD>

<BODY Bgcolor= "#FFFFFF">

<H2 Align= "center"> Hyperlinks </H2>
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<P>Now this will create a hyperlink to the website of

Higher Secondary Department.<BR>

Kindly click on the words

<A Href= "http://www.dhsekerala.gov.in">Higher Secondary

Education</A>.

</BODY>

</HTML>

As shown in Figure 5.7, the

hyperlinked text is in underlined

format (Higher Secondary Education)

and in a different colour.

Hyperlinks are considered either

"internal" or "external" depending on

their target.

5.2.1  Internal linking

A link to a particular section of  the same document is known as internal linking.

The attribute Name of  <A> tag is required for this. We have to give a name to

identify the section to be opened by the browser. This name is used with the Name

attribute to establish the link.

For example, suppose we have three paragraphs on the subject "Environment

Pollution". Let it be the Introduction section, Air pollution section, and Water

pollution section. We refer to these sections by giving different values to the Name

attribute of  <A> tag.

<A Name= "Introduction"> INTRODUCTION </A>

<A Name= "Air"> Air Pollution </A>

Now, we can refer to these sections by giving the values of  Href attribute as

#Introduction, #Air (the # symbol is essential) from another section of the

document as follows:

<A Href = "#Introduction"> Go to Introduction </A>

<A Href = "#Air"> Air pollution </A>

Let us create a web page incorporating the concepts of  internal linking. Example

5.6 is an HTML code that has two internal links. Figure 5.8 shows the resultant page

of this code.

Fig.5.7: Web page containing hyperlink
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Example 5.6: To create a web page containing internal links

<HTML>

<HEAD> <TITLE> Internal Linking </TITLE> </HEAD>

<BODY Bgcolor= "f8f8f8">

<H2 Align= "center">ENVIRONMENTAL POLLUTION</H2>

<A Name= "Introduction"><B>INTRODUCTION</B></A>

<P><FONT Size= "15">E</FONT>nvironment pollution is a

wide-reaching problem and it is likely to affect the

health of human population.Here we discuss the environment

pollution in the perspective of <A HREF= "#Air">air

pollution </A>,

<A Href= "#Water"> water pollution </A>and land/soil

waste pollution. Studies find that these kinds of

pollutions are not only seriously affecting humans

but also animals and plants.

</P>

<A Name= "Air"><B> Air Pollution</B></A>

<P>The air we breathe is an essential ingredient for our

health and wellbeing. Unfortunately polluted air is common

throughout the world, especially in developed countries.

</P>

<A Name= "Water"><B> Water pollution</B></A>

<P>The water we drink is an essential ingredient for our

health and wellbeing. Unfortunately polluted water and

air are common throughout the world.Water pollution is

caused by the discharge of industrial effluents, sewage

water and agricultural or household waste.

</P>

<A Href= "#Introduction">Go to Introduction </A>

</BODY>

</HTML>

On clicking the hyperlink

air pollution and

water pollution on

the web page shown in

Figure 5.8, we get that

particular section of the

document as shown in

Figure 5.9. Fig. 5.8: Web page containing internal hyperlinks
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Similarly, when we click on the

link Go to Introduction

at the bottom of the page

shown in Figure 5.9, the

introduction section will be

displayed on the window.

5.2.2 External linking

The link from one web page

to another web page is known

as external linking. It is made

possible by providing the

URL of the external file in the Href attribute of <A> tag of the current page. The

procedure for external linking is illustrated in the beginning of Section 5.2.

5.2.3 Concept of URL

URL stands for Uniform Resource Locator, and it means the web address. In fact,

there are two types of URLs - relative URL and absolute URL.

The referencing <A Href= "http://www.scertkerala.gov.in"> is an

absolute URL, because it is referring to a specific URL. On the other hand, <A

Href = "image.html"> is relative reference. Here we give the file name, 'image.html'
as the URL, and it is a relative URL, relative to the current document. If the URL

of the current web page document is D:\HTML\hyperlink.html, the web browser

knows that the hyperlink <A Href = "image.html"> points to the file image.html
in the directory D:\HTML itself.

5.2.4  Creating graphical hyperlinks

In the previous sections, we gave hyperlinks to texts. We can make hyperlinks to

images also using <IMG> tag inside the <A> tag. The HTML code given in Example

5.7 and Figure 5.10 show a web page containing graphical hyperlink.

Example 5.7: To create a web page containing graphical hyperlink

<HTML>

<HEAD> <TITLE> Graphical Hyperlink </TITLE> </HEAD>

<BODY Bgcolor = "#E0FFFF">

<H2 Align= "center">Graphical Hyperlink</H2>

Here is the image with <I>Graphical hyperlink </I>

<A Href= "https://www.wikipedia.org">

Fig. 5.9: Hyperlinked section of a page in the browser
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<IMG Src= "wiki.jpg" Alt= "Image of Wiki"

   Height= "30" Width= "40" Border= "1"> </A>.

   We can click over this image and the home page of

   linked site, wikipedia.org will open.

</BODY>

</HTML>

Suppose you move the mouse

pointer upon the image of the

wikipedia logo in the web page,

the mouse pointer will change

to the hand symbol. This

indicates that, this image is a

hyperlink. When we click on

this image, then the

corresponding web page

www.wikipedia.org will be

opened.

5.2.5 Creating e-mail linking

We can create an e-mail hyperlink to a web page using the hyperlink protocol mailto:.
Let us see the code in Example 5.8 and the web page shown in Figure 5.11 to

understand the concept of  e-mail hyper linking.

Example 5.8: To create a web page containing e-mail hyperlink

<HTML>

<HEAD> <TITLE> e-mail Linking </TITLE> </HEAD >

<BODY Bgcolor= "#E0FFFF">

<H2 Align= "center">e-mail linking</H2>

Now we can create an <B><I>e-mail hyperlink </I></B> to

SCERT in the following way. Kindly click on the word

<A Href= mailto: "scertkerala@gmail.com"> SCERT</A> Kerala.

</BODY>

</HTML>

As shown in Figure 5.11, the web contains

a link SCERT. If  we click on it, e-mail

program will be opened with an empty

message box addressed to the mail address

scertkerala@gmail.com.

Fig. 5.10: Web page containing graphical hyperlink

Fig. 5.11: Web page containing e-mail
hyperlink
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5.3 Inserting music and videos

Nowadays, web pages are enriched not only with text and images, but also with

plenty of  music, video and other multimedia resources.  Let us have a basic idea

about the inclusion of  such resources in web pages. There are two ways of  handling

multimedia in a web browser. One is as inline and the other is as external data. The

inline refers to files and data that are handled as part of the page. These files play

the music or video when the page is visible in the browser window. We can also link

a web page to external multimedia files with extensions .jpg, .gif, .avi, .png, .tiff,

.mp3, .mp4, etc.

The easiest way to add music or video to the web page is with a special HTML tag,

called <EMBED>. This tag includes the controls of the multimedia automatically in

the browser window. In case, the browser does not support the <EMBED> tag, then

we can use <NOEMBED> tag. The content within this tag pair will be displayed, if  the

<EMBED> tag is not supported by the browser.

The main attribute of the <EMBED> tag is Src, which specifies the URL of the

music or video files to be included. The other attributes are Height, Width, Align,

Alt, etc. The values of  these attributes are familiar to us. One more important

attribute of <EMBED> tag is Hidden which indicates whether the embedded

component should be made visible or not. It is done by setting the value to True

(by default) or False.

The code in Example 5.9 creates a web page that includes an audio link. Figure 5.12

shows the corresponding web page.

Example 5.9: To create a web page containing audio link

<HTML>

<HEAD>

<TITLE> Embed Tag </TITLE>

</HEAD>

<BODY Bgcolor = "#DDFFFF">

<H2 Align= "center"> Adding Music and Videos </H2>

Here is a tag <B><I>EMBED </I></B> with the Multimedia

features.<BR>

<EMBED Src= "song1.mp3" Width= "300" Height= "60">

</EMBED>

</BODY>

</HTML>
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When the HTML document in Example 5.9

is opened, the webpage will play the music

that we embedded along with the

document. The audio controls like play/

pause, volume, etc. will also be displayed

on  the web page. Similarly we can add

movies in a webpage by using the tag

<EMBED> and its attribute Src.

The code in Example 5.10 and the resultant

web page shown in Figure 5.13 illustrate this

linking.

Example 5.10: To create a web page containing video link

<HTML>

<HEAD>

<TITLE> Embed Tag </TITLE>

</HEAD >

<BODY Bgcolor = "#DDFFFF">

<H2 Align="center">Adding Music and Videos</H2>

Here is a tag <B><I>EMBED </I></B>with the Multimedia

features.

<EMBED Src= "alan.mp4" Width= "300" Height= "150">

</EMBED>

<NOEMBED><IMG Src= "book2.jpg"

    Alt= "Alternative Media">

</NOEMBED>

</BODY>

</HTML>

When we open this page, the video starts to play.

Here again, we can control the different

properties of  the audio and video, such as

volume, pause, full screen mode, etc. We can

also include audios and videos from other web

pages or sites by linking them to our pages.

As mentioned earlier, music can be played in

the background while the page is viewed. This

kind of audio inline is achieved by the tag

<BGSOUND>. The code in Example 5.11 illustrate

the use of  this tag.

Fig. 5.12: Web page containing audio link

Fig. 5.13: Web page with video
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NEWLY DIAGNOSED CANCER PATIENTS IN THE HOSPITAL FOR THE LAST 3 YEARS

Year 2012 2013 2014

Smokers 129 140 143

Pan users 54 56 49

Alcohol users 74 68 77

Other cases 95 93 92

Table 5.1: Cancer patients diagnosed in a hospital

Example 5.11: To illustrate the use of <BGSOUND> tag

<HTML>

<HEAD> <TITLE> Background Music </TITLE> </HEAD >

<BODY Bgcolor = "#DDFFFF">

<H2 Align= "center">Adding Background Music </H2>

Here is a tag <B><I> BGSOUND </I></B> which helps

us to play background music in our web page.

<BGSOUND Src= "Song2.mp3" Loop= "Infinite">

</BODY>

</HTML>

We can adjust the volume control by using the Volume attribute of  <BGSOUND> to

make the music softer or harder. Note that while creating HTML documents that

include external files in Src and Href attributes, the correct path should be

provided. If  you try out the codes given in the examples, you have to make necessary

modifications in these attributes. The attribute Loop determines the duration of

play. The value Infinite causes the music play as long as the page is in view.

5.4 Creating tables in a web page

Sometimes, presenting a lot of  information in a structured way is essential, especially

in websites. Suppose we need to compare the data collected from a hospital for the

period from 2012 to 2014, which states the number of newly diagnosed cancer

patients among regular smokers, pan users and alcohol consumers. It can be

presented in a tabular form as shown in Table 5.1.

As we know, a table is a structured element that consists of  rows and columns of

cells. We can place any kind of  content like text, image, and even other tables within

these cells.In HTML, <TABLE> tag is used to create tables. This tag needs the support

of  some other tags like <TH>, <TR> and <TD> for constructing tables. Let us discuss

these tags in the following sections.
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5.4.1  <TABLE> tag

<TABLE> tag is a container tag. The whole content of  the table should be enclosed

within the tag pair <TABLE> and </TABLE>. This tag has many attributes to improve

the general layout of the table. Some of the main attributes are listed below:

1. Border: This attribute specifies the thickness of the border line around the

table. To draw the border of  the table we have to specify a non-zero value to

Border attribute in pixels. A border value of  zero produces a table without

border.

2. Bordercolor: It is used to assign colour to the table border.

3. Align: The position of  the table inside the browser window is determined by

Align attribute. The possible values are left (by default), right or center.

4. Bgcolor: We can change the background colour of  the table using this

attribute.

5. Background: It is used to assign a background image for a table. To set the

background, specify the pathname of  the image as value of  this attribute. For

example, <TABLE Background = "images/flower.gif"> sets the

background of a table with the image in the file flower.jpg stored in the folder

images in the current drive. When both Bgcolor and Background are specified,

the Background will override Bgcolor.

6. Cellspacing: Table cells have space in between them. We can either increase

or decrease the space between cells. The Cellspacing attribute determines

the space to be left between cells. The value is given in number of  pixels.

7. Cellpadding: There is a space between the content and cell border. We can

increase or decrease the space between cell border and content. The

Cellpadding attribute specifies the space in between the cell border and cell

content. The value is given in number of  pixels.

8. Width and Height: We can set a table width and height using Width and

Height attributes. We can specify table width or height in terms of  pixels or

in terms of  percentage of  browser window.

9. Frame: This attribute with one of  the values given in Table 5.2 indicates how

table borders are displayed.

Value Description

Void Display no borders

Above Display a border on the top of the table only

Below Display a border on the bottom of the table only
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10. Rules: We can use the Rules attribute to control what rules (borders between

cells) are displayed in a table. Table 5.3 shows the values of  Rules attribute.

Now let us discuss some other tags associated with <TABLE> tag.

5.4.2  <TR> tag

The rows in a table are created using <TR> tag. It is a container tag. The whole row
is enclosed within the tag pair <TR> and </TR>. A <TR> tag always comes inside
the <TABLE> tag. A row itself  is a collection of  cells. A cell is the smallest component
of  a table. There are two types of  cells - heading cells and data cells. As seen in
Table 5.1, the values given in red colour are of  heading type. The values given in
blue are just data cells.

5.4.3  <TH> tag

<TH> tag is used to define heading cells. It is also a container tag. The heading data
should be enclosed between <TH> and </TH> tags. The heading cells are displayed
in bold face and in centred form. <TH> tag always comes inside the <TR> tag.

5.4.4  <TD> tag

<TD> tag is similar to <TH> tag and is used to display data cells. It is also a container
tag. The data is given in between <TD> and </TD> tags. Similar to <TH> tag,<TD>
tag is also placed within the <TR> tag.

The code given in Example 5.12 creates a simple table and Figure 5.14 shows the

resultant web page.

Table 5.3:Values of Rules attribute

Value Description

none Display no rules

cols Display rules between columns only

rows Display rules between rows only

groups Display rules between row groups and column groups only

all Rules will appear between all rows and columns

Value Description

Hsides Display borders on the horizontal sides (top and bottom) only

lhs or rhs Display the border only the left side or the right side

Vsides Display borders on the vertical sides (right and left) only

box or border Display borders on all sides of the table (It is the default value)

Table 5.2: Values of Frame attribute
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Example 5.12: To create a web page containing a simple table

<HTML>

<HEAD> <TITLE> Html Tables </TITLE>

</HEAD>

<BODY>

<TABLE Border="1">

<TR>

<TH>Roll No</TH>

<TH>Name</TH>

</TR>

<TR>

<TD>1</TD>

<TD>Aliya</TD>

</TR>

<TR>

<TD>2</TD>

<TD>Arun</TD>

</TR>

</TABLE>

</BODY>

</HTML>

Now, let us create the following table with

some of the attributes discussed above.

The code given in Example 5.13 can create a

web page as shown in Figure 5.15.

Example 5.13: To create a web page containing a table with border and colour

<HTML>

<HEAD> <TITLE> Hospital Table </TITLE> </HEAD>

<BODY>

<TABLE Border= "3" Bordercolor= "RED" Bgcolor= "#4EB0AF"

Align= "left" Cellspacing= "16" Cellpadding= "5"

Width= "50%">

<TR>

<TH> Year </TH>

<TH> 2012-14 </TH>

</TR>

Year 2012 - 14

Smokers 412

Pan users 159

Alcohol users 219

Other cases 280

Fig. 5.14: Web page containing a simple
table with two columns
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Fig. 5.15: Table using Cellspacing and
Cellpadding

<TR>

<TH> Smokers </TH>

<TD> 412 </TD>

</TR>

<TR>

<TH> Pan users </TH>

<TD> 159 </TD>

</TR>

<TR>

<TH> Alcohol users </TH>

<TD> 219 </TD>

</TR>

<TR>

<TH> Other cases </TH>

<TD> 280 </TD>

</TR>

<TABLE>

<BODY>

<HTML>

In Example 5.13, we used <TH> tags within

all <TR> tag pairs, which make the first

column of the table similar to header column

as shown in Figure 5.15.

Attributes of <TR> tag

The characteristics of  a row can be changed using the attributes of  <TR> tag.

1. Align: This attribute specifies the horizontal alignment of the text in a cell in

that particular row. This can take the values left, right or center. The

default is left for data and center for headings (see Figure 5.15).

2. Valign: We can specify the vertical alignment of  the content in a cell of  any

row using Valign. The possible values are top, middle, bottom or baseline.

Baseline vertical alignment aligns the baseline of the text across the cells in the

row.

3. Bgcolor: This attribute gives background colour to a particular row. Usually

this helps in highlighting a row.

The following code segment is the modified part of the code given in Example

5.13. It modifies the third row of the table shown in Figure 5.15 with a background

colour, and horizontal and vertical alignments.
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<TR Bgcolor= "yellow" Align= "right" Valign= "middle">

<TH> Pan users </TH>

<TD> 159 </TD>

</TR>

The modified web page is shown in Figure 5.16.

Attributes of <TH> and <TD> tags

Most of the attributes of <TH> and <TD> tags are

common, as both these tags are used for creating

table cells. Let us discuss some of  the main

attributes.

1. Align: It specifies the horizontal alignment of

the content within a cell. It can take the values

left, right or center. The default value is

center for <TH> and left for <TD>.

2. Valign: It specifies the vertical alignment of the content within a cell. It can

take a value top, bottom, middle or baseline.

3. Bgcolor: We can set background colour for any cell using this attribute. The

tags <TABLE>, <TR>, <TD>/<TH> all have Bgcolor attribute. If Bgcolor

attribute is set for all these tags, the cell will take the colour assigned to this

attribute in <TH>/<TD> tag.

4. Colspan: Usually a cell spans over a single column, but sometimes we may

need columns occupying more than one cell. Colspan value defines the number

of  columns occupied by that particular cell. For example, <TH Colspan="3">

makes the cell span over three columns.

5. Rowspan: Similar to Colspan, Rowspan attribute specifies the number of

rows to be spanned by the cell. The default cell span is single row, but we can

make it span multiple rows by setting Rowspan attribute a numeric value greater

than one. For example, <TD Rowspan="4"> makes the cell span over four

rows.

Let us create a web page with a simple table to illustrate the effect of the attributes

discussed above. The code given in Example 5.14 shows the use of these attributes

and Figure 5.17 shows the corresponding web page.

Example 5.14: To create a table to demonstrate Colspan and Rowspan

<HTML>

<HEAD> <TITLE> Students Registration </TITLE>

</HEAD>

Fig. 5.16: Table with modified row
using Bgcolor, Align and Valign
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Fig. 5.17: Table with row span and
column span

<BODY>

<TABLE Border= "1" Cellspacing= "3" Cellpadding= "5">

<TR>

<TH Colspan= "3"> No. of Registered Students </TH>

</TR>

<TR>

<TH Rowspan= "2"> Year </TH>

<TD> 2014 </TD> <TD> 75 </TD>

</TR>

<TR>

<TD> 2015 </TD> <TD> 88 </TD>

</TR>

</TABLE>

<BODY>

<HTML>

Now, let us create a web page to display the

details of  cancer patients as shown in Table 5.1.

The code given in Example 5.15 can design a

table as shown in Figure 5.18.

Example 5.15: To create a table to show the data of cancer patients

<HTML>

<HEAD> <TITLE> CompleteTable </TITLE> </HEAD>

<BODY Bgcolor= "silver">

<TABLE Border= "3" Bordercolor= "red" Bgcolor= "#4EB0AF"

Align= "left" Cellspacing= "2" Cellpadding= "2"

Width= "50%">

<TR>

<TH Colspan= "5"> Number of cancer patients reported

at the hospital </TH>

</TR>

<TR Align= "center">

<TH Colspan= "2"> Year </TH>

<TH> 2012 </TH>

<TH> 2013 </TH>

<TH> 2014 </TH>

</TR>

<TR Align= "center">

<TH Rowspan= "4"> Cancer Origin </TH>

<TH> Smokers </TH>

<TD> 129 </TD>
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<TD> 140 </TD>

<TD> 143 </TD>

</TR>

<TR Align= "center">

<TH> Pan users </TH>

<TD> 54 </TD>

<TD> 56 </TD>

<TD> 59 </TD>

</TR>

<TR Align= "center">

<TH> Alcohol users </TH>

<TD> 74 </TD>

<TD> 68 </TD>

<TD> 77 </TD>

</TR>

<TR Align= "center">

<TH> Other cases </TH>

<TD> 95 </TD>

<TD> 93 </TD>

<TD> 92 </TD>

</TR>

<TR Align= "center">

<TH Colspan= "2"> TOTAL Patients </TH>

<TD> 352 </TD>

<TD> 357 </TD>

<TD> 371 </TD>

</TR>

</TABLE>

</BODY>

</HTML>

Fig. 5.18: Web page containing a table of cancer patients Bgcolor,
Rowspan, Colspan, Align and Valign
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5.4.5  Table caption with <CAPTION> tag

We can provide a heading to a table using the <CAPTION> tag. It provides an easy

method to add descriptive text to a table as its caption. Suppose we want to modify

the table shown in Figure 5.19 with a caption. We can modify the code section

before the first <TR> tag in Example 5.15 with following code segment:

<TABLE Border= "3" Bordercolor= "red" Bgcolor= "skyblue"

  Align= "left" Cellspacing= "2" Cellpadding= "2"

  Width= "50%">

<CAPTION> Number of new cancer patients reported at the

hospital during 2012-14

</CAPTION>

The modified HTML code

will produce a table as

shown in Figure 5.19.

Try to create a table containing the number of  students studying

different second languages available in your school. The table should

provide details of each class of your higher secondary section.
Let us do

Know your progress

1. Name any two associated tags of  <TABLE> tag.

2. Choose the odd one out:

a. TABLE b. TR c. TH d. COLSPAN

3. Differentiate between <TD> and <TH>.

4. <TABLE> tag is an empty tag. State whether this statement is true

or false.

5. Give any two attributes of  <TR> tag.

Fig. 5.19: Modified table with a caption
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5.5 Dividing the browser window

Sometimes we need to include more than one webpage inside a single browser

window. The browser window can be divided into two or more panes to

accommodate different pages

simultaneously. HTML provides a

facility called frameset to partition the

browser window into different sections.

Each section accommodates different

HTML pages. Each individual section

created by a frameset is called a frame.

Figure 5.20 shows a simple frameset

consisting of  three frames. To create a

frameset, we need <FRAMESET> and

<FRAME> tags.

5.5.1  <FRAMESET> tag

<FRAMESET> is a container tag for partitioning the browser window into different

frame sections. The frames are defined within the tag pair <FRAMESET> and

</FRAMESET>. The main attributes are:

1. Cols: This attribute determines the number of  vertical frames in the frameset

page and its dimensions. The column width can be given either in percentage

of  total width or in number of  pixels. For example, <FRAMESET Cols =

"30%,500,*"> will create three vertical frames. The first frame will occupy

30% of the total window width, the next will take 500 pixels space, and the

asterisk(*) symbol given at the end denotes the remaining space which is given

to the third frame.

2. Rows: Similar to Cols, Rows attribute defines the number and dimension of

horizontal frames.

3. Border: We can specify the thickness of  border for the frames by using Border

attribute. Here the value is given in pixels.

4. Bordercolor: We can specify border colour by assigning a colour to this

attribute.

5.5.2  <FRAME> tag

<FRAME> tag is an empty tag and it defines the frames inside the <FRAMESET>. For

each division inside the <FRAMESET> tag, we should have a corresponding <FRAME>

tag. <FRAME> tag always comes with Src attribute which specifies the HTML page

to be loaded in the frame. The main attributes related to <FRAME> tag are:

Fig. 5.20: A simple frameset with three frames
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1. Src: As we have already discussed, Src specifies the URL of the document to

be loaded in the frame. For example, <FRAME Src = "school.html">

loads the page school.html in a particular frame.

2. Scrolling: When the content inside a frame exceeds the frame size, a scrollbar

appears depending upon the value of the Scrolling attribute. It can take

values Yes, No or Auto. Auto is the default value and it displays scroll bars if

the frame content exceeds the normal display area.

3. Noresize: It is used to prevent users from resizing the border of a specific

frame by dragging on it. Just giving Noresize prohibits resizing the frame

window. For example, <FRAME Src= "school.html" Noresize>.

4. Marginwidth and Marginheight: We can set horizontal and vertical margins

to the frame by using Marginwidth and Marginheight, respectively. The

values are given in pixels.

5. Name: It gives a name to a frame. This particular frame can be referenced

using this name later in the code.

The following code can create the frameset shown in Figure 5.20. It is assumed that

the three HTML pages sampleframe1.html, sampleframe2.html and sampleframe3.html
are already created as in Figure 5.20.

<HTML>

<HEAD> <TITLE> A simple Frameset </TITLE> </HEAD>

<FRAMESET Rows= "20%, 30%, 50%">

<FRAME Src= "sampleframe1.html">

<FRAME Src= "sampleframe2.html">

<FRAME Src= "sampleframe3.html">

</FRAMESET>

</HTML>

5.5.3 Targeting frames

In a frameset page, we can provide hyperlink in any frame and the linked page can

be targeted to any other frame. When we click on the link in a frame, the

corresponding page is opened within another frame in the frameset. For this, first

we have to allot a name for the destination frame using its Name attribute. Then we

can refer the named frame using Target attribute of the link to be displayed.

Create three HTML files bio.html, poem.html and fiction.html to show a

list of  books belonging to biography, poetry and fiction, respectively.

Let us do
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Now let us create a web page with two frames - one for showing the links for these

files and the other for opening the respective web pages. When a user clicks on any

one of the three links available in one frame, the associated file will open in the

other frame.

Once you have created the three files mentioned above, the two HTML codes

given in Example 5.16 can satisfy our need.

Example 5.16: To illustrate the concept of targeting frames

Save the following code in a file main.html

<HTML>

<HEAD> <TITLE> Left Frame </TITLE> </HEAD>

<BODY Bgcolor= "#00AFFF" Text= "#282D2F">

<H2> Select the option </H2>

<FONT Size= "5">

<A Href= "bio.html" Target="right_frame">Biography</A><BR>

<A Href= "poem.html" Target="right_frame">Poetry</A><BR>

<A Href= "fiction.html" Target="right_frame">Fiction</A>

</FONT>

</BODY>

</HTML>

Now create a file to store the following code:

<HTML>

<HEAD> <TITLE> Targeting Frames </TITLE> </HEAD>

<FRAMESET Cols= "200, *">

<FRAME Src= "main.html" Name= "left_frame">

<FRAME Name= "right_frame">

</FRAMESET>

</HTML>

When the above document is executed,
a web page with two frames will be
opened. The first column of the
browser window will show the
main.html and the second column will
be blank. Note that Src attribute is not
specified for that frame, but a name
right_frame is assigned. If the first
link (biography) is selected, the file
bio.html will be opened in the second
frame as shown in Figure 5.21. It is

Fig. 5.21 : Web page with target frame
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<FRAMESET> tag is not supported in HTML 5 version.

There are many arguments against the use of frameset. Some of them

are given below.

m The browser's back button will not work naturally inside a frameset.

m It is difficult to refer a specific document within a frameset.

m Any attempt to reload a specific frame may reload the entire frameset. As a

result it will reset the frame contents to their default sources.

m Search engines can struggle when navigating through framed documents.

m It is difficult to print contents of a frameset.

m Bookmarking contents of a frameset is difficult.

assumed that the file bio.html contains the details as shown in the figure. Note the

difference in colour in the selected link.

Note that, the HTML document main.htm contains three pairs of <A> tag to link

the three HTML files. A tag named Target is used in <A> tags to specify the frame

in which the linked file is to be opened. Here comes the relevance of names given

to the frames.

5.5.4 Nesting of framesets

In Figures 5.20 and 5.21, we can see frames in the browser window. The first figure

shows horizontal division of  the browser window into three frames. But the second

figure shows vertical division into two frames.

Suppose we want to divide the browser

window as shown in Figure 5.22. It is possible

with nested frameset. It is the process of

inserting a frameset within another frameset.

The following steps illustrate the nesting of

frameset for the division shown in Figure 5.22.

1. Create the initial frameset, defining two rows as shown below:

<FRAMESET Rows= "85, *">

<FRAME Src= "sampleframe1.html">

</FRAMESET>

This code horizontally divides the window into two frames and the first row is

reserved for the file sampleframe1.html.

Frame 1 

Frame 2 Frame 3 

Fig. 5.22: Nesting of frameset 
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2. The second row is left free. Now we will divide it into two frames vertically.

So, instead of  a second <FRAME> tag, insert another opening <FRAMESET>

tag as shown below:

<FRAMESET Rows= "85, *">

<FRAME Src= "sampleframe1.html">

<FRAMESET Cols= "220, *">

</FRAMESET>

</FRAMESET>

This code will divide the second row into two columns. Now, we can add two

<FRAME> tags within the inner frameset and complete the HTML code as

given in Example 5.17. The resultant web page is shown in Figure 5.23. It is

assumed that the three HTML pages are already created as in Figure 5.23.

Example 5.17: To implement the concept of nested frameset

<HTML>

<HEAD>

<TITLE> nesting frames </TITLE>

</HEAD>

<FRAMESET Rows= "85, *">

<FRAME Src= "sampleframe1.html">

<FRAMESET Cols= "200, *">

<FRAME Src= "sampleframe2.html">

<FRAME Src= "sampleframe3.html">

</FRAMESET>

</FRAMESET>

</HTML>

5.5.5  <NOFRAMES> tag

Earlier browsers did not support frames. In

such a situation, the browser is expected to

respond to the user in some way or the other.

The tag pair <NOFRAMES> and </NOFRAMES>

is used to display some text content in the

window if the browser is unable to support

frames. The following code illustrates the use

of  <NOFRAMES> tag.

<HTML>

<HEAD> <TITLE> A simple Frameset </TITLE>

</HEAD>

Fig. 5.23: Nested framesets
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<FRAMESET Rows= "20%, 30%, 50%">

<FRAME Src= "sampleframe1.html">

<FRAME Src= "sampleframe2.html">

<FRAME Src= "sampleframe3.html">

</FRAMESET>

<NOFRAMES>

<P> Your browser doesnot support frames.<BR>

Click <A Href="index.htm">here... </A></P>

</NOFRAMES>

</HTML>

Here, if the browser does not support <FRAMESET> then a message "Click here…"

will be displayed with an alternate link to the file index.html.

Know your progress

1. <FRAMESET Rows="100,*"> divides the frame into ____

sections.

2. List any three attributes of  <FRAME> tag.

3. What is nested frameset?

4. What is the use of <NOFRAME> tag?

5. No <BODY> section is needed for frameset page. Say TRUE or

FALSE.

5.6 Forms in web pages

HTML Forms are required when we have to collect some data from the webpage

viewer for processing. For example, we use www.hscap.kerala.gov.in for the

admission to Class XI in Kerala. We enter information such as name, SSLC Register

Number, grades, choice of  course and school, etc. in this web page. It is an

implementation of  HTML Form.

A Form will take input from the web page viewer and then it will post the data to a

back-end application such as Common Gateway Interface (CGI), Active Server

Pages (ASP), PHP, etc. for processing. We will study about these technologies in

the next chapter. A form consists of  two elements: a <FORM> container and any

number of  Form controls within that container. There are various Form controls

like text fields, textarea fields, drop-down menus, radio buttons, checkboxes, etc.
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5.6.1  <FORM> tag

A <FORM> tag provides a container for creating a Form. An HTML Form starts

with <FORM> and ends with </FORM> tag. A web browser can only gather information

through Forms. We must provide some back-end application to handle (save,

modify, etc.) the data collected. We use Form handlers like CGI, JavaScript or PHP

script for that purpose. All of  the input elements associated with a single Form are

processed by the same Form handler. A Form handler is a program on the web

server that manages the data sent through the Form. The form handler is specified

as the value for the Action attribute of  <FORM> tag. The concept of  server and

other associated technologies will be discussed in the next chapter.

Most frequently used attributes of <FORM> are:

1. Action: It specifies the URL of  the Form handler, which is ready to process

the received data.

2. Method: It mentions the method used to upload data. The most frequently

used Methods are Get and Post.

3. Target: It specifies the target window or frame where the result of the script

will be displayed. It takes values like _blank, _self, _parent, etc. The main

values of  Target attribute are given in Table 5.4.

Table 5.4: Values for Target attribute

Value Description

_blank Opens the linked document in a new browser window

_self Opens the linked document in the same frame as the link

_parent Opens the linked document in the parent frameset

_top Opens the linked document in the main browser window,

replacing any frame present

name Opens the linked document in the window with the specified name

A common use for JavaScript (or any client side scripting language) is

to verify that users have filled in all the required fields in a Form and/

or to check whether the input data is valid or not, before the browser

actually submits the Form to the form handler on the web server.

Form controls

There are different types of  Form controls that we can use to collect data using

HTML Form. These controls include Text box, Password, Check Box, Radio Button,
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Text Area, Select Box, Submit and Reset Button.We can create most of  these controls

in any HTML Form using <INPUT> tag.

5.6.2  <INPUT> tag

The visible part of  a Form is a set of  controls to accept the input from the viewers.

Different types of input can be selected based on the nature of input. The <INPUT>

tag is an empty tag that can be used to make different types of  controls such as Text

Box, Radio Button, Submit Button etc. The Type attribute determines the type of

control created by this tag.

Attributes of <INPUT> tag

1. Type: This attribute determines the control type created by the <INPUT> tag.

The main values of  Type are given in Table 5.5.

Table 5.5: Values of Type attribute

Value Description

text creates a text box

password same as text box. But here characters are represented by coded

symbols such as asterisk.

checkbox creates a checkbox where user can enter Yes or No values (check

or uncheck).

radio similar to checkbox but is used to select a single value from a

group of  values. When multiple radio buttons are assigned with

the same value for Name attribute, users can select only one button

at a time. When the user changes the selection, the one that is

already selected becomes deselected.

reset a special button used to clear all the entries made in the form and

to bring it to the initial state.

submit another special button used to submit all the entries made in the

form to the server.

button creates a standard graphical button on the form. We can call

functions on clicking this button.

2. Name:  It is used to give a name to the input control. When the Form is submitted,

the data values are passed to the server along with the corresponding name of

the control.

3. Value: It can be used to provide an initial (default) value inside the control.

4. Size: This attribute sets the width of  the input text in terms of  characters. It is

applicable only to the input types text and password.
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5. Maxlength: It limits the number of characters that the user can type into the

field. It is also applicable only to the text and the password.

A password field helps in hiding the content visually. It doesn't encrypt

or scramble the information in any way.

The HTML code given in Example 5.18 creates an HTML Form to input a name

and password. Figure 5.24 shows the resultant web page.

Example 5.18: To create an HTML Form

<HTML>

<HEAD> <TITLE> Login </TITLE> </HEAD>

<BODY Bgcolor= "Pink">

<FORM Action= "login.php" Method= "post">

<P> Name:&nbsp; &nbsp;&nbsp;

<INPUT Type= "text" Name= "firstname" Size= "30"

   Maxlength= "25"> </P>

<P>Password:

<INPUT Type= "password" Name= "Psswd" Size= "30"

   Maxlength= "25"> </P> <BR>

&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp;

&nbsp;

<INPUT Type= "reset" Value= "Clear">

<INPUT Type= "submit" Value= "Send">

</FORM>

</BODY>

</HTML>

In Example 5.18, a file login.php is assigned

to the Action attribute of the <FORM>

tag. It means that the data entered

through this Form will be captured and

processed by the application stored in the

file login.php. Also observe the use of

HTML entity &nbsp; to provide non

break spaces by referring to the code and

Figure 5.24. Fig. 5.24: HTML Form with text and password
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Let us design an HTML Form to input data with the help of  radio button (or

option button) and check boxes. You might have heard that radio buttons are used

to specify only one option from a set of  alternatives, and that check boxes are used

to mark one or more items in a given list.

The code given in Example 5.19 creates a Form to specify the gender and hobbies

of  a person with the help of  radio buttons and check boxes. Figure 5.25 shows the

corresponding web page.

Example 5.19: To create an HTML Form with radio buttons and check boxes

<HTML>

<HEAD> <TITLE>Checkbox Radio Button Control</TITLE> </HEAD>

<BODY Bgcolor= "#E9BEE5">

<FORM> <BR>Sex: &nbsp; &nbsp;&nbsp;&nbsp;&nbsp;

<INPUT Type= "radio" Name= "sex" Value= "male"> Male

<INPUT Type= "radio" Name= "sex" Value= "female"> Female

<BR> <BR>Hobbies:

<INPUT Type= "checkbox" Name= "Hobby" Value= "Games">

Playing Games

<INPUT Type= "checkbox" Name= "Hobby"

   Value="WatchingTV"> Watching TV

<INPUT Type= "checkbox" Name= "Hobby" Value= "Reading">

Reading

</FORM>

</BODY>

</HTML>

Fig 5.25:Form with checkbox and radio button

5.6.3  <TEXTAREA> tag

We have seen single line text entry facility in a Form with the statement <INPUT

Type = "text"> (refer Example 5.18 and Figure 5.24). But in practice, there are

occasions where we need to enter multiple lines of  text in a Form. Postal address is

an example. The container tag <TEXTAREA> can be used for this purpose. The area
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between the tag pair gives space for multi line text depending on the values given to

the attributes. The main attributes of  <TEXTAREA> tag are:

1. Name: It is used to give a name to the control.

2. Rows: It specifies the number of rows in a text area control.

3. Cols: It indicates the number of columns in a text area, i.e., number of characters

in a line.

Consider the following code segment and observe the usage of  <TEXTAREA> tag:

<FORM Action= "guestbook.php" Method= "post">

<TEXTAREA Rows= "10" Cols= "30" Name= "address">

  Enter your address.

</TEXTAREA>

</FORM>

On completing the code and opening it, we can

see a page as shown in Figure 5.26. Any text we

include between tag pair <TEXTAREA> and

</TEXTAREA> appears in a text box. When the

user enters any data in the text box, it overrides

default text.

5.6.4  <SELECT> tag

A select box, also called dropdown box, provides a list of various options in the

form of  a dropdown list, from where a user can select one or more options. Select

box is helpful when a number of options are to be displayed in a limited space. The

options in the list are specified using <OPTION> tag, which will be contained in the

<SELECT> tag pair.

 The container tag pair <SELECT> and </SELECT> encloses a select box. The main

attributes of <SELECT> tag are:

1. Name: It gives a name to the control, which is sent to the server to be recognized

and to get the value.

2. Size: This can be used to present a scrolling list box. Its value will decide

whether the select box should be a drop down list or a list box. If the value is

1, we get a dropdown list (or combo box).

3. Multiple: It allows users to select multiple items from the menu.

Now let us discuss the role of  <OPTION> tag in select boxes. It is an empty tag

placed inside the container tag <SELECT> and </SELECT>. It lists out the options

provided in the select box. The main attributes of <OPTION> tag are:

Fig. 5.26: HTML Form with text area
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1. Selected: This attribute is used to indicate default selection.

2. Value: It is used here to allow the submission of a value that differs from the

content of  the <OPTION> tag. If  it is not present, the content is used as the

value.

The HTML code given in Example 5.20 creates a web page that contains a drop

down list. Note that the value of the Size attribute of <SELECT> tag is 1 and

there are four options inside the select box.

Example 5.20: To create an HTML Form with a drop down list

<HTML>

<HEAD> <TITLE> Drop down list </TITLE> </HEAD>

<BODY Bgcolor= "#E9BEE5">

<FORM Action= "guestbook.php" Method= "post">

<P> Nationality:

<SELECT Name= "Nationality" Size= "1">

<OPTION Value= "Indian" selected> Indian

<OPTION Value= "British"> British

<OPTION Value= "German"> German

<OPTION Value= "Srilankan"> Srilankan

</SELECT>

</FORM>

</BODY>

</HTML>

Figure 5.27 shows the dropdown list obtained on

clicking the combo button.

Fig. 5.27: Select box in a Form

Modify the code given in Example 5.20 with different values for the

Size attribute and predict the changes in the select box.

Let us do

5.6.5  Grouping Form data with <FIELDSET> tag

Sometimes grouping related controls in a Form become a necessity. The

<FIELDSET> element helps in grouping related data in a Form. By using

<FIELDSET> we can divide a Form into different subsections, each subsection

containing related elements. To identify each <FIELDSET>, we can use the <LEGEND>

tag. The <LEGEND> tag defines a caption for the <FIELDSET> element. It is a

container tag.
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Now let us create a Form with all the elements discussed so far, to submit the

details such as name, age, sex, address, hobbies etc. of  a student. The code given in

Example 5.21 can be used for this so that an HTML Form as shown in Figure 5.28

will be obtained.

Example 5.21: To create an HTML Form to submit the details of a student

<HTML>

<HEAD> <TITLE> FormResume </TITLE> </HEAD>

<BODY Bgcolor= "#E9BEE5">

<CENTER ><H3>Enter your details</H3></CENTER>

<FORM Action= "guestbook.php" Method= "get">

Name:&nbsp;

<INPUT Type= "text" Name= "first_name" Size= "20"

Maxlength= "20" Value= "First Name Here"><BR><BR>

Age:

<INPUT Type="text" Name="age" Size="3" Maxlength="3"><BR>

Sex: &nbsp;&nbsp;&nbsp;

<INPUT Type="radio" Name="sex" Value="male"> Male

<INPUT Type="radio" Name="sex" Value="female"> Female

<FIELDSET>

<LEGEND>Nationality</LEGEND>

<SELECT Name= "Nationality" Size= "4">

<OPTION Value= "Indian" Selected> Indian

<OPTION Value= "British"> British

<OPTION Value= "German"> German

<OPTION Value= "Srilankan"> Srilankan

</SELECT><BR><BR>

Nativity:

<INPUT Type= "text" Name="State" Size="15"><BR><BR>

District:&nbsp;

<INPUT Type= "text" Name= "District" Size= "15">

</FIELDSET><BR>

Hobbies:

<INPUT Type= "checkbox" Name= "Hobby" Value= "games">

Playing Games

<INPUT Type= "checkbox" Name= "Hobby"

    Value= "WatchingTV"> Watching TV

<INPUT Type= "checkbox" Name= "Hobby" Value= "Reading">

Reading<BR><BR>
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<TEXTAREA Rows= "5" Cols= "25" Name= "address">Address

</TEXTAREA><BR><BR>

<INPUT Type= "submit" Value= "submit">

<INPUT Type= "Reset" Value= "reset">

</FORM>

</BODY>

</HTML>

Fig 5.28:An HTML Form to submit the details of a student

5.6.6  Form submission

When we click the submit button on the Form, it will send the collected input data

to the server, a computer capable of  processing the received data. In a web server,

there are special server side programs for processing Form data coming from the

browser of a client (a computer, a tab or a mobile phone through which we submit

the data).

As mentioned earlier, the Action attribute defines the action to be performed

when the Form is submitted. Normally it assigns the URL of  the server side program

to process the Form data. The common way to submit a Form to a server is by

using a submit button. In Example 5.21, a server-side script guestbook.php is specified

to handle the submitted form in the <FORM> tag.
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The Method attribute of the <FORM> tag specifies the HTTP method (get or

post) to be used when submitting the forms.

Know your progress

1. HTML provides _______ to input data through web pages.

2. Name the two tags used within <FORM> to enter text data.

3. How do radio button control and check box control differ?

4. Which tag is used to group data within the Form?

5. Name the tag used within <FORM> to input data.

5.7 Overview of HTML 5

HTML 5 is the major revision of the HTML standard after HTML 4.01. HTML5

was developed jointly by World Wide Web Consortium (W3C) and the Web

Hypertext Application Technology Working Group (WHATWG). The new

standard incorporates features like video playback, drag-and-drop etc.

The latest versions of all leading browsers including Google

Chrome, Mozilla Firefox, Apple Safari, Opera and Internet

Explorer support HTML5. Mobile web browsers that are pre-

installed in iPhones, iPads, Android phones, etc. also support

HTML5. HTML5 is designed, as much as possible, to be

backward compatible with existing web browsers. The logo of

HTML5 is given in Figure 5.29. Fig. 5.29: HTML5 logo

Some new tags introduced in HTML5 are given below:

1. <VIDEO> and <AUDIO>: These tags offer the facility to easily embed
media into HTML documents.

2. <CANVAS>: This tag gives us an easy and powerful way to draw
graphics, build charts and graphs and customise graphics.

3. <HEADER> and <FOOTER>: The <HEADER> element specifies a header for a
document or section. The <FOOTER> element specifies footer for a document or
section. A footer typically contains the author of the document, copyright
information, contact information, etc. We can have several <HEADER>, <FOOTER>
elements in one document.

4. <ARTICLE> and <SECTION>: These tags are used to create articles and sections
within a webpage. An article is an independent, stand-alone piece of discrete
content like a blog post, or a news item. Article represents a full block of content.
Section is used as a way of sectioning a page into different subject areas, or
sectioning an article. <ARTICLE> and <SECTION> tags, if properly used will
increase search engine visibility of the webpage.
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Let us conclude

In this chapter, we have gone through some of the advanced features of HTML.

Different kinds of lists are discussed to make the text more presentable. The beauty

of  the web pages can be enhanced by including marquees, images, audio and video.

We have also discussed the importance of  hyper linking and familiarised with various

kinds of  hyperlinks. Creating a table with the tags <TABLE>, <TR>, <TH>, and

<TD>, and their attributes were discussed. The importance of Rowspan and

Colspan attributes are identified. We can  divide the browser window  into different

frames using framesets so that different pages can be opened and viewed at the

same time. We have also seen that division of  browser window can be done in

different ways with the concept of  nested framesets. We have discussed how Target

attribute is used to create link between different frames of  the browser window. We

have also identified the utility of  Form in the web page to submit data to the server

using online facility. We have seen various elements such as text box, password,

radio button, text area, select box, etc. that facilitate the input of data in different

ways. We have just mentioned the concept of  client side programs and server side

programs. So, this chapter is a stepping stone to the next chapters in which we will

discuss how the input data in the Form is verified and how the data is stored or

processed in the server.

5. <OUTPUT>: This tag represents the result of a calculation usually performed by a

script.

6. <DETAILS>: Sometimes website needs to have an expanding/collapsing block of

text. With <DETAILS> tag it is easier to make a simple block that expands and

collapses the content when the header is clicked.

7. <FIGURE> and <FIGCAPTION>: <FIGURE> is a container for content like images,

and <FIGCAPTION> element represents a caption or legend for a figure. It comes

inside the <FIGURE> tag.

8. <PROGRESS> and <METER>: <PROGRESS> and <METER> are similar. The

<PROGRESS> tag represents the progress of a task. It is useful for things like

displaying the progress of a file upload. <METER> tag is used to display a scalar

measurement within a known range, like showing hard drive usage.
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Let us practice

1. Wrtie an HTML code for a web page of  a district in Kerala with the following

details and features:

• A heading followed by a paragraph of 3 sentences about the district using

text formatting tags and attributes.

• A list of the tourist places in the district.

2. Wrtie an HTML code for a web page for your school with the following details

and features:

• A heading followed by a paragraph of 3 sentences about the district using

text formatting tags and attributes.

• Include a list of  five co-curricular activites like NCC, NSS, Clubs, etc.

3. Wrtie an HTML code for a web page to show the following details:

Components of a Computer
•  Hardware

1.  I/O Devices

2.  RAM

3.  Hard Disk & DVD Drive

•  Software
1.  Operating System

2.  Application Programs

4. Write an HTML code to present some details about Onam - the festival of

Kerala, in a web page with the following features:

• A heading with attractive font characteristics.

• An image of  "Vallam Kali" (boat race) in the background of  the page.

• Internal links to any two of  the traditional events like "Pookkalam",

"Thumpi Thullal", "Thiruvathira", "Onavillu", "Vallam kali", "Kummatti",

"Pulikali", etc.

5. Write HTML codes to create two web pages to show some information about

the higher secondary and high school sections of your school. Create another

web page to divide the browser window horizontally into two. In the first

frame, a brief introduction of the school and two links are to be provided -

one for HSS and the other for HS. On clicking these links the respective web

page is to be opened in the second frame.
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Year

12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567
12345678901234567890123456789012123456789012345678901234567890121234567

6. Write an HTML code to show the following table in a web page and also

provide an external link to the website of  Kerala Police given below the table:

Road Accidents in Kerala during 2012 - 2014

Total Number of

Cases Persons Killed Persons Injured

2012 36174 4286 41915

2013 35215 4258 40346

2014 36282 4049 41096

Data Source: www.keralapolice.org

7. Write an HTML code to display an application form as shown below:

APPLICATION FOR THE BEST STUDENT AWARD

Name: Sex: Male Female

Class & Division:     Select

Total Grade Point in Class XI:

Average Grade Point in Termly Exams in Class XII:

Cocurricular Activities:

NCC   NSS        Sports    Arts        Literary

Other Achievements:

 Let us assess

1. Find the errors in the following and correct it.

a. <UL Type = "i" Start = 3>

b. <IMG Src = "Myschool.jpg" Size  = "50" >

c. <HTML>

<HEAD><TITLE><HEAD></TITLE>

<BODY> this is the body of the HTML

  document</BODY>

</HTML>
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2. Rohit created a table in HTML but a border was not visible. What could be

the reason?

3. ________ attribute is used with <A> tag to display the linked page in a specified

frame.

4. Your computer teacher asked you to prepare a list of  your best friends in a

webpage. Which tag will you prefer? Write HTML code segment for this list.

5. Name the possible values of  type attribute of  <OL> tag.

6. Write the attributes of  <UL> tag.

7. How do you create a list using upper case letters for numbering?

8. Suppose you want to create a list using lower case letters for numbering. How

can this be made possible?

9. How can we create a list starting from 6 onwards?

10. Write the HTML code for creating the following webpage:

ABC Pvt. Ltd.

Kerala

1. Health Care

2. Baby Products

• Toys

• Dress

3. Ladies Wear

• Kurthas

• Jeans

11. Varun is creating a web page. He wants to create a link on the word 'sample' to

a file named sample.html that is stored in a subdirectory Exam in D drive. Write

the HTML command for this purpose.

12. Name the tag which has Noshade attribute.

13. Sunil developed a personal website, in which he has to create an e-mail link.

Can you suggest the protocol used to achieve this link.

14. Shahir wants to connect his webpage to www.gmail.com. Write the tag and

attribute required for this.

15. Mention the characteristics of two types of hyperlinks available in HTML.

16. Differentiate between Cellspacing and Cellpadding.

17. Differentiate between Text control and Textarea control used in Form.

18. Action and ________ are the main attributes of  the <FORM> tag.
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19. Say true or false:

a. The default value of  Align attribute of  <TABLE> tag is center.

b. <FRAME> is a container tag.

c. Scrolling prevents users from resizing the border of a specific frame.

20. Which tag does allow partitioning of the browser window into different

sections?

21. List down the main attributes of  <FRAME> tag.

22. Create a frameset dividing the page into two sections vertically. Give names of

your favorite football players in left frame. The profile of selected players

should appear in the right Frame.

23. Predict the output of the following code:

<HTML>

<HEAD><TITLE>A simple table</TITLE></HEAD>

<BODY>

<TABLE border="1" Cellspacing= "1" Cellpadding= "10">

<TR><TD> 1 </TD><TD> 2 </TD><TD> 3 </TD></TR>

<TR><TD> 4 </TD><TD> 5 </TD><TD> 6 </TD></TR>

<TR><TD> 7 </TD><TD> 8 </TD><TD> 9 </TD></TR>

</TABLE>

</BODY>

</HTML>

24. Write an HTML code to create the given table:

25. Write an HTML code to accept your e-mail, address, phone

number and password.

26. Write an HTML code to create a list of  3 bikes of  your choice in a frame. Link

each one to display the description with a picture in another frame.

27. Raju created a web page as follows. But he is unable to view any tabular format

in the web page, when it is displayed in the browser. Find out the reason for it

and correct it.

<HTML>

<HEAD><TITLE> My Page </TITLE></HEAD>

<BODY>

<TABLE><TR><TH>Roll No. </TH><TH> Name </TH></TR>

<TR><TD>1 </TD><TD> Huda </TD></TR>

<TR><TD>2 </TD><TD>Bincy</TD></TR>

</TABLE>

</BODY>

</HTML>
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After the completion of this chapter, the

learner

• explains the need to use CSS in a

web page.

• identifies the various parts of a style

rule.

• explains the method to embed

style rule in a web page.

• distinguishes different types of

selectors.

• uses properties applicable to

format text in a web page.

• explains various properties used

for displaying text.

• groups selectors in CSS in a web

page.

• differentiates the various methods

to embed style rules in  a web page.

• creates web pages that make use

of style rules.

I
n the previous chapters, we studied

how to create web pages using HTML.

Building a website with HTML is only half

the story. We learned how to use the <FONT>

tag, <P> tag, <IMG> tag, etc. to include text

and images in the web page. A web page can

use images to make the page more attractive.

But the use of excess images for a web page is

not desirable, because it will slow down the

loading of  web pages  through the Internet. So,

a good website should use minimum images,

but at the same time, it must be attractive also.

Cascading Style Sheet (CSS) is an extension of

HTML by which we can enhance the look and

feel of  a website very easily. We can control the

appearance of entire web pages in a website,

by simply modifying a single file in the website.

In this chapter, we will learn the basic concepts

of using CSS in an HTML page.

6.1 Need to use CSS in a web page

We all know how to use a word processor to

create a document. Using word processor, we

can insert an image at any location in the

document very easily.  We can give different left

or right margins for different paragraphs in the

document. We can set foreground colour and

background colour for paragraphs in a

Significant Learning Outcomes
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document very easily. Now, think of  doing these things in a web

page. While creating a web page, is it possible to place an image

at any location in the web page as you desired? Can you set

different margins for different paragraphs or give a background

colour for a paragraph? The tags in HTML provide only limited

attributes to set the visual appearance of the contents in the web

page. HTML is the language used for describing the appearance

of  documents when opened in a browser. Using CSS, we can

control the colour of  text, the style of  fonts, the spacing between

paragraphs, the location of  images, etc. very easily. CSS was first proposed by Hakon

Wium Lie in 1994. It has now become the most powerful tool in the hands of a web

designer to  make the page visually impressive.

Advantages of using CSS

CSS provides an easy way to set the layout of the entire website. The following are

some of  the advantages of  CSS.

Easy to change layout: We can very easily change the style of  a web page using

CSS. Instead of  using CSS for each web page separately, a single CSS file can be

created and it can be used by all the web pages in the site. The browser will download

the CSS file only once, and it will be used for the entire pages in the web site. This

makes it easy to change the style of the entire website.

Reduce the size of a web page: We can seperate CSS styles into a separate file

and link it with an HTML page. This will reduce the size of the web page.

Reduction in bandwidth: Using a single CSS file for the entire website reduces the

size of the files to be downloaded. This will reduce the network traffic load.

Consistency in web pages: Since the appearance of the entire web pages in the

site is defined by a single CSS file, the appearance of all the web pages remains the

same.

Viewing options: Screen size of  media such as computers, mobile phones, etc.

differs considerably. The web page designed for a computer may not be viewed

properly in a mobile phone. If  we use CSS, we can create separate CSS file for

mobile phones and computers. Then the same HTML page can make use of  these

different CSS files to make it suitable to be viewed in that particular device.

Saves time: The size of the HTML file becomes considerably smaller, when we

use CSS. This will reduce the coding time for the web designer. This also improves

the speed of  page loading.

Hakon Wium Lie
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6.2 Style rules

A style rule tells the browser how to render a particular element such as a text,

paragraph, image, button, etc. on a web page. Each web browser has its own style

rule for rendering each element in a web page. We can define our own style rules to

make the element visually attractive.

A style rule can be defined as follows:

A style rule has two portions: a selector and a

declaration block.

Selector: It is the HTML element or elements to which the CSS rule is applied. It

tells the browser how elements should be rendered. In the above rule, ‘P’ is the

selector. Hence, the rule will be applied to all the <P> tags in the web page.

Declaration block: It can contain several declarations enclosed within curly braces,

{ and }. A declaration has a property name, a colon, and one or more values separated

by commas. A style rule can contain more than one declaration. In such cases all the

declarations must be separated by semicolon. In the above example, ‘margin is a
property and ‘40px’ is its value.

6.3 Embedding style rules in an HTML page

A style rule can be embedded in an HTML page using <STYLE> tag. This tag has an

attribute namely Type. This attribute is given the value ‘text/css’ to specify that

the content that follows is a CSS rule. So the style rules must be embeded between

the <STYLE> and </STYLE> tags as follows:

<STYLE Type = "text/css">

style rules

</STYLE>

Example 6.1: To create a simple web page

<HTML>

<HEAD> <TITLE>Simple Web Page</TITLE>

</HEAD>

<BODY>

<P>

We can set the style rules for a paragraph

to improve its visual appearance.

</P>

</BODY>

</HTML>
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We can use the Geany editor or any other text editor that you have used for creating

web pages in the previous chapters. Save the above file as Code 6.1.html. Then

open the file in any web browser.

We will get the output as shown in

Figure 6.1.

All the tags used in the above web

page are quite familar to us. Now

let us add a simple CSS rule in the

above html document.

Example 6.2: To illustrate a simple CSS rule

<HTML>

<HEAD><TITLE>CSS Margin</TITLE>

<STYLE Type= "text/css">

P {

margin: 40px;

}

</STYLE>

</HEAD>

<BODY>

<P>

We can set the style rules for a paragraph to improve its

visual appearance.

</P>

</BODY>

</HTML>

The style rule is included in the above web page using <STYLE> tag in the head

section. The output is given in Figure 6.2. The style rule tells the browser that the

content within the <P> tag must have a margin 40px from all sides of the browser

window. We can

compare the output in

Figure 6.2 with Figure

6.1 and observe the

effect of  the CSS rule in

the web page.

Now, let us make a little

modification in the style

rule as follows: Fig. 6.2: A web page using CSS rule

Fig. 6.1: A web page without using CSS styles
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Example 6.3: To add more styles to a paragraph

<HTML>

<HEAD><TITLE>CSS Paragraph</TITLE>

<STYLE Type= "text/css">

P {

margin: 40px;

background-color: #eee4c1;

font-family: "Courier New";

}

</STYLE>

</HEAD>

<BODY>

<P>

We can set the style rules for a paragraph to improve

its visual appearance.

</P>

</BODY>

</HTML>

The style rule in the above code contains two more declarations. We can see the

semicolon at the end of each declaration. Here each declaration is placed in a separate

line. It is not necessary to put them in separate lines. We can type all the delcarations

in a single line also. But typing

style rules in multiple lines

certainly increases the readability

of the code. The output of the

above code is given in Figure 6.3.

We will study about various

properties and their values later

in this chapter.

In the above web page, the

paragraph is given a margin, a

background colour and a particular font name also. We can note that we have not

made any change in the body section of the web page. The rendering of the paragraph

(<P> tag) is fully controlled by the style rules which is given at the head section of

the web page.

Now, let us make a little modification in the <BODY> section as in Example 6.4.

The body section contains some content within <P> tag and also some content

outside the <P> tag.

Fig. 6.3: A web page containing style rules for a
paragraph
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Example 6.4: To illustrate the working of paragraphs with and without style

rules

<HTML>

<HEAD><TITLE>CSS Paragraph</TITLE>

<STYLE Type= "text/css">

P {

margin: 40px;

background-color: #eee4c1;

font-family: "Courier New";

 }

</STYLE>

</HEAD>

<BODY>

<P>

We can set the style rules for a paragraph to improve

its visual appearance.

</P>

This line is outside the paragraph.

</BODY>

</HTML>

We can see the output in Figure 6.4. See how the content outside the paragraph is

displayed on the web page. Since the text which is outside the paragraph is within

the <BODY> tag, it is rendered by

the style rule for the <BODY> tag.

But we have not specified any

style rule for the <BODY> tag.

Each browser has a default style

rule for rendering contents within

each element (tag). So the text is

rendered by the default style rule

for the <BODY>  tag by the

browser.

Let us see how we can give a style rule for the <BODY> tag.

Example 6.5: To illustrate CSS rules for <BODY> tag

<HTML>

<HEAD><TITLE>CSS Body</TITLE>

<STYLE Type= "text/css">

P {

margin: 40px;

Fig. 6.4: A web page consisting of paragraphs that use
and do not use style rules
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background-color: #eee4c1;

font-family: "Courier New";

}

BODY {

margin: 20px;

background-color: #aae4c1;

font-family: "Tahoma";

font-size: 20px;

}

</STYLE>

</HEAD>

<BODY>

<P>

We can set the style rules for a paragraph to improve

its visual appearance.

</P>

This line is outside the paragraph.

</BODY>

</HTML>

The above web page defines style rules

for two elements, <P> tag and <BODY>

tag. The body section of  this code is

exactly similar to Example 6.4. Look

at the output of the above code in

Figure 6.5.

The content within the body section is

rendered by the style rule specified for

the <BODY> tag.  Thus we can control the visual effects of  the contents within the

web page without making any modification in the body section.

Example 6.6: Example displaying use of style rule for <P> tag

<HTML>

<HEAD> <TITLE>CSS Paragraphs</TITLE>

<STYLE Type= "text/css">

P {

margin: 40px;

background-color: #eee4c1;

font-family: "Courier New";

}

BODY {

margin: 20px;

background-color: #aae4c1;

Fig. 6.5: A web page using CSS rules for
<BODY> tag
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font-family: "Tahoma";

font-size: 20px;

}

</STYLE>

</HEAD>

<BODY>

<P>

We can set the style rules for a paragraph to improve

its visual appearance.

</P>

This line is outside the paragraph.

<P>

This is another paragraph. The style rule which is de-

fined for &ltP&gt tag will be affected to all the

&ltP&gt tags in the web page.

</P>

</BODY>

</HTML>

We have added one more paragraph to the

body section. The output of the above code

is given in Figure 6.6. We can see that the style

rule defined for the <P> tag was applicable

for all the paragraphs in the web page.

Can we think of making the above web page

without using CSS? Ofcourse, we may use a

number of  <FONT>  tags, <B> tags, etc. at

different places in the web page to get the same result.  But, how will you  bring

about the same modification in the appearance of all the paragraphs in a web page?

We will have to change the attribute values of  the <FONT> tag in all the places in the

web page. Still, we may not get the correct result as shown in the figure. But if we

use CSS, we can easily modify the style rule, written only at one location and the

style will be automatically applied to all the <P> tag elements in the web page.

Fig. 6.6: A web page with style rules for
<P> tag

Know your progress

1.What is a selector?

2. Mention the use of  style rules.

3. State whether the statements are true or false

a. A style rule has a selector and a declaration block.

b. A style rule can contain only one declaration.

4. The CSS property used to set the margin of a page is ______.

5. CSS was proposed by ______.
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6.4  Selectors

A selector is an HTML element or set of  elements to which a CSS rule is applied.

HTML supports different type of  selectors. The following are the commonly used

selectors in CSS.

6.4.1 Universal selector

It uses the * symbol in place of  tag element. The style rule given for the universal

selector will be applicable to all the elements in the web page. This selector is rarely

used for a web page.

<STYLE Type= "text/css">

* {

font-family: "Courier New";

color: red;

  }

</STYLE>

To understand the working of  the universal selector, let us consider the following

web page.

Example 6.7: To illustrate the working of univeral selector

<HTML>

<HEAD><TITLE>CSS Universal Selector</TITLE>

<STYLE Type= "text/css">

* {

  font-family: "Courier New";

  color: red;

  }

</STYLE>

</HEAD>

<BODY>

<P>

Universal selector sets the style rule for all the elements

in the web page.

</P>

This line is outside the

paragraph.

</BODY>

</HTML>

The output of the above code is

given in Figure 6.7. We can see that

the content within the <BODY> tag
Fig. 6.7: A web page using universal selector
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and <P> tag are rendered exactly in the same fashion specified in the style rule given

for the universal selector.

6.4.2 Type selector

It uses the element name or tag name. The style rule given for a particular element

of tag will be applicable for all the occurences of that tag in the web page.

<STYLE Type= "text/css">

P {
font-family: "Courier New";

color: red;

margin: 10px;

  }
</STYLE>

When we specify an HTML element in a style rule, do not enclose the element in
angle brackets. The style rule specified in the above example is applicable for all
<P> tags in the web page. Note that we have used only the letter P without the
angle brackets in the style rule.

Example 6.8 : To illustrate the use of type selector

<HTML>

<HEAD> <TITLE>CSS Type Selector</TITLE>

<STYLE Type= "text/css">

P {

font-family: "Courier New";

color: red;

margin: 10px;

 }

</STYLE>

</HEAD>

<BODY>

<P>

Type selector sets the style rule for all occurances of

a particular element in the web page.

</P>

This line is outside the paragraph.

</BODY>

</HTML>

The output of the above code

is given in Figure 6.8. We can see

that the style were applied to

only the <P> tag in the web page.

Fig. 6.8: A web page using type selector

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



6. Cascading Style Sheet

185

6.4.3 Class selectors

We have learned how to use type selector to set style rules for different elements in

a web page. What will we do, if  only two or three paragraphs in the web page have

a style different from the other paragraphs? If  we specify a style rule for a <P> tag,

the rule will be applicable for all the paragraphs in the web page which is not desired

in this case. Using class selector, we can apply a style rule to  the desired element in

the web page. When we use a class selector, we write the class name preceded by a

dot as shown below.

<STYLE Type= "text/css">

.myStyle {

font-family: "Courier New";

color: red;

margin: 10px;

   }

</STYLE>

In the above example, ‘myStyle’ is the class name. We can give any name for a class.

Along with alphabets, we can use numbers also. A class name cannot contain space.

A class name is case sensitive for some browsers. Hence we must be careful while

using upper or lower case letters in the class name. We can also see that the class

name in the above style rule is preceded by a dot symbol. This dot symbol denotes

that the selector is a class selector. Any selector that preceds a dot is a class selector.

Now let us see how a class selector is used in a web page.

Example 6.9: To illustrate class selectors

<HTML>

<HEAD><TITLE>CSS Class Selector</TITLE>

<STYLE Type= "text/css">

.myStyle {

font-family: "Courier New";

color: red;

margin: 10px;

}

</STYLE>

</HEAD>

<BODY>

<P>

This is a paragraph that does not make use of any style

rule.

</P>
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<P Class= "myStyle">

This is another paragraph that makes use of a style rule

using class selector.

</P>

</BODY>

</HTML>

Carefully observe the line <P Class= "myStyle"> in the second paragraph of

the body section of the above web page. It denotes that the paragraph should be

rendered by the style rule specified by the class name ‘myStyle’. That means, the

class selector style rule will be applicable only to those elements where Class

attribute is given the value

‘myStyle’. Whilegiving value for the

class attribute, we do not use the dot

symbol. It is used only when we define

the style rule within the <STYLE> tag.

The output of the above code is give

in Figure 6.9.

Let us consider another example to understand the use of class selector in detail.

Consider the following web page. The body section contains four paragraphs. No

modification is made in the style rule.

Example 6.10 : To create a web page that illustrates class selector in detail

<HTML>

<HEAD><TITLE>CSS Class Selector</TITLE>

<STYLE Type= "text/css">

.myStyle {

font-family: "Courier New";

color: red;

margin: 10px;

}

</STYLE>

</HEAD>

<BODY>

<P>

This is a paragraph that does not make use of any style

rule.

</P>

<P Class= "myStyle">

This paragraph makes use of a style rule using class

selector.

</P>

Fig. 6.9: A web page using class selector
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<P>

This paragraph also does not make use of any style rule.

</P>

<P Class= "myStyle">

This is another paragraph that makes use of the same

style rule using class

selector.

</P>

</BODY>

</HTML>

The output of the above code is given

in Figure 6.10. We can see that the style

rule was applied only to two paragraphs

in the web page.

6.4.4 ID selectors

These selectors are used to apply a style rule only to a single element in the web

page. Just like a class name, an ID name also can be given to a selector. But the ID

name should be preceded by a # symbol. The # symbol denotes that the selector is

an ID selector.

  <STYLE Type= "text/css">

#myStyle {

font-family: "Courier New";

color: red;

margin: 10px;

 }

</STYLE>

The following web page makes use of  an ID selector.

Example 6.11: To illustrate the working of ID selector

<HTML>

<HEAD><TITLE>CSS ID Selector</TITLE>

<STYLE Type= "text/css">

#myStyle {

font-family: "Courier New";

color: red;

margin: 10px;

}

</STYLE>

</HEAD>

<BODY>

Fig. 6.10: A web page that uses a class selector
more than once
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<P>

This is a paragraph that does not make use of any style

rule.

</P>

<P Id= "myStyle">

This is another paragraph that makes use of a style

rule, using ID selector.

</P>

</BODY>

</HTML>

We can note the line <P Id = “myStyle”> in the second paragraph in the body

section of the web page. While

giving value to the Id attribute, we

do not use the # symbol. This #

symbol is used only when we

define the style rule within the

<STYLE> tag. The output of  the

above code is given in Figure 6.11.

The rule defined by an ID selector

can be applied only to a single element in the web page. The reason is that no two

elements in the web page can have the same  ID name. The rule defined by an ID

selector can be applied only to those elements in a web page that have the same ID

name. Consider the following example:

Example 6.12: To illustrate the use of ID selector

<HTML>

<HEAD><TITLE>CSS ID Selector</TITLE>

<STYLE Type= "text/css">

#myStyle {

font-family: "Courier New";

color: red;

margin: 10px;

}

</STYLE>

</HEAD>

<BODY>

<P>

This is a paragraph that does not make use of any style

rule.

</P>

Fig. 6.11: A web page using ID selector
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<P Id= "myStyle">

This is another paragraph that makes use of a style

rule, using ID selector.

</P>

<P Id= "myStyle">

This is another paragraph that wrongly makes use of a

style rule, using ID selector.

</P>

</BODY>

</HTML>

The above code has two paragraphs

with the same ID. In HTML no two

elements in a web page can have the

same ID. But today, some web

browsers allow the same ID for more

than one element. The output from

such a web browser is given in Figure

6.12. If we need to apply a particular

style to more than one place in a web page, we must use class selectors rather than

ID selector.

6.5 Properties

Properties are the keywords used in style rules. We can give different values for

properties.  CSS provides a large number of  properties. We can classify properties

into the following different categories:

6.5.1 Font properties

The following are the important properties applicable to fonts:

Fig. 6.12: A web page that wrongly uses the same
Id for more than one element

Property Possible values

font-family name of font or font family

font-style normal, italic

font-weight normal, bold

font-size values in pixels (12px, 13px, 14px, etc.)

font-family: This property is used to specify the font face. We can give the name of

the font as the value for this property.
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Example:

<STYLE Type= "text/css">

   H1 {

font-family: "Arial";

}

</STYLE>

When we use the above style rule, contents within the <H1> tag will use the ‘Arial’

font. If  necessary, we can give the font name within single or double quotes as

follows.  If  a font name  contains spaces in it, it must be enclosed within single or

double quotes.

<STYLE Type= "text/css">

   H1 {

font-family: "Times New Roman";

}

</STYLE>

The web pages may be viewed by a large number of people all over the world.

They may be using different browsers for viewing the web page. The operating

systems they use may also be different. Therefore we cannot be sure whether the

font that we specify in this font-family property is present in the client computer. To

overcome this issue, we can specify a number of fonts separated by comma as

shown below:

<STYLE Type= "text/css">

   H1 {

  font-family: "Arial, Courier New, Sans-serif";

 }

</STYLE>

In the above case, the browser will search for the Arial font first.  If it is not installed

in the computer, it will search for the Courier New font and then Sans-serif.

font-style: This property is used to specify a text as italic. The possible values for

this property are normal or italic.

If  we use the above style rule, all the content within the <H1> tag will be displayed

in Arial font and will be displayed in italic style also. The following example

demonstrates the working of  these font properties.
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Example 6.13: To create a web page using font properties

<HTML>

<HEAD><TITLE>CSS Font Styles</TITLE>

<STYLE Type= "text/css">

H1 {

font-family: "Arial";

font-style: italic;

}

</STYLE>

</HEAD>

<BODY>

<H1>

This heading is in H1 style

</H1>

</BODY>

</HTML>

The output of the above code is

given in Figure 6.13. We can see that

the content within the <H1> tag is

displayed using Arial font and is in

italics.

font-weight: This property is used to specify a text as bold. The possible values

for this property are normal or bold.

Example:

<STYLE Type= "text/css">

   .boldStyle {

font-weight: bold;
 }

</STYLE>

The above code uses a class selector. To explain the working of  font-weight property,

let us discuss another example.

Example 6.14: To illustrate the use of font-weight property

<HTML>

<HEAD> <TITLE>CSS Font Styles</TITLE>

<STYLE Type= "text/css">

.boldStyle {

font-weight: bold;

}

Fig. 6.13: A web page displaying font properties
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.normalStyle {

font-weight: normal;

}

</STYLE>

</HEAD>

<BODY>

<P Class= "normalStyle">

This is in normal weight.

</P>

<P Class= "boldStyle">

This is in bold weight.

</P>

</BODY>

</HTML>

Figure 6.14 gives the output of

the above code. We can see that

the two paragraphs in the web

page are displayed in normal

and bold weights, respectively.

font-size: It is used to set the size of  a font. We can give values such as 12px, 13px,

14px, etc. for this property. The px in 12px denotes pixels.

<STYLE Type= "text/css">

   .size12 {

font-size: 12px;

}

</STYLE>

The following web page explains the working of  this property.

Example 6.15: To create a web page to display the working of font-size property

<HTML>

<HEAD><TITLE>CSS Font Styles</TITLE>

<STYLE Type= "text/css">

.size12 {

font-size: 12px;

font-family: "Tahoma";

}

.size16 {

font-size: 16px;

font-family: "Arial";

}

Fig. 6.14: A web page displaying font-weight property
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.size20 {

font-size: 20px;

font-family: "Times New Roman";

}

</STYLE>

</HEAD>

<BODY>

<P Class= "size12">

This is in size 12px.

</P>

<P Class= "size16">

This is in size 16px.

</P>

<P Class= "size20">

This is in size 20px.

</P>

</BODY>

</HTML>

The output of the above example

is given in Figure 6.15.

6.5.2 Text properties

Given below are the important properties used for manipulating the display of the

text.

Fig. 6.15: A web page displaying font-size property

Property Possible values

text-align left, right, center, justify

text-decoration none, underline, overline, line-through

text-indent values in pixels. (20px, 25px,..., etc.)

line-height numbers such as 1, 1.5, 2, 2.5, .....

text-align: It is used to align the text. The possible values are left, right, center and

justify.

<STYLE Type= "text/css">

   .alignRight {
 text-align: right;

  }

</STYLE>

We can see the text-align property in action from the following web page.
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Example 6.16: To create a web page to display the working of text-align property

<HTML>

<HEAD>

<TITLE>CSS Text Styles</TITLE>

<STYLE Type= "text/css">

.alignRight {

text-align: right;

 }

.alignLeft {

text-align: left;

}

.alignCenter {

text-align: center;

  }

.alignJustify {

text-align: justify;

font-family: “Arial”;

font-size: 16px;

color: blue;

}

</STYLE>

</HEAD>

<BODY>

<P Class= "alignRight">

This paragraph is right aligned.

</P>

<P Class= "alignCenter">

This paragraph is center aligned.

</P>

<P Class= "alignLeft">

This paragraph is left aligned.

</P>

<P Class= "alignJustify">

This paragraph is aligned with justify. When we align a

paragraph with this option, both the left and right side

will be aligned with the borders of the browser.

</P>

</BODY>

</HTML>
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The output of the above code is given

in Figure 6.16. We can see that

different paragraphs are aligned in

different ways specified by the style

rules.

text-decoration: It is used to

underline, overline and draw a line

through the text. The possible values

are underline, overline, line-through
and none.

<STYLE Type= "text/css">

   .underLine {
text-decoration: underline;

 }

</STYLE>

We can make use of  this property in the following code for the web page shown in

Figure 6.17.

Example 6.17: To create a web page to display the use of text-decoration property

<HTML>

<HEAD><TITLE>CSS Text Styles</TITLE>

<STYLE Type= "text/css">

.underLine {

text-decoration: underline;

font-family: “Arial”;

font-size: 18px;

}

.overLine {

text-decoration: overline;

font-family: “Arial”;

font-size: 18px;

 }

.lineThrough {

text-decoration: line-through;

font-family: “Arial”;

font-size: 18px;

  }

</STYLE>

</HEAD>

<BODY>

<P Class= "underLine">

This paragraph is underlined.

</P>

Fig. 6.16: A web page displaying text-align
property
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<P Class= "overLine">

This paragraph is overlined.

</P>

<P Class= "lineThrough">

This paragraph is linethrough.

</P>

</BODY>

</HTML>

text-indent: It is used to set the starting position of the first line in a paragraph.

The value for this attribute can be given in pixels as 30px, 40px, etc. We can also

give negative value for this attribute as -30px. If a negative value is given to text-

indent, the starting position of the first line is moved to the left margin.

<STYLE Type= "text/css">

.indent {
text-indent: 30px;

font-family: "Arial";

font-size: 18px;

text-align: justify;

margin: 50px;

}

</STYLE>

We can make use of  this in the following example.

Example 6.18: To create a web page that displays the use of text-indent property

<HTML>

<HEAD><TITLE>CSS Text Styles</TITLE>

<STYLE Type= "text/css">

.indent30 {

text-indent: 30px;

font-family: "Arial";

font-size: 18px;

text-align: justify;

margin: 50px;

 }

.negativeIndent {

text-indent: -30px;

font-family: "Arial";

font-size: 18px;

text-align: justify;

margin: 50px;

}

</STYLE>

</HEAD>

Fig. 6.17: A web page displaying font-
decoration property
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<BODY>

<P Class= "indent30">

This paragraph has the indent 30. The indent sets the

starting position of the first line in the paragraph. The

indent value can be given in pixel.

</P>

<P Class= "negativeIndent">

This paragraph has the indent -30. This shows that we can

give negative value as the indent. When a negative value

is given for the indent, the starting position of the

first line in the paragraph is moved before the margin.

</P>

</BODY>

</HTML>

The output of the above example is given

in Figure 6.18.

In the output, we can see that the starting

position of the first line in the first paragraph

is moved 30 pixels towards the right of the

margin and in the second paragraph, the first

line is moved 30 pixels towards the left of

the margin.

line-height: It is used to specify the height

of a line. The value can be a number or a fraction. If we give the value as 2, then the

height of the line will be double the height of the actual line. If the value is 1.5, the

height will be one and half times the height of the actual line.

<STYLE Type= "text/css">

   .height2 {

line-height: 2;

 }

</STYLE>

The following example demonstrates the working of the property line-height.

Example 6.19: To create a web page to display the working of line-height property

<HTML>

<HEAD><TITLE>CSS Text Styles</TITLE>

<STYLE Type= "text/css">

.height1 {

line-height: 1;

font-family: "Arial";

font-size: 18px;

Fig. 6.18: A web page displaying text-
indent property
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text-align: justify;

margin: 40px;

}

.height1_5 {

line-height: 1.5;

font-family: "Arial";

font-size: 18px;

text-align: justify;

margin: 40px;

}

.height2 {

line-height: 2;

font-family: "Arial";

font-size: 18px;

text-align: justify;

margin: 40px;

}

</STYLE>

</HEAD>

<BODY>

<P Class= "height1">

Lines in this paragraph has normal height. The line-

height property is given the value 1 for this paragraph.

</P>

<P Class= "height1_5">

Lines in this paragraph is one and half times the actual

height of the line. The line-height property is given

the value 1.5 for this paragraph.

</P>

<P Class= "height2">

Lines in this paragraph is double

the height of the actual line.

The line-height property is given

the value 2 for this paragraph.

</P>

</BODY>

</HTML>

The output of the above code is given in Figure

6.19. We can see the difference in the height of  the

lines in the different paragraphs. By increasing the

height of a line, we are actually increasing the gap

between the lines.
Fig. 6.19: A web page displaying line-

height property
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Know your progress

1. What is the difference between class selector and ID selector?

2. The selector used to apply a style rule to only a single element in

the web page is __________.

3. The selector used to set style rules for the entire elements in a

web page is _________.

4. The property used to set the line height is _________.

5. The property used to set the starting position of the first line in a

paragraph is _________.

6. The property used to underline a text is _________.

7. A paragraph can be aligned in different ways using __________

property.

8. What is the advantage of universal selector?

9. What are the values that can be given to the text-align property

of CSS?

6.6 Ways to add CSS to a web page

In the previous examples, we used CSS rules in our web page using the <STYLE>

tag. There are three different methods to include CSS in a web page. We will discuss

these methods in the following section.

6.6.1 Internal style sheet

Here style rules are included between <STYLE> and </STYLE> tags directly in an

HTML document. These tags are placed inside the <HEAD> section of an HTML

page. We used this method to include CSS in the previous examples. Consider the

following example.

Example 6.20: To illustrate the use of internal style sheet

<HTML>

<HEAD><TITLE>CSS Internal</TITLE>

<STYLE Type= "text/css">

p {

margin: 40px;

background-color: #eee4c1;

font-family: "Courier New";

}

</STYLE>

</HEAD>
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<BODY>

<P>

Inline style sheet

is used when a web

page has a unique

style.

</P>

</BODY>

</HTML>

The output of the above

example is given in Figure 6.20.

6.6.2 External style sheet

In this method, the style rules are entered and saved in a separate CSS file. This CSS

file can be linked to any web page where the style rules are to be applied. This is the

most powerful and useful method to include style rules in a web page. When we

save the CSS file, the file name must be given an extension .css. This CSS file is

included in a web page using <LINK> tag.

Example 6.21: To create a web page to illustrate the use of external style sheet

Let us create a text file using the following content and save it as ‘myStyle.css’.

  BODY {

background-color: lightgreen;

  }

  P {

font-family: "Arial";

font-style : italic;

color: blue;

 }

Now, create an HTML file as follows.

<HTML>

<HEAD><TITLE>CSS Internal</TITLE>

<LINK Rel= "stylesheet" Type= "text/css" Href=

"myStyle.css">

</HEAD>

<BODY>

<P>

External style sheet is ideal when a style is applied to

many pages.

</P>

</BODY>

</HTML>

Fig. 6.20: A web page illustrating internal style sheet

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



6. Cascading Style Sheet

201

We can see the following line in the above code:

<LINK Rel= "stylesheet" Type= "text/css" Href= "myStyle.css">

Here the <LINK> tag makes use of  three attributes namely Rel, Type and Href

in it. Rel attribute is used to specify the relation between the current document and

the linked document. Here the value of Rel attribute, ‘stylesheet’ specifies that

the linked file is the stylesheet for the web

page. It is used only if the Href attribute

is present. Type property specifies that

the linked file is a CSS file and Href is

used to mention the path and file name

of the external CSS file. The output of

the above code is given in Figure 6.21.

The biggest advantage of  using this method is that when we define style rules for

various elements in a seperate file, the same file can be included in all the web pages

of a web site. Hence all web pages in a website will have a similarity in their

appearance. If we require any modification in the style, we need to modify only a

single CSS file. The changes will automatically be reflected in all the web pages in

the site.

6.6.3 Inline style

It uses the Style attribute of  the HTML tags. Properties and their corresponding

values can be directly assigned to this attribute . This method does not make use of

the power of  CSS. Therefore, using this style is undesirable for web developers. Let

us consider the following example.

Example 6.22: To illustrate the use of inline style

<HTML>

<BODY><TITLE>CSS Inline</TITLE>

<H2 Style= "font-family:'Courier New'; color:blue;">

This head uses inline style.

</H2>

<H2>

This head does not use any style.

</H2>

</BODY>

</HTML>

We can see that the style rule is included in the <H2> tag using Style attribute.

The properties are given within double quotes and and their corresponding values

are specified within single quotes. Each property-value pair must be separated by a

semicolon. The output of the above code is given in Figure 6.22.

Fig. 6.21: A web page illustrating external
stylesheet
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We can also note that the style rule

given for the first <H2> tag does not

have any effect on the second <H2>

tag. Therefore, this method cannot be

used to apply a style rule for all the

occurences of a particular element.

6.7 Grouping of selectors

In all previous examples, we defined a style rule only for a single element in a web

page. If  we need to define the same style rules for more than one element, we can

group those elements as:

P, H1 {

background-color: #eee4c1;

font-color: blue;

 }

In the above code, the style rule is applicable to the two elements <P> and <H1>.

The elements are separated by a comma for defining style rules. Similarly, we can

group any number of  elements. Consider the following example.

Example 6.23 : To illustrate the grouping of selectors

<HTML>

<HEAD><TITLE>CSS Grouping</TITLE>

<STYLE Type= "text/css">

P, H1 {

background-color: #eee4c1;

color: blue;

}

</STYLE>

</HEAD>

<BODY>

<H1>THIS IS H1 HEAD</H1>

<P>

The style rule defined for the &lt;H1&gt; tag is appli-

cable for this paragraph also.

</P>

<H2>THIS IS H2 HEAD</H2>

</BODY>

</HTML>

The style rules defined will be applicable in all the places where these elements are

specified in the web page. The output of the above code is given in Figure 6.23.

Note that the style rule defined was applied only to the tags <H1> and <P>.

Fig. 6.22: A web page illustrating inline style
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Let us conclude

This chapter introduces CSS for

designing web pages. CSS can be

used to provide a uniform

layout and design for web pages.

The four different types of

selectors namely, universal, type,

class and ID can be used for

defining styles. The font and text properties in CSS are also discussed here. CSS

consists of  several properties which we can explore ourselves. These properties

allow you to create attractive web pages. CSS styles can be added to HTML

documents as internal style sheet, external style sheet and as inline style. Grouping

of  selectors is also introduced in this chapter. This chapter provides us with the

basic concepts of  CSS, that allow further experiment with different styles and create

attractive websites.

Let us practice

1. Design a web page that promotes cleanliness in public places. The web page

should contain a description for cleanliness, images and a set of  instructions

for keeping public places clean. The CSS style rules should be specified as

internal style sheet using class selectors. Following are the style rules to be

followed. Heading - font-Tahoma, size-18, colour-green, underline

Paragraphs - font - Garamond, size - 12, colour - blue

Lists - font - Arial, size - 12, colour - brown, italics, line height should be 1.5

lines

The paragraphs should have a margin of 30 pixels and background colour

yellow.

2. Design a web page on Akshaya centers in Kerala. Use an external style sheet to

format the web page. Give suitable font, colour and line spacing for heading

and paragraphs using type selector.

3. Design a web page for tourism promotion - Incredible India - and format it

using external style sheet. Class selectors should be used to provide the style

rules. Give suitable background colour, font, margins and font colour for the

whole page. The popular tourist destinations should be given in brown colour,

using Tahoma font and in bold.

Fig. 6.23: A web page displaying grouping of selectors
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 Let us assess

1. State whether the statements are true or false.

a. Use of style sheet reduces the size of a web page.

b. Style rules enhance the visual appearance of  a web page.

c. There is only one method to include style rule in an HTML page.

d. Class selector is used when a style rule is to be applied only for some

selected elements in the web page.

2. The seperator used  for grouping selectors in a style rule is ________.

3. The tag used to include an external CSS file in a web page is ________.

4. The attribute of  an HTML element used to include style rules inline is

________.

5. The most powerful method to include style rule in a web page is ________.

7. What are the advantages of using CSS in a web page?

8. Explain the different methods to include CSS in a web page.

9. Explain the syntax of  a style rule with an example.

10. Explain the different types of  selectors.

11. Suggest a situation where you can make use of  class selector.

12. What are the various properties used for formating a text.

13. Consider the style rule given below.

.lineThrough18 {

text-decoration: linethrough;

font-family: “Arial”;

font-size: 18;

 }

a. Correct the errors in the above style rule.

b. Modify this style rule to make the text bold, italics and to reduce the font

size to 14 pixels.

14. Explain the various properties used for displaying text.

15. Explain the different methods to include style rules in a web page.

16. How can we group selectors? Explain with an example.
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Web Hosting

Significant Learning Outcomes W
e familiarised ourselves with creating

web pages in the earlier chapters. A

website consisting of several web

pages are designed to give information about

an organisation, product, service, etc. Suppose

we have developed a website for our school

using HTML. How can we make this website

available on the Internet? These web pages are

to be stored in the web servers connected to

the Internet, to be made available to others.

This chapter presents an overview of  web

hosting, its different types and general features.

For accessing a website we need a domain

name. How domain names are chosen and

registered are also presented here. The various

FTP client softwares available to transfer the

files of  the website (web pages, images, etc.)

from our computer to the server are also

discussed. After learning this chapter, one will

be able to register a domain name and host a

website.

7.1 Web hosting

To develop a website for our school we need

to design web pages. In the previous chapters,

we discussed how to design web pages. Any

text editor or a web designing tool can be used

to develop a home page, a page for the courses

After the completion of this chapter, the

learner:

• describes the use of a web server

and the concept of web hosting.

• classifies different types of hosting.

• explains the way to buy hosting

space.

• registers a domain and hosts a

website using FTP client software.

• explains the features of free

hosting.

• identifies the use of Content

Management Systems.

• describes the need for responsive

web design.

7
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in the school, facilities available, contact address, etc. and link them using a menu to
form an attractive website.

After developing the school website in our computer, it has to be made available in
the Internet. The designed website has to be uploaded to a web server to make it
available to Internet users all over the world. For this, either storage space is rented
on a web server to store the web pages that we have created or our own web server
is set up. Setting up a web server is very expensive compared to hosting a website in
a rented storage space.

Web hosting is the service of  providing storage space in a web server to serve files
for a website to be made available on the Internet. The companies that provide web
hosting services are called web hosts. Web hosts own and manage web servers.
These web servers offer uninterrupted Internet connectivity, software packages for
offering additional services such as databases and support for programming
languages such as PHP, Java, ASP.NET, etc.

7.1.1 Types of web hosting

Suppose the entire content of  our school website including html files, images, etc.,
require 4 MB of  hard disk space on the web server. Web hosts provide only standard
packages of  10 MB, 20 MB, etc. of  space on the web server. We may need to
choose the web host considering the packages offered by them that suit our purpose.
The number of  visitors expected to visit our website is also a factor. If  our website
requires a database, contains scripts, etc. then the support of  such features are also
to be considered while choosing a web host.

The type of web hosting has to be decided based on requirements like the amount
of space needed for hosting, the number of visitors expected to visit the website,
the use of  resources like databases, programming support, etc. Web hosts provide
different types of  hosting packages. They can be shared hosting, virtual hosting and
dedicated hosting.

a. Shared hosting: Shared web hosting is the most common type of  web hosting.
It is referred to as shared because many different websites are stored on one single
web server and they share resources like RAM and CPU. The features available on
shared web servers are generally basic and are not flexible to suit a website that
require specific features like high bandwidth, large storage space, etc. Shared hosting
is most suitable for small websites that have less traffic. Shared servers are cheaper
and easy to use, since they are configured with the most popular options. The updates
and the security issues of  the software installed in the web server are taken care of
by the hosting company itself. A drawback is that since the bandwidth is shared by
several websites, if  any of  these has a large volume of  traffic, it will slow down all
other websites hosted in the shared server.
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b. Dedicated hosting: Dedicated web hosting is the hosting where the client leases

the entire web server and all its resources. The web server is not shared with any

other website. Websites of  large organisations, government departments, etc. where

there are large numbers of  visitors,  opt for dedicated web hosting. Here, the client

has the freedom to choose the hardware and software for the server and has full

control over the web server. Dedicated servers provide guaranteed performance,

but they are very expensive. The advantage of  dedicated servers is that such servers

are usually hosted in data centers where the service provider facilitates Internet

connectivity, round-the-clock power supply, etc. and the technical expertise for

managing web servers. The cost of  setting up and managing these facilities is thus

reduced for the client. Since the bandwidth is not shared with other websites, it

speeds up the access of the website. If the client is allowed to place their own

purchased web server in the service providers facility, then it is called co-location.

c. Virtual Private Server: A Virtual Private Server (VPS) is a physical server that

is virtually partitioned into several servers using the virtualization technology.  Each

VPS works similar to a dedicated server and has its own separate server operating

system, web server software and packages like e-mail, databases, etc. installed in it.

Unlike shared hosting, VPS provides dedicated amount of RAM for each virtual

web server. Each of  these VPS works as a fully independent web server, as if  each

were running on a separate physical server. The users of  VPS are provided with the

rights to install and configure any software on their VPS. They are also given the

right to restart their VPS without affecting other virtual servers running on the

same physical server.

VPS hosting provides dedicated bandwidth to each website on the server. This

provides the advantages of  a dedicated hosting, even though the actual server is

shared. This type of hosting is suitable for websites that require more features than

that provided by shared hosting, but does not require all the features of dedicated

hosting. VPS provides almost the same

services at a lesser cost than that of

dedicated hosting. Some popular

server virtualization softwares are

VMware, Virtualbox, FreeVPS, User-

mode Linux, Microsoft Hyper-V, etc.

Figure 7.1 gives a symbolic

representation of the different types of

web hosting packages. Fig. 7.1 : Types of web hosting
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7.1.2 Buying hosting space

We have designed and stored the web

pages of our school website in a folder

in the computer. These files are to be

copied to a web server to make it

available on the Internet as shown in

Figure 7.2. For this, the appropriate

type of web hosting has to be chosen.

It is preferred that the website is hosted

using the services of  a shared hosting

service provider as it is cheaper and

appropriate. Once the type of hosting

server is decided, hosting space has to

be purchased from a web hosting service provider.

While purchasing hosting space, several factors have to be taken into consideration.

First, we have to decide on the amount of  space required. We need to select a

hosting space that is sufficient for storing the files of our website. If the web pages

contain programming content, we need a supporting technology in the web server.

The program used in the web page may require Windows hosting or Linux hosting.

Here we need to

choose between a

Windows server or a

Linux server as shown

in Figure 7.3. If our

website contains only

HTML code, we can

choose any server.

Other features like

database support, e-

mail facility, etc. can

also be considered

while choosing the

web host.

7.1.3 Domain name registration

We have now bought hosting space for our web pages and now we need an

identification (URL) on the Internet. For this a suitable domain name has to be

registered for our school. Domain names are used to identify a website in the Internet.

Fig. 7.2 : Making a website available on the
Internet

Fig. 7.3 : Hosting options
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Most of  the web hosting companies offer domain name registration services. After

finalising a suitable domain name for our website, we have to check whether this

domain name is available for registration or it is already in use by somebody else.

The websites of  the web hosting companies or web sites like www.whois.net provide

an availability checker facility where we can check this. These websites check the

database of ICANN that contains the list of all the registered domain names and

gives a response as shown

in Figure 7.4. If the

domain name entered is

available, we can proceed

with the registration. The

registration requires filling

information for WHOIS

database of domain names for

ICANN. WHOIS information

requires the name, address,

telephone number and e-mail

address of the registrant, as

shown in Figure 7.5. This

information can be made public

or can be kept private according

to the registrant's wish. After

paying the annual registration fees

online, the domain is purchased

and is registered in our name. The

shopping cart of the purchase is shown in Figure 7.6.

Thus, we have

purchased a web

server space for our

school website and

have registered a

domain name for it.

Now, when the user

types our domain name,

www.stjosephsbhss.org,

in the browser window, it should display the webpage stored in the web server we

have purchased. This will happen only if  the DNS for server returns the IP address

of  our web server when the browser requests for it with www.stjosephsbhss.org.

 
Fig. 7.4 : Domain name registration search result 

 

Fig. 7.4 : Domain name registration search result

Fig. 7.5 : Providing WHOIS information

Fig. 7.6 : Buying a domain name
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Therefore, our domain name has to be connected to the IP address of the web

server where the web pages are stored. This is done using 'A record' (Address

record) of the domain. An 'A record' is used to store the IP address of a web

server connected to a domain name. The 'A record' can be modified by logging

into the control panel of the domain. Here, you can set the 'A record' of the domain

name to point to the IP address of  web server as shown in Figure 7.7. After this,

the DNS

servers will be

able to resolve

our domain

name to

connect to our

web server. Fig. 7.7 : Changing 'A record' of the domain

A WHOIS search will provide information regarding a domain. It may

include information like domain ownership, where and when registered,

expiration date, etc. It is also used to determine whether a given domain

name is available or not. A WHOIS lookup on www.kerala.gov.in returns

the following.

Prepare a comparative table of popular web hosts and their prices

per year for their respective minimum hosting space. Provide pricing

for both Windows and Linux web hosting.

Prepare a comparative table for the pricing for a year for .org and

.com domain registrations in the popular service providers.

Search the WHOIS details of  www.dhsekerala.gov.in and

www.scert.kerala.gov.in in www.whois.net and prepare a chart of  the

details.

Let us do
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7.1.4 FTP client software

After buying a space on the hosting server and a domain name, we need to transfer

the files of  the website from our computer to the web server. This requires an FTP

client software.

We have already discussed FTP in Chapter 8, Computer Networks of  Class XI.

FTP is used to transfer files from one computer to another on the Internet. FTP

client software establishes a connection with a remote server and is used to transfer

files from our computer to the server computer. To connect to an FTP server,

FTP client software requires a

username and password and also the

domain name. This is to be provided

in the Site Manager dialog box as

shown in Figure 7.8. FTP sends

username and password to the server

as plain text which is unsecure.

Therefore nowadays, SSH FTP

(SFTP) protocol which encrypts and

sends usernames, passwords and data

to the web server is used in the FTP

software. SFTP uses Secure Shell

(SSH) protocol which provides

facilities for secure file transfer.

Once the FTP client is authenticated the IDE of FTP software appears as given in

Figure 7.9. In this figure, the portion on the left side displays the folders and files in

our computer and the right side displays the files in the web server computer. We

Fig. 7.8 : FTP Login

Know your progress

1. The companies that provide web hosting services are called

__________.

2. List the factors that decide the type of  web hosting.

3. VPS is

a. Virtual Premium Service b. Virtual Private Service

c. Virtual Premium Server e. Virtual Private Server

4. What is co-location?

5. What does WHOIS information contain?

6. Why is 'A record' important for a domain name?
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Fig. 7.10 : FTP control panel provided by a hosting company

can use either the  menu or ‘drag and drop’ files from the left side window to the

right side window to upload the files to the web server. The files will then be

transferred (copied) from our computer to the web server. The popular FTP client

software are FileZilla, CuteFTP, SmartFTP, etc.

Fig. 7.9 : FTP client software IDE

Some web hosting companies provide their own control panel webpage through

which users can upload the files. Such hosting companies do not allow third party

FTP client

software to

upload files to

their web

servers. Figure

7.10 displays a

control panel

provided by a

web hosting

company to

transfer files.
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7.2 Free hosting

Free hosting provides web hosting services free of  charge. The service provider
displays advertisements in the websites hosted to meet the expenses. Some free
web hosting sites provide the facility to upload the files of our website in their
server, but may place certain restrictions on the files. The size of  the files that can
be uploaded may be limited (supports upto 5 MB only), audio/video files (mp3,
mp4, etc.) may not be permitted and so on. These websites usually provide control
panels to upload files from our computer to the web server as shown in Figure
7.10. Some other websites only permit us to use the templates (pre-formatted
designs) they provide for designing websites. They do not allow external files to be
uploaded to their web server.

Free web hosting services usually provide either their own subdomain
(oursite.example.com) or as a directory service (www.example.com/oursite) for
accessing our websites. Some free web hosting companies provide domain name
registration services also. Free web hosting is useful for sharing content on the web,
among groups having similar interests like family unions, nonprofit organisations,
etc. who are not able to spend money on web hosting. The availability of  cheap
web hosting services has reduced the need for free web hosting. Sites.google.com,
yola.com, etc. are free web hosting services. A website of  higher secondary school
teachers that uses free hosting is given in Figure 7.11.

Fig. 7.11 : A free web site

7.3 Content Management System

Content Management System (CMS) refers to a web based software system which

is capable of  creating, administering and publishing websites. CMS provides an

easy way to design and manage attractive websites.
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Fig. 7.14 : A web site developed using Joomla CMS

Most CMS is available for free download at their websites. Copy the files of  the

CMS to the hosting space on our web server and configure the website as shown in

Figure 7.12. Templates that provide a list of  preset designs for websites are also

available for download in some

websites. Some sample

templates available are

displayed in Figure 7.13. The

users need to choose a template

from the given list, upload them

to our website and add titles,

images and other descriptions

for the chosen design. This is as

simple as designing a document

in a word processor.

CMS provides standard

security features in its design,

that help even people with less

technical knowledge to design

and develop secure websites.

The CMS templates also reduce

the need for repetitive coding

and design for headings and

menus that appear in all pages

in a website, by internally

providing features to add them

in all pages. Templates are available for download for free or for a small price at

Fig. 7.12 : Configuring a website using Joomla!

Fig. 7.13 : Templates available in Joomla!
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popular CMS websites. There are also third party vendors who customise the CMS
for a fee. If  you are hosting on a shared web server, verify whether the web server
supports the CMS you have downloaded.

CMS is economical and now many organisations, bloggers, etc. use it for their
websites. Some of  the popular CMS software are WordPress, Drupal and Joomla!
Figure 7.14 shows the website of  Motor Vehicles department of  Government of
Kerala, developed using Joomla!

7.4 Responsive web design

Today we browse web pages using various devices like desktops, laptops, tablets
and mobile phones. All these devices have different screen sizes. Traditional web
pages are designed to be displayed on the screens of devices like desktops and
laptops. These web pages are difficult to view when it is accessed using tablets and
mobile phones. The user may have to use the scroll bar to move from one part of
the web page to another. In earlier days, a separate website was created for the
purpose of  viewing in mobile devices. These websites contained web pages whose
size matched the screen size of  these devices. But maintaining two websites for a
single organisation created issues. It would be better if  the web page was able to
adjust itself to the screen size of the device. This type of web page designing is
called responsive web design. Figure 7.15 shows the appearance of a responsive
website in different devices.

Responsive web design is the custom of
building a website suitable to work on
every device and every screen size, no
matter how large or small, mobile phone
or desktop or television. The term
'responsive web designing' was coined by
Ethan Marcotte, an independent designer
and author, to describe a new way of  designing for the ever-changing Web. Responsive
web design can be implemented using flexible grid layout, flexible images and media
queries. Flexible grid layouts set the size of  the entire web page to fit the display
size of the device. Flexible images and videos set the image/video dimensions to
the percentage of display size of the device. Media queries provide the ability to
specify different styles for individual devices. A horizontal menu in a web page for
larger displays might have to be converted to a drop down menu for a mobile
phone. These settings can be done using media queries inside the CSS file.

Screen sizes always vary - from a wearable device, mobile phones, tablets to laptops,
desktops and televisions. Therefore, it is important that websites are designed to
adapt to the screen size of the device.

Fig. 7.15 : Responsive web design
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Let us conclude

After designing a website, it has to be hosted over the Internet using a suitable type
of  hosting. Websites of  small organisations can be hosted using shared hosting,
websites that have more traffic and need more security can opt for VPS hosting,
whereas websites of large organisations or those with very high traffic require
dedicated hosting. After buying a suitable web hosting space, FTP software can be
used to connect to the web server and can securely transfer the files of  the website
to it. Domain name can be registered through a service provider and the 'A record'
can be set to point the domain to the web server. There are free hosting websites
that provide hosting free of cost. Content Management Systems (CMS) offer tools
and standard security features in its design that helps even people with less technical
knowledge to design and develop secure websites. Today, since we browse websites
using devices like mobile phones, tablets, laptops, etc. that have different screen
sizes, it is important to design websites that display themselves according to the
size of the screen they are viewed from.

 Let us assess
1. What do you mean by web hosting? Explain the different types of  web hosting.

2. A supermarket in a city wishes to take its business online. It plans to accept
orders for its products through a website and receive payments online.

a. Which type of hosting is suitable for this website?

b. Explain the reason for your choice.

3. Emil wishes to purchase the web hosting space required to host a website for
his medical shop. List the features to be taken into consideration while buying
hosting space on a web server.

4. How can we connect a website hosted in a webserver to a domain name?

5. What is the advantage of using SFTP protocol in FTP software?

6. Raju wishes to host a website for his family. What are the advantages that free
web hosting companies provide?

7. What is CMS? What are the features of  CMS? Give Examples.

8. Explain the need for applying responsive web design while developing websites
today.

9. How is responsive web design implemented?

Design a website containing the name, age, total runs scored, no. of

wickets taken, etc. of the members of the Indian cricket team and

host the web site using any free hosting services.

Prepare a list of  popular CMS providers and write their features.

In the web hosting space provided, upload the files of the school

website you have prepared using any FTP software.

Let us do
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After the completion of this chapter, the

learner

• recognises the need for files.

• identifies the major limitations of

the conventional file manage-

ment system.

• lists and explains the different

advantages of the Database

Management System.

• lists the various components of

DBMS and explains their purpose.

• recognises the types of users and

their roles in the DBMS environ-

ment.

• explains the levels of data

abstraction and data indepen-

dence in DBMS.

• explains relational data model by

citing examples.

• uses different terminologies in

RDBMS, appropriately.

• applies and evaluates various

operations in Relational algebra.

Database Management
System

Significant Learning Outcomes T
his is an era of  information. The

survival of  organisations in this

competitive world largely depends on

the need for information obtained with high

accuracy and speed. We know that

information is obtained through the

processing of  data. For this, a huge amount

of data is to be collected, stored and

processed to generate information. Every

organisation that we can think of  like schools,

banks, business organisations, etc. are in need

of  information. Can you imagine how this

huge quantity of data was handled

traditionally? In earlier days, this was handled

manually with data recorded in books termed

as 'book keeping'. It is obvious that large

storage space is a hazard and processing of

data is laborious. With the advent of

computers the data could be stored effectively,

but the possibility of duplication,

inconsistency, invalidity, etc. remained. This

chapter provides an effective mechanism to

overcome these limitations. The concept of

Database Management System (DBMS) is

introduced in this chapter as an effective

record keeping system (earlier called book

keeping). Various operations are also

discussed to retrieve the required and relevant

information from the database.

8
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8.1 Concept of database

Consider the Single Window System (SWS) of the Department of Higher Secondary

Education, maintaining a large collection (say 5,00,000 applications or 19 GB) of

data concerning students, courses, schools and grades each year for Class XI

admission process. This data is accessed simultaneously by several schools and

students. Questions about the allotment of  students and schools must be answered

quickly, changes made to the data by different schools must be applied consistently,

and access to certain parts of  the data (e.g., Grades or WGPA) must be restricted.

We can manage the data by storing it in the conventional file management system.

But, this approach has many drawbacks:

• We must keep more copies of  the same data for different applications. This

storage leads to duplication of data.

• There is no mechanism to protect the data from inconsistent changes made by

different users accessing the database simultaneously.

• If  the data are not properly organised, retrieval of  information will be difficult,

and time consuming, and there may be chances of  inaccuracy in the information..

• There is no way to ensure that data is restored to a consistent state if the system

crashes while changes are being made.

• Operating systems provide only a password mechanism for security. This is

not sufficiently flexible to enforce security policies in data.

• There is no standardisation on data.

8.1.1 Need of database

The drawbacks mentioned above can be overcome by using database. In situations,

where huge amount of data is to be mantained and manipulated, conventional file

system will not be sufficient. In such a situation we use database. Database is an

organized collection of  inter-related data stored together with minimum redundancy,

in a manner that makes them accessible for multiple applications. Now we can try

to manage the data in SWS by storing it in a database. The software Database

Management System (DBMS) is essentially a set of programs which facilitates

storage, retrieval and management of database. The primary goal of DBMS is to

provide an environment that is both convenient and efficient to use in retrieving

and storing database.

8.1.2 Advantages of DBMS

Database systems are designed to manage large amounts of data. DBMS involves

both the database structures definition for the storage of  data and the provision of
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mechanisms for the manipulation of data. In addition, the database system must

ensure the safety of the data stored, against unauthorized access or system failure.

If  data is to be shared among several users, the system must avoid possible

anomalous results. The database management system has a number of  advantages

over the traditional file management system. They are listed below.

• Controlling data redundancy: In file management systems, data may be placed

in many files. The storing of  the same data in multiple locations (may be in the

same file or different files) or duplication of  data is known as data redundancy.

Redundancy leads to higher cost in storage and data access. Database systems

do not maintain redundant data, instead all the data is kept at one place in a

centralized manner. All the applications or users that require data refer to the

centrally maintained database. Sometimes there can be technical or business

reasons for maintaining several copies of the same data. However, redundancy

should be carefully controlled in any case.

• Data consistency: Data redundancy may lead to data inconsistency; that is,

the various copies of  the same data show different values in different files.

Assume that your class teacher and Principal maintain separate copies of the

address list of  all students admitted in your class. During periodic address

change a few students report to the Principal and a few students report to the

changes to the class teacher. After a certain period of  time both the address

lists become irrelevant and inconsistent since total corrections are not updated

in both. By controlling data redundancy, data consistency is obtained. If  a data

item appears only once, any update to its value has to be performed only once

and the updated value is immediately available to all users.

• Efficient data access: A DBMS utilises a variety of techniques to store and

retrieve data efficiently.

• Data integrity: Data integrity refers to the overall completeness, accuracy

and consistency of data in the database. This can be indicated by an absence

of any alteration in data between two updates of a data record. Data integrity

is imposed within a database at its design stage through the use of standard

rules and procedures. Data integrity can be maintained through the use of

error checking and validation routines.

• Data security: The information inside a database is valuable to any company

or organization. Therefore it must be kept secure and private. Data security

refers to the protection of data against accidental or intentional disclosure or

unauthorized destruction or modification by unauthorized persons. The various

programs and users may share data in common. But access to specific

information can be limited to selected users by setting the access rights. Through
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the use of  passwords, the information in a database is made available only to

authorised persons.

• Sharing of data: The data stored in the database can be shared among several

users or programs even simultaneously and each may use it for different

purposes.

• Enforcement of standards: With central control of the database, a Database

Administrator (DBA) defines and enforces the necessary standards. Standards

can be defined for data formats to facilitate exchange of  data between systems.

Applicable standards might include naming conventions, display formats,

report structures, terminology, documentation standards, update procedures,

access rules and so on. This facilitates communication and cooperation among

various departments, projects and users within the organization.

• Crash recovery: When a system crashes, all or a portion of  the data can become

unusable. DBMS provides some mechanism to recover data from the crashes.

Thus the DBMS protects data from the effects of  system failures.

8.2 Components of the DBMS environment

DBMS have several components, each performing very significant tasks in its

environment. The components are

• Hardware

• Software

• Data

• Users

• Procedures

Know your progress

1. Storing of the same data in different places is called _______.

2. Address of a particular student is stored in two ways in a school

record; this situation is known as _______.

3. Unauthorised accessing of data can be prevented from using

______.

4. Sharing of  data can reduce data redundancy. State whether true

or false?

5. Data redundancy will reduce data consistency. State whether true

or false?
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Hardware: The hardware is the actual computer system used for storage and

retrieval of  the database. This includes computers (PCs, workstations, servers and

supercomputers), storage devices (hard disks, magnetic tapes), network devices

(hubs, switches, routers) and other supporting devices for keeping and retrieval of

data.

Software: The software

part consists of the actual

DBMS, application

programs and utilities.

DBMS acts as a bridge

between the user and the

database. In other words,

DBMS is the software that

interacts with the users,

application programs, and

databases. All requests from

users for access to the

database are handled by the DBMS. Database management system software consists

of several software components that handle various tasks such as data definition,

data manipulation, data security, data integrity, data recovery and performance

optimization. One general function provided by the DBMS is thus the shielding of

database from complex hardware-level detail. The DBMS controls the access and

helps to maintain the consistency of the data.

Application programs are most commonly used to access data found within the

database to generate reports, tabulations, and other information to facilitate decision

making. Utilities are the software tools used to help manage the database system.

For example, all major DBMS provide graphical user interfaces (GUIs) to help

create database structures, control database access, and monitor database operations.

Data: It is the most important component of DBMS environment from the end

users point of  view. The database contains operational data and the meta-data (data

about data). The database should contain all the data needed by the organization.

The major feature of databases is that the actual data and the programs that uses

the data are separated from each other. For effective storage and retrieval of

information, data is organized as fields, records and files.

Assume a box containing a collection of cards which stores the Admission Number,

Name, Batch, Result, Marks of  students in a class. Each card will have the same

format but the data written on them is different as in Figure 8.2.

Fig. 8.1: Database system environment
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Fields: A field is the smallest unit of stored data. Each field consists of data of a

specific type. In Figure 8.2 Adm. No., Name, Batch, Result, and Marks are the

fields.

Record: A record is a collection of  related fields. In the Figure 8.2, each card in the

box contains the related fields of  a record. For example, the fields 103, Mohanan,

Science, Pass, and 520 constitute a record.

File: A file is a collection of  all occurrences of  same type of  records. The box

shown in Figure 8.2 may be considered as a file.

Users: There are a number of users who can access data on demand using

application programs. The users of  a database system can be classified depending

on the mode of  their interactions with DBMS. The different categories of  users are

Database Administrator (DBA), Application Programmers, Sophisticated users

and Naive Users.

Procedures:  Procedures refer to the instructions and rules that govern the design

and use of the database. The users of the system and the person that manages the

database require documented procedures on how to use or run the system. These

may consist of  instruction on how to:

i. log onto the DBMS.

ii. use a particular DBMS facility or application program.

iii. start and stop the DBMS.

iv. make backup copies of the database or handle hardware or software

failures

v. reorganise the database across multiple disks, improve performance, or

archive data to secondary storage.

Fig. 8.2: Concept of data organisation
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8.3 Data abstraction and data independence

For the system to be usable, it must retrieve data efficiently. The need for efficiency

has led designers to use complex data structures to represent data in the database.

Since many database system users are

not computer trained, developers hide

the complexity from users through

several levels of abstraction. The data

in a DBMS is described at three levels

of abstraction, as illustrated in Figure

8.3. The database description consists

of  a structure at each of  these three

levels of abstraction: the physical level,

conceptual level and view level.

a. Physical level

The lowest level of abstraction describes how data is actually stored on secondary

storage devices such as disks and tapes. The physical level describes complex low-

level data structures in detail. We must decide what file organisations are to be used

to store the relations and create auxiliary data structures, called indexes, to speed

up data retrieval operations.

A sample physical schema for the SWS database follows:

• Store all relations as unsorted files of  records. (A file in a DBMS is either a

collection of records or a collection of data)

• Create indexes on the first column of the files Student, School, and Course.

b. Logical level

The next-higher level of abstraction describes what data is stored in the database,

and what relationships exist among those data. The logical level thus describes the

entire database in terms of  a small number of  relatively simple structures. Although

Fig. 8.3: Levels of abstraction

Know your progress

1. Data about data is called ________.

2. List the name of major components of a database system?

3. Categorize the following components of DBMS environment.

Hard disk, Switch, DBA, Payroll system, End user, railway

reservation system.
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implementation of  the simple structures at the logical level may involve complex

physical-level structures, the user of  the logical level does not need to be aware of

this complexity. Database administrators, who must decide what information to

keep in the database, use the logical level of abstraction. Logical level is also referred

as conceptual level.

c. View level

View level is the highest level of  database abstraction and is the closest to the users.

It is concerned with the way in which individual users view the data. It describes

only a part of the entire database. Most of the users of the database are not concerned

with all the information that is contained in the database. Instead they need only a

part of the database that is relevant to them. This simplifies their interaction with

the system. The system may provide many views for the same database. Figure 8.4

shows the three levels of  data abstraction for a STUDENT  file with fields AdmNo,

Name, Batch, Result, Marks.

Fig. 8.4: Example for levels of abstraction

8.3.1 Data independence

Since a database may be viewed through three levels of abstraction, any change in

the database structure at a particular level may affect the schema of  other levels.

The frequent changes made on database should not lead to the redesigning and re-

implementation of the database. The ability to modify the schema definition (data

structure definition) in one level without affecting the schema definition at the next
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higher level is called data independence. There are two levels of data independence,

physical data independence and logical data independence.

a. Physical data independence

Physical data independence refers to the ability to modify the schema followed at

the physical level without affecting the schema followed at the conceptual level.

That is, the application programs remain the same even though the schema at physical

level gets modified.

b. Logical data independence

Logical data independence refers to the ability to modify a conceptual schema

without causing any changes in the schema followed at view (external) level. The

logical data independence ensures that the application programs remain the same.

It is more difficult to achieve logical data independence than physical data

independence because the application programs are heavily dependent on the logical

structure of  the database.

8.4 Users of database

Depending on the degrees of expertise or the mode of the interactions with DBMS

the users of a database system can be classified into the following groups:

• Database Administrator (DBA)

• Application Programmers

• Sophisticated Users

• Naive Users

8.4.1 Database Administrator

The person who is responsible for the control of the centralized and shared database

is the Database Administrator (DBA). The DBA is responsible for many critical

tasks such as,

Design of the conceptual and physical schemas: The DBA is responsible for

interacting with the users of the system to understand what data is to be stored in

the DBMS and how it is likely to be used. Based on this knowledge, the DBA must

design the conceptual schema and the physical schema.

Security and authorization: The DBA is responsible for ensuring authorized access

of  data. For example, in a school, teachers allow students to find out course details,

results of the student and the details as to who teaches a particular subject. At the

same time students shall not be permitted to see teachers' salaries or grades of
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other students. The DBA can enforce this policy by giving permission to students

to read only the course view.

Data availability and recovery from failures: The DBA must take steps to restore

the data to a consistent state when the system fails to complete a transaction or in

case of  a system crash. The DBMS provides software support for  these functions,

but the DBA is responsible for implementing procedures to back up the data

periodically and maintain logs (special files for storing all activities in a database

such as insertion, deletion, updation etc.) of system activity (to  facilitate recovery

from a crash).

8.4.2 Application programmers

Application programmers are computer professionals who interact with the DBMS

through application programs. Application programs are programs written in any

host language (for example Visual Basic, C, C ++, Java, etc.) and interact with the

DBMS through Data Manipulation Language (DML). Application programs should

ideally access data through the external schema.

8.4.3 Sophisticated users

Sophisticated users include engineers, scientists, business analysts, and others who

are thoroughly familiar with the facilities of  the DBMS. They interact with the systems

through their own queries (a request to a database) to meet their complex

requirements.

8.4.4 Naive users

Naive users interact with the system by invoking one of the application programs

that were written previously. They are not concerned with or even aware of  the

details of  the DBMS. Naive users deal only with the higher level of  abstraction.

People accessing data over the web, clerical staff  in an office, billing clerk in a

supermarket or hotels, bank clerk, etc. are examples of  some naive users.

Know your progress

1. The person who interacts with the database through query

language is called ________

2. The billing clerk in a Supermarket is a ________ user.

3. Who provides data security in a database?

4. Who changes the structure of  a database?

5. ________ interacts with the database through the prewritten

application program.
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8.5 Relational data model

The relational data model represents database as a collection of  tables called relations,

each of which is assigned a unique name. In relational model, both data and the

relationships among them are represented in tabular form. This representation

enables even beginners to understand the concepts of  a database easily.

Edgar Frank Codd (19 August 1923 - 18 April 2003)

was an English computer scientist who invented the

relational model for database management. He was

born on the Isle of Portland in England. He served

as a pilot in the Royal Air Force during the Second World War. In

1948, he joined IBM.  He received the Turing Award in 1981. He

died of heart failure at his home in Williams Island, Florida, at

the age of 79 on 18 April 2003.

Today, a vast majority of  database products are based on the relational model and

they are known as Relational DataBase Management System (RDBMS). The major

advantages of the relational model over the other data models are its simple data

representation and the ease with which even complex queries can be expressed. The

popular RDBMS are Oracle, Microsoft SQL Server, MySQL, DB2, Informix and

Ingress. Most commercial relational database systems offer a query language that

includes Structured Query Language (SQL), Query-by-Example (QBE) or Datalog.

We shall study the widely used query language SQL in the Chapter 9.

8.6 Terminologies in RDBMS

Before discussing the operations on relational databases, let us be familiar with

some terminologies associated with RDBMS.

a. Entity

An entity is a person or a thing in the real world that is distinguishable from others.

For example, each student is an entity, and each school can be considered as another

entity.

b. Relation

Relation is a collection of  data elements organized in terms of  rows and columns.

A relation is also called Table. A sample relation named STUDENT is shown in

Table 8.1.
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c. Tuple

The rows (records) of  a relation are generally referred to as tuples. A row consists

of  a complete set of  values used to represent a particular entity. In Table 8.1, each

row in the STUDENT relation represents the result of a particular student.

d. Attribute

The columns of  a relation are called attributes. AdmNo, Roll, Name, Batch, Marks

and Result are attributes of the STUDENT relation. The values of each attribute

are taken from the range of possible values called domain.

e. Degree

The number of  attributes in a relation determines the degree of  a relation. The

relation STUDENT has six columns or attributes and therefore the degree of the

STUDENT relation is 6.

f. Cardinality

The number of rows or tuples in a relation is called cardinality of the relation. The

relation STUDENT has eight tuples and hence the cardinality of the STUDENT

relation is 8.

g. Domain

A domain is a pool of values from which actual values appearing in a given column

are drawn. For example, the domain of  the column Batch in the relation STUDENT

shown in Table 8.1 is the set of  values {Science, Humanities, Commerce}. That is,

AdmNo Roll Name Batch Marks Result

101 24 Sachin Science 480 EHS

102 14 Rahul Commerce 410 EHS

103 4 Fathima Humanities 200 NHS

104 12 Mahesh Commerce 180 NHS

105 24 Nelson Humanities 385 EHS

106 8 Joseph Commerce 350 EHS

107 24 Shaji Humanities 205 NHS

108 2 Bincy Science 300 EHS

STUDENT relation

Table. 8.1: A sample relation
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any one of  the values from this set only can appear in the column Batch. Similarly,

the set {EHS, NHS} is the domain of  the column Results.

h. Schema

The description or structure of  a database is called the database schema, which is

specified during database design. In the relational model, the schema for a relation

specifies its name, the name of each column, and the type of each column. As an

example, student information in a School database may be stored in a relation with

the following structure:

STUDENT (Admno : integer,

Roll : integer,

Name : character(50),

Batch : character(20),

Marks : decimal,

Result : character(4))

i. Instance

An instance of a relation is a set of tuples in which each tuple has the same number

of fields as the relational schema. The preceding schema says that each row in the

STUDENT relation has six columns, with column names and types as indicated.

An example for instance of  the STUDENT relation is shown in Table 8.1.

Know your progress

1. Organization of  data in terms of  rows and columns is called

________.

2. ________  in a table gives the complete data of a particular

entity.

3. Number of rows in a relation is called ________.

4. Number of ________ in a relation is called degree of the

relation.

5. In the relational model, data is organised as ________.

8.6.1 Keys

A relation is defined as a set of  tuples. All the tuples in a relation must be distinct.

That is, no two tuples can have the same combination of  values for all their attributes.

Therefore there should be a way to identify a tuple in a relation. The concept of a

key allows us to make such distinctions. A key is an attribute or a collection of

attributes in a relation that uniquely distinguishes each tuples from other tuples in a
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given relation. If a key consists of more than one attribute then it is called a  composite

key. In the extreme, the entire tuple is the key since each tuple in the relation is

guaranteed to be unique. However, we are interested in smaller keys, if  they exist,

for a number of  practical reasons.

a. Candidate key

A candidate key is the minimal set of attributes that uniquely identifies a row in a

relation. In the STUDENT relation of  Table 8.1, AdmNo can uniquely identify a

row. Therefore it can be considered as a candidate key. There may be more than

one candidate key in a relation. Also, a candidate key need not be just one single

attribute. It can be a composite key. For example, a combination of  Roll, Batch

and Marks can also be used to identify a particular student. Therefore, Roll + Batch

+ Year can be considered as another candidate key of  STUDENT relation.

b. Primary key

A primary key is one of the candidate keys chosen to be the unique identifier for

that table by the database designer. A primary key is a set of  one or more attributes

that can uniquely identify tuples within the relation. As it uniquely identifies each

entity, it cannot contain null value and duplicate value.

Candidate keys are considered as candidates for primary key position. From the

candidate keys the one with the least number of attributes may be selected as primary

key. In our example (STUDENT relation), the attribute AdmNo  can be used as the

primary key. That is, no two students in the STUDENT relation can have the same

AdmNo. In Table 8.1, we can see unique values in the column Name, but in real

case scenario, more than one student can have the same name.

c. Alternate key

A candidate key that is not the primary key is called an alternate key. In the case of

two or more candidate keys, only one of  them can serve as the primary key. The

rest of  them are alternate keys. In our example the combination of  Roll + Batch +

Year is the alternate key since AdmNo is taken as the primary key.

d. Foreign key

A key in a table can be called foreign key if it is a primary key in another table. Since

a foreign key can be used to link two or more tables it is also called a reference key.

Suppose we have used Batch code instead of  Batch name as shown in Table 8.2 and

we have a relation BATCH as shown in Table 8.3. It is clear that BatchCode is the

primary key in relation Batch, but it is used in STUDENT table as a non-key attribute.

So, BatchCode is referred to as a foreign key with respect to STUDENT relation.
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Know your progress

1. The minimal set of

attributes that uniquely

identifies a row in a

relation is ________

2. In a table Employee

Emp_code, Pan_no

are the candidate keys.

If Emp_code is taken

as the primary key then

Pan_no  is ________ key.

3. How many primary keys are possible in a relation?

4. If a key consists of more than one attributes then it is called

________

AdmNo Roll Name BatchCode Marks Result

101 24 Sachin S2 480 EHS

102 14 Rahul C2 410 EHS

103 4 Fathima H2 200 NHS

104 12 Mahesh C2 180 NHS

105 24 Nelson H2 385 EHS

106 8 Joseph C2 350 EHS

107 24 Shaji H2 205 NHS

108 2 Bincy S2 300 EHS

STUDENT relation

Table 8.2: Modified STUDENT relation

BatchCode BatchName Strength

S1 Science 150

S2 Science 150

C1 Commerce 100

C2 Commerce 100

H1 Humanities 100

H2 Humanities 100

BATCH relation

Table 8.3: Instance of Batch relation

8.7 Relational algebra

We have discussed the features of  relational model, which provides facilities for

craeting a database. Once the database is designed and data is stored, the required

information is to be retrieved. A variety of  operations are provided by RDBMS.

The collection of operations that is used to manipulate the entire relations of a

database is known as relational algebra. These operations are performed with the
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help of a special language associated with the relational model, called query language.
We will learn this language in the next chapter to perform these operations. The
operations involved in relational algebra take one or two relations as input and
produces a new relation as the result. The fundamental operations in relational algebra
are SELECT, PROJECT, UNION, INTERSECTION, SET DIFFERENCE,
CARTESIAN PRODUCT, etc. The SELECT and PROJECT operations are unary
operations because they operate on one relation. The remaining operations are
binary operations as they operate on pairs of  relations.

8.7.1 SELECT operation

SELECT operation is used to select rows from a relation that satisfies a given
predicate. The predicate is a user defined condition to select rows of user's choice.
This operation is denoted using lower case letter sigma (σ ). The general format of
select is as follows:

σ condition (Relation)
The result of SELECT operation is another relation containing all the rows satisfying
the given predicate (or conditions). The relational algebra uses various comparison
operators < (less than), <= (less than or equal to), > (greater than), >= (greater
than or equal to), = (equal to) and < > (not equal to) to set up simple conditions,
and logical operators ∨  (OR),  ∧ (AND) and ! (NOT) to construct composite
conditions.
To illustrate the SELECT operation, consider the relation STUDENT given in Table
8.1. The following examples show how SELECT operations are expressed in
relational algebra and what output they produce.
Example 8.1: To select all the students who are eligible for higher studies.

σ Result="EHS" (STUDENT)

The output of this
operation is a relation
as shown in Table 8.4.

Example 8.2: To select
all the students in the
Commerce batch who
are failed.

AdmNo Roll Name Batch Marks Result

101 24 Sachin Science 480 EHS

102 14 Rahul Commerce 410 EHS

105 24 Nelson Humanities 385 EHS

106 8 Joseph Commerce 350 EHS

108 2 Bincy Science 300 EHS
Table 8.4: Output of Example 8.1
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σ Result="NHS" ∧  Batch="Commerce" (STUDENT)
The result of this
operation is a relation
as shown in Table 8.5

Example 8.3:  To select all the students in the batch Science or Commerce.
σ Batch="Science" ∨  Batch="Commerce" (STUDENT)

Table 8.6 shows the
output this operation.

AdmNo Roll Name Batch Marks Result

101 24 Sachin Science 480 EHS

102 14 Rahul Commerce 410 EHS

104 12 Mahesh Commerce 180 NHS

106 8 Joseph Commerce 350 EHS

108 2 Bincy Science 300 EHS
Table 8.6: Output of Example 8.3

Table 8.5: Output of Example 8.2

AdmNo Roll Name Batch Marks Result

104 12 Mahesh Commerce 180 NHS

8.7.2 PROJECT operation

The PROJECT operation selects certain attributes from the table and forms a new
relation. If  the user is interested in selecting the values of  a few attributes, rather
than all the attributes of the relation, then use PROJECT operation. It is denoted by
lower case letter π . The general format of  project operation is as follows:

π A1, A2,…., An (Relation)
Here A1, A2, . . . ., An refer to the various attributes that would make up the
relation specified.
Example 8.4:  Select Name, Result and
Marks attributes in STUDENT relation.

π Name, Marks, Result (STUDENT)
The output of  this operation is given in Table
8.7.
It is possible to combine the SELECT and
PROJECT operations into a single statement.
The illustration of this is shown in Examples
8.5 and 8.6.

Table 8.7: Output relation of Example 8.4

Name Marks Result

Sachin 480 EHS
Rahul 410 EHS

Fathima 200 NHS
Mahesh 180 NHS
Nelson 385 EHS
Joseph 350 EHS
Shaji 205 NHS
Bincy 300 EHS
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Example 8.5: To select admission number and name
of  students who are Eligible for Higher Studies.

π AdmNo, Name (σ result="EHS" (STUDENT))

The resultant relation of  this operation is given in Table
8.8. Compare it with Table 8.4 for the verfication of
correctness of the result.

Example 8.6: To select name and marks of  those
students in the Humanities batch who are Not eligible
for Higher Studies.

π Name, Marks (σ result="NHS" ∧ Batch="Humanities" (STUDENT))

The result of  this nested operation is shown in Table
8.9.

8.7.3 UNION operation

UNION operation is a binary operation and it returns a relation containing all tuples
appearing in either or both of  the two specified relations. It is denoted by . The
two relations must be union-compatible, and the schema of the result is defined to
be identical to the schema of the first relation. If two relations are union-compatible,
then they have the same number of  attributes, and corresponding attributes, taken
in order from left to right, have the same domain. Note that attribute names are not
used in defining union-compatibility.

Consider two relations ARTS and SPORTS given in Tables 8.10 and 8.11 containing
the details of students who participate in the arts festival and the sports meet of a
school, respectively. Both the relations ARTS and SPORTS consist of  AdmNo,
Name and BatchCode as fields. It is clear that that these two relations are union

Table 8.8: Output relation of
Example 8.5

AdmNo Name

101 Sachin
102 Rahul
105 Nelson
106 Joseph
108 Bincy

Table 8.9: Output relation of
Example 8.6

Name Marks

Fathima 200

Shaji 205

Table 8.10: Instance of ARTS relation

AdmNo Name BatchCode

101 Sachin S2
103 Fathima H2
106 Joseph C2
110 Nikitha S1
132 Vivek C1
154 Nevin C1

ARTS relation AdmNo Name BatchCode

102 Rahul C2
103 Fathima H2
105 Nelson H2
106 Joseph C2
108 Bincy S2
132 Vivek C1
164 Rachana S1

Table 8.11: Instance of SPORTS relation

SPORTS relation
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compatible. That is, the two relations have the same number of  attributes and the
type of the corresponding attributes are also the same.

Relation ARTS SPORTS returns the
details of the students participated in arts
or sports or both. That is, the expression
ARTS SPORTS returns a table as shown
in Table 8.12. This table consists of  the
records belonging to the tables ARTS or
SPORTS or both, eliminating the
duplication. In Table 8.12, we can see that
records of students with admission
numbers 103, 106, and 132 appear only
once in the relation.

8.7.4  INTERSECTION operation

INTERSECTION operation is also a binary operation and it returns a relation
containing the tuples appearing in both of  the two specified relations. It is denoted
by . The two relations must be union-compatible, and the schema of the result is
defined to be identical to the schema of the first relation.

If  we apply INTERSECT operation on the relations in Tables 8.10 and 8.11, the
expression ARTS SPORTS returns the
details of the students participated in both
arts and sports. That is ARTS SPORTS
returns a table consisting of rows
common to ARTS and SPORTS as shown
in Table 8.13.

8.7.5 SET DIFFERENCE operation

SET DIFFERENCE operation is also a binary operation and it returns a relation
containing the tuples appearing in the first relation but not in the second relation. It
is denoted by - (minus). The two relations must be union-compatible, and the
schema of the result is defined to be identical to the schema of the first relation.

The result of  SET DIFFERENCE operation ARTS - SPORTS on Tables 8.10 and
8.11  returns the details of  the students participated in arts but not in sports. That is,
the resultant table will contain the rows appearing in relation ARTS but not in relation
SPORTS as given in Table 8.14.

Table. 8.12: Relation of ARTS U SPORTS

AdmNo Name BatchCode

101 Sachin S2
103 Fathima H2
106 Joseph C2
110 Nikitha S1
132 Vivek C1
154 Nevin C1
102 Rahul C2
105 Nelson H2
108 Bincy S2
164 Rachana S1

Table. 8.13: Relation of ARTS  SPORTS

AdmNo Name BatchCode

103 Fathima H2

106 Joseph C2

132 Vivek C1
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Relation SPORTS - ARTS returns the
details of the students participated in
sports but not in arts as shown in Table
8.15.

Union and Intersection operations are
commutative, that is the order of relation
is not important. For example, the result
of ARTS U SPORTS and SPORTS U
ARTS are same. Also the result of
ARTS SPORTS and SPORTS ARTS
are the same. But Set Difference operation
is not commutative, that is the order of
relation is important. For example, the
result of ARTS - SPORTS  and SPORTS
- ARTS are not same (refer to Tables 8.14 and 8.15).

8.7.6 CARTESIAN PRODUCT operation

CARTESIAN PRODUCT returns a relation consisting of all possible combinations
of  tuples from two relations. It is a binary operation on relations, which has a degree
(number of attributes) equal to the sum of the degrees of the two relations operated
upon. The cardinality (number of tuples) of the new relation is the product of the
number of tuples of the two relations operated upon. CARTESIAN PRODUCT is
denoted by ×  (cross). It is also called CROSS PRODUCT. All the tuples of  the first
relation are concatenated with tuples of  the second relation to form tuples of  the
new relation.

Let us consider a relation TEACHER as shown in Table 8.16, which contains the
details of  teachers in the school. We can use this relation to perform cartesian
production operation with STUDENT
relation in Table 8.2. The output of  the
operation STUDENT× TEACHER is
shown in Table 8.17. This table shows that
each record of STUDENT relation is
concatenated with the rows in TEACHER
relation.

TeacherId Name Dept

1001 Viswesaran English

1002 Meenakshi Computer
Table 8.16: Instance of TEACHER relation

TEACHER relation

Table. 8.15: Relation of SPORTS - ARTS

AdmNo Name BatchCode

101 Rahul C2
105 Nelson H2
108 Bincy S2
164 Rachana S1

Table. 8.14: Relation of ARTS - SPORTS

AdmNo Name BatchCode

101 Sachin S2
110 Nikitha S1
154 Nevin C1
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Let us conclude

We have discussed the basic concepts of DBMS and its components. The advantages
of database over traditional file system have been detailed. A brief idea about
various terminologies associated with database is presented in the context of
relational data model. Once the data is organised systematically in database, the
operations provided by relational algebra to generate required information are

A Database model defines the logical design of data. The model describes
the relationships between different parts of the data. The different
models used in database design are Hierarchical Model, Network Model,
Relational Model and Object-Oriented Model. Hierarchical structures

were widely used in the early mainframe database management systems, such as the
Information Management System (IMS) by IBM. Popular DBMS product in Network
model were Cincom Systems' Total and Cullinet's IDMS.

Adm Roll Name Batch  Marks Result TeacherId Name Dept
No Code

101 24 Sachin S2 480 EHS 1001 Viswesaran English

101 24 Sachin S2 480 EHS 1002 Meenakshi Computer

102 14 Rahul C2 410 EHS 1001 Viswesaran English

102 14 Rahul C2 410 EHS 1002 Meenakshi Computer

103 4 Fathima H2 200 NHS 1001 Viswesaran English
103 4 Fathima H2 200 NHS 1002 Meenakshi Computer

104 12 Mahesh C2 180 NHS 1001 Viswesaran English

104 12 Mahesh C2 180 NHS 1002 Meenakshi Computer

105 24 Nelson H2 385 EHS 1001 Viswesaran English
105 24 Nelson H2 385 EHS 1002 Meenakshi Computer

106 8 Joseph C2 350 EHS 1001 Viswesaran English

106 8 Joseph C2 350 EHS 1002 Meenakshi Computer

107 24 Shaji H2 205 NHS 1001 Viswesaran English
107 24 Shaji H2 205 NHS 1002 Meenakshi Computer

108 2 Bincy S2 300 EHS 1001 Viswesaran English

108 2 Bincy S2 300 EHS 1002 Meenakshi Computer
Table 8.17: Result of STUDENT X TEACHER operation
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experienced with the help of  sample relations. A good understanding about the
concepts introduced by this chapter is essential to learn the next chapter effectively.
In that chapter we will discuss how database is created and information is retrieved
using a query language.

Let us assess
1. Who is responsible for managing and controlling the activities associated with

the database?
a. Database administrator b. Programmer
c. Naive user d. End user

2. In the relational model, cardinality is the
a. number of tuples b. number of  attributes
c. number of tables d. number of constraints

3. Cartesian product in relational algebra is
a. a Unary operator b. a Binary operator
c. a Ternary operator d. not defined

4. Abstraction of the database can be viewed as
a. two levels b. four levels
c. three levels d. one level

5. In a relational model, relations are termed as
a. tuples b. attributes
c. tables d. rows

6. In the abstraction of a database system the external level is the
a. physical level b. logical level
c. conceptual level d. view level

7. Related fields in a database are grouped to form a
a. data file b. data record
c. menu d.bank

8. A relational database developer refers to a record as
a. criteria b. relation
c. tuple d. attribute

9. An advantage of the database management approach is
a. data is dependent on programs
b. data redundancy increases
c. data is integrated and can be accessed by multiple programs
d. none of the above
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10. Data independence means
a. data is defined separately and not included in programs
b. programs are not dependent on the physical attributes of  data
c. programs are not dependent on the logical attributes of data
d. both (b) and (c)

11. Key to represent relationship between tables is called
a. primary key b. candidate Key
c. foreign Key d. alternate Key

12. Which of the following operations is used if we are interested only in certain
columns of a table?
a. PROJECTION b. SELECTION
c. UNION d. SELECT

13. Which of the following operations need the participating relations to be union
compatible?
a. UNION b. INTERSECTION
c. SET DIFFERENCE d. All of the above

14. Which database level is closest to the users?
a. External b. Internal
c. Physical d. Conceptual

15. The result of the UNION operation between R1 and R2 is a relation that
includes
a. all the tuples of R1
b. all the tuples of  R2
c. all the tuples of R1 and R2
d. all the tuples of R1 and R2 which have common columns

16. A file manipulation command that extracts some of the records from a file is
called
a. SELECT b. PROJECT
c. JOIN d. PRODUCT

17. An instance of  relational schema R (A, B, C) has distinct values of  A including
NULL values. Which one of  the following is true?
a. A is a candidate key b. A is not a candidate key
c. A is a primary Key d. Both (a) and (c)
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18. How many distinct tuples are there  in a relation instance with cardinality 22?
a. 22 b. 11
c. 1 d. None

19. A set of possible data values is called
a. Attribute b. Degree
c. Tuple d. Domain

20. Why should you choose a database system instead of simply storing data in
conventional files?

21. Explain the different levels of data abstraction in DBMS?
22. How are schema layers related to the concepts of logical and physical data

independence?
23. Consider the instance of  the EMPLOYEE relation shown in the following

table. Identify the attributes, degree, cardinality and domain of  Name and
Emp_code.

Reg_no Name Batch Result Marks

101 Sachin Science Pass 480
103 Fathima Humanities Fail 200
106 Joseph Commerce Pass 350
108 Bincy Science Pass 300

Emp_Code Name Department Designation Salary

1000 Sudheesh Purchase Manager 25000

1001 Dhanya Sales Manager 25000

1002 Fathima Marketing Clerk 12000

1003 Shajan Sales Clerk 13000

24. Identify primary key, candidate keys and alternate keys in the instance of
EMPLOYEE relation in Question 23.

25. Consider the instance of the STUDENT relation shown in the following table.
Assume Reg_no as the primary key.
a. Identify the candidate keys and alternate keys in the STUDENT relation.
b. How are the primary key and the candidate key related?
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26. What is a database? Describe the advantages and disadvantages of  using DBMS.
27. What is data independence? Explain the difference between physical and logical

data independence.
28. Enforcement of  standard is an essential feature of  DBMS. How are these

standards applicable in a database?
29. Cardinality of a table T1 is 10 and of table T2 is 8 and the two relations are

union compatible. If the cardinality of result T1 T2 is 13, then what is the
cardinality of  T1 T2? Justify your answer..

30. Cardinality of a table T1 is 10 and of table T2 is 8 and the two relations are
union compatible
a. What will be the maximum possible cardinality of T1 T2?

b. What will be the minimum possible cardinality of T1 T2?
31. Consider the relations, City (city_name, state) and Hotel (name, address,

city_name). Answer the following queries in relational algebra
a. Find the names and address of hotels in Kochi.
b. List the details of cities in Kerala state.
c. List the names of  the hotels in Thrissur.
d. Find the names of  different hotels.
e. Find the names of hotels in Kozhikode or Munnar .

32. Using the instance of  the EMPLOYEE relation shown in question 23, write
the result of  the following relational algebra expressions.
a. σ Department="Sales" (EMPLOYEE).
b. σ salary>20000 ∧  Department="Sales" (EMPLOYEE).
c. σ salary>20000 ∨  Department="Sales" (EMPLOYEE).
d. π name, salary (EMPLOYEE).
e. π name, salary (σ Designation="Manager" (EMPLOYEE)).
f. π name, Department (σ Designation="Clerk" ^ salary > 20000 (EMPLOYEE)).

33. Consider the instance of  the BORROWER  and DEPOSITOR relations shown
in following figure which stores the details of customers in a Bank. Answer the
following queries in relational algebra.
a. Display the details of the customers who are either a depositor or a

borrower.
b. Display the name of  customers who are both a depositor and a borrower.
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Acc_No Name Amount

AC123 Albin 50000

AC103 Rasheeda 25000

AC106 Vishnu 25000

AC108 Aiswarya 30000

Acc_No Name Amount

AC123 Albin 500

AC105 Shabana 25000

AC116 Vishnu 125000

AC108 Aiswarya 3000

BORROWER DEPOSITOR

Acc_No Name Branch_ID Amount

AC123 Albin B1001 50000

AC103 Rasheeda B1001 25000

AC106 Vishnu B1001 25000

AC108 Aiswarya B1077 30000

CUSTOMER

Branch_ID Name

B1001 Kochi

B1002 Guruvayur

B1077 Idukki

BRANCH

c. Display the details of  the customers who are depositors but not borrowers.
d. Display the name and amount of customer who is a borrower but not

depositor.

34. Consider the instance of the CUSTOMER and BRANCH relations shown in
the following table. Write the Cartesian Product of  the two relations.
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Structured Query
Language

Significant Learning Outcomes

After the completion of this chapter, the

learner

• recognises the importance and

features of Structured Query

Language.

• explains the components of SQL.

• distinguishes the features of DDL,

DML and DCL commands.

• identifies the characteristics of

MySQL.

• lists different data types and their

features.

• explains the effect of different

constraints in SQL.

• performs operations using DDL

commands like CREATE, ALTER,

DROP.

• uses DML commands like SELECT,

INSERT, UPDATE, DELETE for data

manipulation.

• identifies various clauses

associated with SQL commands and

their purpose.

• uses operators for setting different

conditions.

• lists different aggregate functions

and explains their usage.

• constructs nested queries for

information retrieval.

I
n the last chapter, we discussed the

Relational Database Management System

(RDBMS). We know that relational

database is a set of related data stored in tables

called relations. We also have a basic idea about

relational algebra, which deals with various

operations performed on relations. Now, we

need more clarity on these operations which

include creating a table, inserting data into a

table, manipulating the data stored in a table

and deleting data from a table, modifying the

structure of  a table, removing a table, etc. on

a relational database. This chapter introduces

a language called Structured Query Language

(SQL) for these operations. Most of  the

relational database management systems like

MySQL, Oracle, Sybase, Informix, Postgres,

SQL Server and MS Access use SQL as

standard database language. We use one of  the

most popular open source RDBMS, like

MySQL, to implement Structured Query

Language.

9.1 Structured Query Language

Structured Query Language (SQL) is a

language designed for managing data in

relational database management system

(RDBMS). SQL provides an easy and efficient

9
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way to interact with relational databases. There are numerous versions of  SQL. The

original version was developed in the 1970’s by Donald D. Chamberlin and Raymond

F. Boyce at IBM's San Jose Research Laboratory (now the Almanden Research

Centre). This language was originally called Structured English Query Language

(Sequel) and later its name was changed to SQL. In 1986, American National

Standard Institute (ANSI) published an SQL standard.

As we know a relational database system is a structured collection of  tables

(relations) and the data is stored in these tables. Tables are uniquely identified by

their names and are comprised of  columns and rows. A column (field) in a table

represents a particular type of  information. In a table, each row represents a

collection of  related data. We know that rows in a table are known as tuples (or

records) and columns are known as attributes.

Examine the following table, named "Student" (refer to Table 9.1)

and answer the questions given below for recollecting the basic

terminologies related to database.
Let us do

i. The cardinality of the table is _________.

ii. The degree of the table is _________.

iii. List out the different tuples in the table.

iv. List out the different attributes in the table.

v. What are the values in the domain of the attribute 'Course'?

SQL is a powerful tool for implementing RDBMS. It provides facilities to create a

table, insert data into a table, retrieve information from a table, modify data in the

table, delete the existing data from a table, modify the structure of  a table, remove

a table from a database, etc.

Table 9.1: Student table

Adm_no Name Gender Date_Birth Income Course

1001 Alok M 2/10/1998 24000 Science

1002 Nike M 26/11/1998 35000 Science

1003 Bharath M 1/1/1999 45000 Commerce

1004 Virat M 5/12/1998 22000 Science

1005 Meera F 15/8/1998 Science

1006 Divakar M 21/2/1998 Humanities
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9.1.1 Features of SQL

Structured Query Language is an ANSI/ISO standard language for writing database

queries. A query is a request to a database. It can perform all the relational operations

mentioned earlier. SQL is effective in framing queries because of  the following

features:

• SQL is a relational database language, not a programming language like C,

C++.

• It is simple, flexible and powerful.

• It provides commands to create and modify tables, insert data into tables,

manipulate data in the tables etc.

• It gives guidelines to major popular RDBMS like Oracle, SQL Server, MySQL,

MS Access, Sybase, Informix and Postgres to perform database operations.

• SQL is a non-procedural language since it describes what data to retrieve,

delete, or insert, rather than how to perform the operation.

• As part of  ensuring data security, SQL provides facility to add or remove

different types of  access permissions to users on databases or tables.

• It provides the concept of views (This concept will be discussed later in this

chapter).

9.1.2 Components of SQL

SQL has three components, namely Data Definition Language (DDL), Data

Manipulation language (DML) and Data Control Language (DCL). Let us discuss

these components and their roles in developing RDBMS.

Data Definition Language

Consider Table 9.1 (Student table). How can we create such a table?  Is it possible

to add a new column to this table? How can we remove a table from the database?

The Data Definition Language (DDL) will give solutions to all these questions.

DDL is a component of SQL that provides commands to deal with the schema

(structure) definition of  the RDBMS. The DDL commands are used to create,

modify and remove the database objects such as tables, views and keys. The common

DDL commands are CREATE, ALTER, and DROP.

Data Manipulation Language

In Table 9.1, we can see several tuples (or rows or records). How are these tuples

inserted into the table? Suppose the monthly family income of a particular student

is to be modified. Is it possible? How can we delete the record of a student from
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the table? The Data Manipulation Language (DML) provides commands for these

types of  manipulations.

DML is a component of SQL that enhances efficient user interaction with the database

system by providing a set of  commands. DML permits users to insert data into

tables, retrieve existing data, delete data from tables and modify the stored data.

The common DML commands are SELECT, INSERT, UPDATE and DELETE.

Data Control Language

Data Control Language (DCL) is used to control access to the database, which is

very essential to a database system with respect to security concerns. DCL includes

commands that control a database, including administering privileges and committing

data. The commands GRANT and REVOKE are used as a part of DCL.

GRANT : Allows access privileges to the users to the database.

REVOKE : Withdraws user's access privileges given by using GRANT command.

Know your progress

1. SQL stands for __________.

2. Which are the three components of SQL?

3. SQL can be used to:

a. create database structures only. b. query database data only.

c. modify database data only. d. All of these can be done by

SQL.

4. SQL is:

a. a programming language. b. an operating system.

c. a data sublanguage. d. a DBMS.

5. Which of the following is not an RDBMS package?

a. ORACLE b. SQL SERVER c. MySQL d. HTML

9.2 Working on MySQL

The American National Standards Institute (ANSI) in 1986, and the International

Organization for Standardization (ISO) in 1987, standardised SQL. Since 1986, the

SQL standard has been evolving to include a larger set of  features. The standard

has been revised several times and several versions exist. SQL:2011 is the seventh

revision of the ISO and ANSI  standard for the SQL database query language. It

was formally adopted in December 2011. Despite the existence of  such standards,

the different database software packages provide their own versions of the standard
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ANSI SQL. Therefore, most SQL codes are not completely portable among different

database software without adjustments. In this chapter, SQL will be discussed using

open source database software MySQL.

MySQL is a free, fast, easy-to-use RDBMS, used for many applications. It is

developed, marketed, and supported by MySQL AB, which is a Swedish company.

MySQL is becoming very popular for many reasons:

• MySQL is released under an open-source license. So it is customizable.

• It provides high security to the database.

• It is portable as it works on many operating systems and with many languages

including PHP, PERL, C, C++, JAVA, etc.

• MySQL works rapidly and effectively even with large volume of data.

• It is highly compatible with PHP, one of  the popular languages for web

development.

MySQL was developed by Michael "Monty" Widenius and David Axmark

in 1995. It was originally owned by a Swedish company called MySQL

AB, and was bought over by Sun Microsystems in 2008. Sun Microsystems

was acquired by Oracle in 2010.

MySQL is often deployed in a Linux-Apache-MySQL-PHP (LAMP), Windows-Apache-

MySQL-PHP (WAMP), or Mac-Apache-MySQL-PHP (MAMP) environment. All components

in LAMP are free and open-source, inclusive of the Operating System. The official site

for MySQL is  www.mysql.com. The reference for MySQL is the "MySQL Reference

Manual", available at http://dev.mysql.com/doc

9.2.1 Opening MySQL

We can work on MySQL by giving commands at the mysql> prompt. In Ubuntu

Linux, we have to open the Terminal window using the following command sequence

to get this prompt:

Applications → Accessories → Terminal

In the Terminal window we give the following command to start MySQL:

mysql -u root -p

MySQL in Windows OS can be opened by proceeding as follows:

Start → Programs → MySQL → MySQL Server (version number) → MySQL

command line client

Downloaded from https:// www.studiestoday.com

Downloaded from https:// www.studiestoday.com



Computer Applications (Humanities) - XII

248

When we open MySQL, it may ask for the password for verification. (Here we

should use the same password that we entered during the installation process). After

the password verification, we will get the prompt of MySQL as shown in Figure

9.1.

Fig 9.1: MySQL prompt at Ubuntu Linux Terminal window

The prompt gives us the message that MySQL is ready to accept any query from the

user. Now we can input our queries at this prompt.

To exit from MySQL, give the command QUIT or EXIT at the prompt as:

mysql> EXIT;

9.2.2 Creating a database

We need to create a database before we work on the data. The database is the

container in which we store the tables. To create a database in MySQL, we use the

CREATE DATABASE command. The syntax is as follows:

CREATE DATABASE <database_name>;

While creating a database, the following points are to be remembered:

• The <database_name> in the syntax indicates the name of the database that

we want to create. It is recommended that the database name should be as

meaningful and descriptive as possible.

SQL is not case sensitive. That is, commands can be given in the upper or

the lower case or even in a mix. But hereafter, we will use some styles to

distinguish SQL commands and keywords from other texts. Commands

and keywords will be specified in the upper case letters, whereas user-

defined words such as table name, column name etc. will be in the lower case. Commands

and outputs (or responses) can be stored in a text file after using the command tee.

For example, tee E:\outputs.txt will create a file outputs.txt in E: drive to store

whatever appears in the screen after the execution of this command. In this chapter

the outputs stored in this file will be presented as figures.
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• The <database_name> should be unique. We cannot have two databases

with the same name in a MySQL database server.

Let us start our database operations

with the creation of a new database

called "school". Figure 9.2 shows the

screen shot after the execution of the

command. We can see the MySQL

command prompt and the command

in the first line. The second line is the

message returned by MySQL as a

response to the command being executed. From the message, it is clear that a new

database with the name school has been created successfully. (Note that here onwards we

will avoid such screen shots as figures, instead the command required for the specified operation

will be presented in a separate font.)

9.2.3 Opening database

To perform operations on a database, we have to open it explicitly. When we open

a database, it becomes the active database in the MySQL server. MySQL gives a

command USE to open a database. The syntax is:

USE <database_name>;

Let us open the data base school using the command as follows:

USE school;

The response of this command after the execution is given below:

Database changed

Now the database named school is the active database in our system. That means, the

different DDL, DML and DCL commands we execute hereafter will be related to

the database school. We can check the existence of  a database. The SHOW DATABASE

command is used to check whether a database exists or not. It will list the entire

databases in our system. The syntax is:

SHOW DATABASES;

The output of this command is shown in Figure 9.3.

9.2.4 Data types in SQL

Data type defines the type of value that may be

entered in the column of a table. Data types ensure

Fig. 9.2: MySQL window after the execution
 of a command

Fig. 9.3: Output of SHOW
DATABSES command
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the correctness of  the data, if  we use them in a meaningful way. Care should be

taken to assign correct data types for columns during the designing of the database.

For example, if  the numeric value 2 is designated as a text data type, such as a

string, then it cannot be used in a mathematical operation; whereas the same number

stored in an integer column can be used mathematically. So, let us understand the

concept of SQL data types like, the type of data they represent, range of values

supported by each of them, etc. Data types differ in different versions of SQL.

Here, we look at the different data types available in MySQL.

MySQL data types are classified into three. They are numeric data type, string (text)

data type, and date and time data type. All numerical values like 7, 100.234, -456, 0,

etc. can be represented by any of  the numeric data types. The data "Aleena" (name

of a student), "Kerala" (name of a state), 'F' (specification of a gender), etc. are

string type by nature. Data like '01-01-2020', '23:34:3' can be represented by Date

and Time data types.

a. Numeric Data types

Numeric data type values can be used like any normal number. They can be added,

subtracted, multiplied and divided. The most commonly used numeric data types

in MySQL are INT or INTEGER and DEC or DECIMAL.

(i) INT or INTEGER

As we know, integers are whole numbers without a fractional part. They can be

positive, zero or negative. An integer value can be represented in MySQL by INT

or INTEGER data type. The data items like 69, 0, -112 belong to INT data type.

(ii) DEC or DECIMAL

Numbers with fractional parts can be represented by DEC or DECIMAL data type.

The standard form of  this type is DECIMAL(size,D) or DEC(size,D). The

parameter size indicates the total number of digits the value contains including

decimal part. The parameter D represents the number of digits after the decimal

point. For example, the type specification DEC(5,2) or DECIMAL(5,2) denotes

that 5 is the precision and 2 is the scale. The column with this specification is able to

store any value having a maximum of  five digits, out of  which two are after the

decimal point. That is, the range of  values will be from  -999.99 to 999.99.

Table 9.2 shows an overview of  numeric data types in MySQL. Remember that the

values are version dependent.
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b. String (Text) data types

String is a group of  characters. The most commonly used string data types in MySQL

are CHARACTER or CHAR and VARCHAR.

(i) CHAR or CHARACTER

Character includes letters, digits, special symbols etc. The CHAR is a fixed length

character data type. The syntax of this data type is CHAR(x), where x is the maximum

number of characters that constitutes the data. The value of x can be between 0

and 255. CHAR is mainly used when the data in a column are of the same fixed

length and small in size. For example, if  we want to store data like 'M' for male and

'F' for female, in the column Gender of a table, it is better to declare that column as

of  type CHAR. It always uses the specified amount of space even though the data

Usage

Very small

integer values

A small integer

A medium-

sized integer

value

Normal sized

integer value

Large integer

value

Floating point

numbers

A double

precision

floating-point

number

Store exact

precision

values

Signed

-128 to 127

-32768 to 32767

-8388608 to

8388607

2147483648 to

2147483647

Value up to 19 digits

Decimal precision

can go to 24 places

Decimal precision

can go to 53 places

A Decimal type can

store a Maximum of

65 Digits, with 30

digits after decimal

point.

Unsigned

0 to 255

0 to 65535

0 to 16777215

0 to

4294967295

Value up to 264

Storage in

Bytes

1

2

3

4

8

4

8

8

Table 9.2: Numeric data types of MySQL and their characteristics

Data types

TINY INT

SMALL INT

MEDIUM INT

INT

BIG INT

FLOAT(M,D)

DOUBLE(M,D)

DECIMAL(M,D)
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need not require that much. If the number of characters in the data is less than the

declared size of the column, the remaining character positions in the string will be

filled with white spaces (spacebar character). But when we retrieve this value from

the table, all trailing spaces are removed. Note that if the size of a column of type

CHAR is 1, it is not necessary to mention the size, because the default size of CHAR

type is 1.

(ii) VARCHAR(size)

VARCHAR represents variable length strings. It is similar to CHAR, but the space

allocated for the data depends only on the actual size of the string, not on the

declared size of  the column. For example, if  we want to store data in the column

Name of a table, it is better to declare that column as of type VARCHAR, because the

data in the column may contain different number of  characters. The length of  the

string can vary from 0 to 65535 characters (MySQL version dependent). The

VARCHAR type saves memory space since VARCHAR type did not append spaces

with the values when they are stored. The data like name of people, addresses etc.

are examples of this data type.

C. Date and Time data types

MySQL has data types for storing dates and times. The data type used to store date

type value is DATE and to store time value is TIME.

(i) DATE

The DATE data type is used to store dates. MySQL represents date values in YYYY-

MM-DD format. The supported range is from 1000-01-01 to 9999-12-31. Dates

are displayed in MySQL in one format, but we can use various date formats in our

SQL statements. The YYYY-MM-DD is the standard format. But we can use any

punctuation character between the date parts. For example, '2011-01-24',

'2011/01/25', '20110126' are valid date combinations in MySQL. We can insert

date type values into a column of  DATE data type in any of  the above formats.

Although MySQL tries to interpret values in several formats, date parts must always

be given in year-month-day order (for example, '98-09-04').

(ii) TIME

The TIME data type is used to specify a column to store time values in MySQL. It

shows values in the standard HH:MM:SS format. The TIME data type can be used

to store a specific point in time (like 10 hours 05 minutes 25 seconds) as well as an

interval of  time between two points in time (like the time between now and the

weekend) that may sometimes be larger than 23 hours. When manually entering a

time into MySQL it is highly recommended that you use the exact format HH:MM:SS.
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9.3 SQL commands

SQL provides commands to perform different operations on database. As we

mentioned earlier, the commands are classified as DDL commands, DML

commands and DCL commands. Here, we will discuss the most commonly used

DDL commands and DML commands. DDL commands are used to perform

operations associated with the structure of  database. The operations include creation

of  tables, modification in the structure of  tables and removal of  tables. DML

commands are associated with the operations on the content of  tables. These

operations include insertion of  records, retrieval of  records, modification or

updation of  records and deletion of  records.

These commands will be introduced in such a way that we can create a table for

organizing data of  a particular entity, retrieve required information and remove

those we do not want to keep further.

9.4 Creating tables

Tables are the central and the most important objects in any relational database.

The primary purpose of  any database is to hold data that are stored in tables. Now

Now look at Table 9.3 and fill

the Data type column with

suitable MySQL data type for

the given data.
Let us do

Table 9.3: Data type of values

Value Data type

325.678

'A'

'Computer'

'2016-01-01'

450

22:32:45

456787

Know your progress

1. SQL stands for ___________.

2. ___________ command is used to make a database active.

3. How can we see the names of databases in the system?

4. What is the difference between CHAR and VARCHAR data types?

5. Which is the format for storing date type data in MySQL?

6. Can we store the number 234 in a column declared with CHAR(5)

data type?
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let us again consider the table student given in Table 9.1. How can we create a table

with a set of columns?  The DDL command CREATE TABLE is used to define a

table by specifying the name of the table and giving the column definitions consisting

of  name of  the column, data type and size, and constraints if  any, etc. Remember

that each table must have at least one column. The syntax of CREATE TABLE

command is:

CREATE TABLE <table_name>

(<column_name> <data_type> [<constraint>]

[, <column_name> <data_type> [<constraint>,]

..............................

..............................   );

Here, the <table_name> represents the name of the table that we want to create;

<column_name> represents the name of a column in the table; <data_type>

represents the type of data in a column of the table; and <constraint> specifies

the rules that we can set on the values of  a column. All the columns are defined

within a pair of  parentheses, and are separated by commas. We can define all the

columns even in a single line.

9.4.1 Rules for naming tables and columns

While naming the tables and columns, certain points are to be remembered and

they are listed below.

• The name may contain letters (A - Z, a - z), digits (0 - 9), under score ( _ ) and

dollar ($) symbol.

• The name must contain at least one character. (Names with only digits are

invalid).

• The name must not contain white spaces, special symbols.

• The name must not be an SQL keyword.

• The name should not duplicate with the names of other tables in the same data

base and with other columns in the same table.

In some MySQL versions, the table name can be a quoted identifier. The

identifier quote character is the backtick ("`").  If we use table name

as quoted, then we can include any special symbols in the name of the

table.

Now, let us create a table student to store the details of  a group of  higher secondary

students in a school. The fields of  the table and their descriptions are given in Table

9.4.
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The SQL statement or query to create a table in MySQL to incorporate the details

shown in Table 9.4 is given in Query 9.1.

CREATE TABLE student

(adm_no INT,

name VARCHAR(20),

gender CHAR,

dob DATE,

course VARCHAR(15),

f_income INT);

Here, the CREATE TABLE statement creates a table named student with five columns

adm_no, name, gender, dob, course and f_income. The columns adm_no can

contain  integer values, name can contain strings up to a maximum of  20 characters,

gender can store a single character indicating whether a student is a boy or a girl,

dob can store date of birth, course can contain the group in which he/she is

studying and f_income can hold the monthly income of  the family. The columns

name and course will spare only the actual space required by the respective string

data.

After creating a table, when we insert records in that table, some kind of restriction

may need to be enforced in certain columns. Restrictions may be in the form of

denying empty values in some columns and refusing duplicate values in some other

columns. But it should be addressed during the table creation itself. MySQL provides

some keywords called constraints, for this purpose.

9.4.2 Constraints

Constraints are the rules enforced on data that are entered into the column of  a

table. When we create a table, we can apply constraints on the values that can be

entered into its fields. If  this is specified in the column definition, SQL will not

Query 9.1

Table 9.4: Attributes of student table

Sl. No. Attributes Description

1 Admission number Integer value

2 Name String of 20 characters long

3 Gender A single character

4 Date of birth Date type

5 Course String of 15 characters long

6 Family income Integer value
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accept any values that violate the criteria concerned. This ensures the accuracy and

reliability of the data in the database. The constraints ensure database integrity and

hence they are often called data base integrity constraints. Constraints could be

column level or table level.

a. Column Constraints

Column constraints are applied only to individual columns. They are written

immediately after the data type of the column. The following are column constraints:

i. NOT NULL

This constraint specifies that a column can never have NULL values. NULL is a keyword

in SQL that represents an empty value. It is important to remember that NULL

does not equate to a blank or a zero; it is something else entirely. Though a blank is

equal to another blank and a zero is equal to another zero, a NULL is never equal to

anything, not even another NULL. Two NULL values cannot be added, subtracted or

compared.

ii. AUTO_INCREMENT

MySQL uses the AUTO_INCREMENT keyword to perform an auto-increment feature.

If no value is specified for the column with AUTO_INCREMENT constraint, then

MySQL will assign serial numbers automatically and insert the newly assigned value

in the corresponding column of the new record. By default, the starting value for

AUTO_INCREMENT is 1, and it will be incremented by 1 for each new record. This

special behavior also occurs if we explicitly assign the value NULL to the column.

The AUTO_INCREMENT feature makes it easy to assign a unique ID to each new

row, because MySQL generates the values for us. The auto increment column must

be defined as the primary key of the table. Only one AUTO_INCREMENT column

per table is allowed.

iii. UNIQUE

It ensures that no two rows have the same value in the column specified with this

constraint.

iv. PRIMARY KEY

This constraint declares a column as the primary key of the table. This constraint is

similar to UNIQUE constraint except that it can be applied only to one column or a

combination of  columns. The primary keys cannot contain NULL values. In other

words, it can be considered as a combination of  UNIQUE and NOT NULL constraints.

A PRIMARY KEY constraint is used to enforce a rule that a column should contain

only unique, non-NULL data.
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v. DEFAULT

Using this constraint, a default value can be set for a column, in case the user does

not provide a value for that column of a record.

Let us apply some of these constraints in the student table and modify Query 9.1 as

given in Query 9.2.

CREATE TABLE student

(adm_no INT PRIMARY KEY AUTO_INCREMENT,

name VARCHAR(20) NOT NULL,

gender CHAR DEFAULT 'M',

dob DATE,

course VARCHAR(15)

f_income INT);

In Query 9.2, the constraints PRIMARY KEY and AUTO_INCREMENT are applied to

the column adm_no. So, this column will not allow duplicate values during data

entry. If  we donot specify a value for this column, MySQL will generate a data

automatically. The constraint NOT NULL applied to the column name does not

allow to leave the column with a null value. That is, data is a must in this column.

Similarly, if  we do not give a value to the column gender, ‘M’ will be stored as the

default value.

b. Table constraints

Table constraints are similar to column constraints; the main difference is that table

constraints can be used not only on individual columns, but also on a group of

columns. When a constraint is to be applied on a group of  columns of  a table, it is

called table constraint. The table constraint appears at the end of the table definition.

For example, Query 9.3 creates a table named stock. The constraint UNIQUE is

applied to the combination of icode and iname.

CREATE TABLE stock

(icode CHAR(2) PRIMARY KEY AUTO_INCREMENT,

iname VARCHAR(30) NOT NULL,

dt_purchase DATE,

rate DECIMAL(10,2),

qty INT,

UNIQUE (icode, iname));

In Query 9.3, the constraint UNIQUE is applied to the combination of values of

columns icode and iname. It enforces a situation that no two rows can have the

same values for the columns icode and iname when taken together.

Query 9.2

Query 9.3
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9.4.3 Viewing the structure of a table

We have created two tables, student and stock. How do we know the structure of  the

table after its creation? The DESCRIBE command is used to display the structure

definitions of a table. The syntax is:

DESCRIBE <table_name>;

 OR

DESC <table_name>;

The structure of  the table student can be viewed using the command:

DESC student;

Figure 9.4 shows the output of this command.

Fig. 9.4: Structure of student table

Fig. 9.5: Output of SHOW TABLES

Write the structure of  the table stock, referring to Figure 9.4 and

Query 9.3. Verify your answer in the lab with the command, DESC

stock;
Let us do

Note that in Query 9.2, we did not mention the

size for the columns adm_no and f_income while

creating the table. But MySQL takes the default

size 11 as the size of  these two columns. The

column adm_no is declared with PRIMARY KEY

and AUTO_INCREMENT. So this column will not

allow duplicate values and null values. If  we do

not specify a value for this column, a new value will be generated by adding 1 to the

value of the respective column of the previous record. In the absence of a value for

this column for the first record, MySQL gives 1 as the value. We can also see that a

default value 'M' is set for the column gender. Figure 9.4 illustrates these aspects.

There is a command SHOW TABLES, which shows the tables created in the current

database as given in Figure 9.5.
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9.5 Inserting data into tables

We have created a database and its tables. Now we need to put some records into

these tables. We have the details of  six students in Table 9.1. Let us discuss how

these records can be inserted into the table.

The DML command INSERT INTO is used to insert tuples into tables. The syntax

is:

INSERT INTO <table_name> [<column1>,<column2>,...,<columnN>]

VALUES(<value1>,<value2>,...,<valueN>);

Here <table_name> is the name of the table into which the tuples are to be

inserted; <column1>, <column2>, …., <columnN> indicate the name of columns

in the table into which values are to be inserted; <value1>,<value2>, ….,

<valueN> are the values that are inserted into the columns specified in the

<column_list>.

For example, let us insert a new record into the table student with data 1001, 'Alok',

'M', 1998/10/2, 'Science', 24000 into the columns adm_no, name, gender, dob,

course and f_income, respectively. Query 9.4 makes it possible.

INSERT INTO student

VALUES (1001,'Alok','M','1998/10/2', 'Science',

    24000);

The response of the system will be:

Query OK, 1 row affected (0.05 sec).

Query 9.4

Know your progress

1. Which of  the following commands is used to display the structure

of a table?

a. LIST b. SHOW c. DESCRIBE d. STRUCT

2. Write the syntax of  CREATE TABLE command.

3. Name the different column constraints.

4. What is the difference between primary key constraint and unique

constraint?

5. What are the features of AUTO_INCREMENT constraint?

6. Write down the rules for naming a table.

7. How many columns in a table can be specified as primary key of

the table?
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The INSERT statement adds a new row to the table student giving a value for every

column in the table. While inserting a row, if  we provide values for all the columns

of  the table, we need not specify the name of  column(s) in the query. But we need to

make sure that the order of the values is in accordance with the order of the columns

in the table. Now let us insert another row with some modifications as shown in

Query 9.5.

INSERT INTO student (name, dob, course, f_income)

VALUES ('Nike','1998/11/26','Science',35000);

The response for this statement will be:

Query OK, 1 row affected (0.01 sec)

In Query 9.5, admission number and gender are not provided. Being a record after

the one with admission number 1001, the admission number of this student will be

1002. The gender will be set with the default value 'M'.

While inserting data into tables, the following points are to be taken care of:

• While adding a new row, we should ensure the data type of  the value and the

column matches.

• We follow the integrity constraints, if  any, defined for the table.

• CHAR or VARCHAR type data should be enclosed in single quotes or double

quotes.

• Column values for DATE type columns are to be provided within single quotes.

The string will internally be converted into DATE data type.

• Null values are specified as NULL (or null) without quotes.

• If  no data is available for all columns, then the column list must be included,

following the table name.

MySQL allows inserting several rows into a table with a single INSERT command

by specifying multiple value lists. The general format is as follows:

INSERT INTO <table-name> VALUES(...), (...), ... ;

Let us insert two more records given in Table 9.1 using Query 9.6.

INSERT INTO student (name, dob, course, f_income)

VALUES('Bharath','1999/01/01','Commerce',45000),

  ('Virat','1998/12/05','Science',22000);

The response of the system will be:

Query OK, 2 rows affected (0.02 sec)

Records: 2 Duplicates: 0  Warnings: 0

Query 9.5

Query 9.6
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We can observe that the two records are given within separate pairs of  parentheses.

The response indicates that the two records are inserted successfully.

Suppose we do not have the monthly income data of a student. How can we insert

the record? Query 9.7 illustrates the solution.

INSERT INTO student(name, dob, gender, course)

VALUES('Meera','1998/08/15','F','Science');

As a response to this query, the value for adm_no will be generated by the system,

but the value for f_income column will be kept as NULL. The order of columns is

also changed in this query. The absence of  values in a row can be managed in another

way also as shown in Query 9.8.

INSERT INTO student(name, dob, gender, course,

 f_income)

VALUES('Divakar','1998/02/21','Science',NULL);

Note that, in the VALUES clause, NULL is given for f_income.

Query 9.7

Query 9.8

Let us insert some more records in table student. Write queries to

store the details of  students shown in Table 9.5.

Let us do

Know your progress

1. Which of the following is used to add a row into a table?

a. ADD b. CREATE c. INSERT d. MAKE

2. Which statement is used to insert new data into a table?

a. ADD RECORD b. INSERT RECORD

c. INSERT INTO d. INSERT ROW

3. Write the essential keywords used along with INSERT command.

adm_no name gender dob course f_income

1025 Kaushi M 1998/10/2 Commerce 17000

1026 Niveditha F 1999/03/04 Humanities 52000

1027 Sreekumar M 1998/06/06 Science 15000

1057 Chaithanya F 1999/06/03 Science

Table 9.5: More records for Student table
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9.6 Retrieving information from tables

We have created a database school and a table student, and then inserted ten records

into it. Now let us learn how information is retrieved from the data stored in tables.

It is a kind of data manipulation operation and SQL provides the command SELECT

for this purpose. It is used to retrieve information from specified columns in a

table. The SELECT command has several forms of  its own. The simplest form of

SELECT command is:

SELECT <column_name>[,<column_name>,<column_name>, ...]

FROM <table_name>;

Here <column_name> indicates the column from which data is retrieved and

<table_name> denotes the name of  the table from which the information is

retrieved. The name of the table is given with the keyword FROM, which is an essential

clause with SELECT command. The SELECT command will display the data in

columns, in the order in which they appear along with the SELECT command.

Now let us illustrate the execution of SELECT

command through various queries. On executing

Query 9.9 we get the name and course of students

in the table student as shown in Figure 9.6.

SELECT name, course

FROM student;

If we want to display the entire column values of

a table, we need not give a complete list of

columns of the relation. Instead, an asterisk (*)

symbol can be used to substitute the complete

list of columns as shown in Query 9.10. The output

is shown in Figure 9.7.

SELECT * FROM student;

Write SQL statements to insert some records in the table stock created

using Query 9.3. While giving values to the columns, utilise the facility

of  AUTO_INCREMENT and UNIQUE constraints.
Let us do

Query 9.9

Fig. 9.6: Output of Query 9.9

Query 9.10
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We can see NULL values in column f_income of  some rows in Figure 9.7. It is due

to the missing of values in the insertion of those rows (refer Queries 9.7, 9.8 and

Table 9.1, and 9.5).

9.6.1 Eliminating duplicate values in columns using DISTINCT

Suppose we want to know the names of different courses in the table student. If we

construct a query SELECT course FROM student; it will display the column

course with all the ten values as shown in Figure 9.7. Data will be selected from all

rows of  the relation to display, even if  the data appearing in the result get duplicated.

This duplication can be eliminated using the keyword DISTINCT as given in Query

9.11. Observe the output given in Figure 9.8.

SELECT DISTINCT course

FROM student;

In the output, there are no duplicate values. If

the column used with DISTINCT keyword

contains more than one NULL value, only one

will be shown in the result.

If we give the keyword ALL in the place of

DISTINCT, then the result will contain all the

duplicate values in the column. That is, the

output will be the same as that in the case when

we neither specify DISTINCT nor ALL.

9.6.2 Selecting specific rows using WHERE clause

In certain situations, we need to display only a subset of  a table. For example, we

may require the details of  female students only, or the details of  students whose

family monthly income is below Rs. 25000/-. In these cases, there is a selection in

Fig. 9.8: Use of DISTINCT

Query 9.11

Fig. 9.7: Entire content of student table
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the retrieval of  records. Obviously the selection is based on some condition(s).

SQL enables us to impose some selection criteria for the retrieval of records with

WHERE clause of SELECT command. The syntax of SELECT command with WHERE

clause is:

SELECT <column_name>[,<column_name>,<column_name>, ...]

FROM <table_name>

WHERE <condition>;

When a WHERE clause is present, the SELECT command goes through the entire

table one row at a time and examines whether the row satisfies the condition(s) or

not. If a row satisfies the condition, that row is displayed in the output. The conditions

are expressed with the help of  relational operators and logical operators. MySQL

provides a variety of  such operators and they are listed in Table 9.6.

Query 9.12

Fig. 9.9: List of female students - the output of Query 9.12

Operator Meaning/Result

= Equal to

<> or != Not equal to

> Greater than

< Less than

>= Greater than or equal to

<= Less than or equal to

NOT True when condition is false

AND True if  both the conditions are true

OR True if  either of  the conditions is trueL
o

gi
ca

l

o
p

er
at

o
rs

R
el

at
io

n
al

 O
p

er
at

o
rs

Table 9.6: Operators used for setting conditions

Let us write an SQL statement to display the details of female students in the table.

Query 9.12 is the required statement which contains a WHERE clause and = operator

for setting the condition and Figure 9.9 shows the output.

SELECT * FROM student

WHERE gender='F';
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Suppose we want to see the name, course and monthly family income of only the

Science group students whose income is below Rs. 25000. Here we have to constitute

two conditions - one for checking the income and the other for checking the course.

When these two conditions are matched while going through the records in the

table, the values of their name, course and f_income columns will be retrieved

for display. Query 9.13 is the required query and Figure 9.10 shows the output.

Note that AND operator is used to combine the two conditions.

SELECT name, course, f_income FROM student

WHERE course='Science' AND f_income<25000;

Write a query to display the name, course

and monthly income of students studying

in courses other than Science group (i.e.,

the students of Commerce and Humanities

groups).

While writing the above query, you might

have used OR operator for setting the

condition. The same information can be obtained by the use of  NOT operator.

Query 9.14 illustrates this and Figure 9.11 shows the corresponding output.

SELECT name, course, f_income FROM student

WHERE NOT course='Science';

Identify some requirements with respect

to the table stock which can be attained

by setting different conditions, and

construct queries using appropriate

operators.

SQL has a set of special operators for

setting conditions. These include

BETWEEN...AND, IN, LIKE and IS. Let us discuss how these operators help us to

constitute conditions.

a. Condition based on a range of values

A range of values can be given as condition. The SQL operator BETWEEN...AND

is used to specify the range. Suppose we need a list of students whose monthly

income falls in the range of  Rs. 25000/- to Rs. 45000/-. We know that this can be

obtained by the statement given in Query 9.15. Figure 9.12 shows the output.

SELECT name, f_income FROM student

WHERE f_income>=25000 AND f_income<=45000;

Query 9.13

Fig. 9.10: Use of AND operator

Query 9.14

Fig. 9.11: Use of NOT operator

Query 9.15
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The same output can be obtained by using the statement given in Query 9.16. In this

statement the operator BETWEEN...AND is used to construct the condition. The

output includes both the lower and upper values given in the range.

SELECT name, f_income FROM student

WHERE f_income BETWEEN 25000 AND 45000;

From Query 9.16 and Figure 9.12, we can

conclude that the BETWEEN...AND operator

allows specifying a range of values which belong

to either numeric or date and time type data.

b. Conditions based on a list of values

While setting conditions for the retrieval of

records, a list of  values can be provided. The

values may be of any data type, but it should match with those of the column used

in the condition. In such a case, the operator IN is used with the list. Suppose we

want to retrieve the details of  students in Commerce and Humanities groups. The

statement in Query 9.17 can generate the details as shown in Figure 9.13.

SELECT * FROM student

WHERE course='Commerce' OR course='Humanities';
Query 9.17

Fig. 9.12: Use of BETWEEN...AND
operator

Fig. 9.13: Output of Query 9.17

Query 9.16

The same output can be obtained by using IN operator in the condition as shown in

Query 9.18.

SELECT * FROM student

WHERE course IN('Commerce', 'Humanities');

As we see in Query 9.18, the IN operator checks whether the value in the specified

column (here it is course) of a record matches any of the values in the given list.

When matches are found while going through the records, they will be displayed.

Since there are only three courses in the table, the result shown in Figure 9.13 can

also be obtained using Query 9.19.

SELECT * FROM student

WHERE course NOT IN('Science');

Query 9.18

Query 9.19
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c. Conditions based on pattern matching

There may be the need of  retrieving data based on some pattern matching. That is,

string data having some similarities in characters may be the criterion for the retrieval

of  records. SQL provides a pattern matching operator LIKE for this purpose.

Patterns are specified using two special wildcard characters % and _ (underscore),

where % (percentage) matches a substring of characters and _ (underscore) matches

a single character. Patterns are case sensitive; i.e.; uppercase characters do not match

lower case characters. Consider the following examples:

• "Ab%"  matches any string beginning with "Ab".

• "%cat%" matches any string containing "cat" as substring. For example,

"education", "indication", "catering" etc.

• "_ _ _ _" matches any string of exactly four characters without any space in

between them.

• "_ _ _ %" matches any string of  at least 3 characters.

Query 9.20 illustrates the use of  LIKE operator. It gives a list of  names in the table

that end with the substring 'ar'. Figure 9.14 shows the output of  this query.

SELECT name FROM student

WHERE name LIKE '%ar';

The following query will display only 'Divakar'

since there are two _ (underscore) characters for

pattern matching.

SELECT name FROM student

WHERE name LIKE 'Div__ar';

d. Conditions based on NULL value search

We have seen that there may be NULL values in

some fields of  a record. We can retrieve such

records with the help of  IS operator. The

condition will be true when the specified column

contains a NULL value in the records. In the student

table, the f_income column contains NULL value

in three records (refer to Figure 9.7). Query 9.21

retrieves these records and Figure 9.15 shows

the output.

SELECT name, course FROM student

WHERE f_income IS NULL;

Query 9.21

Query 9.20

Fig. 9.14: Use of pattern matching

Fig. 9.15: NULL value checking
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On the other hand, if we want to retrieve the records containing non-null values in

the f_income column, the following statement can fulfill the task:

SELECT name, course FROM student

WHERE f_income IS NOT NULL;

Identify some requirements with respect to the table stock which need

the use of  the special SQL operators we discussed, and construct

queries to solve the problems.
Let us do

9.6.3 Sorting results using ORDER BY clause

As we can see in the results of the SELECT queries discussed so far, the records are

always obtained in the order in which they appear in the table. Is it possible to

display them in a specific order - ascending or descending, of some column values?

Yes. The result of  a query can be sorted in the ascending or descending order by

making use of ORDER BY clause. The order is to be specified by using the keyword

ASC (for ascending) or DESC (for descending) along with the column name that is

used with ORDER BY clause. By default, the display will be in the ascending order.

Remember that only the results that appear on the screen are sorted. The order of

records in the table will be kept unaltered.

Query 9.22 will display the details of students in the alphabetical order of their

names. Figure 9.16 shows the output.

SELECT * FROM student ORDER BY name;

Know your progress

1. Name the keyword used with SELECT command to avoid

duplication in the values of a column.

2. Which is the essential clause for SELECT query?

3. Which of the following operators is used to check for NULL value

in a column?

a. IN b. LIKE c. IS d. NOT

4. The operator used for checking pattern matching is _________.

5. What is wrong with the following statement?

SELECT * FROM emp WHERE grade = NULL;

6. The command that extracts records from a table is _________.

Query 9.22
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Suppose we want to see the details according to their monthly family income. If we

have to obtain the result from the highest income to the lowest, Query 9.23 can

serve the purpose. Figure 9.17 shows the output.

SELECT * FROM student

ORDER BY f_income DESC;

Fig. 9.16: Details of students according to the alphabetical order of their names

As shown in Figure 9.17, if the column used with ORDER BY clause contains NULL

values, they will be listed last.

Multiple sorting can be performed after selection with the help of  ORDER BY

clause. For example, if  we need a course-based listing of  students in the alphabetical

order of  their names, a statement as given in Query 9.24 can be used. Figure 9.18

shows its output.

SELECT name, course FROM student

ORDER BY course, name;

Query 9.23

Query 9.24

Fig. 9.17: Age-based listing of students (younger to older)
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Look at the output shown in Figure 9.18. First

the values in the column course is arranged

alphabetically and then the names are arranged

under each course.

Earlier we have used the WHERE clause for

condition based retrieval of  records. The

retrieved records can be displayed in a

particular order using ORDER BY clause.

Suppose we want to display the name and

family income of Science group students

according to the descending order of income.

The two clauses can be combined to generate

this output as shown in Query 9.25. The

output is shown in Figure 9.19.

SELECT name, course, f_income FROM student

WHERE course='Science'

ORDER BY f_income DESC;

As shown in Figure 9.19, the records

with NULL values in the sorted column

will appear at last as they appear in the

table. Another important aspect is that,

if an ORDER BY clause is used in a

SELECT statement, it should appear

only after the WHERE clause, if  any.

Because, the records should be

selected first, then only they are given

for reordering.

Fig. 9.18: Multiple sorting

Fig. 9.19: Condition based selection and sorting

Query 9.25

Know your progress

1. What is the meaning of ORDER BY clause ?

2. Which keyword is used for sorting the data in descending order

in MySQL?

a. DESC b. ASC c. SORT d. MODIFY

3. In which order are the records displayed in the absence of ORDER

BY clause.

4. In SQL, what is the default sort order of the ORDER BY clause?
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Table 9.7: Some built-in functions of MySQL

9.6.4  Aggregate functions

MySQL provides a number of built-in functions that can be applied to all rows in a

table or to a subset of the table specified by WHERE clause. These functions are

called aggregate functions because they operate on aggregate of  tuples (records).

The result of  an aggregate function is a single value.

Commonly used aggregate functions are given in Table 9.7.

Function Return value

SUM() Total of  the values in the column specified as argument.

AVG() Average of  the values in the column specified as argument.

MIN() Smallest value in the column specified as argument.

MAX() Largest of the values in the column specified as argument.

COUNT() Number of non NULL values in the column specified as argument.

Let us discuss these functions to generate useful information from the table. Query

9.26 gives the highest, lowest and average family monthly incomes of  the students.

Figure 9.20 shows the result.

SELECT MAX(f_income), MIN(f_income), AVG(f_income)

FROM student;

While calculating

these values, the

NULL values in the

argument column are

not considered.

These functions can be applied to a subset of  the table formed by some selection

crierion as shown in Query 9.27. It gives the number of  students in the Science group.

Figure 9.21 shows the output.

SELECT COUNT(*), COUNT(f_income)

FROM student

WHERE course='Science';

Identify some requirements with respect to the table stock which need

the sorting of  records based on different conditions, and construct

queries to solve the problems.
Let us do

Query 9.26

Fig. 9.20: Use of aggregate functions

Query 9.27
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If we refer to Figure 9.19, we can see that

the correct answer is 7. Then, why is there a

mismatch between the two column values

in Figure 9.21? The first column is

COUNT(*) and it gives the number of

records having Science as the value in column

course. Note that the * (asterisk) symbol stands for the collection of all the columns

in the table. So, if  there is at least one field in a record, that record will be taken into

consideration for COUNT(*). But COUNT(f_income) in Query 9.27 counts only

the non-NULL values in column f_income of the records which contains Science in

column course. This is why the second column in Figure 9.21 contains only 4.

Refer to Figure 9.17 and identify the rows that conatins NULL in column f_income.

9.6.5 Grouping of records using GROUP BY clause

Sometimes, we need to divide the tuples in a table into different groups based on

the values in a column. The rows of a table can be grouped together based on a

common value using the GROUP BY clause. The attribute (column) specified in the

GROUP BY clause is used to form groups. Tuples with the same value in the attribute

specified in the GROUP BY clause are placed together in one group. Thus different

groups are formed based on distinct values in the column. So this process can be

considered as categorisation of  records.

Using Query 9.27, number of students in Science group is obtained. Suppose we

want to know the number of students in each group along with average family

monthly income. Query 9.28 can be used. The output is shown in Figure 9.22.

SELECT course, COUNT(*),AVG(f_income)

FROM student

GROUP BY course;

Here different groups are

formed under different values

('Commerce', 'Humanities' and

'Science') in column course and

the functions COUNT(*) and

AVG(f_income) are applied

to each group.

9.6.6  Applying conditions to form groups using HAVING clause

We have already learnt about the WHERE clause, which places conditions on individual

rows. We can apply conditions to form groups with the help of  HAVING clause.

Query 9.28

Fig. 9.21: Use of COUNT() function

Fig. 9.22: Grouping of rows using GROUP BY clause
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This clause is used along with GROUP BY clause. The condition in HAVING clause is

applied to form groups of  records, not individual rows.

Query 9.29 applies a condition for forming groups. Here the groups will be formed

only if the condition provided with HAVING clause is satisfied.

SELECT course, COUNT(*) FROM student

GROUP BY course

HAVING COUNT(*) > 3;

If we refer to Figures 9.22 and 9.23, we can find

that only Science group has more than 3 students.

Groups are not formed based on values 'Commerce'

and 'Humanities', since the number of records with

each of  these values are 2 and 1, respectively. That

is why details of these groups are not shown by Query 9.29.

Query 9.29

Fig. 9.23: Condition based
grouping

9.7 Modifying data in tables

In certain situations, we need to change the values in the columns of  a table. For

example, following a revision in salary or wages, the family monthly income of  a

student may be changed. Similarly, the missing values (NULL) in monthly income of

some students may need to be replaced by valid data at a later stage. This kind of

changes can be done using the DML command UPDATE. It changes the values in

one or more columns of  specified rows. These changes may be affected in all or

only in selected rows of the table. The new data for the column within these rows is

given using the keyword SET, which is the essential clause of  UPDATE command.

The new data can be a constant, an expression or data from other tables.

Know your progress

1. List the aggregate functions of  SQL.

2. How do COUNT(*) and COUNT(column_name) differ?

3. What is the difference between WHERE clause and HAVING clause?

4. The usage SUM(*) or MAX(*) is invalid. Why?

5. What will be the result of the following query?

SELECT COUNT(DISTINCT course) FROM student;

Identify some queries with respect to the table stock which requires

the utilisation of  aggregate functions and ORDER BY clause. Write

SQL statements to answer these queries.
Let us do
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The syntax of UPDATE command is:

UPDATE <table_name>

SET <column_name> = <value> [,<column_name> = <value>,...]

[WHERE <condition>];

Suppose the family monthly income of  the student Kaushi is to be changed to Rs.

27000/-. Query 9.30 can perform this modification.

UPDATE student

SET f_income=27000

WHERE name='Kaushi';

After the execution of  this query, the response of  MySQL will be as follows:

Query OK, 1 row affected (0.08 sec)

Rows matched: 1  Changed: 1  Warnings: 0

Let us see the change in the record using the query,

SELECT * FROM student WHERE name='Kaushi';

The output of this query is shown in Figure 9.24. Compare this figure with Figure

9.17 and see the change.

Query 9.30

Fig. 9.24: Details of Kaushi with modified data in f_income column

We can use expressions to set the column values in records. Query 9.31 illustrates

this concept.

UPDATE student

SET f_income=f_income+1000

WHERE f_income<25000;

The output of this query will be as follows:

Query OK, 3 rows affected (0.06 sec)

Rows matched: 3  Changed: 3  Warnings: 0

The output reveals that three records satisfy the given condition and hence the

values in f_income column of these records are incremented by 1000 (refer to

Figures 9.17, 9.25).

The columns with NULL values can also be modified with UPDATE command. Suppose

we want to store Rs. 20000/- as the monthly income in the respective field of  the

Query 9.31
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records in which the column contains NULL value at present. Query 9.32 makes it

possible.

UPDATE student

SET f_income=20000

WHERE f_income IS NULL;

The changes made by Queries 9.31 and 9.32 can be observed in Figure 9.25, which

is obtained by the query: SELECT * FROM student;

Query 9.32

Fig. 9.25: Modifications in column f_income

9.8 Changing the structure of a table

In some situations, we may need to modify the structure of  tables. It is an operation

related to the schema and hence SQL provides a DDL command ALTER TABLE

to modify the structure of  a table. The alteration will be in the form of  adding or

dropping column(s), changing the data type and size of existing column(s), renaming

a table, etc. Let us see how these changes are incorporated.

9.8.1 Adding a new column

One or more columns can be added at any position in an existing table. The syntax

for adding a new column to a table is:

ALTER TABLE <table_name>

ADD <column_name> <data_type>[<size>] [<constraint>]

[FIRST | AFTER <column_name>];

With respect to the table stock, write SQL statements to make some

modifications in some column values.

Let us do
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Here the <table_name> indicates the name of the table which is to be altered;

ADD is the keyword to add the new column; <column_name> <data_type>

[<size>] indicates the description of the new column. FIRST | AFTER indicates

the position of the newly added column.

If  we want to add a column at the first position, use the clause FIRST. If  we want to

add a column at a specified position, use the clause AFTER <column_name>.

Note that if we do not specify the position of the new column, then by default, it

will be added as the last column of the table. Remember that the newly added

column contains only NULL values.

Let us add two columns gr_mks and reg_no in the table student to hold the

grace marks awarded to the students and their register number for the Higher

Secondary examinations, respectively. Query 9.33 can make these changes in the

structure of  the table.

ALTER TABLE student

ADD gr_mks INTEGER AFTER dob,

ADD reg_no INTEGER;

The response of MySQL for this query will be as follows:

Query OK, 10 rows affected (0.25 sec)

Records: 10  Duplicates: 0  Warnings: 0

9.8.2 Changing the definition of a column

We can modify the characteristics of  a column like data type, size and/or constraints

by using the clause MODIFY with ALTER TABLE command. The syntax to modify

the definition of a column is:

ALTER TABLE <table_name>

MODIFY <column_name> <data_type>[<size>] [<constraint>];

Let us modify the newly added column reg_no by providing a constraint UNIQUE

to ensure that no two students have the same register number. Query 9.34 makes

this change.

ALTER TABLE student

MODIFY reg_no INTEGER UNIQUE;

The response of  MySQL will be the same as that we obtained for Query 9.30. We

can observe the changes made by the Queries 9.33 and 9.34 using the command:

DESC student;. The output is shown in Figure 9.26.

Query 9.33

Query 9.34
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We can see from Figure 9.26 that column gr_mks is added after dob and reg_no

as the last column. Also note that column Key for reg_no contains UNIQUE

constraint. Now, if  we see the contents in the new columns using the command

SELECT * FROM student;, we can see NULL values as shown in Figure 9.27.

Fig. 9.26: Structure of table student after alteration

Fig. 9.27: Contents in the new columns after modifying the structure of table student

9.8.3 Removing column from a table

If we want to remove an existing column from a table, we can use DROP clause

along with ALTER TABLE command. The syntax for removing a column from a

table is:

ALTER TABLE <table_name>

DROP <column_name>;

For example, if  we want to remove the column gr_mks from the table student,

Query 9.35 is sufficient.

Write SQL statements to fill in data in the new columns with proper

values and display the changes in the records.

Make some structural modifications in the table stock and store

values according to the changes.Let us do
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ALTER TABLE student

DROP gr_mks;

The response of MySQL will be the same as we received for the earlier ALTER

TABLE statements. The change can be observed using the command: DESC

student;

9.8.4 Renaming a table

We can rename a table in the database by using the clause RENAME TO along with

ALTER TABLE command. We can rename a table even though it contains tuples.

The syntax for renaming a table is:

ALTER TABLE <table_name>

RENAME TO <new_table_name>;

For example, if  we want to rename the table student

as student2015, Query 9.36 can help us.

ALTER TABLE student

RENAME TO student2015;

The response of this query will be as follows:

Query OK, 0 rows affected (0.06 sec)

The change can be viewed using the query: SHOW TABLES; and the output will be

as shown in Figure 9.28.

9.9 Deleting rows from a table

Sometimes we need to remove one or more records from the table. The DML

command DELETE is used to remove individual or a set of rows from a table. The

rows which are to be deleted are selected by using the WHERE clause. If the WHERE

clause is not used, all the rows in the table will be deleted. The DELETE command

removes only records and not the individual field values. The syntax of  the DELETE

command is:

DELETE FROM <table_name> [WHERE <condition>];

For example, if  the record of  Sreekumar with admission number 1027 is to be

deleted from the table, Query 9.37 can be used.

DELETE FROM student2015 WHERE adm_no=1027;

The output of this query will be: Query OK, 1 row affected (0.08 sec)

Note that the name of the table is specified as student2015, because we have renamed

the table student as student2015. The change in the table can be observed in Figure

9.29, which is obtained by the query: SELECT * FROM student2015;

Query 9.35

Query 9.37

Query 9.36

Fig. 9.28: Renaming of table
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Figure 9.29 shows only seven columns. This is because of  the removal of  column

gr_mks as a result of Query 9.35.

Fig. 9.29: Contents in the renamed table after deleting a record

9.10 Removing table from a database

If we do not need a table, it can be removed from the database using DROP TABLE

command. This DDL command removes a table from the database permanently

even though the table contains tuples. We have to be very careful while deleting any

existing table because once data is lost, it cannot be recovered later. The syntax to

remove a table is:

DROP TABLE <table_name>;

For example, if  we want to remove the table student2015 from the database school,

Query 9.38 can be used.

DROP TABLE student2015;

Know your progress

1. The command used to edit the structure of  a table is ________.

2. Restructuring of  a column affects the values in it. State whether

true or false.

3. How will you remove a column from a table?

4. Name the command used to remove a row from a table.

5. What happens when we use DELETE FROM command without a

WHERE clause?

The deletion of values in a column is not possible. The effect may be

brought out by filling the column with NULL values using UPDATE command

as follows:

UPDATE <table-name>

SET <column-name> = NULL

[WHERE <condition>];

Query 9.38
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9.11 Nested queries

We are all familiar with the concept of  nesting as we discussed it in nested if, nested

loop, etc. Now, we will discuss nested queries. We know that nested means one

inside another. Here the result of  one query is dynamically substituted in the condition

of  another. A MySQL inner query is also called sub query, while the query that

contains the sub query is called an outer query. SQL first evaluates the inner query

(sub query) within the WHERE clause and the result of inner query is then substituted

in the condition of  the outer query. While using relational operators, ensure that the

sub query (inner query) returns a single row output.

Suppose we want to display the name and course of the students who have the

highest family monthly income. Query 9.39 can perform this task and Figure 9.30

shows the output.

SELECT name, course FROM student2015

WHERE f_income=(SELECT MAX(f_income)

  FROM student2015);

In this example, the sub query (here query inside the

pair of parentheses) is evaluated first and the highest

value in f_income column (here 52000) is returned.

This value is then compared with the value in

f_income attribute of the records in the table and

when a match is found, it is retrieved by the outer

query.

9.12 Concept of views

MySQL supports the concept of  views, which is a feature of  RDBMS. A view is a

virtual table that does not really exist in the database, but is derived from one or

more tables. The table(s) from which the tuples are collected to constitute a view is

called base table(s). These tuples are not physically stored anywhere, rather the

definition of the view is stored in the database. Views are just like windows through

which we can view the desired information that is actually stored in a base table.

The contents of a view are taken from other tables depending upon a query

condition. A view can be created with the DDL command CREATE VIEW. The

syntax is:

CREATE VIEW <view_name>

AS SELECT <column_name1> [,<column_name2],...]

FROM <table_name>

[WHERE <condition>];

Query 9.39

Fig. 9.30: Result of nested query
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Let us create a view that contains the details of only those students who were born

before January 1, 1999. Query 9.40 creates this view named student1998.

CREATE VIEW student1998

AS SELECT * FROM student2015

WHERE dob < '1999-1-1';

The output of this query will be: Query OK, 0 rows affected (0.31 sec)

Figure 9.31 shows the structure of  the view and Figure 9.32 shows the contents of

the view. These can be obtained by the commands DESC student1998; and

SELECT * FROM student1998; respectively.

Query 9.40

Fig. 9.32: Contents in the view student1998

Fig. 9.31: Structure of the view student1998

Note that in Figure 9.31, the column Key does not contain the constraints of adm_no

and reg_no, and Figure 9.32 shows the details of  students born in the year 1998

only.

We can use all the DML commands with the view in quite a similar fashion as in the

case of  tables. Figure 9.32 is a result of  such a query. Remember that we are accessing

the base table though the associated views. So, take care when operations like update

and delete are performed on views as they actually reflect in the base tables.

Query 9.41 illustrates this concept.

UPDATE student1998

SET reg_no=2201020

WHERE adm_no=1001;

Query 9.41
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Let us check the data in the table 'student2015' after executing this query. Figure

9.33 shows the output of the query: SELECT * FROM student2015;

Fig. 9.33: Effect of updation in the base table through the view

The advantages of views lie in the fact that without sparing extra storage space, we

can use the same table as different tables (but virtual). Another advantage is that the

views implement sharing along with privacy. It also helps to reduce the complexity

of conditions with WHERE clause while retrieving, updating or deleting records

from tables.

If a view is no longer needed, it can be removed from the database with DROP

VIEW command. But it will not affect the base table(s). The syntax is:

DROP VIEW <view_name>;

For example, if  we want to delete the view student1998 from the database, Query

9.42 can be used.

DROP VIEW student1998;Query 9.42

Know your progress

1. What is mean by nested query?

2. What is view in SQL?

3. Creation of a view needs a SELECT command. State whether

true or false.

4. Removal of a view deletes a table from the database. State

whether true or false.

5. Can we update a table using its view?

We have discussed all the DDL and DML commands of  SQL, which

are implemented through MySQL, with examples and their outputs.

Let us summarise them in Table 9.8. The first two rows are filled in

and the remaining rows are left to you.Let us do
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Let us conclude

Structured Query Language is used to operate on relational database. MySQL is a

popular RDBMS package by which we can implement SQL commands. We have

used various DDL commands to perform operations related with the structure of

database. Constraints have been presented to ensure data validity and integrity in

database. We have also discussed different DML commands to perform operations

associated with the data contained in tables of a database. These operations include

insertion, retrieval, modification and deletion of  data in tables. We have also

familiarized ourselves with nested queries and the concept of  views. A good

understanding of this chapter is essential for your higher studies in the field of

computers.

Let us practice

1. The structure of  a table is given to store the details of  marks scored by students

in an examination.

Table 9.8: Summary of SQL command

SQL Command Essential Purpose of the command
Keyword

CREATE TABLE To create tables

ALTER TABLE ADD/MODIFY To change the structure of  tables

DROP TABLE

CREATE VIEW

DROP VIEW

INSERT

SELECT

UPDATE

DELETE

D
M

L
D

D
L

Data Type Description

Register number Numeric A unique and essential data to identify a

student

Name String A maximum of 30 characters

Course String It can be Science, Commerce or

Humanities

Marks of six subjects Numeric each Six separate columns are required
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Write SQL statements for the creation of  the table and the following

requirements:

a. Insert data into the fields (at least 10 records).

b. Display the details of  all students.

c. List the details of  Science group students.

d. Count the number of students in each course.

e. Add a new column named Total to store the total marks.

f. Fill the column Total with the sum of  the six marks of  each student.

g. Display the highest total in each group.

h. Find the highest, lowest and average score in Subject 6 in Commerce

group.

i. Display the names in the alphabetical order in each course.

j. Display the name of the student with the highest total.

2. The structure of  a table is given to store the details of  items in a computer

shop.

Data Type Description

Item number Numeric A unique and essential data to identify

an item

Item name String A maximum of 30 characters

Date of purchase Date Duplication is allowed

Unit price Fractional Number Price of a single item

Quantity Numeric Number of items

Manufacturer String Name of supplier (can duplicate)

Write SQL statements for the creation of  the table and the following

requirements:

a. Insert data into the fields (at least 10 records).

b. Display the details of all items in the table.

c. Display the names of items and total price of each.

d. List the items manufactured by a company (specify the name) avialable in the

table.

e. Find the number of  items from each manufacturer.

f. Display the details of items with the highest price.
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g. List the names of items whose price is more than the average price of all

the items.

h. Display the names of items purchased after 1-1-2015.

i. Get the details of items manufactured by two or three companies (specify

the names) avialable in the table .

j. Display the details of items from a company (specify the name) with a stock

of  more than 20 pieces.

3. The structure of  a table is given to store the details of  higher secondary school

teachers.

Data Type Description

Teacher ID Numeric A unique and essential data to identify a teacher

Name String A maximum of 30 characters

Gender Character Male or Female

Date of joining Date Duplication is allowed

Department String Science, Commerce, Humanities or Language

Basic pay Numeric Basic salary of a teacher

Write SQL statements for the creation of  the table and the following

requirements:

a. Insert data into the fields (at least 10 records).

b. Display the details of all female teachers in the table.

c. List the details of male teachers in the Science department.

d. Display the names and basic pay of teachers in the Language department

whose basic pay is Rs. 21000/- or more.

e. Display the names and 71% of  basic pay of  the teachers.

f. Find the number of teachers in each department.

g. Display the details of teachers whose basic pay is less than the average

basic pay.

h. List the male teachers who joined before 1-1-2010.

i. Increment the basic pay of  all teachers by Rs. 1000/-.

j. Delete the details of teachers from the Language department.

4. The structure of  a table is given to store the details of  customers in a bank.
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Write SQL statements for the creation of  the table and the following

requirements:

a. Insert data into the fields (at least 10 records).

b. Display the details of customers having SB account.

c. Display the names of  customers with a balance amount greater than Rs.

5000/-.

d. Display the details of female customers with a balance amount greater

than Rs. 10000/-.

e. Count the number of  male and female customers.

f. Display the names of customers with the highest balance amount.

g. Display the names of customers whose names end with 'kumar'.

h. Update the balance amount of a particular customer with a deposit amount

of  Rs. 2000/-.

i. Display the details of customers with a tax deduction of 2% of the balance

amount for those who have Rs.2,00,000/- in their account.

j. Delete the details of customers with current account.

Let us assess

1. The command to remove rows from a table 'CUSTOMER' is:

a. REMOVE FROM CUSTOMER b. DROP TABLE CUSTOMER

c. DELETE FROM CUSTOMER d. UPDATE CUSTOMER

2. If values for some columns are unknown, how is a row inserted?

3. Distinguish between CHAR and VARCHAR data types of SQL.

4. What is the difference between PRIMARY KEY and UNIQUE constraints?

5. What do you mean by NULL value in SQL?

Data Type Description

Account number Numeric A unique and essential data to identify a

customer

Name String A maximum of 30 characters

Gender Character Male or Female

Date of joining Date Duplication is allowed

Type of  account String SB or Current

Balance amount Numeric Can be a fractional number
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6. Which of the following is the correct order of clauses for the SELECT

statements?

a. SELECT, FROM, WHERE, ORDER BY

b. SELECT, FROM, ORDER BY, WHERE

c. SELECT, WHERE, FROM, ORDER BY

d. SELECT, WHERE, ORDER BY, FROM

7. The SQL operator ________ is used with pattern matching.

8. Read the following strings:

(i) 'Sree Kumar' (ii) 'Kumaran'    (iii) 'Kumar Shanu'   (iv) 'Sreekumar'

Choose the correct option that matches with the pattern '%Kumar', when used

with LIKE operator in a SELECT statement.

a. Strings (i) and (ii) only c. Strings (i) and (iii) only

b. Strings (i), (iii) and (iv) only d. All the strings

9. List any five built-in functions of SQL and the value returned by each.

10. Distinguish between WHERE clause and HAVING clause.

11. Write any four DML commands in SQL.

12. Write the essential clause required for each of  the following SQL command.

a. INSERT INTO b. SELECT c. UPDATE

13. Consider the given table Customer and write the output of the following SQL

queries:

AccNo Name Branch Amount

1001 Kumar Calicut 10000

1002 Salim Trivandrum 20000

1003 Fida Kottayam 18000

1004 John Kannur 30000

1005 Raju Thrissur 5000

a. SELECT * FROM customer WHERE Amount>25000;

b. SELECT Name FROM customer

WHERE Branch IN ('Calicut, 'Kannur');

c. SELECT COUNT(*) FROM customer WHERE Amount < 20000;

d. SELECT Name FROM customer WHERE Name LIKE "%m%";

e. SELECT * FROM customer ORDER BY Amount DESC;
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14. Distinguish between COUNT(*) and COUNT(column-name).

15. Consider the given table ITEMS.

Item Name Category Unit Sales
Code Price Price

0001 Pencil Stationery 5.00 8.00

0002 Pen Stationery 8.00 10.00

0003 NoteBook Stationery 10.00 20.00

0004 Chappal Footwear 50.00 70.00

0005 Apple Fruits 60.00 90.00

0006 Orange Fruits 40.00 60.00

0007 Pen Stationery 10.00 12.00

a. Suggest a suitable primary key for the above table. Give justification.

b. Write SQL statements for the following:

i. To list all stationery items.

ii. To list itemcode, name and profit of  all items.

iii. To count the number of  items in each category.

iv. To list all stationery items in the descending order of  their unit price.

v. To find the item with the highest selling price.

vi. To create a view that contains the details of  all stationery items.

16. What are the different modifications that can be made on the structure of  a

table? Which is the SQL command required for this? Specify the clauses needed

for each type of modification.

17. A table is created in SQL with 10 records. Which SQL command is used to

change the values in a column of  specified rows? Write the format.

18. Name the keyword used with SELECT command to avoid duplication of values

in a column.

19. Distinguish between DISTINCT and UNIQUE in SQL.

20. Pick the odd one out and give reason:

a. CREATE b. SELECT c. UPDATE d. INSERT
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After the completion of this chapter, the

learner

• identifies the various mobile

computing terminologies.

• recognises the features of mobile

operating systems.

• discovers the features of Android

operating system.

• lists and explains various

Intellectual Property Rights.

• explains  cyberspace.

• distinguishes different types of

cyber-crimes.

• details cyber law and ethics.

• identifies the importance of IT Act.

• recognise infomania.

Significant Learning Outcomes T
he use of Internet has increased
rapidly in the last few decades. The
modern society cannot think of a day

without the Internet and the services provided by
it. The developments in computer technology
have led to the development of powerful but
cheaper mobile devices. People have started
accessing these services on Internet using their
mobile devices like mobile phones, tablets, etc.

Information and Communication Technology
(ICT) is the term often used as an extended
synonym for Information Technology (IT). ICT
is more specific in integrating telecommunication
and computers. In this chapter we discuss the
different technologies and services in mobile
communication. The various mobile operating
systems available are discussed here with special
focus on Android operating system.

Similar to rights on property like land, house,
etc., intellectual properties like music, films,
software, designs, etc. have also ownership rights.
These rights are called Intellectual Property
Rights and the issues related to them are
discussed in this chapter. Every technology has
a dark side. Internet also has its share of issues
and threats. Some people use this medium for
performing illegal activities. We will discuss such
actions and how we can safeguard ourselves in
the Internet.
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10.1  Mobile computing

The advances in computer technology have led to the development of  more

computing power in small devices. Light weight computing devices with low power

consumption are now cheap and common. Devices like laptops, tablets, smart

phones, etc. have drastically changed the lifestyle and work culture of  people. Today

people are able to connect to others, send and receive files or other information

anywhere, anytime. This has increased computing demands on a daily basis.

Mobile computing is a technology that has computing capability and can transmit/

receive data while in motion. Mobile computing requires portable computing

devices like laptops, tablets, smart phones, etc., wireless communication networks

and connectivity to the Internet. The demand for mobile computing initiated the

growth and development of  mobile communication technology.

10.2  Mobile communication

The term ‘mobile’ has completely revolutionised communication by opening up

innovative ways for exchanging information. Today, mobile communication has

become the backbone of  society. Mobile system technologies have improved

standards of  living. Mobile communication networks do not depend on any physical

connection to communicate between two devices.

10.2.1  Generations in mobile communication

The mobile phone was introduced in the year 1946. In the initial stage, growth in

mobile communication was very slow. With the increase in the number of  users,

accommodating them within the limited available frequency spectrum became a

major problem. To solve this problem, the concept of  cellular communication

was evolved.The cellular concept was developed in the 1960’s at Bell Laboratories.

However, in the late 1990’s, when the

Government of  India offered spectrum

licenses for mobile communication,

cellular technology became a common

standard in our country. The different

generations in mobile communication are

given below:

a.   First Generation networks

Firsts Generation (1G) network refers to the first-generation of wireless telephone

technology (mobile telecommunications) developed around 1980. 1G mobile

phones were based on the analog system and provided basic voice facility only.
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b.   Second Generation networks

Second Generation (2G) networks follow the digital system for communication.

This improved the audio quality in transmission. In 2G networks, phone

conversations are digitally encrypted.These networks provided far greater mobile

phone coverage. 2G networks also introduced data services for mobile.  Picture

messages and Multimedia Messaging Service(MMS) were introduced. The two

popular standards introduced by 2G systems are Global System for Mobiles (GSM)

and Code Division Multiplew Access (CDMA). A detailed discussion on the GSM

and CDMA standards are given below.

i. Global System for Mobile

Global System for Mobile (GSM) is a globally accepted standard for digital cellular

communication. It is a digital, circuit-switched network for voice telephony. The

frequency band for GSM is 900 MHz to 1800 MHz. GSM follows a uniform

international standard that made it possible to use a mobile device around the

world. The network is identified using the Subscriber Identity Module (SIM). Users

can select a handset of their choice. GSM is the most successful family of cellular

standards. Let us now discuss the different technologies that are used to enhance

data communication features to GSM.

GPRS and EDGE

2G network was expanded later to include improved data communication features

using GPRS (General Packet Radio Services) and EDGE (Enhanced Data rates

for GSM Evolution).

GPRS is a packet oriented mobile data service on GSM. When compared to

conventional GSM, users of GPRS benefited from shorter access time and higher

data rates. GPRS allows billing based on the volume of  data transferred. Although

GPRS is a data only technology, it helps to improve GSM’s voice quality.

EDGE is a digital mobile phone technology that allows improved data transmission

rates for GSM. EDGE is a superset to GPRS and can function on any network

with GPRS deployed on it. It provides nearly three times faster speeds than the

GPRS system. Both the phone and the network must support EDGE, otherwise

the phone will revert automatically to GPRS.

ii. Code Division Multiple Access

In  Code Division Multiple Access (CDMA) system, several transmitters can send

information simultaneously over a single communication channel. CDMA provides

wider coverage than GSM and provides better reception even in low signal strength

conditions. The voice quality in CDMA is better than GSM. It has a signal with
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wider bandwidth and increased resistance to interference. CDMA technology

provides better security to the mobile network when compared to GSM.

c.   Third Generation networks

Third Generation (3G) wireless network technology provides high data transfer

rates for handheld devices. The high data transfer rates allow 3G networks to offer

multimedia services combining voice and data. 3G is also referred to as wireless

broadband as it has the facility to send and receive large amounts of data using a

mobile phone. The access part in 3G networks uses Wideband Code Division

Multiple Access (WCDMA). It requires upgrading the base stations (mobile towers)

and mobile phones. Besides, the base stations need to be close to each other.

d.   Fourth Generation networks

Fourth Generation (4G) system, also called Long Term Evolution (L.T.E.),

provides mobile ultra-broadband Internet access to mobile devices. 4G networks

offer very high speeds and provides excellent performance for bandwidth intensive

applications such as high quality streaming video. One of  the key requirements for

4G is a wireless IP-based access system. The access part in 4G networks uses

Orthogonal Frequency Division Multiple Access( OFDMA). 4G provides good

quality images and videos than TV.

e.   Fifth Generation networks

Fifth Generation (5G) is the next step in the evolution of mobile communication.

It will offer faster, more number of  connections, more energy-efficient and cost-

effective data communication than its predecessors. 5G will be a key component

that will help to realise the vision of  unlimited access to information and sharing of

data anywhere and anytime. 5G will also provide wireless connectivity for a wide

range of  new applications in wearable devices, smart homes, traffic safety/control,

industry applications, etc. By 2020, it is thought that 5,000 crore to 1,00,000 crore

devices will be connected to the Internet. 5G will be a wireless access solution which

is aimed at addressing the demands and requirements of mobile communication

beyond 2020.

10.2.2  Mobile communication services

Mobile communication industry uses a number of acronyms for the various

technologies that are being developed. Here, we will discuss a few popular mobile

communication technologies like SMS, MMS, GPS and smart cards.
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a.   Short Message Service

Short Message Service (SMS) is a text messaging service in mobile communication

systems that allows exchanging short text messages. SMS is the most widely used

data application by mobile phone users. The GSM standard allows to send a message

containing upto 160 characters. When a message is sent, it reaches a Short Message

Service Center (SMSC), which provides a ‘store and forward’ mechanism. SMSC

attempts to send messages to the recipients. If  a recipient is not reachable, the

SMSC waits and then retries later. Some SMSC’s also provide a ‘forward and forget’

option where transmission is tried only once and if  it fails, the message is not sent

again. SMS messages are exchanged using the protocol called Signalling System

No. 7 (SS7).

The First SMS

The first SMS message was sent on 3rdDecember 1992 from a personal

computer to a cellular phone on the Vodafone GSM network in the UK.The

content of the message was ‘Merry Christmas’.

b.   Multimedia Messaging Service

Multimedia Messaging Service (MMS) is a standard way to send and receive messages

that consists of  multimedia content using mobile phones. It is an extension of  the

capability of  SMS to send text messages. Unlike SMS, MMS does not specify a

maximum size for a multimedia message. MMS supports contents such as text,

graphics, music, video clips and more. An MMS server is responsible for storing

and handling incoming and outgoing messages. Associated with the MMS server is

the MMS proxy relay, which is responsible for transferring messages between

different messaging systems.

c.   Global Positioning System

The Global Positioning System (GPS) is a satellite based navigation system that is

used to locate a geographical position anywhere on earth, using its longitude and

latitude. GPS is designed and operated by the U.S. Department of  Defence and it

consists of  satellites, control and monitoring stations, and receivers.

The basis of the GPS is a group of satellites that are continuously orbiting the

earth. These satellites transmit radio signals that contain their exact location, time,

and other information. The radio signals from the satellites, which are monitored

and corrected by control stations, are picked up by the GPS receiver. GPS receivers

take the information transmitted from the satellites to calculate a user’s exact location

on earth. A GPS receiver needs only three satellites to plot a 2D position, which
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will not be very accurate. Ideally, four or more satellites are needed to plot a 3D

position, which is much more accurate.

Fig. 10.1: GPS fleet tracking

Global positioning satellite network

Cellular
Data

Network Internet

GPS Tracking
Application

Fig. 10.2:  A model smart card

GPS is used for vehicle fleet tracking by transporting companies to track the

movement of  their trucks. Figure 10.1 depicts the working of  a truck tracking

application using GPS. Vehicle navigation systems will direct the driver to his or

her destination through the best route. In commercial aviation GPS is used for

aircraft navigation. GPS is also used in oil exploration, farming, atmospheric studies,

etc. GPS receivers are now integrated in many mobile phones for implementing

various tracking applications.

d. Smart cards

Let us recollect about smart cards and smart card readers that we discussed in

Chapter 2 of Class XI. A smart card is a plastic card embedded with a computer

chip / memory that stores and transacts data. The advantages of using smart cards

is that it is secure (data is protected), intelligent (it

can store and process data) and that it is convenient

(it is easy to carry). That is why business firms and

other organisations use smart cards for

authentication and storing data.A model of smart

card issued by the Government of India for RSBY

scheme  is shown in Figure 10.2.
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In mobile communication, the smart card technology is used in Subscriber Identity

Modules (SIM) for GSM phone systems (refer to Figure 10.3). The smart card is

inserted or integrated into the mobile handset. The card stores personal subscriber

information and preferences. SIM cards help to identify a subscriber, roam across

networks and provide security to value added services

like Internet browsing, mobile commerce, mobile

banking, etc. Smart cards also work as credit cards, ATM

cards, fuel cards, authorisation cards for television

receiver, high-security identification cards, etc.

10.3  Mobile operating system

A mobile operating system is the operating system used in a mobile device (smart

phone, tablet, etc.), similar to an operating system used in a desktop or laptop

computer.

Fig. 10.3 : GSM SIM card

Fig. 10.4: Icons of popular mobile operating systems

A mobile OS manages the hardware, multimedia functions, Internet connectivity,

etc. in a mobile device. It is the software platform on which other programs, called

application programs, run. Popular mobile operating systems are Android from

Google, iOS from Apple, BlackBerry OS from BlackBerry and Windows Phone

from Microsoft.

Android operating system

Android is a Linux-based operating system designed mainly for touch screen mobile

devices such as smart phones and tablet computers. It was originally developed by

Android Inc. that  was founded in Palo Alto, California in 2003 by Andy Rubin and

his friends. In 2005, Google acquired Android Inc. making it a wholly owned

subsidiary of Google. At Google, the team led by Rubin developed a mobile device

platform powered by the Linux kernel. In 2007, the Open Handset Alliance, a

consortium of several companies which include Google, HTC, Intel, Motorola,

etc. was established with a goal to develop open standards for mobile devices.

Android was released along with the formation of  the Open Handset Alliance

(OHA).
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The user interface of Android is based on touch inputs like swiping, tapping, pinching

and reverse pinching to manipulate on-screen objects. Android allows users to

customise their home screens with shortcuts to applications and widgets. Since its

launch in 2007, the Android operating system’s market share has been growing at a

fast pace to make it the most widely used mobile operating system today. Major

Android versions have been developed under a codename and released according

to alphabetical order. Table 10.1 shows the Android version names.

The Android OS consists of a

kernel based on Linux kernel.

Android uses Linux kernel as it

has a powerful memory and

process management system,

permissions-based security

structure and open source

nature. An Application

Framework for developers to

build applications using the

Android Software

Development Kit is available in

Android. Android Software

Development Kit can be used to

develop applications like

Google Maps, Facebook, etc. that run on Android.

The Android code is released under the Apache License. Apache licensing allows

the software to be freely modified and distributed by device manufacturers and

developers. Android has a large community of  developers writing applications

called ‘apps’ that enhance the functionality of  devices. Apps are written using a

customised version of  the Java programming language.

The acceptance of  Android is due to factors like it’s open source nature. This makes

it easy for developers to make programs/applications for Android OS called

Android apps. Most of  these apps are available for free download from the Android

Play Store. It enhances the popularity of  this OS.

With remarkable advances in mobile hardware and software, these trimmed-down

operating systems may be heading in a direction that could replace a desktop OS. It

is also likely that mobile OS could be further developed to be included in electronic

devices like televisions, washing machines, watches, etc.

Version Code name

4.4 KitKat

4.1 Jelly Bean

4.0.3 Ice Cream Sandwich

3.1 Honeycomb

2.3 Gingerbread

2.2 Froyo

2.0 Eclair

1.6 Donut

1.5 Cupcake

Table 10.1: Android version names
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Know your progress

1. SIM is

a. Subscriber Identity Module

b. Subscriber Identity Mobile

c. Subscription Identification Module

d. Subscription Identification Mobile

2. What is a GPS?

3. The protocol used to send SMS messages is ______.

4. Name the technology used to send multimedia content using

mobile phones.

5. What are the functions of a mobile operating system?

Prepare a chart displaying the different mobile operating systems

available in the market and their features.

Let us do

10.4 Information security

Today, almost all activities that we perform in real life ,like communication, buying

goods, banking, etc. can be achieved through the Internet. While executing all these

activities, information is exchanged between computers. The security of information

passed over Internet is a primary concern. In this section, we will discuss in detail

about the cyber world and the various issues like copyright and trademark violations,

cyber crimes, etc. that we come across while surfing the Internet.

10.4.1 Intellectual Property Right

Many people are engaged in creative work like music, literary work, artistic work,

discoveries, inventions, designs and software development. These works are the

creation of the mind. They demand a lot of hard work and time. The outcome of such

work is called intellectual property. It is unjust to use the idea of a person without his

permission. The person involved in developing such properties must get the benefits

of it. So it should be protected from unauthorised access.

The importance of intellectual property was first recognised in the Paris Convention

for the Protection of Industrial Property in 1883 and the Berne Convention for the

Protection of Literary and Artistic Work in 1886. Both treaties are now administered

by the World Intellectual Property Organization (WIPO). WIPO was established in

1960 as an agency of United Nations (UN). It is dedicated to ensure that the rights
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of creators or owners of intellectual property are protected

worldwide and the inventors and authors are recognised and

rewarded by their creation. The logo of WIPO and its Indian

counterparts is given in Figure 10.5.

Intellectual Property Rights (IPR) are similar to any other

property right like right over land, house, etc. IPR refers to

the exclusive right given to a person over the creation of his/

her mind for a period of time. IPR enables people to earn

recognition and financial benefit from what they invent or

create. IPR owners can disclose their creations in exchange

for money. The company which receives the rights, markets and sells this innovation

to the society. In this way, the IPR owner, the company and the society benefit from

the creation. IPR is encouraged by UN and almost all countries worldwide with the

intention of encouraging innovations.

Each country has its own IPR registration system which is applicable to that country.

WIPO serves as an international registration system for trademark, industrial design,

etc. which is applicable to its member countries. Intellectual property is divided into

two categories - industrial property and copyright.

A. Industrial property

Industrial property right applies to industry, commerce and

agricultural products. It protects patents to inventions,

trademarks, industrial designs and geographical indications.

In India, industrial property rights can be registered with

Controller General of Patents Designs and Trademarks

under Ministry of Commerce and Industry. Logo of

Intellectual Property India is given in Figure 10.6.

Patents: A patent is the exclusive rights granted for an invention. An invention means

a new product or process (procedure) involving an inventive step, and capable of

industrial application. It is the legal right obtained by an inventor for exclusive control

over the production and sale of his/her mechanical or scientific invention for a limited

period of time. To be patentable, an invention must:

• relate to a process or product

• be new

• involve an inventive step

• be capable of industrial use

• not  be developed with the intention to harm others

Fig. 10.5: Logo of WIPO

Fig. 10.6: Logo of IP
India
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Patent protection means that the invention cannot be
commercially made, used, distributed or sold without
the patent owner's consent. A patent provides the right
to the patent owner to decide how the invention can
be used by others. The owner can sell the right to the
invention to someone else, who will then become the
new owner of the patent. The term of every patent in
India is 20 years from the date of filing of patent
application. Once a patent expires, the protection
ends and an invention can be used by the public freely.
The details of the first patent filed for a zipper is given
in Figure 10.7.

Trademark: A trademark is a distinctive sign that identifies certain goods or services
produced or provided by an individual or a company. A trademark can be a name,
logo, symbol, etc. that can be used to recognise a product or service. It provides
protection to the owner of the trademark by ensuring
the exclusive right to use it to identify goods or
services. It helps consumers to identify and purchase
a product or service. A trademark must be registered.
The initial term of registration is for 10 years.
Thereafter it can be renewed. In order to determine
whether any person or company is using a particular
trademark, a trademark search can be conducted
through the trademark registry maintained by Controller
General of Patents Designs and Trademarks (http://
ipindiaonline.gov.in). The effect of a trademark
registration is limited to that country. Some popular
trademarks in India are given in Figure 10.8.

Industrial designs: An industrial design refers to the
ornamental or aesthetic aspects of an article. A design may
consist of three-dimensional features such as the shape,
surface of an article or two-dimensional features, such as
patterns, lines or colour. An industrial design right protects
the visual design of objects that are not purely functional.
Industrial designs are applied to a wide variety of industrial
products and handicrafts like medical instruments,
watches, jewellery, vehicles, textile designs, etc. The
registered designs of Coca-Cola bottle and iPhone are
given in Figure 10.9.

Fig. 10.7: The first patent for
zipper

Fig. 10.8: Popular Indian
trademarks

Fig. 10.9: Popular
industrial designs
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Geographical indications: Geographical indications are

signs used on goods that have a specific geographical

origin and possess qualities or a reputation that are due to

that place of origin. Agricultural products typically have

qualities that derive from their place of production and

are influenced by factors like climate and soil. Place of

origin may be a village or town, a region or a country.

Some of the popular products with geographical

indications related to Kerala are Aranmula Kannadi and

Palakkadan Matta Rice (Figure 10.10).

B. Copyright

A copyright is a legal right given to the creators for an

original work, usually for a limited period of time.

Copyright applies to a wide range of creative, intellectual or artistic forms of works

which include books, music, painting, sculpture, films, advertisement and computer

software. This covers rights for reproduction, communication to the public,

adaptation and translation of the work.

 In India, the Copyright Act, 1957 came into effect from January 1958. This Act has

been amended five times. Some of the important amendments to the Copyright Act

in 2012 are extension of copyright protection in the digital environment, liabilities

of Internet Service Providers, ensuring right to receive royalties for music composers

and exception of copyrights for physically disabled to access any work.

Under Indian Copyright Act, a work is automatically protected by copyright when

it is created. The general rule is that the copyright lasts for 60 years after the death

of the last surviving author. Registration of copyright

gives a legal status to a creative work . This makes it an

intellectual property, giving exclusive legal right over

the creation. It should be noted that it is not necessary

to register to get the copyright. Copyright registrations

in India are handled by the Copyright Office under the

Ministry of Human Resource Development. The logo of

Indian Copyright Office is given in Figure 10.11.

Table 10.2 shows the different symbols used to specify the registration status of

intellectual property.

Fig. 10.10: Geographical
indications related to Kerala

Fig. 10.11: Logo of Copyright
Office, India
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The copyright holders of a work can authorise

or prohibit

• its reproduction in all forms, including

print form and sound recording;

• its public performance and communication

to the public;

• its broadcasting;

• its translation into other languages;

• its adaptation, such as from a novel to a

screenplay for a film.

Creators often sell the rights of their works to individuals or companies for financial

benefit. Computer software (source code, databases, web sites, etc.) can be

copyrighted as a literary work. Even though computer software is protected under

copyright, nowadays they are increasingly getting patented. This is because software

development is considered as an industry and patents provide better protection when

compared to copyright. It should be noted that the criteria required for obtaining

patent protection is more stringent.

Table 10.3 displays the rights and the related intellectual property. The differences

in the egistration of intellectual property rights are shown in Table 10.4.

INTELLECTUAL PROPERTY

Registered trademark ®

Unregistered trademark ™

Copyright ©

Sound-recording copyright !

Table 10.2: Symbols used for intellectual
property

Table 10.3: Rights related to intellectual property

Intellect Property Right

Idea Invention/innovation Patent

Idea Quality + identity Trademark

Idea Appearance Design

Goods Geographical origin Geographical Indication

Idea Expression Copyright

Table 10.4: Differences in the registration of rights for intellectual property

Patent Trademark Copyright

Refers to Product, Process Name, Logo, Creative, intellectual or artistic

Symbols forms of  work

Registration Required Required Automatic, can be registered

Duration 20 years 10 years Until 60 years after the death

of  the last surviving author

Renewable No Yes
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10.4.2 Infringement

Unauthorised use of intellectual property rights such as patents, copyrights and

trademarks are called intellectual property infringement. It may be a violation of civil

law or criminal law, depending on the type of intellectual property, jurisdiction

(countries) and the nature of the action.

Patent infringement is caused by using or selling a patented invention without

permission from the patent holder. Many countries allow using patented inventions

for research purpose. The legal dispute between Apple and Samsung over their

mobile phone technologies is an example of patent infringement.

Trademark infringement occurs when one party uses a trademark that is identical to

a trademark owned by another party, where both the parties use it for similar

products or services. It is better to register the trademarks to get the legal advantages.

An example of trademark infringement is the legal suit where a small company

manufactured toffees under the trademark 'HORLIKS'. This violated the trademark

rights enjoyed by 'HORLICKS'.

Copyright infringement is reproducing, distributing, displaying or adaptating a work

without permission from the copyright holder. It is often called piracy. Software

piracy is the illegal copying, distribution, or use of software. Music piracy is the

copying and distributing of a piece of music without the consent of the composer,

artist or the copyright holding music company. Enforcement of copyright is generally

the responsibility of the copyright holder.

Know your progress

1. Creation of the mind is known as ________.

2. Expand WIPO.

3. Intellectual property rights are categorised into ____ and _____.

4. Patents are exclusive rights given to ________.

5. ________ is a sign used to recognise a product or service.

6. What is industrial design?

7. What is the importance of geographical indicators?

10.4.3 Cyber space

Cyber space is a virtual environment created by computer systems connected to the

Internet. It is the term used to refer to a simulated world, where we can do many things

at one place. Let us now discuss various instances where cyberspace has influenced

our lives.
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Formerly, communication was mainly dependent on postal service. Nowadays e-mail

has gained wide acceptance and legal validity for communication. In the Department

of Higher Secondary Education (DHSE), all communications to higher secondary

schools related to admissions, examinations, National Service Scheme,

administration, etc. are done through website/e-mail. Today, Internet has become a

popular medium for communication among common people.

In December 2012, a girl student was subjected to inhuman physical torture in a

moving bus in a metro city in India. After a few days the girl succumbed to her

injuries. This incident invoked protests among people from various walks of life.

Social media like facebook, twitter, etc. became a platform for the protest. These

people organised a movement in support of the girl through messages over the social

media. Thousands of people gathered in the streets of Delhi with lighted candles as

a protest. Taking this incident into account, the Loksabha passed 'The Criminal Law

(Amendment) Act, 2013', which strictly deals with sexual assault cases. Such

movements organised over social media, show its influence on society.

People purchase mobile phones, shoes, apparels, etc. by visiting showrooms. Today,

many people prefer to purchase these goods online from e-commerce websites. The

e-commerce sites provide catalogs which display different search options like price

range, brands, etc. about the product. This made shopping easier from the comfort

of home and saves time too.  e-Commerce requires payments through credit cards,

debit cards, Internet banking, etc. Nowadays more and more people are attracted

to online buying and selling. Figure 10.12 shows e-Commerce websites.

Fig. 10.12: Sample e-Commerce websites

Almost all banks offer Internet banking facilities to its customers. Through this facility

we can transfer funds, pay telephone bills, electricity bills, payments for online

purchases, train tickets, cinema tickets, etc. This saves a lot of time and effort when

compared to performing these activities by actually visiting the respective offices.

Hence banking is also a popular service over Internet. An Internet banking website

is displayed in Figure 10.13.
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With the passage of time,

more services are going

online. Many people spend a

considerable amount of time

surfing the Internet to avail of

various services in the web.

Internet is often referred to

as cyberspace.

Figure 10.14 shows a

symbolic representation of

cyberspace.

Cyberspace is an unreal world in which

communication over computer networks occurs. It is

an information superhighway where individuals gather

information, interact, exchange ideas, provide social

support, conduct business, play games, engage in

discussions and so on.

Cyberspace is a space where social interactions

dominate. Some people consider cyberspace as an

uncontrolled and unregulated electronic space where anyone is free to do anything

as they wish and express themselves freely. Such acts of people badly affect or

negatively influence many others. Hence, when an individual works on the Internet,

they have to follow some rules and ethics which are beneficial to all users.

This unregulated space also provides room for criminals. Since activities like

communication, financial transactions, etc. in the cyberspace increases day by day,

it has opened a new medium for criminal activities. Today cyberspace security has

become a serious concern.

Fig. 10.13 : An Internet banking website

Fig. 10.14 : Symbolic
representation of cyberspace

'Cyberspace' is a term coined by William Gibson, a

Canadian science fiction writer, in his short story

'Burning Chrome' (1982). He used it to represent a world

where events or transactions that are not in real world

occur. He believed that cyberspace is a consensual hallucination.

According to Gibson, consensual hallucination is the nature of

existence within cyberspace.
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10.4.4 Cyber Crimes

We know that the Internet has opened new opportunities in entertainment, business,
communication education, sports, etc. At the same time, it is a reality that some
people use the Internet for committing illegal activities.

The increasing use of the Internet through smart phones and tablets for online banking
and other financial transactions has increased the risk. Rising Internet penetration and
online banking provides opportunities for cyber criminals to target online financial
transactions, using malicious software
(malware) or through illegal hacking.
The statistics of cyber crime
committed in the recent years
according to National Crime Records
Bureau is given in the graph shown in
Figure 10.15.  This graph shows the
significant rise of cyber crimes in India
through the years.

Cyber Crime is defined as a criminal activity in which computers or computer
networks are used as a tool, target or a place of criminal activity. The victims of cyber
crime lose money, reputation and face mental trauma.

An important aspect of cybercrime is its nonlocal character. A crime can occur in
jurisdictions separated by vast distances. That is an attacker may operate from a
country and attack a destination in some other country. So the investigating team and
the judiciary of different countries must keep hand in hand. Due to the anonymous
nature of the Internet, it is possible for people to engage in a variety of criminal
activities. People commit cyber crimes knowingly or unknowingly.

Cyber crimes include phishing, hacking, denial of service attacks, etc. which we have
learned in Chapter 9 of Class XI. Computer crime mainly consists of unauthorised
access to computer systems, credit card frauds, illegal downloading, child
pornography, cyber terrorism, creation and/or distribution of viruses, spam and so
on. Cyber crimes can be basically divided into 3 major categories: They are cyber
crimes against individuals, against property and against government.

A. Cyber crimes against individuals

The popularity of broadband Internet increased the dependence of Internet for daily
activities. This increased the risk of online crimes. An act of a person in cyberspace
that causes physical or mental trouble to an individual is referred as cyber crime.
Harassment, assuming some ones identity, impersonation and violation of privacy
are some examples of cyber crimes.

Fig. 10.15 : Cyber crime statistics in India
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i. Identity theft: Identity theft occurs when someone uses another person's

identifying information, like their name, credit card number, etc. without their

permission to commit fraud or other crimes. It is a form of stealing a person's identity,

by which someone pretends to be someone else, to gain access to resources like bank

account, social media accounts, etc. This is done

with the intention of transferring money from the

victim's bank account, payments for purchases,

defaming the person through social media, etc.

This is done with the intention of obtaining credit

from financial institutions or gaining benefits in

that persons name.

Before transferring money from bank accounts, the thief may change the mailing

address of the account so that the victim will not be able to realize that money is

withdrawn. The stolen personal information may be used to open new accounts,

open new credit card accounts, to apply for a mobile phone connection and more.

ii. Harassment: Posting humiliating comments focusing on gender, race, religion,

nationality at specific individuals in chat rooms, social media, e-mail, etc. is

harassment. The use of vulgar or indecent language, threatening any illegal or

immoral act through a computer or a computer network is considered as harassment.

The use of the Internet, to harass someone is called cyber stalking. You might have

read about statements from celebrities that the facebook accounts in their names are

fake. This is because such accounts may contain pictures or posts with defaming

content. These profiles might be created using the photographs and personal

information of the celebrity by people with criminal intentions. There are people who

defame others by sending humiliating e-mails, facebook posts, etc. All these amount

to harassment against person. Common characteristics of cyber stalking include

threats, false accusations, monitoring, identity theft and data destruction or

manipulation. Cyber stalking also includes sexual or other exploitation of minors. It

can destroy friendships, careers, self-image and confidence.

iii. Impersonation and cheating: Impersonation is an act of pretending to be

another person for the purpose of harming the victim. There are people who utilise

the anonymity of the Internet to commit impersonation online.

Sometimes we may receive e-mails seeking help for transferring large amounts of

money from a distant country to India. Usually, the sender states that this money is

in the form of an asset (land, gold, etc.) that is to be sold. To dispose the asset and

complete the legal formalities, the sender requires some amount of money. The mail

requests us to share a portion of the expenses and offers us up to 50% of the value
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of the asset. After receiving the cheque or money order, the sender tells that due to

some complications more money is required. In this way the victim may lose large

amounts. We often receive similar mails with a different story. Mailing scams like this

are examples of Internet fraud/cheating.

Similar crimes occur in online auction also. In some cases, individuals announce

products for sale on Internet auction sites. They demand money before the delivery

of the item and never carry out their order.

iv. Violation of privacy: Violation of privacy is the intrusion into the personal life

of another, without a valid reason. This gives the person whose privacy has been

invaded, the right to file a lawsuit for damages against the person/organisation that

intruded. It consists of distributing private information like personal data,

photography, workplace monitoring videos, etc.

You might have heard of issues regarding the use of hidden cameras, mobile cameras,

etc. to capture images of women in public places. Photography of any person (men

or women) without his/her permission amounts to violation of privacy. Posting

images of others in social media, transferring them to others through e-mail/copying,

etc. without their permission are considered as violation of privacy.

v. Dissemination of obscene material: The Internet has provided a medium for

the facilitation of crimes like pornography. The distribution and posting of obscene

material is one of the important cyber crimes today. Pornography on Internet may

take various forms. It may include hosting website containing prohibited materials,

use of computers for producing obscene material, downloading obscene materials

through the Internet, etc. These obscene content may misguide adolescents.

Most of the cyber crimes occur without the knowledge of the victim, whereas in some

others, the victim also takes part in crime to become rich easily. It should be noted

that various types of preventive mechanisms have been installed to avoid such crimes.

E-mail service providers use spam filter that filters unwanted mails. Different types

of authentication mechanisms that exist for online financial transactions prevent fraud

to a certain extent. Above all, an individual has to be careful while using the Internet.

B. Cyber crimes against property

Cyber crimes against all forms of property like credit cards, intellectual property, etc.

are termed as cyber crime against property. These crimes include hacking, piracy,

computer vandalism (destruction of others property), unauthorised intrusion through

cyberspace, unauthorised possession of information stored in computers, etc. Let us

discuss the classification of cyber crimes against property.
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i. Credit card fraud: Credit card fraud involves an unauthorised usage of another

person's credit card information for the purpose of payments for purchases or

transferring funds from it. There are instances where the web servers of large

organisations are hacked and credit card information of a large number of people

is stolen by Internet thieves. They use this information to make payments or they sell

this information to other fraudsters over Internet for a small price.

ii. Intellectual property theft: The infringement of IPRs come under this category.

Violation of copyright, patent, trademark, etc. are intrusions against property.

Recently, an Indian IT company developed

a software for correcting errors in program

code. One of the employees of this

company copied this software in a CD and

tried to sell it to a competitor for a big

price. This led to huge financial and

property loss to the company. This is

considered as theft of intellectual property.

Software piracy is also a crime under cyber

law.

Nowadays intellectual property theft has become common. Information about any

topic is now freely available on the Internet. Copying of another person's language,

thoughts, ideas or expressions and presenting them as one's own original work is

called plagiarism. There are stringent copyright laws available in India which protect

the intellectual property rights. Plagiarism can be easily detected through various tools

available online.

iii. Internet time theft: Today almost all modems/routers have wireless Internet

facility. They provide sharing of Internet at homes, schools, business establishments,

etc. If this is not properly secured using passwords, other people may use our Internet.

The usage of the Internet time by unauthorised persons, without the permission of

the person who pays for it is called Internet time theft. This leads to loss of Internet

time and money. Above this, others may use our Internet account for committing

crimes, for which we may also be held responsible.

The different types of attacks like viruses, worms, man in the middle attack, etc.,

discussed in Chapter 9 of Class XI also fall under cyber crimes against property.

C. Cyber crimes against government

Increasing popularity of e-governance has made governments vulnerable to cyber

attacks. The various governmental computer networks and websites are vulnerable
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to risks and threats of cyber crimes. The

different categories of cyber attacks against

government are cyber terrorism, website

defacement and e-governance denial attack.

i. Cyber terrorism: Cyber terrorism is a

cyber attack against sensitive computer

networks like nuclear power plants, air traffic

controls, gas line controls, telecom, etc.

These types of  attacks against governments are increasing globally. Cyber terrorism

focuses on the use of the Internet by anti nationals to affect a nation's economic and

technological infrastructure.

In 2010 a computer virus called tuxnet was used to carry out an invisible attack on

Iran's secret nuclear programme. This virus was aimed at disabling Iran's Uranium

enrichment programme. This virus infected large number of nuclear controls and

gave false instructions leading to nuclear malfunctions and break down. Cyber

terrorism may prove to be very costly to a country. Therefore governments provide

very powerful security mechanisms for their servers.

ii. Website defacement: This is a common cyber attack against a government.

Defacement of websites includes hacking of government websites and posting

derogatory comments about a government in those websites.

iii. Attacks against e-governance websites: These types of attacks deny a particular

online government service. This is done using a Distributed Denial of Service

(DDoS) attack which we discussed in Chapter 9 of Class XI. In another case the

website may be hacked and controlled by the hackers. They gain access to website

administration through content management system and destroy the data. This causes

huge loss to the government.

Cyber terrorism has increased in the modern world because of the anonymous nature

of cyberspace. The availability of a variety of targets that affect a large number of

people, and the fact that attacks can be conducted from a distance, have increased

terrorism through cyberspace.

10.4.5 Cyber ethics

The available statistics shows that the volume of cyber crimes is increasing rapidly

all over the world. Internet crime has many faces and is committed in diverse ways.

Awareness is the first step in protecting ourselves, our family and our business. We

should ensure that our actions in the cyberspace do not harm others. We should also

remember that our actions over the Internet are being monitored by several others.
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Suggestions given below can be considered as ethical practices over the Internet.

• Use anti-virus, firewall, and spam blocking software for your PC.

• Ensure security of websites (https and padlock) while conducting online cash

transactions.

• Do  not  respond  or  act  on  e-mails  sent  from  unknown  sources.

• Use unique and complex passwords for accounts and change your passwords

on a regular basis. (Should have a minimum of  8 characters, contain alphabets,

numbers and special characters)

• Do not select the check boxes or click OK button before reading the contents

of any agreement/message.

• Avoid the use of  unauthorised software.

• Do not hide your identity and fool others.

• Do not use bad or rude language in social media and e-mails.

• Remove the check mark against 'Remember me' before logging into your

account using computers other than your personal ones.

10.4.6 Cyber laws

The term cyber law in general refers to the legal and regulatory aspects of the Internet.

Cyber law can be defined as a law governing the use of computers and Internet.

We have already discussed that there are different kinds of cyber crimes. Criminal

activities such as theft, fraud, forgery and defamation are traditional in nature and are

subject to the Indian Penal Code. The abuse of computers (cyber crime) has become

wide spread in India which is addressed by the Information Technology Act, 2000

and IT Act Amendment Bill 2008.

Know your progress

1. What do you mean by cyberspace?

2. Criminal activity using computer, mobile phone and Internet is

termed as __________.

3. What is cyber crime against a person?

4. Cyber terrorism is a type of cyber crime against __________.

5. Stealing one's information such as username and password is ___.

Conduct an awareness program about various cyber crimes.

Prepare a chart listing how we can protect ourselves in cyber space.

Let us do
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Cyber law is important because it touches almost all aspects of transactions and

activities using Internet. Whether we realise it or not, every action and every reaction

in cyberspace has some legal perspectives.

10.4.7 Information Technology Act 2000 (Amended in 2008)

The Information Technology Act, 2000 is India's legislation regulating the use of

computer, servers, computer networks, data and information in electronic format.

The legislation has touched various aspects related to authentication, digital signature,

cyber crime and liability of network service provider. The acts aim to provide legal

recognition for transactions carried out by means of electronic data interchange and

other means of electronic communication. IT Act allows using alternatives to paper

based communication and facilitates electronic filing of documents with government

agencies. It gives legal acceptance for electronic communication. It also addresses

offenses and disputes in the cyberspace and provides justice to victims of cyber

crimes.

IT Act aims to provide legal infrastructure for e-commerce in India. This Act was

developed to promote IT industry, regulate e-commerce, facilitate e-governance and

prevent cyber crimes. It promotes security practices within India that would serve the

country in a global context. Under the Act certain violations are treated as serious

crimes and offenders are liable to penal actions. Therefore it is important to

understand the various perspectives of the IT Act, 2000 and what it offers.

In May 2000, the Indian Parliament passed the Information Technology Bill and it is

known as the Information Technology Act, 2000. The Act was amended by the

Information Technology Amendment Bill 2008, which was passed in December

2008. This amendment accommodates further development of IT and related security

concerns, since IT Act 2000 was passed. Compensation has to be given to affected

persons if damage is done to the computer system or computer network by the

introduction of virus, denial of service, etc. Sections 65-74 of the Act specifically

deals with cyber crimes.

Section

65

66

Punishments

Imprisonment up to three years, or with
fine which may extend up to two lakh
rupees, or with both.

Imprisonment for a term which may extend
to two three years or with fine which may

extend to five lakh rupees or with both.

Offences

Tampering with computer
source code

Computer related offences

SOME COMMON OFFENCES AND THEIR PUNISHMENTS

NOTED IN IT ACT 2000 AND IT AMENDMENT 2008
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Section

66B

66C

66D

66E

66F

67

67A

67B

Punishments

Imprisonment for a term which may extend
to three years or with fine which may
extend to rupees one lakh or with both.

Imprisonment for a term which may extend
to three years and shall also be liable to
fine which may extend to rupees one lakh.

Imprisonment for a term which may extend
to three years and shall also be liable to
fine which may extend to one lakh rupees.

Imprisonment which may extend to three
years or with fine not exceeding two lakh
rupees, or with both.

Imprisonment which may extend to
imprisonment for life.

Imprisonment for a term which may extend
to two to three years and with fine which
may extend to five lakh rupees.

In the event of a second or subsequent
conviction with imprisonment for a term
which may extend to five years and also
with fine which may extend to ten lakh
rupees.

Imprisonment for a term which may
extend to five years and with fine which
mayextend to ten lakh rupees.

Imprisonment for a term which may extend
to five years and with a fine which may
extend to ten lakh rupees.

In the event of second or subsequent
conviction with imprisonment for a term
which may extend to seven years and also
with fine which may extend to ten lakh
rupees.

Offences

Punishment for dishonestly
receiving stolen computer
resource or communication
device.

Punishment for identity
theft.

Punishment for cheating
by personation by using
computer resource.

Punishment for violation
of  privacy.

Punishment for cyber
terrorism.

Punishment for publishing
or transmitting obscene
material in electronic form.

Punishment for publishing
or transmitting of material
containing sexually explicit
act, etc. in electronic form.

Punishment for publishing
or transmitting of material
depicting children in
sexually explicit act, etc. in
electronic form.

Punishment for sending offensive messages through online communication service

like e-mail, social media, SMS, etc. will be according to the sections in Indian Penal

Code (IPC).
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10.4.8 Cyber Forensics

The increase in computer crimes affects our daily lives and national security. Internet

and digital technologies bring us a lot of convenience. But at the same time they also

provide criminals more chance to commit crimes. Traditional law enforcement tools

and methodologies do not successfully address the detection, investigation and

prosecution of cyber crime.

Forensics is the process of using scientific knowledge for identifying, collecting,

preserving, analyzing and presenting evidence to the courts. Cyber forensics can be

defined as the discipline that combines elements of law and computer science to

collect and analyze data from computer systems, networks, communication systems

and storage devices in a way that is admissible as evidence in a court of law. The goal

of computer forensics is to analyse data in a way that preserves the integrity of the

evidence collected so that it can be used effectively in a legal case.

10.4.9 Infomania

Information is considered as the key to success. It has to be collected, managed and

processed well. But what happens if a person gets overloaded with information?

Infomania is the state of getting exhausted with excess information. It occurs due to

accumulation of information from many sources like Internet, e-mail and cell phones,

but cannot be processed. While collecting information, its quality and relevance is also

to be considered. Infomania is the excessive enthusiasm for acquiring knowledge.

This may result in neglecting the more important things like duties, family, etc. We

may see people browsing for information during dinner. It is now treated as a

psychological problem. Constantly checking e-mails, social networking sites, online

news, etc. are the symptoms of infomania. Many people do this to keep themselves

up to date with the fear of being out of the group.

Studies prove that people addicted to infomania lose concentration and sleep.

Excessive use of technology reduces intelligence. Some people give high priority to

respond to incoming messages through mail and social media. These people may

skip or interrupt their important family or professional engagements to answer an

e-mail or a social media post. To get away from such situations, users must learn to

log off social media, online news and discussion groups while they are at work or

spending time with family.

Let us conclude

The convergence of a mobile phone and a computer has shifted the focus from

desktops to mobile computing devices. These devices are always connected to the

Internet and therefore mobile communication technology has gained importance.
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The mobile communication technology has evolved through generations from 1G
to 5G, the prime focus being speed. This also has led to the development of features
like SMS, MMS, GPS, etc. Android is one of the popular mobile operating systems,
developed by Google based on Linux kernel. A person can do a variety of jobs
through cyberspace. Due to its anonymous nature, cyber space has became a venue
for criminals. Crimes can be against a person, property or government. The best way
to be safe is to be aware of the traps in the Internet. The rights of the creator or owner
of music, software, artistic works, inventions, etc. are protected by Intellectual
Property Rights. There are cyber laws which provide the framework for a secure
environment  in cyberspace. India has a robust IT Act. It addresses the different
crimes committed using computers, Internet and mobile phones. Cyber forensics has
emerged as a part of legal proceedings of almost all civil and criminal cases. While
using the Internet, ensure that our actions do not harm others. The term Infomania
is used for addressing the problems created by information overloading.

 Let us assess

1. What is mobile computing?

2. Explain generations in mobile communication?

3. Compare GSM and CDMA standards.

4. Write short notes on SMS.

5. Differentialte GPRS and EDGE?

6. Expand GPS?

7. What is a smart card? How is it useful?

8. Explain the features of  Android OS.

9. What is cyberspace?

10. Why is cyberspace called a virtual world?

11. Phishing is an example of _________.

12. Explain different categories of cyber crimes in detail.

13. “Awareness is the best way to protect ourselves in cyberspace”. Comment.

14. How do trademark and industrial design differ?

15. What is copyright? How does it differ from patent?

16. Explain the exclusive right given to the owner by IPR?

17. What is piracy?

18. What do you meant by infringement?

19. Why is a cyber law important?

20. “Non-local nature of cyber crime creates problems to the investigators”.
Explain.

21.  “Infomania has became a psychological problem”. Write your opinion.
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